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1. Release Notes

Backaground / Environment

Oracle Financial Services Software Limited has developed Oracle Financial Services Lending and
Leasing solution. The suite is a comprehensive, end-to-end solution that supports full lifecycle of
direct and indirect consumer lending business with Origination, Servicing and Collections modules.
This enables financial institutions to make faster lending decisions, provide better customer service
and minimize delinquency rates through a single integrated platform. It addresses each of the
lending processes from design through execution. Its robust architecture and use of leading-edge
industry standard products ensure almost limitless scalability.

Purpose

The purpose of this Release notes is to highlight the enhancements and bug fixes included in the
Oracle Financial Services Lending and Leasing Release.

Abbreviations

Abbreviation | Detailed Description
OFSLL Oracle Financial Services Lending and Leasing
XML Extensible Mark-up Language
XSD XML Schema Definition
GL General Ledger
XLF Extended Log Format
JSF Java Server Faces
EAR Enterprise Application Archive
ul User Interface
WSDL Web Services Description Language
ACH Automated Clearing House
SCRA Service members Civil Relief Act
LOV List of Values

Product Summary

Oracle Financial Services Lending and Leasing Release is built to meet various challenges faced
by financial institutions. It addresses each of the lending processes from design through
execution. Its unique value lies in its ability to provide the business with predefined processes and
a world-class framework that takes care of business risk and compliance needs.
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1.5 Release Highlights

The key highlight of this patch release is to fix the critical bugs and to enhance the industry
specific requirements.
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2. Enhancements

Enhancement

Description

Search capability for
Producer, vendor,
Work Order and
Invoice

New user defined search capability is provided along with existing search for
Producer, Vendor, Work Order and Invoice.

Lease Sales tax
Interface with vertex

OFSLL interface with Vertex to compute and get Lease Sales tax in
Origination and Servicing.

Lease Compensation

Lease compensation chargeback based on the paid off or charged off.

Lease Insurance

Lease insurance for financing of insurance products during origination and
automatically end the insurance.

Lease SCRA

Support for the Service members Civil Relief Act (SCRA) for leasing module.

Lease Securitization

Ability to create securitization pool for the Lease Accounts.

Lease Compliance
ASC 842

Lease ASC 842 report format generation.

Customer Credit Limit

New feature to define credit limit to customer and track the usage of the Limit
for each account (Loan/Line/Lease).

e Sanction Limit to customer

e 360 Degree view of the customer

e Limit Utilization tracking

e Limit reinstating

e Hold limit

e Suspend limit

e Customer Credit Limit transactions (increase/decrease)
e Customer level document upload

e Pricing for the existing customer

e Limit related web service changes

Data Masking

Data Masking capability is enhanced to support robust configuration of
masking Personal Identification Information.

Customer Preference
Web service

Enhanced the customer preference capability to accept the customer contact
preferences through web service which was handled only through user
interface in previous releases.

Permission to text

New flag at each Telecom is provided to take the consent to text for
Customer, Applicant, Producer, vendor, and reference.

Estimated Life of the
Asset

New fields to capture data of Estimated Life of the Asset is added for all
collateral types.
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Enhancement

Description

Lease Enhancements

Support for Weekly, Bi-Weekly, Quarterly and Annual Lease Billing Cycle.
Variable Rate adjustments

Rate caps (Floor and Ceiling)

Flexible repayment (User defined repayment, Step up, Step Down, Balloon)
Lease Contract Expiry Letter

Residual Value Inclusion in Final Bill

Lease Repayment in Advance/Arrears

Lease Termination allowed during life of Lease (Billed Term/Lease
receivables recovered Percentage)

Change Payment
Lease Term Extension
Lease Promotions

Lease Security Deposit adjustment

Lease Sales tax
Internal

Ability to define the Lease Sales tax for internally funded products:
e Setup
o Sales tax definition Origination
= Percentage of Itemization
= |ease Payment Amount
= Total of Lease Payments
= Purchase Price Amount
o Lease Sales Tax Servicing/Collections
=  Upfront
= Payment Stream
o Sales Tax Range definition
o Tax Exemption
e Origination
o Calculate Sales Tax
o New Edits
o Contract Parameters
o Tax Exemption
e Servicing/Collection
o Sales tax as part of the Bill
o Sales tax in Statement
o Sales Tax Payment Stream
o Sales Tax handling in case of Reversal

o Tax Exemption
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Enhancement

Description

Swagger
documentation for
Web service

Swagger documentation is introduced for OFSLL

Note: With this enhancement, the existing web service documentation and

sample zip with request/response files are deprecated.

Web service changes

List of new web services

Change to existing
Web services

List of modified web services
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2.1 Search Screen for Producer, Vendor, Work Order, &

Invoice

2.1.1 Search screen for producers

Search tab is added in Producers screen

Search tab has the following two sections:

Search Criteria

Search Results

Search Criteria

Provided ‘Reset Criteria’ and ‘Search’ buttons to the ‘Search Criteria’ section. These two
buttons doesn’t have any access keys. System uses the same search tab access key to
this i.e. if Search tab is accessible to the logged in user, then these two buttons are
available.

‘Reset Criteria’ button — on click of this, system will clear the search parameter values.

‘Search’ button:

On click of this, system will get the exact Producer details based on the parameter
value provided and comparison operator.

If system finds the data that matching to the values then, system displays the
Producer Details in the ‘Search Results’ section.

If user doesn’t provide any data then system displays an error message ‘No search
criteria defined. Please define minimum one search criteria”

If system doesn’t find any record using the provided information, then system
displays a warning message, “No records found for given search criteria”

“Search Criteria” section has three columns ‘Criteria’, ‘Comparison Operator’ and ‘Value’.

‘Criteria’ — displays the user defined table attribute description

- Provided Producer #, Producer Name, Producer Status, Producer Group,
Producer Type, Producer Grade, and Producer Zip Code parameters to search.

- If user wants to add few more parameters, then user can in new columns in
SEARCH_PRO_PRODUCERS user defined table.

‘Comparison Operator’ — displays the user defined table attribute operator.
‘Value’ — displays LOV or input filed based on user defined table attribute field type.

“Search Results” section displays the following fields along with “Open” button.
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Producer #, Old Producer #, Name, Company, Branch, Start Dt, End Dt, Status,
Contact, Group, Type, Grade

> If user clicks on the Open button or double clicks on the record in search results,
system will open the record in Producer Details tab with ‘Remove Filter’ button.

> On click of ‘Remove Filter’ system displays all the producer records.

Note: If user doesn’t have access to Producer’s tab then system displays an error ‘you
don’t have access to Producer Details screen”.

Search Criteria:

Producers 3 Close

Producer Details | Search

Search Criteria
& ResetCriteria || ) Search

View ¥ Formatv  [Ep Freeze i Detach Wrap o)

Criteria Comparison Operator Value

PRODUCER. # LIKE v

PRODUCER NAME LIKE ~

PRODUCER STATUS LIKE o ~
PRODUCER GROUP LIKE ~ ~
PRODUCER TYPE LIKE ~ “
PRODUCER. GRADE LIKE v ~
PRODUCER. ZIP CODE LIKE v

Search Results
View = Format v @ Freeze ﬁj‘ Detach Wrap Gﬂ
Producer Old Producer = Name Company Branch Start Dt End Dt Status Contact Group

Mo data to display.
< >

2.1.2 Search screen for Vendor, Work Order, and Invoice

Provided a new ‘Search’ tab under Vendors with new access key

o Based on the access setup, user should able to access ‘Search’ tab.

e Provided three new radio buttons ‘Vendor’, ‘Work order’, and ‘Invoice’. By default, vendor
is selected.

2.1.2.1 Vendor search:

On selection of ‘Vendor’, “Search” tab displays below two sections,

e Search Criteria
e Search Results

Search Criteria

o Provided ‘Reset Criteria’ and ‘Search’ buttons to the ‘Search Criteria’ section. These two
buttons doesn’t have any access keys. System uses the same search tab access key to
this i.e. if Search tab is accessible to the logged in user, then these two buttons will be
available.

o ‘Reset Criteria’ button — on click of this, system will clear the Values i.e. system will set
the null value to the value fields and keeps the radio button whatever the user selected it.

e ‘Search’ button
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> On click of this, system will get the exact Vendor details based on the data provided
in the value fields and based on selected comparison operator.

> Displays the Vendor results in the ‘Search Results’ section.

> If user doesn’t provide any data then system displays an error message ‘No search
criteria defined. Please define minimum one search criteria”

>  If system doesn’t find any matching record(s) using the provided information, then
system displays a warning message, “No records found for given search criteria”
e “Search Criteria” section has three columns, ‘Criteria’, ‘Comparison Operator’ and ‘Value’.
> ‘Criteria’ — displays the user defined table attribute description.

Provided Vendor #, Vendor Name, Status, Channel, Phone 1 #, Country, ZIP as
search parameters.

» ‘Comparison Operator’ — displays the user defined table attribute operator.
> ‘Value’ — displays LOV or input filed based on user defined table attribute LOV Type.

e ‘Search Results’ section will show the following fields along with Open button (No access
key is provided for ‘Open’ button)
> Vendor #, Channel, Old Vendor #, Name, Status, Company, Branch, Start Dt, End Dt,
Zip
> If user clicks on the Open button or double clicks on the record in search results,
system will open the record in vendor screen with filter.
> On click of ‘Remove Filter’ system displays all the vendor records.

Note: If user doesn’t have access to vendors tab then show an error ‘you don’t have
access to vendors screen”.

Vendor Search screen:

Vendors [#8] Close

Wendors = Assignment Allocation |~ Woark Orders Involcesl Search |

Search Criteria

Search Options: (@) Vendor () Workorder () Invoice

& Reset Criteria || @8 Search
View ¥ Format¥  [Ep Freeze  gdiDetach Wrap ot}

Criteria Comparison Operator Value
VENDOR # LIKE
VENDOR NAME LIKE
STATUS LIKE
CHAMMEL LIKE
PHOME 1% LIKE
COUNTRY LIKE
P LIKE

R EEEE
<

(2 Open

Search Results
View v Formatv [ Freeze i Detach Virap o)
Vendor # Channel Old Vendor # Name Status Company Branch Start Dt End Dt Zip
No data to display.
€ >

2.1.2.2 Work order search:

On selection of ‘Work order’, “Search” tab displays below two sections:

e Search Criteria
e Search Results
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Search Criteria:

e Provided ‘Reset Criteria’ and ‘Search’ buttons to the ‘Search Criteria’ section. These two
buttons doesn’t have any access keys. System uses the same search tab access key to
this i.e. if Search tab is accessible to the logged in user, then these two buttons will be
available.

e ‘Reset Criteria’ button — on click of this, system will clear the Values i.e. system will set
the null value to the value fields and keeps the radio button whatever the user selected it.

e ‘Search’ button

> On click of this, system will get the exact Work Order details based on the data
provided in the value fields and based on selected comparison operator.

> Displays the Work order results in the ‘Search Results’ section.

> If user doesn’t provide any data then system displays an error message ‘No search
criteria defined. Please define minimum one search criteria”

>  If system doesn’t find any matching record(s) using the provided information, then
system displays a warning message, “No records found for given search criteria”
e “Search Criteria” section has three columns, ‘Criteria’, ‘Comparison Operator’ and ‘Value’.
> ‘Criteria’ — displays the user defined table attribute description.

Provided Work Order #, Case #, Channel, Work order type, Account #, Work order
status, Work order date as search parameters.

> ‘Comparison Operator’ — displays the user defined table attribute operator.

> ‘Value’ —displays LOV or input filed based on user defined table attribute LOV Type.
e ‘Search Results’ section displays the following fields along with Open button (No access

key is provided for ‘Open’ button)

Work order #, Case #, Channel, Account, Collateral Description, Vendor, work order Dt,
Company, Branch, Status, Reason, Work order type

> If user clicks on the Open button or double clicks on the record in search results,
system will open the record in Work order screen with filter.

> On click of ‘Remove Filter’ system displays all the Work order records.

Note: If user doesn’t have access to vendors tab then system displays an error ‘you don’t
have access to Work order screen”.

Work order search screen:

Vendors s (%] Close
Vendors ~ Assignment Allocation  Work Orders  Inwoices Search
Search Options: ) Vendor @ Warkorder O Invoice
Search Criteria
& Reset Criteria || @@ Search
View ™ Format By Freeze  §4iDetach Wrap [oe)
Criteria Comparison Operator Value
WORK ORDER. # LIKE ~
CASE # LIKE ~
CHANNEL LIKE ~ ~
WORK ORDER. TYPE LIKE ~ ~
ACCOUNT = LIKE ~
WORK ORDER. STATUS LIKE ~ ~
WORK ORDER. DT GREATER THAN OR EQUAL ~ E’Eg
[ Open
Search Results
View v Format = Ep Freeze  {diDetach Wrap o0}
Work Order # Case # Channel Account Collateral Desc Wendor Work Order Dt Company Branch Status Reason Workorder Typ
No data to display.
< >
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2.1.2.3Invoices search:

On selection of Invoice, ‘Search’ tab displays the below two sections:

e Search Criteria
e Search Results

Search Criteria:

e Provided ‘Reset Criteria’ and ‘Search’ buttons to the ‘Search Criteria’ section. These two
buttons doesn’t have any access keys. System uses the same search tab access key to
this i.e. if Search tab is accessible to the logged in user, then these two buttons will be
available.

e ‘Reset Criteria’ button — on click of this, system will clear the Values i.e. system will set
the null value to the value fields and keeps the radio button whatever the user selected it.

e ‘Search’ button

> On click of this, system will get the exact Invoice details based on the data provided
in the value fields and based on selected comparison operator.

> Displays the Invoice results in the ‘Search Results’ section.

> If user doesn’t provide any data then system displays an error message ‘No search
criteria defined. Please define minimum one search criteria”

>  If system doesn’t find any matching record(s) using the provided information, then
system displays a warning message, “No records found for given search criteria”
e ‘Search Criteria’ section has three columns, ‘Criteria’, ‘Comparison Operator’ and ‘Value’.
> ‘Criteria’ — displays the user defined table attribute description.

Provided Invoice Type, Vendor Id, Invoice #, External Reference #, Invoice Status,
Channel, and Invoice Date as search parameters.

> ‘Comparison Operator’ — displays the user defined table attribute operator.
> ‘Value’ — displays LOV or input filed based on user defined table attribute LOV Type.

e ‘Search Results’ section will show the following fields along with Open button (No access
key is provided for ‘Open’ button)
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> Vendor, Company, Branch, Invoice #, External Ref #, Invoice Dt, Due Dt, Status,

Chanel

- If user clicks on the Open button or double clicks on the record in search results,
system displays the record in Work order screen with filter.

- On click of ‘Remove Filter’ system displays all the Work order records.

Note: If user doesn’t have access to vendors tab, then system displays an error ‘you
don’t have access to invoice screen”.

Invoice search screen:

No data to display.

Vendors 3] Close
Vendors = Assignment Allocation =~ Work Orders  Invoices | Search
Search Options: (O Vendor O Workarder @ Invoice
Search Criteria
& ResetCriteriz | () Search
View > Format~ 5 Freeze  HffDetach &l wrap [ee)
Criteria Comparison Operator Value
INVOICE TYPE LIKE ~ w
WVENDOR. # LIKE ~
INVOICE # LIKE -
EXTERMAL REFERENCE # LIKE ~
INVOICE STATUS LIKE v v
CHANNEL LIKE ~ ~
INVOICE DATE GREATER THAN OR EQUAL w~ I?(B
[0pen
Search Results
View v Formatv 5P Freeze  HffDetach ¢l Wrap oo}
Wendor Company Branch Invoice # External Ref # Invoice Dt Due Dt Status Channel
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2.2

2.2.1

L ease Changes

Overview

OFSLL by default supports Rent Factor/ Money Factor based lease formula methods with fixed
Index. In the current release, the Lease module is enhanced to support ‘Variable Rate’. To
facilitate this, following changes are done in Setup, Servicing, and Origination modules.

Note the following:

e Lease module is not complaint with the Metro-II credit bureau reporting in this release.

e Rent factor lease only support Monthly (This capability is not enhanced)

e Reports impact of Lease changes is not in current scope.

Summary of Lease supported features:

Rent Factor (Formula Based)

Interest Rate (IBL Method) New

Origination

Advance

Advance / Arrears

Flexible Repayment Schedule

Variable Rate including rate adjustment

Balloon not applicable

Balloon Applicable

Amortization Schedule supported

Amortization Schedule Supported

Commission Commission
Insurance Insurance
- Promotion

Scenario Analysis

Scenario Analysis

Servicing

Residual Valuation Limits applicable

Early Termination Rules

Facility to include residual value in final bill

Maturity Interest Rate applicable

Billing Cycle supported is Monthly

Billing Cycle supported is Monthly, Weekly, Bi-weekly,
Quarterly, Semi Annual, Annual

Expiry Letter Notice

Expiry Letter Notice

Asset Change Usage/ Charge Details
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Rent Factor (Formula Based) Interest Rate (IBL Method) New

- Securitization for Lease accounts

- Scenario Analysis

Lease 842 Report Lease 842 Report

- Transactions to modify transaction parameters
e Account Early Termination

e Check Early Termination Allowed

- Monetary Transactions for Lease
e Rate Change
¢ Index/ Rate Change

e Change Payment

Monetary Transactions for Lease Monetary Transactions for Lease

e Security Deposit e Security Deposit Adjustment Transaction
Adjustment
Transaction

2.2.2 Lease Changes - Setup

Product’ Setup

Lease Product > Header Block Changes

Added following fields to Setup > Product > Lease Product tab.

e System renders following fields & tabs only on selection of ‘Calculation Method’ =
‘Interest Rate’ - Flexible Repayment, Index Rounding, Reschedule Method, Reschedule
Value and Lease Calculation method in ‘Lease Product’ Tab and ‘Rate Adjustment’ tab.

e Default value of ‘Calculation Method’ field for ADD button is ‘Rent Factor'.

Calculation Method = Interest Rate

Lease Product
Save and Stay SaveandRetun | (S Retun

Product LEASE_MAC * Colateral Type | VEHICLE COLLATERAL = Calculation Parameters
*Desar
Description LEASE_MAC * Colateral Sub Type | PERSONAL PROPERTY VEHICLE  [= | « Catuiaon Method [TEREST FETE =]
alcuiation Methor =
N B,
sertot ooy B * Credit Bureau Portfolio Type | INSTALLMENT [=] + Fixible Repayment [
. A y
j;d D: fmﬂmn © * Credit Bureau Account Type | AUTO LEASE [+ Index Rounding | NO ROUNDING TOINDEXRATE [
rect
. . -
* Customer Credit Limit Biling Cydle | MONTHLY = Reschedule Method | UNDEFINED =
* Same Biling Cyde *Category | STANDARD [=] Reschedule Value
* Enabled (V]
ORACLE
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Calculation Method = Rent Factor

Lease Product

Product LEASE_MAC
* Description |LEASE_MAC
*Sartot oyoy00 [y
*EndDt 12/31/4000 (B
* Direct [V
* Customer Credit Limit
* Same Biling Cyde
*Enabled [V]

* Collaters| Type  VEHICLE COLLATERAL
* Colateral Sub Type
* Credit Bureau Portfolio Type

* Credit Bureau Account Type

Save and Stay. Save and Return

[=]
[=
[=]

PERSONAL PROPERTY VEHICLE

INSTALLMENT

Calculation Parameters

* Calculation Methad | RENT FACTOR

[zl

AUTO LEASE =
[=]

[l

*Biling Cyde  MONTHLY

*Category STANDARD

Field Name Reference

Type

Comments

Values in LOV

Flexible
Repayment

Check box | NA

Allows user to define the
Flexible repayment for a
lease Contract.

Index LOV

Rounding

INDEX_RAT
E_ROUND_F
ACTOR_CD

Select the applicable
index rate rounding factor

NO ROUNDING TO
INDEX RATE

INDEX RATE
ROUNDED TO
NEAREST .25

INDEX RATE
ROUNDED TO
NEAREST .125

Reschedule | LOV

Method

RATE_CHG_
RSC_METH
OD_CD

Applicable only for
Calculation method =
Interest Rate

UNDEFINED (the default
value), if user want to
include the impact of rate
change in final bill instead
of impacting payment
amount.

‘CHANGE PAYMENT - if
user want to
automatically recalculate
the repayment amounts
on the interest rate
change.

Here, if change payment
is greater than ‘Max Pmt
Inc/ Life’ (contract setup);
instead of posting ‘Term
change’ transaction,
system exits and do not
post Rate Change
transaction. (Undefined or
Change Payment)

UNDEFINED
CHANGE PAYMENT
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Field Name

Type

Reference

Comments

Values in LOV

Error Message: Rate
Change not allowed, as
new payment amount
exceeds max increase
life.

Reschedule
Value

Numeric

NA

Specify the value in
percent (%) to decide the
repayment change.
Example: If user inputs
10, then the periodic
repayment amount will
change only, if the newly
computed repayment
amount is higher by 10%
of the previous
repayment amount.

If input value is ‘0’,
system changes
repayment amounts with
every index rate change.

Lease Calc
Method

LOV (New
LOV)

NA

Based on the lease
calculation method,
system calculates lease
payment.

Rent Factor (Default
Value)

Interest Rate

‘Product’ Setup Changes — ‘Rate Adjustments’ Tab

Product Itemizations  Rate Adjustments

Rate Adjustments
View v Formatv &P Freeze i Detach Irap 25}
Seq Adjustment Frequency
1 RATE CHANGE OCCURS AT MATURITY

N Period

1.0000

dpadd | AEdt | Evew | o Audt

# of Adjustments Enabled
1.0000 ¥

New ‘Rate Adjustments’ tab is introduced with Add, Edit, View and Audit facilities.

Field Name | Type Reference Comments

Values in LOV

Check box | NA Specify the sequence
number of the rate

change adjustments.

Seq

Consider 1 as the initial
(first) rate change
adjustment frequency. All
subsequent frequencies
will be considered for rate
change adjustments
according to their
sequence number.

NA
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Field Name | Type Reference Comments Values in LOV

Adjustment | LOV RATE_CHAN | Select the frequency RATE CHANGE
Frequency GE_FREQ_T | value for adjustments, OCCURS EVERY X
YPE_CD from the drop-down list. YEARS

RATE CHANGE
OCCURS EVERY X
MONTHS

RATE CHANGE
OCCURS EVERY X
DAYS

RATE CHANGE
OCCURS EVERY
BILLING DATE

RATE CHANGE
OCCURS EVERY
DUE DATE

RATE CHANGE
OCCURS AT
MATURITY

Period Numeric NA Specify the period NA
associated to adjustment
frequency.

# of Numeric NA Enter the number of NA
Adjustments adjustments associated
with the adjustment
frequency.

Example: If user input
value = 2, then rate
payment adjustment
occurs on the loan every
five years and will
happens 2 times before
switching to the next
adjustment frequency.

Enabled Check NA Enable check box NA
Box

‘Pricing’ Setup Changes

Following changes are done in Setup > Pricing screen

Applicable for both Calculation method = Rent Factor & Interest Rate types

e Included ‘Index Type’ as ‘Result’ parameter in pricing definition.
e This LOV refers INDEX_TYPE_CD’ lookup which is considered for Result.
e ‘Capital Cost field renamed as ‘Gross Capital Cost’.

Applicable for both Calculation method = Rent Factor
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e Billing cycle applicable is only ‘Monthly’

e Product LOV displays only product applicable for calculation type = Rent Factor and ‘All’
indicates only those products for calculation type = Rent Factor

e Maturity Index, Maturity From and Maturity To fields are not applicable for pricing
selection.

e Rent Factor from, Rent Factor To, Buy Rent Factor fields and other enabled fields in
figure are applicable and considered for selection criteria.

Pricings . E]

Lease Pricing Definition

Save and Stay Save andRetum | (aRetum

Pricing  DEFAULT_PRICING_LEASE * Maximum Capital Cost  100,000.00 * Asset Class E\
* Description DEFAULT_PRICING_LEASE * Maximum Term 120 * hsset Type ALL =
= 12
startDt 12132003 [ oo *SubType AL =
election Criteria
“endor 3ys00 By * AssetMake AL [=]
* Enabled
* Company ALL [=] * AssetModel AL [+
Result =Branch ALL [~ *age 0
Caleulation Method RENT FACTOR [~ Tradedn AL [+
* Residual % From 20.000000
giling Cyce MONTHLY Mileage 0
B 5
Residual % To |60.000000 *Product ALL [~ *Currency | ALL [=]
*Index FLATRATE -
| = ndex =] *State ALL = * Subvention NONE [=]
-
Rate From 6.0000 *Pro Group | ALL (= *Down Pt 0.00
-
RataTo 12,0000 =ProType ALL [~ * Asset Value 0.00
*Buy Rate 4,0000 ,
*Producer Region  ALL [+ *LTV 0.0000
Rent Factor From 0.002500 .
Rent Factor To 0005000 * Producer Territory ALL [+ Existing Customer ALL [=]
Buy Rent Factor 0.001667 *Channel AL [+ * Existing Customer Sincz (In Years) 0
Maturity Index *Producer AL S
Selection Criteria : Business
Maturity From 0 *Grade AL [+
Maturity To |‘ Grass Capital Cost 0,00 | * Years In Business 0

*LeaseTerm 4

Applicable for both Calculation method = Interest Rate

Billing cycle shown as LOV and applicable is types are ‘Monthly, Weekly, Biweekly,
Quarterly, Semi Annual and Annual

Product LOV displays only product applicable for calculation type = Interest Rate and ‘All’
indicates only those products for calculation type = Interest Rate.

Maturity Index, Maturity From and Maturity To and other enabled fields in figure are
applicable and considered for selection criteria.

Rent Factor From, Rent Factor To, Buy Rent Factor fields are not applicable for pricing
selection.

Promotions LOV displays all list of enabled records from the promotions setup.
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Lease Pricing Defin
B Save and Stay, B Save and Return @_Retum
Pricing DEFAULT_PRICING_LEASE TEST * M_axmlum 1,000,000,000.00 * Asset Class ALL v
* Description  DEFAULT PRICING_LEASE_INT Ea;":jni‘j: . * Asset Type ALL v
*Start Dt 04/21/1996 % Term *SubType ALL v
*End Dt 12/31/4000 % Selaction Criteria * Asset Make ALL v
* Enabled LJ = Asset Model  ALL T
* Company ALL 7 *Age 0
Result
mestt =Branch ALL b Trade-In ALL M
= ReswduFaI % 0,000000 Ca‘ﬁlgtﬂgg INTEREST RATE hd Mileage 0
. rom ) * Currency ALL 5
Reswdual;’: 50.000000 Billing Cycle MONTHLY Y I - Fon | NONE - I
0 romotion
- * Product ALL =
Index FLAT RATE Y rp— - * Subvention  NONE Y
ate
* Rate From  0.0000 = Pro Group AL v * Down Pmt  0.00
*Rate To 12.0000 “Pro Type ALL v * Asset Value 0.00
* Buy Rate 0.0000 “Pproducer | v * LTV 0.0000
Rent Factor (,000000 Region * Existing | v
From “Producer p v Customer
Rent Factor (,005000 Territory * Existing g
To = Channel  ALL v Custurmel Sincg
Buy Rent §,000000 (In Years)
Factor *Producer ALL -
= Ma[tu;ty FLAT RATE v * Grade | ALL v Selection Criteria : Business
ndex
*Maturity .0po0 T Gross | g,00 *YearsIn
From Capital Cost Business
= Maturity To 120000 * Lease Term 4
‘ ’
Contract’ Setup Changes
- F— s
Rearranged or regrouped fields in ‘Contract’ setup screen.
Setup > Contract > Calculation Method = Rent Factor
Contract .
Extension
Instruments Scheduled Dues
Lease Contract Max Extn Peroid /Life 0
Instrument INS-LEASE_COPY_TEST *Due Day Min 1 ™: Extn /Life 0
lax # Extn  Li
* Description | LEASE INSTRUMENT * Due Day Max 31 "leaseType OPERATING  [x] M # of Payments 0
*Start Dt 31/03/2018 [E) * Max Due Day Change [ Year 2 Tax Book Type | CONDITIONAL SA{w]
*End Dt | 31/12/4000 Y * M Due Day Change [Life 5 Depreciation Method ' NONE [=] Rate Cap And
*Enabled (] * Max Due Day Change Days 15 Depreciation Convention | DAY [=] —t
Selection Criteria *Pmt Tolerance Amt 10 T Mex Rate Inc / Year 0
*pmt Tolerance % 95 o Max Rate Inc /Life 0
*Company | ALL [z * Promise Tolerance Amt 0 *Sales Tax Mode | AT CYCLETIME [+ Max Rate Dec [ Year 0
*Branch AL [=] * Promise Tolerance % 0 * Sales Tax Method | PAYMENT STREAM =] Max Rate Dec /Life 0
Calaulation Method | RENT FACTOR || Max # of Adjust { Year 0
Biling Cycle MONTHLY e Max # of Adjust / Life 0
*Product | ALL
rede =] *preBil Days 21 Allowed To Terminate Min Int Rate {Floor) 0.00
-
State ALL [ =EilType STATEMENT [ Biled Term 0 Max IntRate (Celing) 0.00
* Currency | ALL [= =5l Method | LEVEL = Lease Amt Recovered % 0.00
*Pricing | ALL [=] Other
Balloon Method 1 + ,
Residual Details
Accrual

*Rent Accrual Method

ACTUARIAL - MO = |
307380

*Late Charge Grace Days
Base Method
* Stop Accrual Days
Start Dt Basis

* Delq Grace Days
Start Days 0
*Time Bar Years
Time Counting Method | A

* Cure Letter Gen Days

Instaliment Method

PAYME

MONTHLY (MONTH = |

* Cure Letter Valid Days
* Int Amortization Freq
* Delq Category Method

Accrual Post Maturity

Delinguency
Minimum Residual %

Maximum Residual %

Residual Value in Final Bil

Residual Valuation 1

8

£

953

0 Max Pt Inc / Year
Max Pt Inc /Life

* Refund Allowe:

*Refund Tolerance Amt 1,00
Anniversary Period 12
Contract Expiry Letter Days 0

* \Writeoff Tolerance Amt 10,0000

*Recourse [

Payment Caps

* Max Recourse % 0.0000
2 *Repmt Currency ALL [+
2 *PDC Security Check [

* Default Pmt Spread | ACTIVE LEASE-IBL[ = |
* acHFee [
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Setup > Contract > Calculation Method = Interest Rate

Contract
Instruments
Instrument BALLOON TEST
*Description INS- LEASE_VEHICLE
*StartDt 01/24/2018

*End Dt 12/31/4000
* Enabled

Selection Criteria

* Company AL [=]
*Branch ALL [=]

Calculation Method | INTEREST RATE [ |

*Biling Cycle  MONTHLY

*Product ALL
*State AL

* Currency | ALL

[0 JER g En e[

*Pricing | ALL

Accrual

Scheduled Dues

* Due Day Min 1

*Due Day Max 31

* Max Due Day Change | Year |3
* Max Due Day Change /Life 6

* Max Due Day Change Days | 15

*PmtTolerance Amt 10
*Pmt Tolerance % 90
* Promise Tolerance Amt 0

* Promise Tolerance % 0

Lease Contract

* Lease Type | DIRECT FINANCE ]
Tax Book Type | CONDITIONAL SA{x|

Depreciation Method | NONE =1
Deprediation Convention DAY [=]
Tax

* Sales Tax Mode | UPFRONT (CAPIT] |

* Sales Tax Method | PURCHASE PRICE [

illin

* preBil Days |30
*Eil Type | STATEMENT [

*Bil Method | LEVEL [+l
Balloon Method N + 1PMTS

Delinguency

Early Termination

Allowed To Terminate
Biled Term | 5

Lease AmtRecovered % 99

Residual Details

* Rent Acrual Method | INTEREST BEARIN = |
*+Base Method | 30/360 =]
Start Dt Besis EFFECTIVE DATE
*Start Days 0
* Time Counting Method | ACTUAL DAYS [
Instalment Methad EQUATED PAYMENTS
*Int Amortization Freq  MONTHLY (MONTH |

*Late Charge Grace Days 9
* Stop Accrual Days 9999
* Delq Grace Days 0
*Time Bar Years 999
# Cure Letter Gen Days 999
* Cure Letter Valid Days 0
* Delq Category Method DAYS

* accrual Post Maturity [

Minimum Residual % 0
Maximum Residual % 100
Residual Value in Final 8il [
Residual Valuation CONTRACT MARK[ x|

Payment Caps

*Max PmtInc / Year 5

[=] *Max Pmt Inc /Life 10

Extension

*Max Exin Peroid /Life 0
*Max # Extn /Life 0

* Minmum # of Payments 0

Rate Cap And

Adjustments

*Max Rate Inc / Year 20
*Max Rate Inc [ Life 20
*Max Rate Dec / Year 20
* Max Rate Dec [ Life 20
*Max # of Adjust / Year 10
*Max # of Adjust /Life 20

*Min Int Rate (Floar) 1,00

* Min Int Rate (Ceiing) 35.00

Other

| *Rent Collection Method ADVANCE [+] ‘
*Refund Allowed
* Refund Tolerance Amt. 1,00

Anniversary Period 0

| Contract Expiry Letter Days 30

* Writeoff Tolerance Amt 0.0000
* Recourse [0
* Max Recourse % 0.0000
*Repmt Currency AL [=]
*PDC Security Check [
* Default Pmt Spread  ACTIVE SPREAD [
* ACHFee [
Stmt Preference Mode PHYSICAL [=]

Matrix of applicable changes in Contract:

Block

Field
Name

Rent Factor
Method

Interest Rate Method

Default

Selection
Criteria

Lease
Calculatio
n Method

Applicable

Applicable

Rent Factor

Billing
Cycle

Monthly only

Supports Weekly,
Quarterly, Semi Annual,
Annual, Bi-weekly

Monthly

Accrual

Rent
Accrual
method

Applicable

Interest Bearing

For RF- Actuarial
Method is applicable

For Interest — Interest
Bearing is applicable.

Base
Method

Only 30/360
to be shown

Accrual Methods defined
at
ACCRUAL_BASE_MET
HOD_CD

30/360

Start Date
Basis

NA

Applicable

Effective Date

Start Days

NA

Applicable

0

Time
counting
method

NA

Applicable

Actual Days
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Block

Field
Name

Rent Factor
Method

Interest Rate Method

Default

Installmen
t method

NA

Applicable

Equated Payments

Interest
Amortizati
on
Frequency

Daily/Monthly

Daily/Monthly

Monthly

Billing

Balloon
Method

NA

Applicable

N+1

Delinquency

Accrual
Post
Maturity

NA

Applicable

Payment
Caps

Max Pmt
Inc/ year

Max Pmt
Inc/ Life

NA

Applicable

Extension

Max Extn
Period /
Life
Minimum
#
Payments

Max Extns
Allowed

NA

Applicable

Rate Cap
Adjustment

Minimum
#
Payments

NA

Applicable

Other

Max Extns
Allowed

NA

Applicable

Interest Rate -
Advance

| Arrears

Contract
Expiry
Letter
Days

Applicable

Applicable

30

Early
Termination

All Fields

Applicable

Applicable

Residual
Details

All Fields

Applicable

Applicable

Validations:

Both the methods supports only Calendar method = Gregorian.
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Following validations applicable to ‘Product’ where Calculation Method = ‘Rent Factor’

System lists the applicable ‘Products’ based on the Calculation Method = Rent Factor
and Billing Cycle.

System lists the applicable ‘Pricing’ based on the calculation method = Rent Factor

If user selects the any other ‘Billing Cycle’ apart from ‘Monthly’, system will not allow user
to select / input inappropriate value - For rent factor, billing cycle would be defaulted to
Monthly and read only"

> If user selects the any other ‘Base method’ apart from ‘30/360’, system will not allow
user to select / input inappropriate value - System displays error message as
"Selected Rent accrual method is not supported for the Calculation Method Code -
Interest rate”

> If user selects or inputs any irrelevant details like Balloon method or Accrual Post
maturity, Extension, Rate Cap Adjustments — system ignores the selections during
application or account processing or system does not allow user to select / input
inappropriate value.

Following validations to be built based on ‘Product’ where Calculation Method = ‘Interest Rate’.

System lists the applicable ‘Products’ based on the Calculation Method = Interest Rate
and Billing Cycle.

System lists the applicable ‘Pricing’ based on the calculation method = Interest Rate.

If user selects the any other ‘Rent Accrual Method’ apart from ‘Interest Bearing’, system
displays error on save as ‘Invalid Product — Rent Accrual Method’ combination or system
does not allow user to select / input inappropriate value.

System displays only ‘Start Dt Basis’ = ‘Effective Date’, Installment Method = ‘Equated
Payments’, Bill Method = Level / Percentage of Principal Plus Interest / Percentage of
Outstanding Balance, ‘Balloon Method’ = N+1 Payments or system does not allow user to
select / input inappropriate value.

A balance ‘Interest’ is created and applicable only for this method. On load, system loads
this balance.

Lease Contract > ‘Others’ Block

Rent Collection Method

Rent Collection Method — New LOV is defined to show values —Advance/ Arrears.

Based on the selected value, system generates the bill either on contract date or
scheduled billing date.

If user selects ‘Arrears’ as Rent collection method, system will not fire the following EDIT.
ORIGINATION CONTRACT EDITS -- XVL: CON 1ST PMT DT IS <> CONTRACT DATE.

Advance Rent Collection: Contract 15t Payment is deducted as part of the account
creation, 1st payment date and Account creation date/Contract Date should be same.

Arrears Rent Collection: In this case, 15t payment date is more than the contract start
date.

‘Accrual’ Block

New Accrual Method
> ‘Interest Bearing’ method is introduced for lease.

New Base Method field
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> New ‘Base Method’ field is introduced and refers lookup with following values -
ACCRUAL_BASE_METHOD_CD. (365/360, 365/365, 365/366, 360/360, 360/365,
360/366, 366/360, 366/365, 366/366)

>  While calculating the ‘Rent Charge’, system considers the ‘base method’ selected in
contract.

‘Billing’ Definition
e Added new field ‘Balloon method’ - LOV [BALLOON_METHOD_CD] is introduced.
e System amortizes payment based on balloon method selected as N+1 PMTS.
‘Billing’ Cycle
e Added values to billing cycle LOV — Weekly, Quarterly, Semi Annual, Annual, Bi-weekly.

e System supports billing cycle as selected for Lease.
> Due Day Logic:

The value of the due day is the day of the month(1-31) in case of
monthly/quarterly/semi-annually

In case of the weekly/biweekly it is day of the week (1-7).

8/4/2018 | 9/4/2018 | 10/4/2018 | 11/4/2018 | 12/4/2018 | 13/4/2018 | 14/4/2018
SUN MON TUE WED THU FRI SAT
Weekly/Bi- | 1 2 3 4 5 6 7
weekly
Monthly 8 9 10 11 12 13 14

‘Rate Cap and Adjustments’ Definition
e Provided following set of fields in Setup > Lease Contract to define limits.

e List of fields shown below are part of Origination > Contract, Servicing > Contract (View
only), Servicing > Account Details (View only).

e On successful posting of transaction, system updates the counters in Account Details
and Summary Screen.

e Any rate changes (variable rate or transaction posting rate changes) are governed by
these caps defined in setup.

Rate Cap &
Adjustments

* Max Rate Inc f Year
* Max Rate Inc f Life

* Max Rate Dec [/ Year

o |0 B8 o

* Max Rate Dec [ Life

* Max #F Adjust f Year
* Maw = Adjust [ Life
* Min Int Rate {Floor)

* Max Int Rate (Ceiling)

99
999
10,0000

35.0000

Residual Block
New ‘Residual Block’ in Setup > Contract (to Input details)
Origination > Contract (View Only)

Servicing > Contract (View Only) is introduced.

ORACLE

Financial Services
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Residual Caps

Parameter Name | Type Mandatory | Description Default Value
Min Residual % Number | Yes Input applicable Min Residual | O
Amt.

System does not allow less
than zero and greater than
Max Residual value.

Max Residual % Number | Yes Input applicable Max Residual | 100
Amt.

System does not allow less
than Min Residual value and
greater than 100

¢ New Origination > Contract EDITS are created to validate the Min and Max Residual
Values during contract details entry.

e These caps are considered for origination only and not validated in servicing stage (say
for extension etc.)
Residual Value in Final Bill & Residual Valuation:

Residual Value in Final Bill flag

e New field ‘Residual Value in Final Bill’ is introduced to indicate whether residual value of
asset to be included in final bill.

e This flag is applicable only for ‘Finance’ Lease and if user tries to select the check box for
operating lease, system gives ‘Error’ stating ‘Residual Value in Billing’ is applicable for
Finance Lease’ and does not allow user to save the Setup > Contract.

e Whenever bill is generated, system checks whether the generated bill is last bill and
include the ‘Residual Value’ (either Contract Value or FMV based on flag) in final bill.
Here while considering Fair Market Value [FMV], system considers the sum value of all
collaterals where current indicator =Y.

e Here FMV = ‘Retail Base Amt’ in collateral screen.

Residual Details

Minimum Residual 3. 10

Maximum Residual 3= 100

* Residual Value in Final |+
Bill

* Residual Valuation FAIR MARKET VAL |

Parameter Name | Type Mandatory | Description Default Value
Residual Value in | Check Yes Indicates whether ‘Residual No
Final Bill Box Value’ to be included in final

bill.

Residual Valuation

e Fair Market Value -This is the price that a given asset would fetch in the marketplace at
the end of the lease term.
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e Contract Value — This is the price that is determined as residual value during the
contract agreement time.

Parameter Name | Type Mandatory | Description Default Value
Residual LOV Yes New lookup to choose Default
Valuation residual type Purchase

LOV contains — None, Fair Value

Market Value and Contract
Value

Validations:
e Residual Valuation in dependent flag to ‘Residual Value in Final Bill’.

e If ‘Residual Flag in Final Bill’ field is not yes, system does not allow user to select the
‘Residual Valuation’ LOV and show error message ‘Residual Valuation’ is applicable only
for ‘Residual Amt in final bill’.

e ‘Residual Valuation’ cannot be none, if user selects the residual value in final bill as Yes.

Impact:

e Based on the value selected in LOV, while generating the final bill, system includes either
‘Fair Market’ value or Default purchase value of residual.

Note: Adjustment to ‘Statement’ is handled by adjusting balance and no transaction is created.

Sample Amortizations Schedules for multiple combinations:
Lease Type = Interest Rate
Lease contract with Advance
Contract Start Date: 01/01/2018
Lease Amount = $ 1,000000
Term=4
Residual Value=10%
Rate = 4.99%

Amortization Schedule
View = Fomat~ & Freeze g Detach Wrap H
Seq PmtDt Pmt Am Lease Receivable Income Balance Amt
101/01/2018 20,186.51 20,186.91 0.00 78,813.09
202/01/2018 20,186.91 19,855.02 33189 59,958.07
3 03/01/2018 20,186.91 19,937.58 249.33 40,020.49
4 04/01/2018 20,186.91 20,020.43 166.42 20,000.00
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Lease Type = Interest Rate
Lease contract with Arrears

Contract Start Date: 01/01/2018

Lease Amount = $ 1,000000

Term=4
Residual Value=10%
Rate = 4.99%

Amortization Schedule

View v Fomatv  Ep Freeze i Detach Virap @) 38 Amortize | 3 Print Report
Seq Pmt Dt Pmt Amt: Lease Receivable Income Balance Amt
102/01/2018 20,291.52 19,875.69 415,83 80,124.31
2 03f01/2018 20,291.52 19,958.34 333.18 60,165.97
3 04f01/2018 20,291.52 20,041.33 250,19 40,124.64
4 05/01/2018 20,291.52 20,124.67 166.85 20,000.00
Lease Type = Rent Factor
Lease contract with Advance
Contract Start Date: 01/01/2018
Lease Amount = $ 1,000000
Term=4
Residual Value=10%
Rate = 4.99%
Amortization Schedule
View v Format = % Freeze ﬂ' Detach Wrap @E {§}Amﬁrh’ze ‘ElﬁrintReport
Seq PmtDt Pmt Amt Lease Receivable Income Balance Amt
101/01/2018 22,958.33 22,500.00 458.33 77,500.00

2 02f01/2018
3 03/01/2018

22,958.33
22,958.33

22,500.00
22,500.00

458,33
458.33

55,000.00
32,500.00

‘ 4 04/01/2018

22,958.33

22,500.00

458,33

10,000.00

‘Lease’ contract expiry letters Setup Changes

o New letter is introduced ‘Lease Contract’ expiry letter.

e This letter includes brief details of contract along with multiple options available to lessee

like ‘Purchase of Vehicle’, Extension Details etc., (indicative amounts).

¢ New field in Setup > Contract (input field), Origination (Display field), Servicing (Display
field) is introduced called ‘Expiry Letter Days’ which indicates that ‘Lease Expiry Letter’ to

be generated before X’ Number of days from the maturity date.

> New batch job LEASE EXPIRY LETTER is created to generate the ‘Lease Expiry’

letter.

> Usage of generated Letter is done based on letter setup.

> Letter is part of batch job set SET-LTR
e Letter will be generated and archived/email based on the letter setup configuration.
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Lease Expiry Letter ORACLE
Financial Services Lending and Leasing

To,

ROBERT SMITH

(Acc #:20180300021447)
SIZNPROADBCHN#12

Dear ROBERT SMITH

This is to notify that Lease contract is expiring and details are as follows:

Contract Date 03/27/2018
Maturity Date 04/16/2018
Lease Buyout Option | N

Residual Value for 998
Buyout

Please contact Bank Personnel, in case of any discrepancy in numbers.

Notice date: 11" day of April,2018.

‘Promotions’ setup

Setup > Products > Promotions > Lease Introductory

Provided a new tab Lease Introductory screen of Promotions screen allows user to set up the
promotions a financial institution can offer its customers. Promotions can be selected as part of
the Application Entry

User can define an introductory promotion based on the following attributes:

> Type
> Period Type
> Period

» User can define multiple promotions for a product, then select the appropriate
promotion at the time the application is processed. Promotions also serve as a
selection criteria on the Pricing screen.

Note the following:

The system supports promotions selected when a product is funded and currently system
is only supported for interest rate (new calculation method) Products only. Also current
system doesn’t consider the Tolerance amount and Cancel Delq Days parameters.

If user generating the payoff quote while an active promotion on any account, system
doesn’t consider the promotion.

System doesn’t allow to post “Lease Change Payment” monetary transaction on an
account if promotion is active.
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Calculation Method = Interest Rate

Promotions x

Loan Introductory | Line Introductory Lmelncenuvsl Lease Introductory I

[ Cose

Promotion Definition

Format v I 22 g Detach Wrap 5}

View v

¢

Code
PRM-3
<

Description
NO INTREST FOR 3 PERIODS

Promotion Definition

Code PRM-3
*Description NO INTREST FOR 3 PERIODS

*Type NO INTEREST DUE v

k *Period Type  PROMOTION TERM v

*Tolerance Amt  100.00

+

Type
NO INTEREST DUE

Period Type
PROMOTION TERM

Save and Stay Save and Return

*Period 3
* Enabled
*Index FLAT RATE v

*Margin 0.0000

Period

* Cancel Delg Days 12

Lease CalcMethod INTEREST RATE

add | 7 Edit | view qﬁm

Tolerance Amt Index
3 100.00 FLAT RATE
>

{aRetum

/

Field Name | Type

Default Values

Comments

Reference

Code A/N Null

Specify the code identifying
the promotion

NA

Description | A/N Null

Specify a description of the
promotion being offered

LOV NONE

Type

Select the promotion type
from the drop-down list.

LEASE_PROM_T
YPE_CD

Period Type | LOV

Promotion Term

Select the period type from
the drop-down list.

Note: Select
PROMOTIONAL DAYS, if
the length of the promotion
is to be measured in days.
Select PROMOTION TERM,
if the length of the promotion
is more accurately measured
in terms.

PROM_PERIOD_
TYPE_CD

Period Integer | 0

Specify the specific
promotion period. If you
have selected
PROMOTIONAL DAYS in
the Period Type field, then
enter the number of days of
the promotion period
duration. If you selected
PROMOTION TERM, then
enter the number of terms
for which the promotion
applies. Remember that the
system uses the same
length of the term increment
that is used in the billing
cycle for the loan; for
example, weekly, monthly,
semi-annual, or annual.
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Field Name

Type

Default Values

Comments

Reference

Tolerance
Amt

Numbe

0

Specify the dollar amount of
the allowed “tolerance”, if
applicable. This is the
amount that can be
outstanding at the end of the
promotion period.

Note: This applies only to
the promotion type SAME
AS CASH.

Index

LOV

Flat Rate

Select the promotional index
rate from the drop-down list.

INDEX_TYPE_CD

Margin

Numbe
r

Specify the promotional
margin rate

Cancel Delq

Days

Integer

Specify the tolerance days
for the promotion
cancellation due to

Delinquency

Note: Currently there is no
relevance to this filed.

Enabled

Check
Box

Check this box to enable the
promotion

Lease Calc
Method

Read
only

AN

Supports only for New
calculation method.

System defaults the value
while saving the record.

INTEREST RATE

Commission Setup

The Lease Commission Plan screen allows user to configure dealer commission plans for
additional products (for example, life insurance and disability insurance) for lease sold by the
dealer and entered in the Itemization sub screen during lease origination. User can setup the
various commission plans, which system select during funding. In addition to the criteria, user can
also define the insurance itemization, as well as the commission itemization for which the plan is

valid.

e User can select one of the following two system-defined methods to calculate the
commissions:
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> 1. Flat fee
> 2. Percentage of itemization amount.

Commission x ] Close
Loan| Lease
Commission Plan Definition 4 add | Edit ] view ? Audit
View ~ Format + |§\ Freeze ! Detach Wrap 0]
& £ £
Code Description Start Dt End Dt Enabled Calculztion Method
QUA_INS GAP COMMISSION 04/02/2002 12/31/4000 i PERCENTAGE OF TTEMIZATION AMOUN
13
Commission Plan Definition
B Save and Stay, B Save and Returm <@ Return
Code QUA_INS o = Producer PR-00001 : EVER GREEN SERVICES  [»
* Description | GAP COMMISSION Selection Criteria
* Grade ALL v
*siartDr 04022002 By * Company USO1 . « Amt | 10.00
*End Dt 12/31/4000 EZ‘J =Branch USHQ v *=Term 1
* Enabled ¥ * Billing Cycle QUARTERLY v * Asset Class ALL v
Result * Product QUATERLY LEASE VEHICLE A * fisset Type  ALL =
. - " State | ALL v *SubType ALL v
\.E\Ch‘LI‘ILctﬂgg PERCENTAGE OF ITEMIZATION AM( ¥ * Currency  ALL W * Asset Make ALL A
* value | 0.50 * Pro Group | GROUP 1 M = Asset Model ALL v
= Commission | ITM SUBVENTION v * Pro Type | DEALER v “hge 0
Ttemization * Ins/Warranty ITM INSURANCE GAP v
Itemization
Field Name Type Default Values | Comments Reference
Code Text Null Should be unique -
Description Text Null Any text -
Can’t be greater than the
Start Dt Date GL date end date and less than -
year 1800
Can'’t be less than the start
End Dt Date 12/31/4000 date and greater than year | -
4000
Check Check this box to enable
Enabled N . -
box the compensation plan
Results section
. Enabled lookup
Calculation Select the commission .
. codes in
LOV Null calculation method from COMM CALC M
Method the drop-down list. = -
ETHOD_CD
b Specify the commission
Numbe
Value ; 0.00 value )
Can’t be less than zero ‘0’
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Field Name Type Default Values | Comments Reference
Itemization Txn
Codes (Producer
Commission Select the CommiSSion and Thlrd Party
o LOV Null itemization from the drop- | 9r0up)
Itemization down list. (user need to
select appropriate
itemization)
Selection Criteria section
Select the portfolio
company associated with
Company LOV ALL the commission, from the Company Setup
drop-down list.
Select the portfolio branch
Branch LOV ALL assom_ate_d with the Company setup
commission, from the
drop-down list.
Select the billing cycle Enabled lookup
- associated with the codes in
Billing Cycle LoV Monthly commission, from the LEASE_BILL_CY
dropdown list. CLE_CD
Select the product
Product LOV ALL assoc[ate.d with the List of enabled
commission, from the lease products
drop-down list.
Select the state associated | Enabled lookup
State LOV ALL with the commission, from | codes in
the drop-down list STATE_CD
Select the currency ,
associated with the List of e_nab_led
Currency LOV ALL o currencies in
commission, from the Currency setu
drop-down list. y P
Select the producer group | Enabled lookup
associated with the codes in
Pro Group LoV ALL commission, from the PRO_GROUP_C
drop-down list. D
Select. the pr(_)ducer type Enabled lookup
associated with the .
Pro Type LOV ALL commission. from the codes in
L] PRO_TYPE_CD
dropdown list. — —
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Field Name Type Default Values | Comments Reference
Select the producer L'StdOf enalz)led d
associated with the producers base

Producer LOV Null o on selected
commission, from the
drop-down list producer group,

' type, and state
Select the credit grade
associated with the Enabled lookup

Grade LOV ALL commission, from the codes in
dropdown list. PRO_GRADE_CD
Specify the minimum
itemization amount
associated with the

Amt Numbe | 5 55 commission

r

Can’t be less than zero ‘0.
it will compare against the
itemization
Specify the minimum
insurance, warranty term
associated with the
commission, from the

Term Integer | O drop-down list.
Can’t be less than zero ‘0.
it will compare against
insurance term
Select the asset class Enabled lookup
associated with the codes in

Asset Class LoV ALL commission, from the VEHICLE_ASSET
dropdown list. _CLASS _CD
Select the asset ?” enfabled‘ : sset
associated with the ype from "Asset

Asset Type LOV ALL o Type Setup’ where
commission, from the )
drop-down list collateral type is

' ‘Vehicle’
Select the asset sub type
associated with the List of enabled

SubType LOV ALL commission, from the ‘Asset Sub Type’
dropdown list.

Select the asset make List of enabled

Asset Make LOV ALL associated with the Make under
commission, from the ‘Makes and

dropdown list.

Models’ setup
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Field Name Type Default Values Comments Reference
Select the asset model List of enabled
Asset Model LOV ALL associated with the Model under
commission, from the Makes and
dropdown list. Models setup
Specify the asset age
Age integer | O associated with the
commission
. List of enabled
Select the insurance or . N q
Ins/Warranty warranty itemization !':_?_:\n/llzLelt:_tX)nsEun er
o LOV Null associated with the AMOUNTS
ltemization commission, from the INSURANCE'
drop-down list.
group

Insurance Setup

e Most financial institutes offer financing for insurance to the borrowers; examples include
credit life, credit disability, and GAP. The insurance product offer permits the customer to
cancel the insurance in mid-term or automatically end when the product matures or is

paid-off.

e The system supports financing of insurance products during origination and automatically
end the insurance when the product is paid-off. The system also can compute the rebate
premium based on “Rule of 78” or “Actuarial” or “Flat” method.

e As the customer might cancel the insurance in mid-term of the lease, the system
computes the premium rebate on a prorate basis. This also applies to additional
insurance purchase during the life of the lease. Normally, midterm insurance
cancellations have associated fees and grace period. In such cases, the customer may
cancel the insurance during the grace period without accruing any fees.

e However, when a customer cancels after the grace period, the result is a predefined fees
which the system deducts from the computed rebate.

Description Field Validation Default Values | Object Type
Code Should be unique Null Field
Description Free text filed Null Field
Start Dt Should not be less than year 1800 System Date Date
End Dt Should not be greater than year 4000 12/31/4000 Date
Enable - N Check box
Result
Insurance INSURANCE_TYPE_CD Null LOV
Type
Insurance Free text filed Undefined Text Filed
Company
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Cancellation Check box N Check Box
Refund
Allowed

Grace Days Free text fled 15 Number

Refund INS_ REFUND_CALC_METHOD_CD None LOV
Calculation
Method

Cancellation Free text fled 0 Number
Fee

Grace Days - N Check box
Cancellation
Fee Allowed

Deduct Fee CANCEL_FEE_FROM_CD Null LOV
From

Selection Criteria

Company From Company setup ALL LOV

Branch From Branch setup ALL LOV

Product From Lease Product setup ALL LOV

State STATE_CD ALL LOV

Currency From currency setup ALL LOV

Insurance [3] Close

Loan  Line| Lease

Insurance 3 add | Z Edit ] view 2 hudit
view » Format ~ [ Freeze [ Detach Wrap B New Insurance Create Copy
c = Cancellation/Refund
ode Description Start Dt End Dt Enabled Insurance Type  Insurance Company yinee Grace Days
INS DIS FLAT INS DIS FLAT AMOUNT 01/01/1993 12/31/4000 Y INSURANCE DISA...  UNDEFINED Y i+
»
Insurance

[H save and Stay | [ save and Retun | CaReturn

Result
Selection Criteria
> * Insurance Type  INSURANCE DISABILITY M
Code INS DIS FLAT = Company
. = Insurance Company UNDEFINED Company ALL M
=Description INS DIS FLAT AMOUNT + gsanich [0 =
Cancellation/Refund Allowed ¥ -
=Start Dt 01/01/1993 [E) ~ product | ALL =
d Dt 12/31/4000 B ” Grata Days 13
*End Dt 12/31/40¢ = state
" ! * Refund Calculation Method FLAT BASIS v State (AL J
* Enabled = Currency v
* Cancellation Fee 15 Currency (AL
= Grace Days Cancellation Fee @
* Deduct Fee From PREMIUM g
Insurance Details 4 add | Edit view || & Audit
View» Format ~ 5 Freeze [ Detach Wrap o]
Insurance Sub Type Term From Rate Max Coverage Amt Enabled
SINGLE 0 0.0000

Insurance Details:

In this section user can define the different types of insurance details which applicable for defined
insurance type (for information only - there is no functionality behind it.)
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Field Name

Type

Default Values

Comments

Reference

Insurance

LOV

Null

Select the insurance sub
type you want to define for

INS_SUB_TYPE_
CD

Sub Type

the entry in the Insurance
section, from the drop-
down list. For example
SINGLE

Term From

Integer | O

Specify the minimum term
for the insurance sub type.

Rate

Numbe | 0.000

r

Specify the rate for
premium calculation per
$1,000.00 for the
insurance sub type.

Max Coverage

Amt

Numbe | 0.00

Specify the maximum
coverage amount covered
by the insurance sub type.

Enabled

Check N
box

Check this box to enable
the insurance

Lease Compensation Setup Changes:

Compensation setup has been enhanced with below:

e Added PERCENTAGE OF ASSET COST as new compensation calculation Formula
Method and Formula. On selection of PERCENTAGE OF ASSET COST Formula Method
only PERCENTAGE OF ASSET COST Formula should be displayed for user selection.

¢ New Compensation Chargeback criteria will enabled for Paid OFF and Charge OFF.

Compensation Plan Definition

[ save and Stay | [ Save and Return | = Return

Code CL_1 Paid Off Me PERCENTAGE = product ALL v

* Description  COMPENSATION LEASE Paid Off DAYS T =State A v

~stwrtDt 04211996 B *Paid Off Days 90 = Currency AL v

*End Dt 12/31/4000 B = Paid OFf Term 0 = Pro Group AL v

*Enabled = Paid Off Percent 100.00 *Pro Type ALL v
- : e .

Disbursement Method | UPFRONT MONTHEND ~ Charge off Days 0 E An; ;cn
* Formula Method | FLAT AMOUNT ™ Charge Off Term 0 Term 0

*Formula | FLAT AMOUNT * Charge off Percent | 0.00 = Asset Class | ALL v

Selection Criteria = hsset Type ALL v

*SubType ALL v

=Company ALL M * Asset Make ALL v

* Flat Amount 500.00 " Branch AL il Asset Model | ALL v

*Upfront % 50.00 = Billing Cyde  MONTHLY A4 “hge 0
Attribute | Description Object Type | Field Default | Values
Validation | Values | available for
selection
Paid Off | Select the method of the Drop Down - Percent | -Percentage
Method compensation that will be age
recovered by the producer,
if the amount is paid early
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Attribute | Description Object Type | Field Default | Values
Validation | Values | available for
selection
Paid Off | Select the basis used to Drop Down - Blank -Billed Term
Basis determine the amount of _Davs
compensation to be ¥
recovered from the
producer, if the amount is
paid early
Paid Off Specify the number of Input Box Number of | O NA
Days days in which the Days to be
compensation can be entered
recovered, if the Basis is when the
selected as Days Paid Off
Basis is
Days
Paid Off Specify the number of Input Box Number of | O NA
Term days in which the Days to be
compensation can be entered
recovered, if the Basis is when the
selected as Term Paid Off
Basis is
Billed
Term
Paid Off | Specify the percent of the | Input Box - 0 NA
Percent compensation that will be
recovered by producer, if
the amount is paid off
Charge Select the method of the Drop Down - Percent | -Percentage
Off compensation that will be age
Method recovered by the producer,
if the amount is charge off
Charge Select the basis used to Drop Down - Blank -Billed Term
Off Basis | determine the amount of
. -Days
compensation to recover
from the producer, if the -Paid Term
product is charged off as
uncollectable
Charge Specify the number of Input Box Number of | 0
Off Days | days in which Days to be
compensation can be entered
recovered, if the Basis is when the
Days Charge Off
Basis is
Days
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Attribute | Description Object Type | Field Default | Values
Validation | Values | available for
selection
Charge Specify the number of Input Box Number of | 0
Off Term | terms in which Days to be
compensation can be entered
recovered, if the Basis is when the
Term Charge Off
Basis is
Billed
Term
Charge Specify the percent of the | Input Box - 0
Off compensation that will be
Percent recovered by producer if
the account is charged off
as uncollectable, and the
charge off basis is
Percentage
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2.3

Lease Changes - Origination

Origination > Application Entry Screen Changes:

Application Header Block

e If Product > Calculation method = Rent Factor, ‘Billing Cycle’ = Monthly is applicable and
if user selects any other billing cycle, system displays error on save as ‘Only ‘Monthly’
billing cycle is applicable for selected product’.

Application
Save and Stay Save andRetun | GaRetun
App # UNDEFINED Biling Cycle MONTHLY * Class | INDIVIDUAL =
*ot 1213017 By Purpose | VEHICLE LOAN OR LEASE [=] Sales Agent DEMOSUPR
*Product LEASE_MAC [=] *Producer | DEALER [=] | select the producer * Joint [[]
.
* Channel WEB ENTRY [+ *Producer Name [£0-00003 : ED CARROLL MITSUBISHL [+ cosigned [7]
* Priority NORMAL = Producer Contact Number (370)-226-3000 Contact
. = Region ALL Lead # =]
Company [US01 = Territory AL = crepul F
*Branch USHQ [+ Existing Customer __ * Qverride OK
Sub Unit  UNDEFINED Duplicate Application __ * Warning OK
Status Loan Currency USD.
Origination Stage Code

Requested Section (Calculation Method = Rent Factor)

Parameter Name Type Mandatory | Description Default Value
Gross Capitalized Number | Yes Input Gross Capitalized Cost 0
Cost (Existing Field Capitalized

Cost renamed)
Capitalized Cost Number | Yes Input Capitalized Cost Adj 0
Reduction (Same as down payment)
Adjusted Number | Yes Input Adjusted Capitalized
Capitalized Cost cost. (Display only field)
Signing Dt Date No Input applicable Signing Dt
Probable Delivery Date No Input applicable probable
Dt Delivery Dt

Changes to ‘Request Screen’
¢ Rearranged fields as shown below.

e System automatically calculates ‘Adjusted Capitalized Cost’ as Gross Capitalized Cost —
Capitalized cost reduction.

Reduction (-)
Adjusted Cap Cost (=) 50,00
*Pmt Amt 0.00

Summary  Applicant  Business Request Decision Bureau Collateral Comments Tracking Document Verification Correspondence  Tools
Requested Edit View # Audit
View ~ Format » B Freeze Ef} Detach Wrap 5]
Gross Capitalized Cost Capitalized Cost Reduction (-} Adjusted Cap Cost (=) Pmt Amt Term Rate Signing Dt
50,000.00 0.00 50,000.00 0.00 24 7.00
»
Requested
A saveand stay || [ save and Return || Ga Return
* Gross Capitalized Cost 50,000.00 Term 24 Probable Delivery Dt E’ED
= Capitalized Cost 0,00 *Rate 7.00 * Promotion UNDEFINED v

Balloon Amt 0.00
Signing Dt [£)
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Requested Section (Calculation Method = Interest)

Parameter Name | Type Mandatory | Description Default Value
Gross Capitalized | Number | Yes Input Gross Capitalized Cost 0
Cost (Existing Field Capitalized
Cost renamed)
Capitalized Cost Number | Yes Input Capitalized Cost Adj 0
Reduction (Same as down payment)
Adjusted Number | Yes Input Adjusted Capitalized
Capitalized Cost cost. Display only field
Rate Number | Yes Input Rate 0
Balloon Amt Number | Yes Input Balloon Amt 0
Promotion LOV Yes Input Promotion Value Undefined
Signing Dt Date Yes Input applicable Signing Dt
Probable Delivery | Date Yes Input applicable probable
Dt Delivery Dt
Promotion LOV Yes Select the applicable Undefined
promotion

Changes to ‘Request Screen’
e Introduced 'Signing Dt and Probable Delivery Dt’

e Rearranged fields as shown below and Rename Capitalized cost as ‘Gross Capitalized
cost’.

e System automatically calculates ‘Adjusted Capitalized Cost’ as Gross Capitalized Cost —
Capitalized cost reduction.

e User can select the promotion that requested by customers for a variable rate lease.
>  System will show the set of Promotions that linked to the Interest Rate lease pricings.

Requested
[ saveand stay || [ save and Return || (a3 Return
* Gross 13,000.00 *Term 12 Probable Delivery Dt [2:Y
Capitaized
Cost * Rate 0.00 * Promotion  UNDEFINED =
* Capitaized o.00 * Balloon Amt  0.00
Cost -~
Reduction (-} Signing Dt By
* adjusted 12 000.00
Cap Cost (=)
* Pmt Amt 1,000.00

Origination > Decision Screen Changes:

Approved Section

e Following new fields — Gross Capitalized Cost, Capitalized Cost Reduction, Adjusted
Capitalized cost, Index Rate, Decision Margin Rate and Balloon Amount are introduced.

Parameter Name | Type Mandatory | Description Default Value
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Gross Capitalized | Number | Yes Input Gross Capitalized Cost 0
Cost (Existing Field Capitalized
Cost renamed)
Capitalized Cost Number | Yes Input Capitalized Cost Adj 0
Reduction (Same as down payment)
Adjusted Number | Yes Input Adjusted Capitalized
Capitalized Cost cost. Display only field
Index LOV Yes Select applicable index type
Index Rate Number | Yes System default applicable 0
index rate
Balloon Amount Number | Yes Input ‘Balloon Amount’, if 0
applicable

Changes to ‘Decision Screen’ — Rent Factor

Introduced ' Gross Capitalized Cost, Capitalized Cost Reduction, Adjusted Capitalized
cost, Index Type and Index Rate.

Renamed 'Approved Term' as 'Decision Term' and ‘Rate as 'Decision Margin Rate'

Rearranged fields as shown below and renamed ‘Capitalized Cost’ as ‘Gross Capitalized
Cost'.

System does not allow user to select any other index rate apart from ‘Flat Rate’ for
Calculation Method = ‘Rent Factor’

‘Pricing’ is defaulted considering the product / pricing > calculation method = Rent Factor

Changes to ‘Decision Screen’ — Interest Rate

Introduced 'Gross Capitalized Cost, Capitalized Cost Reduction, Adjusted Capitalized
cost, Index Type, Index Rate and Balloon Amt' fields. Here Balloon Amount field
populates from ‘Request’ tab.

Introduced ‘Maturity Index Type and ‘Maturity Rate’ and populate from pricing.
Renamed 'Approved Term' as 'Decision Term' and 'Rate as 'Decision Margin Rate'

Rearranged fields as shown below and rename ‘Capitalized Cost’ as ‘Gross Capitalized
Cost'.

‘Pricing’ is defaulted considering the product / pricing > calculation method = Interest
Rate

Note: In application entry and decision screens - Capitalized Cost Reduction stores value in
‘Down Payment’ field and in contract the same value stores in ‘Cap Cost Reduction’ field.
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Rent Factor

Decision Information

Save and Stay. SaveandReturn | (9Retun
Pricing
Current ¥ Decision Dt 03/07/2018 Status
Pricing RENT FACTOR DEMO PRICING Underwriter RMACHARL Sub Status
Approved
* Dedision Term 12 * Buy Rent Factor 0.002083 Grade [ A RAE El
*Pmt Amt | 1,000.00 * Gross Capitalized Cost 12,000.00 * Saare (300
* Capitalized Cost Reduction (9 0.00 Bureau [=
IndexRate 0,000 Adjusted Cap Cost (=) 12,000.00 Bureau 2 [
* Dedsion Margin Rate | 7.0000 *Residual % 10.0000 Bureau 3 [=]
Pricing Buy Rate 5.0000 Comments
* Approved Buy Rate | 5,0000
*RentFactor 0.002917
Interest Rate
Decision Information
Save and Stay Save andReturn || {3 Retun
Pricin q
Current ¥ Decision Dt 03/07/2018 Status
Pricing PR-NEW-LEASE-VEHICLE Underwriter RMACHARL Sub Status
Approved
* Dedsion Term 12 * Gross Capitalized Cost | 12,000.00 Grade [=]
*Pmt Amt  1,000.00 Capital 0.00 *Score O
= Index PRIME RATE =1 12.000.00 Bureau 1 [=]
Index Rate 12,0000 *Residual % 20,0000 R =
* Decision Margin Rate 4.9900 *Maturity Index | PRIME RATE [+ Bureau 3 [+
Pricing Buy Rate  4.9900 Maturity Margin Rt 4.9900
Comments
* Approved Buy Rate 4.9900 *Balloon Amt | 0.00
Following set of new Edits are created for Lease > Decision Stage
Attribute Description Default Value | Value

XVL_ADC_IRATE_MR
ATE_RATE

XVL : DECISION RATE NOT EQUAL TO
INDEX RATE + MARGIN RATE

ERROR

NA

MAX_ADC_MRATE

RANGE : DECISION MARGIN RATE >
THAN MAX ALLOWED

ERROR

NA

MIN_ADC_MRATE

RANGE : DECISION MARGIN RATE <
THAN MIN ALLOWED

ERROR

NA

XVL_ADC_IRATE_MR
ATE_RATE

XVL : DECISION RATE NOT EQUAL TO
INDEX RATE + MARGIN RATE

ERROR

NA

XVL_ADC_MRATE_
PRP_MRATE

XVL : DECISION MARGIN RATE IS NOT
WITHIN PRICING MARGIN RATE

ERROR

NA

XVL_ADC_RATE_APP
_REQ_RATE

XVL : DECISION RATE NOT EQUAL TO
APP REQUESTED RATE

WARNING

NA

XVL_ADC_RENT_FA
CTOR_PRP

XVL : DECISION RENT FACTOR NOT
BETWEEN PRICING RENT FACTOR FROM
AND TO

This EDIT should be applicable only for
‘Rent Factor’. (not in Seed Data sheet)

Error

NA
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Attribute

Description

Default Value | Value

XVL_ADC_DOWN_A

MT_APP_DOWN_A
MT

XVL : DECISION DOWN AMT NOT
EQUAL TO APP DOWN AMT

Warning NA

XVL_ADC_CAP_CO
ST_ADJ_AIT

XVL : DECISION ADJUSTED CAP COST | Error
<> SUM OF APPROVED ITEMIZATION
DETAILS

NA

Origination > Contract Screen Changes:

e Oninput of ‘Contract Date’, system automatically populates the same value in ‘Revd

Date’.

Contract Section — Produced with ‘Rent Factor’ Based is selected

e System show the fields and layout of contract based on the ‘Product’ selected for

application.

e Following fields are applicable ‘Rent Factor’ based product.

e System lists the applicable ‘Products’ based on the Calculation Method = Rent Factor
and Billing Cycle.

e Here, system displays only ‘Monthly’ for Billing Cycle.

e Index Rate is input field for user and other details are populated from setup > Contract.

e Additional fields introduced in Setup > Contract are shown as VIEW only in Origination >

Contract

e For this method, system doesn’t allow any variable rate and flexible repayment methods.

e If user selects any index rate, apart from ‘Flat Rate’, system displays error on save —
‘Index Rate selected is not applicable for Product Selected’.

e System does not allow user to select any other index rate apart from ‘Flat Rate’ for
Calculation Method = ‘Rent Factor’

Parameter Name | Type Mandatory | Description Default Value
Index Type LOV Yes System default applicable 0

index rate
Index Rate Display | Yes Display based on ‘Index Type’ | O
Contract Margin Number | Yes Input Margin Rate 0
Rate
Contract Rate Display | Yes Sum of Index Rate + Contract | O

Margin Rate
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Contract Information

Save and Stay. SaveandReturn | 5 Retun
* Contract Dt 03/21/2018 £ Verified By Tax
Instrument ; LE; —— T Depreciation Sales Tax Method PURCHASE PRICE
83 Load Instrument Details Sales Tax Mode  UPFRONT (CAPITIALIZED)
* Amt Due at Signing  6,827.33 Deprediation Start Dt E’E'B TaxLfe 0
*Total of Pmts (Estimated) 81,927.96 Deprediation Method | UNDEFINED Adslife 0
*DueDay 21 FirstLast Year Conv DAY Tax Salvage Value 0.00
* istPmtDt 03/21/2018 [E) EOT Value 0.00
Instrument Details
* Maturity Dt 02/21/2018 Q) Tax Book Type COND_SALE
Index FLAT RATE Accruzl Method  ACTUARIAL - MONTHLY
Index Rate 0.00 Start Dt Basis EFFECTIVE DATE PDC
* Contract Margin Rate |6.00 Base Method 30/360 .
Contract Rate 6.00 Bil Method LEVEL e PDf i“:
. ecurity Ind _
* Security Deposit 0,00 Bil Type  STATEMENT
Time Counting Method ACTUAL DAYS
* Gross Capitalized Cost 98,000.00 Calendar Method GREGORIAN
* Capitalized Cost Reduction () 0.00 Installment Method EQUATED PAYMENTS Recourse Details
Adjusted Cap Cost (=) 98,000.00 Stop Accruzl Days 99999
* Residual % | 20,0000 Lease Type DIRECT FINANCE Recourse __
Residual Value (-) 19,600.00 ACHFeeInd _ Recourse Type NONE
* Depreciation Value (=) | 78,400.00 Recourse Reason NONE
Recourse Max % 0.0000
*Rent Charge (+) '3,528.00 N ot 0,00
ecourse Amt 0.
RentFactor 0.002500
*Total of Base Pmis (=) 81,928.00 Others
*Lease Term () |12
Contract Expiry Letter Days 30
*Base Payment (=) 6,827.33
Stmt Preference Mode  EMALL [=]
* Estimated Sales Tax (+) 0.00
Sales Tax 00000
* Estimated Pmt (=) 6,827.33
“Revd Dt 03/21/2018 [y
Verified Dt 03/21/2018 [E:)

Contract Section — Product with ‘Interest Rate’ Based is selected

e System show the fields and layout of contract based on the ‘Product’ selected for

application.

e Following fields are applicable ‘Interest’ based product.

e System lists the applicable ‘Products’ based on the calculation Method = Interest Rate

and Billing Cycle.

e Index Rate is input field for user and other details are populated from setup > Contract.

e Additional fields introduced in Setup > Contract are shown as VIEW only in Origination >

Contract
e Details regarding ‘Early Termination, Residual Details and Other Details like — Rent
Collection Method, Rate Adjustments explained above.

e For this method, system allows any variable rate and flexible repayment methods.

e System considers ‘Rent Collection’ method — Advance / Arrears, while calculating

installment and amortizing the lease schedule.

e System amortizes lease as shown in spread sheet — ‘Lease Adjustments Final'.

e During lease origination up to the funding process, the rate is computed based on the

prevailing index rate.

e However, once the lease is funded, the rate on the lease may change when the index

rate changes (subjected to cap provided at contract definition).

e Existing ‘Rate Change’ batch job is extended to handle lease rate changes also.
Parameter Name | Type Mandatory | Description Default Value
Index Type LOV Yes System default applicable 0

index rate
Index Rate Display | Yes Display based on ‘Index 0
Type’
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Parameter Name | Type Mandatory | Description Default Value

Contract Margin Number | Yes Input Margin Rate 0
Rate

Contract Rate Display | Yes Sum of Index Rate + Contract | 0
Margin Rate

Promotions Block:
e Provided new ‘Promotion Details’ block under ‘Origination > Lease > Contract’
e Under this block, following fields are available.

> Promotion — by default it will show UNDEFINED and displays the all promotions
linked to enable lease pricings.

>  System will populate the following fields from the setup on selection of ‘Promotion’
after save

> Type, Delq Days, Period Type, Period, Tolerance Amt, Index, Index Rate, Promotion
Margin Rate, Promotion Rate

> If the linked promotion type to the contract is ‘Promotional Rate’, then in ‘Origination
> Funding > Tools > Lease Calculator > Import > Calculate’, then system wiill
consider the promotion details and show the rate change reschedule details
according to the promotion and contract details .

Contract Information
Save and Stay SaveandReturn | {aReturn

* Contract Dt |03/23/2018 2 Instrument Details Rate Caps and Adjustments
Instrument | CR-1 = Accruzl Method INTEREST BEARING Increase Per Year 10,00
48} Load Instrument Details Start Dt Basis EFFECTIVE DATE Increase Max Lifetime 10,00
*+ Amt Due at Signing |891.39 Base Method 30/360 Increase Fioor 0,00
= Tatd o Prais [Estimated) (50280 Bill Method LEVEL Increase Ceiling  50.00
b c Bil Type STATEMENT Decrease Per Year 10.00
*DueDay |23 Time Counting Method ACTUAL DAYS Decrease Max Lifetime 10,00
* 1stPmtDt 03/23/2018 [£2) Calendar Method GREGORIAN #of Adjs [ Year 5§
* Maturity Dt |02/23/2019 [2Y Installment Method EQUATED PAYMENTS = of Adjs fLife 10
i PRIE RATE = Stop Accrual Days 99999
ndex -
Lease Type DIRECT FINANCE
Index Rate 12.00 ACH Fee Ind
* Contract Margin Rate 6,00 Post Maturi
Contract Rate 18,00 Tax . .
Defauit Rat
Baloon Method N + 1PMTS ledtree
* Balloon Amt 0,00 Sales Tax Method PURCHASE PRICE *Index PRIMERATE  [=]
Sales Tax Mode UPFRONT (CAPITIALIZED) * M .
« Seaurtty Depost [2.00 B Post Margin Rate | 6.00
axLi
+
Gross Capitalized Cost | 12,000.00 islife [0 Recourse Details
* Capitalized Cost Reduction (-} |0.00
Tax Salvage Value |0.00
Adjusted Cap Cost (=) 12,000.00 Recourse __
EOT Value 0.00 "
 Residual % [10.0000 Recourse Type NONE
y Recourse Reason  NONE
Resicual Value () 1,200.00 Tax Book Type | COND_SALE N " o000
ecourse Max % 0.
B Value (=) | 10,800, N
Deprecition Value (=) | 10,800.00 Early Termination Recourse Amt 0,00
*Rent Charge (+) 1,102.63
*Total of Base Pmts (=) | 11,902.63 Allowed To Terminate Others
+ Lease Term ) [12 Biled Term 2
ease Term (/) ’
Lease Amt Recovered % 0 Rent Collection Method ADVANCE
* Base Payment (=) 991.89 Contract Expiry Letter Days 30
* Estimated Sales Tax (+) 0.00 Residual Details Stmt Preference Mode EMAIL [=]
Sales Tax  0.0000
Minimum Residual % 0 Promotion Details
* Estimated Pmt (=) 991,89 Fromotion Derals
stmatseEm Maximum Residual % 100
*Rovd Dt 03/23/2018 £ Residual Value In Final Bil _ “promotion UNDEFINED [
Verified Dt 03/23/2018 [E Residual valuation R —
verified By SURIYA ooc DlgDays 0
— Period Type
Depreciation R D Period 0
Tolerance Amt 0,00
Depreciation Start Dt 6 POC Security Ind Index
Depreciation Method UNDEFINED IndexRate 0.0000
First Last Year Conv DAY Promotion Margin Rate  0.0000
Rate 0.0000

Payment Caps

Max Pmt Increase / Year 5.00
Max Pmt Incresse /Life 1000

Promotion type behaviour on Lease accounts

e Same As Cash: customer need to make the complete Lease Receivable amount with in
the promotion period then customer can avail the benefit of no interest on it. System
doesn’t accrue interest and full payment will goes to lease receivable.
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> User need to set the First Payment date after promotion end date.
> So, system won'’t bill until promotion ends, Say
- Period Type: Month
- Promotion Period: 3
- Cancel Delg Days : 0 (no relevance because no bills)
— Tolerance Amt: 10 (same as contract write off tolerance amount)

Then, if user makes a complete Lease Receivable amount on or before 3 months from the
contract date then system will waive the accrued interest on the account. If user miss the full
payment then system will start billing. User need to make the 3 months interest and subsequent
bills. In case of Operating Lease, user need to post the residual adjustments manually.

e Promotional Rate: customer can get reduced rate (less than the contract rate) with in
the promotion period. Whether customer makes the payment or not he/she will get the
benefit of the promotion. |.e. system doesn’t accrue additional interest.

> This is applicable only for Flexible Repayment allowed product. Funder need to set
the contract with User Defined Rate Schedule as per the promotional rate and
contract rate

>  After selecting the ‘Promotional Term’ promotion in contract, if user import in Tools,
system will automatically set the user defined rate schedule. After calculate system
will bill at promotional rate till the promotional period and subsequently it will bill with
contract rate. Say
- Type: Month
- Period: 3
— Cancel Delq Days : 0 (no relevance — even customer dishonour the promotion

system will provide the full benefit of the promotion )

— Tolerance Amt: O (no relevance — even customer dishonour the promotion
system will provide the full benefit of the promotion )

- Index : Flat Rate
- Margin: 2
- Contract rate: 7

Then, system will accrue interest for first three months at promotion rate 2% and remaining term
with Contract Rate 7%. System will automatically end the promotion after 3 months and system
will post the rate change transaction.

e No Payment Due No Interest Due: User need to make sure the payment amount is zero
during the promotional period. System doesn’t accrue interest and full payment will goes
to lease receivable.
> As per the schedule system will bill zero amount. Say

- Type: Month

- Period: 3

- Tolerance Amt: 0 (not applicable as payment amount is zero).
- Cancel Delg Days : 0 (not applicable)

- Margin: 0 (should be zero)

Then, system will bill zero amount for three months. Even there are any payments on the account
then system will not accrue the interest. After end of promotion system will post the rate change
transaction.

e No Interest Due: system will not accrue the interest during promotional period. Funder
can schedule the contract with interest or without interest, system will not accrue the
interest and full payment will goes to lease receivable.
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>  System will bill as per the scheduled amount. Say

—  Type: Month

- Period: 3

- Tolerance Amt: 0 (not applicable - even customer dishonour the promotion
system will provide the full benefit of the promotion )

- Cancel Delg Days : 0 (not applicable - even customer dishonour the promotion
system will provide the full benefit of the promotion )

- Margin: 0 (should be zero)

Then, system will schedule as per the schedule and while making the payments on account
system doesn’t accrue the interest during these three months.

Insurance Sub Tab

e If there is any information regarding an itemized insurance amount, system will allows
user to select the insurance plan defined for selected insurance type and enter the details
on the Insurance sub screen. The Insurance sub screen also enables user to calculate
the commission if there is a commission rule defined during Contract set up On click of
‘Calculate’ button, system will identify the commission rule from the new commission

setup and arrive the commission amount.

Financial Services

Field Name Type Default Values | Comments Reference

Policy Information section

Insurance Plan LOV Null Select the insurance plan Lease
associated with the financed Insurance
insurance product. Setup

Insurance Type | Read ITM Description | View the insurance type Contract

only associated with the insurance | Itemizations
plan.

Sub Type LOV Single Select the insurance sub type Lease
offered under the insurance Insurance
plan. Setup

Insurance Text Null Specify the insurance

Company company associated with the
insurance plan. The system
populates the default
insurance plan defined during
product setup

Policy # Text Null Specify the insurance policy
number

Effective Dt Date Null Specify the insurance effective
date.

Term Integer | O Specify the insurance term.

Expiry Dt Date Null Specify the insurance expiry
date.

Commission Text Null View the commission rule. Commission

Rule Setup
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Field Name Type Default Values | Comments Reference

Premium Amt Number | 0.00 Specify the insurance premium
amount.

Commission Number | 0.00 View the insurance
Amt commission amount

Phone No Number | Null Specify the insurance
company’s primary phone
number

Extn Number | Null Specify the insurance
company’s primary phone
extension

Phone No Number | Null Specify the insurance
company’s alternate phone
number.

Extn Number | Null Specify the insurance
company’s alternate phone
extension.

Beneficiary section

Primary Text Null Specify the primary beneficiary
of the insurance.

Secondary Text Null Specify the secondary
beneficiary of the insurance

Cancellation/Refund section

Allowed Check N If selected, a refund is allowed.
box A selected box indicates that
the insurance premium can be
a rebate to the customer in
case of early payoff.

Grace Days Integer Null View the number of grace days
allowed for cancellation
without charging a cancellation

fee.
Calculation Text NONE View the insurance premium
Method refund/rebate calculation
method to be used when
insurance is cancelled.
Grace Day's Check N If selected, indicates that
Cancellation Box cancellation fees during grace
Fee Allowed days allowed fee for the
insurance
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Field Name Type Default Values | Comments Reference
Cancellation Number | Null View the amount of the
Fee cancellation fee to be charged
when the
insurance is cancelled
Deduct Fee Text Null
From

Compensation Changes

e System will populate the following chargeback details under following existing screens

»  Origination > Underwriting > Decision > Compensation
> Origination > Funding > Contract > Compensation
- Paid Off Method, Paid Off Basis, Paid Off Days, Paid Off Term, Paid Off Percent,
Charge Off Method, Charge Off Basis, Charge Off Days, Charge Off Term,
Charge Off Percent.
Contract (2) | Repayment  Itemizations Trade-In Subwention Insurances ESC Compensation Proceeds  Disbursements Fees ACH & Coupot » ™
Compensation F Edit || B view || & Audit
View » Format « % Freeze d‘ Detach Wrap Glﬁ = CH' Load Calculate
Compensation Plan Buy Rate Flat Amt Comp Amt r[‘:iesi:lhuorjement Calculation Method  Paid Calc Method Paid % F
UPFRONT 2.9900 750.00 750.00 UPFRONT MONTH... FLAT AMOUNT PERCENTAGE 80.0000 [
13
Compensation
Save and Stay E Save and Return Cigetum
Compensation Plan UPFRONT Chargeback
Dishursement Method UPFRONT MONTHEND Paid Calc Method PERCENTAGE Calculation
Calculation Method FLAT AMOUNT Paid % 80.0000 Spread Formula FLAT AMOUNT
Paid Basis DAYS Buy Rate 4.9900
Paid Term 0 Buy Rent Factor 0
Paid Days 90 Factor 100
Chg Off Calc Method PERCENTAGE Addl Factor 100
Charge Off % 80.0000 I Max Markup or Percent U.DDDDI
Chg off Basis DAYS Flat Amt 800.00
Chg Off Term 0 Compensation Amt  800.00
Chg Off Days 90
Edits for Contract & Account Onboarding
Attribute Description Default Value | Value
MAX_CON_BALLOO RANGE : CONTRACT BALLOON AMT > | Warning 100000
N_AMT THAN MAX ALLOWED
MAX_CON_FINANCE | RANGE : CONTRACT FINANCE Warning 25000
_CHARGE CHARGE > THAN MAX ALLOWED
MAX_CON_MRATE RANGE : CONTRACT MARGIN RATE > | Error 33
THAN MAX ALLOWED
MAX_REPAYMENT_S | RANGE : REPAYMENT SKIP MONTHS | Error 12
KIP_PERIOD COUNT > MAX ALLOWED
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Attribute Description Default Value | Value
MIN_CON_BALLOON | RANGE : CONTRACT BALLOON AMT < | Warning 100000
_AMT THAN MIN ALLOWED
MIN_CON_FINANCE_ | RANGE : CONTRACT FINANCE Warning 5
CHARGE CHARGE < THAN MIN ALLOWED
MIN_CON_MRATE RANGE : CONTRACT MARGIN RATE < | Error 0

THAN MIN ALLOWED
MIN_REPAYMENT_S | RANGE : REPAYMENT SKIP MONTHS | Error 1
KIP_PERIOD COUNT <1
REQ_REPAYMENT_S Error NA
CHEDULE REQUIRED : REPAYMENT SCHEDULE
REQ_REPAYMENT_T Error NA
YPE_CD REQUIRED : REPAYMENT TYPE
XVL_CON_ACD_ADV | XVL : CONTRACT SUM OF Warning NA
ANCE_AIT ITEMIZATION DETAILS <> SUM OF

APPROVED ITEMIZATION DETAILS
XVL_CON_BALLOON | XVL : FINAL PAYMENT MUST MATCH Warning NA
_FINAL_PMT BALLOON PMT FOR N METHOD
XVL_CON_BILL_MTH | XVL: CURRENT REPAYMENT Error NA
D_FP_REPAYMENT METHOD NOT SUPPORTED WITH FP

BILLING METHOD
XVL_CON_FINANCE_ | XVL : CONTRACT FINANCE CHARGE Warning 10
CHARGE_TOL IS NOT WITHIN TOLERANCE
XVL_CON_INDEX_A XVL : CONTRACT INDEX TYPE <> Error NA
DC APPROVED INDEX TYPE
XVL_CON_INDEX_P XVL : CONTRACT INDEX <> PRICING Error NA
RP INDEX
XVL_CON_MRATE_A | XVL : CONTRACT MARGIN RATE <> Error NA
DC APPROVED MARGIN RATE
XVL_CON_RATE_AD | XVL : CONTRACT RATE <> Warning NA
C APPROVED RATE
XVL_CON_RATE_IRA | XVL : CONTRACT RATE != INDEX Error NA
TE_MRATE RATE + MARGIN RATE
XVL_CON_SKIP_MT XVL : MATURITY DATE MONTH Error NA
H_MATURITY_MTH CANNOT BE SKIP MONTH
XVL_CON_TOTAL_P | XVL: CONTRACT TOTAL OF PMTS <> | Error 0.99
MTS_TERM_PMT TERM * MONTHLY PMT
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Attribute Description Default Value | Value

This is existing Lease EDIT, in current
release; added tolerance of < =0.99
Seed data from EDIT value).

Applicable for Calc method = Rent

Factor
XVL_CON _TOTAL O | XVL: CONTRACT TOTAL OF Error 0.99
F PMTS_EST ESTIMATED PMTS <> TERM *

ESTIMATED MONTHLY PMT

This is existing Lease EDIT, in current
release; added tolerance of < =0.99
Seed data from EDIT value).

This is an existing EDIT, but should be
fired only for Calc method = Rent Factor

XVL_CON_TOTAL_P | XVL: CONTRACT TOTAL OF PMTS <> | Error 0.99
MTS_DEP_RENT DEPRECIATION VALUE + RENT
CHARGE

This is existing Lease EDIT, in current
release; added tolerance of <= 0.99
(Seed data from EDIT value)

XVL_CON_TERM_AS | XVL : CONTRACT TERM > ASSET Warning NA
E_ESTM_LIFE ESTIMATED LIFE

XVL_CON_PREPAID | XVL :CONTRACT AMT DUE AT Error NA
_AMT_ACD SIGNING <> DOWN PMT + PRE-PAIDS

+ 1ST MTH PMT + DEPOSIT
Applicable only for ‘Advance’ billing

Collateral Changes:
e New field ‘Estimated Life’ is introduced at ‘Collateral Details’ block.
e This field is non mandatory field and allows values greater than ZERO.

e This field is introduced at Origination & Servicing > Collateral tab and Collateral
Management Tab.

e Primary Collateral ‘Estimated Life’ captured at collateral field is defaulted in Origination >
‘Contract Screen’
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Collateral Details

Save and Stay. Saveand Return || (@ Return
Type & Description Body
Collateral Type Description Address
Primary ¥ Condition E|
Assetld 3029 * Country UNITED STATES [=]
Asset # 1012 Lien Details County E
* Asset Class E| Address #
Lien Stotus | UNDEFINED =] Address =
* AssetType El Address Line 1
Lien Event Dt [ "‘
SubType CAR El Second Lien Address Line 2
Status ACTIVE Holder Zp =
Select Make and Model - Comments )
Zip Extn
*Year 0
| | City
Estmated Life 0
State B
Make UNDEFINED
Model UNDEFINED LienRelease | cusTOMER =]
Entity
Identification # Entty Name =

Calculator Changes:

Provided a new ‘Calc Method’ LOV with two values, Rent Factor and Interest Rate.

>  System will default the screen based on the ‘DEFAULT’ sub code maintained in
CALC_METHOD_CD lookup.

Provided new ‘Rent Collection Method’ LOV with two values, Advance and Arrears.

>  System will default the LOV based on the ‘DEFAULT’ sub code maintained in
RENT_COL_METHOD_CD lookup.

> But for Rent Factor, system makes it as read only with ‘Advance’ and ‘First Pmt Dt’
as read only and system will set the date to ‘Contract Dt'.

> For Interest Rate system makes it as selectable. If user selects it as ‘Advance’ ‘First
Pmt Dt’ will be read only and system will set the date to ‘Contract Dt'. If user selects it
as ‘Arrears’ then user can select any date greater than or equal to Contract Date.
Even the Contract Date is equal to First Payment Date system doesn’t validate.

Provided the following sections for ‘Interest Rate’ method

> Repayment Options with ‘Flexible Repayment Allowed’ check box and Type LOV
(defaulted with ‘UNDEFINED”).

>  Skip Months, Repayment Schedule, Payment Change Schedule, Rate Schedule,
Amortization Schedule sections

Provide the following sections for ‘Rent Factor’ Method
> Repayment Schedule and Amortization Schedule sections.

Parameters Block

Following highlighted fields are part of ‘Lease’ calculator (applicable for all options like
‘Calculate Payment, Calculate Rate, Calculate Residual Percentage and Calculate Gross
Capitalized Cost.

If the Product type = ‘Interest Rate’ based, system displays the lease calculator including
‘Rent Collection method — Advance / Arrears’,

Stand-alone Lease calculator displays these options based on LOV.
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Repayment Options Block:

>  System displays following options in ‘Repayment Options’ block and allows user to
select Type as ‘Skip Period, User Defined, Graduated Payment and Extended

Balloon’.

> Amortization Schedule for Lease is the new feature provided for — Rent Factor Based
> Note: The amortization schedule excludes the tax amount to be paid for instalment

amount.

For Rent Factor

o System will populate the repayment schedule only for Calculate Payment. Still user can
amortize the schedule for any Parameter

e User need to provide the Rent Factor to ‘Calculate Rate’. (User first need to calculate
payment and then calculate rate)

Rent Factor screen changes:

Lease Calculator x

Lease Calculator

Parameters

*Calc Method RENT FACTOR

[~

@ Calculate Payment () Calciate Rate (©) Calaulate Residusl Percent (©) Calculate Gross Capitalized Cost

Adjusted Capitaized Cost 12,000.00
Residual Value(-)  1,200.00

G print Quote

& mtalze

Total of Base Pmis (=) 10,800.00

[f) colaiete

*Term 12

* Contract Dt 04/18/2015 S Resdusl % 10.0000 pase Payment (=) [EO0IE0
FirstPmt Dt 04/18/2018 Depredation Value (=) 10,800.00 Rent Collection Method
Rent Charge (+) 0.00
Maturity Dt 03/18/2018 Billng Cycdle  MONTHLY
*Rate 0.0000
Gross Capitalized Cost 12,000.00
RentFactor 0,000000
Capitalized CostReduction 0.00
Repayment Schedule
View v Format = Ep Freeze £ Detach Wirap @ add  cancel save 3§ Clear User Payments
= Seq = Pmt Amt. * % of Payments * Generated
1 12 Y
Amortization Schedule
View v Format = B Freeze i Detach Wirap § 483 Amortize | &) Print Report
Seq Pmt Dt Pmt Amt Lease Receivable Income Balance Amt
104/18/2018 900.00 900.00 0.00 11,100.00
2 05/18/2018 900.00 900,00 0.00 10,200.00
3 05/18/2018 900.00 900,00 0.00 9,300.00
407/18/2018 900.00 900,00 0.00 8,400.00
5 08/18/2018 900.00 900,00 0.00 7.500.00
Lease Calculator =g
Lease Calculator
Parameters
@ Calculate Payment (©) Calculate Interest Rate (©) Calculate Term () Calculate Lease Amount. 453 Initialize [E] calculate (E} Print Quote
*Rate 0.0000 *Time Counting Method  ACTUAL DAYS [=]

*Calc Method | INTEREST RATE
*Contract Dt 04/18/2018
*FirstPmtDt 05/18/2018
Maturity Dt 04/13/2018
Gross Capitalized Cost 12,000.00
Capitalized Cost Reduction 0.00

¥ Adjusted Capitalized Cost 12,000.00

Residual Value(-) 1,200.00

Residual
Deprediation Value (=) 10,800.00
Rent Charge (+) 0.00

10,0000

Repayment Options

Flexible Repayment Alowed ]

Type

=

&
)

Total of Base Pmts (=)  10,800.00
*Term 12

Base Payment (=)

* Balloon Pmt Amt 0.00

Calculator Options

*+Rent Collection Method ARREARS
*Biling Cycle  MONTHLY
*Balloon Method N + 1 PMTS

* Accrual Base Method | ACTUAL/ACTUAL

Skip Months

Jan
May

sep

Feb [] mar (] apr
un [ 3 [ Aug

oct [} nov [l pec

=
[=]
[=
=

* Instaliment Method  EQUATED PAYMENTS  [=]
*Bil Mcthod | LEVEL [=]
Accrual Start Dt Basis

Accrual Start Days 0

First Period

Calendar Days 30
Interest 0.0000
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Troe

Repayment Options

Flesible Repayment Allowed [7] Select the Repayment Type

Repayment Schedule
View - Format~ [ Freere [ Detach wrap @ dadd  condl Eseve 3 Cear User payments

No data to display.

Payment Change Schedule

View - Format ~ [ Freeze  [of Detach Wrap W dPadd  Cancel Save Clear Table
= 52q * Option Type = Frequency = period =% of Ads =value
Mo data to display.
Rate Schedule
View w Format [ Freeze [ Detach Wrap W dpadd  Cancel EHsave 3 ClearTable
* * Rate * Start Dt
No data to display.
Amortization Schedule
View ~ Format~ B} Freeze [l Detach Wrap W & Amortize Z, print Report

Seq Pmt 0t Pt Amt Lease Recaivable Income Balance Ame
Mo deta to display.

|user permen I8 Jan [] Feb [] Mar | Apr
May [ Jun [] Jul [] Aug

Sep [[] ©ct [] Mov[] Dec

= seq # Pt Amt # # of Paymants = Ganeratad

Origination Scenario Analysis

Provide following Fields
» Calculation Method, Balloon Pmt Amt,
»  Calculator Options as read only

- Rent Collection Method, Billing Cycle, Balloon Method, Actuarial base method,
Time Counting method, Instalment Method, Bill Method, Actuarial Start Dt Basis,
Accrual Start Days,

>  First Period as read only
- Calendar Days, Interest
‘Rent Collection Method’ LOV with two values, Advance and Arrears.

e For Interest Rate system populates the value form selected contract. If it is ‘Advance’, ‘First
Pmt Dt’ will be read only and system will set the date to ‘Contract Dt’. If user selects it as
‘Arrears’ then user can select any date greater than or equal to Contract Date. Even the
Contract Date is equal to First Payment Date system doesn’t validate.

Provided the following sections for ‘Interest Rate’ method
> Repayment Options
- ‘Flexible Repayment Allowed’ is populated from the selected product
- Type is defaulted as ‘UNDEFINED’ only.
»  Skip Months
> Repayment Schedule
> Payment Change Schedule
> Rate Schedule
> Amortization Schedule
Provided the following sections for ‘Rent Factor’ Method
> Repayment Schedule
> Amortization Schedule

After creating the Scenario Analysis record, system defaults the ‘Calc Method’ based on the
selected product.

On click of ‘Suggest, system considers the ‘Calc Method’ linked to the selected product and
populate the pricing and instrument. Along with this,

>  System updates the Residual % form the pricing i.e. with Residual % from and Rate
based on the pricing i.e. Index Margin Rate + Rate From

> System defaults the ‘Calculator Options’ linked to the suggested instrument

On click of ‘Calculate’, system also updates the First Period details.
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On click of ‘Initialize, reset the values to defaults.

On click of ‘Create Application’, system creates application with ‘Calculator Options’

Scenario Analysis 3 =4
Scenario Analysis e add || Zedt | [Evew || o audit
View v Format + Freeze  fiDetach Wrap [ Product Type © Loan @ Lease Tnquiry 1d 3004 =) (L Show Details hSuggest [ Calalate o Create App {5} Initialize (4 Print Quote:
Gross Capitalized €
Company Branch Incuiry Id Application # FirstName Last Name Phone Email Product Producer Type Producer Name petse
uso1 UsHQ 3004 TESTLEASE21321 TESTLEASE21321 (034)-543-5435 DEMO RENT FACT... DEALER CA-00002 : RAND. 10,000.00
< . v
Lease Calculator  Subvention  Compensation
Parameters
53 Initialize
Adjusted Capitalized Cost 9,990.00 Total of Base Pmts (=) 8,168.48
CalcMethod RENT Residual value(-) 1,998.00 Term 10
* Contract Dt | 03/23/2018 [E) Residual % 20,0000 Base Payment (=) 816,85
First Pmt Dt 03/23/2018 Depredation Value #,992.00 Rent Collection Method = AD CE
P Maturity Dt 12/23/2018 RentCharge (+) 176.58 Biling Cyde MONTHLY
o Rate 9.9900 Hine e
Gross Capitalized Cost 10,000.00 Rent Factor 0.007079
Capitalized Cost Reduction 10,00
Repayment Schedule
View v Format = Ep Freeze [ Detach Wrap W dradd  Cancel Save 9§ Clear User Payments
*Seq *Pmt Amt. * # of Payments * Generated
1 816.85 10 Y
Amortization Schedule
View ~ Format ~ g Freeze (A Detach Wrap @ 8 Amortze 3, PrintReport
Seq Pmt Dt Pmt Amt Lease Receivable Income Balance Amt
103/23/2018 0.00 799.20 49.90 9,190.80
2 04/23/018 0.00 799.20 49.50 8,391.60
3 05/23/2018 0.00 799.20 49.90 7,592.40
4 06/23/2018 0.00 799.20 49.90 5,793.20
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Scenario Analysis [E3[
Scenario Analysis Gpadd | AEdt | [Fview | o Audit
View > Format + Fresze ! Detach ¢l Wirap ) Product Type OLoan @) Lease InquiryId 0 = (L) 5how Details »
Company Branch Inquiry Id Application # First Name Last Name Phone Email Product Producer Type Producer
No data to display.
< >
Lease Cakulator ~ Subvention — Compensation
Rate 0.0000 Time Counting Method
Calc Method T = I Total of Base Pmts (=) 0.00
I o N Installment Method TS
= [ Term 0
ContractDt 01/08/2018 i) Sl Method
*FirstPmt Dt 02/08/2018 ) Base Payment (=) 0.00
Accrual Start Dt Basis B
Maturity Dt 01/08/2018 I * Balloon Pmt Amt 0.00
Accrual Start Days 0
Gross Capitalized Cost 0.00
Calculator Options
Capitalized Cost Reduction 0,00 First Period
Adjusted Capitalized Cost 0.00 *Rent Collection Method  ARREARS
Residual Value(-) 0.00 Calendar Days 0
Residual % 0.0000 Bilng Cycle B Interest 0.0000
Depredation Value (=) 0.00 Balloon Method | 1 + 1 PMTS
Rent Charge (+) 0.00 Accrual Base Method  ACTUAL/ACTUA
Repayment Options
Flexible Repayment Allowed  [] Skip Months
Type Jan Feb Mar Apr
May | Jun ] 3ul[] Aug
Sep Oct Mov Dec
Repayment Schedule
View v Format~ [ Freeze i Detach I wrap @ add  Cancel save 3§ Cear User Payments
*Seq *Pmt Amt * #of Payments * Generated
No data to display.
Payment Change Schedule
View ¥ Formatv g Freeze  pfDetach ¢l wirap @) padd  Cancel [ save 3 ClearTable
*Seq * Option Type * Frequency * Period * % of Adjs *Value
No data to display.
Rate Schedule
view = Format v = [Ep Freeze fiDetach o Wrap @ padd Cancel [Fsave 3 CearTable
*Seq *Rate *StartDt
No data to display.
Amortization Schedule
view v Formatv | [&p Freeze pdiDetach ¢l wrap W % Amortze &, Frint Report
Seq PmtDt Pmt Amt Lease Receivable Income Balance Amt
No data to display.

Origination > Underwriting > Scenario Analysis > Compensation tab has enhanced with new
fields. On selection of the compensation and click of load, system populates below additional filed

e Paid Off Method, Paid Off Basis, Paid Off Days, Paid Off Term, Paid Off Percent, Charge
Off Method, Charge Off Basis, Charge Off Days, Charge Off Term, Charge Off Percent
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2.4

Lease Changes - Servicing

Servicing > Contract / Account Information Changes:

e Additional fields captured in Contract and Origination are shown under Contract Details.
e Additional fields captured in Contract and Origination are shown under Account Details

with Current Values.
> Changes are highlighted in boxes.

Servicing > Contract Information Screen (Interest Bearing Method)

Contract

o8/15/2018

tmated) 13,372,352
Balloon Amt_0.00
DueDay 15 T
iat PmEDE 07/15/2016
Maturity DE_06/15/2018
Index  PRIME RATE
12.00
s.00

ax Method
Lease Type

Bl Cycle
Pre Bl Days

Bane Payment (=)

Estimated Tax (+)

Allowed Ta Terminate
Biled Term

a6/15/2016

08/15/2016

v SURABMI

Deprecation Start Dt Residusl Value 1n Finsl Bl

Residual valuation

0.00 Poc
0.00 PDC Security Tnd
0.00

Lease Amt Recovered % 0

Gamenrn

INTEREST BEARING
EFFECTIVE DATE
307360

LeveL

STATEMENT

ACTUAL DAYS
EQUATED PAYMENTS

o
a9599

Lease contract

UPFRONT (CAPTTIALIZED)
PURGHASE PRICE
DIRECT FINANCE

0.00

g
Default Rate »

MONTHLY dex  PRIME RATE

Early Termination others

Stmt Freference Mode  EMAIL

Promation NOME
Type NONE
Pramotional Period Type

Servicing > Account Information Screen (Interest Bearing Method)

IAccount Information

Interest and Accruals

Accrual Start Dt 11/10/2017

Recourse Type
Recourse Reason
Max Recourse % 0,00

Last Accrual Dt 03/29/2018
Stop Accrual
Accrual Method INTEREST BEARING
Base Method 30/360
Accrued Interest 0.00
Index Type PRIME RATE
Index Rate 450
Margin Rate 4,99
Rate 9.49
Depreciation Value 10,800.00
Residual Value 1,200.00
Residual % 10.00
Rent Charge 743.19

f Due Day

# of Extensions (Life) 1
# of Extension Tem (

changes(Year) 0
# of Due Day changes(Life) 0 Start Date
Last Extn Dt 03/29/2018 Expiry Date
Due Day Change Dt
Others

Allowed To Terminate ¥

Lease Amt Recovered % 0

Extn and Due Dates Recourse Amt  0.00

e) 2 Cure Letter

Early Termination i
Stmt Preference Mode EMAIL

Time Zone

Billed Term 0
Time Bar Details

Balloon Amt 0.00
Residual Value In Final Bill —
Residual Valuation

Rate Change Details

Rate Start of the Year 9.49
Last Rate Adj Dt

# of Rate Adjs

# of Rate A )

Reschedule Method

Reschedule Value

Start Date 3/29/2018
End Date 3/28/2117
Days to Time Bar 36,158

Additional Details
Total Term 14
Paid Term 1
Maturity Dt

Settlement Information

Effective Dt
Good Through Dt
Agreed Amt
Paid Till Dt

Recourse Details

Recourse
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Servicing > Contract Information Screen (Rent Factor Method)

Contract Information
Gagewn
ContractRecvd Dt 03/21/2018
Contract Contract Verify Dt 03/21/2018
Contract Verified By PRITAM Lease Contract
ConfractDt 03/21/2018
Instrument CR-141 Deprecation Sales Tax Mode UPFRONT (CAPITIALIZED)
AmtDue at Signing 6,827.33 Sales Tax Method PURCHASE PRICE
Total of Pmts (Estimated) 81,927.96 Depreciation Start Dt Lease Type DIRECT FINANCE
Due Day 21
1stPmtDt 03/21/2018 Tax Billing
Maturity Dt 02/21/2019
i FLATRATE Tax Life 0.00 Bill Cyde MOMTHLY
Index Rate 0.00 AdsLife 0.00 Pre il Days 21
Contract Margn Rate 6,00 Salvage Value 0.00
ContractRate 6.0000 EOT Value 0,00 £oc
SEEU_HW Deposit 0.00 Instrument Details POC
Gross Capitalized Cost 98,000.00 POC Security Tnd __
Capitalized Cost Reduction () 0.00 Accrual Method  ACTUARIAL - MONTHLY
Adjusted Cap Cost (=) 98,000.00 ctartDtEass EFFECTIVE DATE Recourse Details
Residual value (-) 19,600.00 Base Method 30/%60
Residual % 20,0000 iling Method LEVEL Recourse __
Depreciation Valus (=) 78,400.00 Biling Type. STATEMENT Recourse Type
Rent Charge (+) 3,528.00 Time Counting Method ACTUAL DAYS Recourse Reason
Rent Factor 0.002500 Instalment Method EQUATED PAYMENTS Max Recourse % 0.00
Total Of Base Pmis (=) 81,928.00 Calender Method GREGORIAN Recourse Amt 0,00
Lease Term () 12 StartDays 0
Base Payment (=) 6,827.33 Stop Accrual Days 99899 Others
setmetedSdes Tax (9 .00 ACHFeeInd Stmt Preference Mode EMALL
Sales Tax % 0.0000
Estimated Pmt (=) 6,827.33
Servicing > Account Information Screen (Rent Factor Method)
Account Information
{aRetum
Interest and Accruals Reschedule Value Recourse Amt 0.00
Accrual Start Dt 01/23/2018 Cure Letter
Last Accrual Dt 01/23/2018 Extn and Due Dates
Stop Accrual __ # of Extensions (Life) 0 Start Date
Accrual Method  ACTUARTAL - MONTHLY # of Extension Term (Life) 0 Expiry Date
Base Method  30/380 # of Due Day changes(Year) 0
Rebate Method ACTUARIAL - MONTHLY # of Due Day changes(Life) 0 Othets
Index Type FLAT RATE LastExtn Dt
Index Rate 0.00 Due Day Change Dt Stmt Preference Mode EMAILL
Margin Rate 6,00 Time Zone
”Rate o Total Term ?’:d't'o"al pesals Time Bar Details
Deprecition Value 12,000.00
Residual Value 3,000.00 PaidTerm 1 StertDate 47/2018
Residual % 20,00 End Date 4/6/2117
Rent Charge 54000 Days to Time Bar 36,154
Rate Change Details Recourse Details Settlement Information
Rate Start of the Year 6.00 Recourss Effective Dt
LastRate Adj Dt S - Good Through Dt
#of Rate Adjs (Year) 0 Agresd Ant
= ofRate Adis (R 0 Recourse Reason .
Reschecule Metrod Max Recourse % 000

Following new monetary transactions for Interest Rate (IBL) Lease

INSURANCE ADDITION

>  With this transaction, user can create the insurance details either, which will impact
the account balances (Financed) or doesn’t impact the account balances (Non-
Financed) using the ‘Insurance Mode’ parameter system is controlling this.

INSURANCE MODIFICATION — with this transaction user can modify the premium
amount of active insurance.

>  System will cancels the existing active insurance with applicable rebate amount and
crates the new insurance.

INSURANCE CANCELLATION - This transaction cancels the active insurance

Note the following:
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e Before posting Charge Off transaction or Paid off transaction, or while making a payment
more than payment date’s payoff amount on active insurance account user need to post
Insurance Cancellation transaction manually i.e. system cancels active insurances on the
account but doesn’t auto adjust the balances with rebate amount.

e There is no relevance for ‘Current Usage’ and ‘Payment Amount’ transaction parameters
in Insurance Cancellation transaction.
Servicing > Customer Service > Account Details > Contract Information > Compensation

e As soon as funding a lease account, system will propagate the following details from the origination

> Paid Off Method, Paid Off Basis, Paid Off Days, Paid Off Term, Paid Off Percent,
Charge Off Method, Charge Off Basis, Charge Off Days, Charge Off Term, Charge
Off Percent

> Based on the chargeback criteria defined in the origination, system will support
producer chargeback if the account is Charge OFF or Paid OFF

e Producers > Compensation Sub Tab

> The compensation amounts and balances should also be viewed in the Producer
Window. The Compensation Plan subpage will display information related to
compensation and chargeback for the producer for a lease account also.

> It will display summaries as well lease account level information. The data will be
gathered from lease applications and accounts in the system that are approved and
funded and linked to the producer
‘Scenario Analysis’ in Lease

e Scenario Analysis screen is introduced in servicing to reschedule the Lease parameters
in Lease account.

e This will be enabled only for lease contract does having calculation method is Interest
Rate

e ‘Amortization Schedule tab with Amortize options are provided.

Scenario Analysis Tab: (link to account)
e This screen has option to ‘Link to Account’.
e Provided Import Values, Calculate and Post to Account buttons.
> ‘Import Values’ defaults values from contract to scenario analysis screen
» ‘Calculate’ button calculates payment.

» ‘Post to account’ will post the ‘Lease Change Payment’ transaction with Txn Date and
Base Monthly Payment amount provided in the screen.

e Here, system does not impact ‘Term’ and impact only ‘Payment Amount’.

e System does not allow to adjust ‘Residual Value', if the payment received on account is
greater than ‘Adjusted Residual Value’.
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Example:

Original Lease Receivable Amt = $ 140

Residual value = $ 20

Amount already collected on account = $ 125

In this scenario, if user tries to change the residual value as 35%, system does not allow
user to post transaction and show error message.

Fig: Link to Account (Calculate Payment Amount)

Scenario Analysis Parameters  Amortization Schedule

Scenario Analysis

* Link To Account [~ o} Initialise

Loan Details

Account # 2016060001012
Title DUE DATE NEW LEASE

Contract Dt 04/11/2018
Twn Ot 04/15/2018 E?.‘)
Term
Current Maturity Dt

Gross Capitalized Cost

&I Import Values j Calculate

Capitalized Cost Reduction 0.00
Adjusted Capitalized Cost
Residuzl Value(-)

Residual %

Depreciation Value (=)
Rent Charge (+) 2,

Rate 12.0000
Rent Factor  0.002500

Total of Base Monthly Pmts  0.00
e

=)
=)

Base Monthly Payment (=)} 0.00

{2} Post To Account

* Balloon Amt 0.00

Calculator Options
Balloon Method E
Billing Cyde ~
Accrual Base Method ~
Instaliment Method E
Billing Method -

‘Calculate Payment’ radio button

e Provided Initialise and Calculate buttons

> Initialise button clears user inputted values
» Calculate will do payment calculation.

e On selection of ‘Calculate Payment’, system allows the user to input

> ‘Txn Dt, Term, Gross Capitalized Amount, Capitalized Cost Reduction, Residual %’,
‘Balloon Pmt Amt’ and calculator options.

e If User inputs ‘Residual %’, system auto-calculates ‘Residual Value’ and Depreciation

Value.

e System calculates new payment amount based on new values input by user.

¢ In Amortization Schedule tab, on click of ‘Amortize’ button, will show the new payment

schedule.

‘Calculate Term’ radio button

e On selection of ‘Calculate Term, system allows the user to input

e ‘Txn Dt, Gross Capitalized Amount, Capitalized Cost Reduction, Residual %’, ‘Balloon
Pmt Amt’, Base Monthly Payment Amount and calculator options

e If User inputs ‘Residual %’, system auto-calculates ‘Residual Value’ and Depreciation

Value.

e System calculates ‘New Term’ based on new values input by user.

>  System displays error message as follows, if final number in payments is not zero -
To calculate Term, final number of payments in schedule is zero

e In Amortization Schedule tab, on click of ‘Amortize’ button, will show the new payment

schedule.
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Fig: Link to Account unchecked (Calculate Payment and Calculate Term)

Scenario Analysis Parameters  Amortization Schedule

Scenario Analysis
*Link To Account (7] 0§ Initialise |} Import Values Calaulate §3% Post To Account.

Capitalized Cost Reduction 0.00

Details Calculator Options

Adjusted Capitslized Cost  12,000.00

Account # 2016060001018 Residual Value(3) 1,200.00

Title DUE DATE LEASE Residual % | 10.0000
Depreciation Value (=) 10,800.00

Balloon Method

Biling Cyde
ContractDt 12/01/2017
Rent Charge (+) 261.47 Accrual Base Method
Txn Dt 04/18/2018 [

Rate Instalment Method

=Term [
= Total of Base Pmts

} iling Method
Current Maturity D Base Payment (<)

Gross Capitalized Cost 1. *Balloon Amt 0.00

Security Deposit Handling

Following changes are done for Lease Security Deposit Adjustment

Introduced ‘New Security Deposit field” in ‘Accounts’ table to store the current value of
deposit amount after adjustment

Existing batch job to refund excess payment now refers new field in accounts table as
against ‘Contract’ Security Deposit’ Amount to generate refund requisition.

New monetary transaction created to adjust ‘Security Deposit’ against arrears and this
transaction works similar to payment transaction to refer spread matrix for allocation.

On successful posting of transaction, system generates ‘Security Deposit adjustment’
letter (on run of batch job)

Termination transaction now refers ‘Security Deposit’ current field in account table for
adjustment against lease buyout.

Validations:

System adjusts using the ‘spread’ applicable based on spread matrix or spread defined at
contract level.

While posting the transaction, if no sufficient balance is available, system throws error —
‘Insufficient Security Deposit’ amount to adjust’.

Actions:

On successful posting, system updates ‘Security Deposit’ amount at account level.

The behavior of this transaction would be like payment transaction, which means this
adjustment amount is treated as ‘Payment’ and if any ‘Late Fee’ is eligible for reversal,
system reverses the ‘Late Fee’.

In case of reversal of transaction, system updates balance and add back transaction
amount to ‘Security Deposit Current’ bucket.

System generates the ‘Security Deposit’ Adjustment’ Letter’ on successful posting of
transaction.

Early Termination

Following changes are done for ‘Early Termination’

New block and related fields for ‘Early Termination’ created under
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> Setup > Lease Contract (Input Fields)
> Origination> Lease Contract (View Only)
>  Servicing > Lease Contract (View Only)

Early Termination

Allowed To Terminate |3
Biled Term 5

Lease Amt Recovered % 99

e System allows to terminate the lease contract if check box is selected and any of
condition is satisfied.

> ‘Allowed to Terminate’ indicates whether the contract is allowed to terminate before
maturity date.

> Billed Term indicates - Minimum no. of bills needs to be generated before allowing
termination.

> ‘Lease Amt Recovered’ indicates minimum amount (Depreciation + Rent Charge i.e.
Lease Receivable + Interest)) needs to be recovered before allowing termination.

Transactions to modify contract parameters

Following new non-monetary transactions introduced to modify contract parameters. On
successful posting of transaction, system updates the value in ‘Current’ fields at account level
and these balances are being used as references in impact areas. These transactions are
applicable for interest rate only.

Transaction to modify ‘Early Termination’ values defined in contract - ACCOUNT EARLY
TERMINATION

Validation: If User changing the value from ‘Allowed to Terminate’ = N to Y, either Billed Term or
Lease Amt Recovered% should be greater than ZERO.

Parameter Data Type | Mandatory | Description Validation / Comments
Date Date Yes Input transaction date | Allows current or back
dated.
Allowed to Check Box | Yes Indicates if contract is | System should not
Terminate allowed to terminate allowed to post this
before maturity date transaction, if
‘Terminate’ transaction
is already posted on
account.
Billed Term Numeric No Minimum no. of bills
needs to be
generated before
allowing termination.
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Parameter Data Type | Mandatory | Description Validation / Comments

Lease Amt Numeric No Minimum amount

Recovered % (Depreciation + Rent
Charge i.e. Lease
Receivable +

Interest)) needs to be
recovered before
allowing termination.

Transaction to query ‘Early Termination’ allowed or not - CHECK EARLY TERMINATION
ALLOWED

e New transaction is introduced to find the information whether account is eligible for early
termination and what is the amount needed to early terminate account.

Validation:
For Billed Term: Billed Term on account — Billed term specified in account current field.

For Lease Receivable Amt: Amount to be paid for early termination: Amt (with following breakup
details):

e For Interest Rate Method, consider - Lease Receivable Amt + Interest/Rent Amt

Parameter Type Mandatory | Description Comments

Name

Date Date Yes Input transaction date. | Should not allow back
dated transaction.

Letter Generation Changes

e New batch job is created Icstxn_bj 121 01 - LETTER FOR LEASE MONETARY TXNS
batch job under Set_LTR2.

e New Lookup - LEASE_LETTER_TYPE_CD - LEASE LETTER FOR MONETORY TXN is
created to define the mapping of Letter type for corresponding transaction.

e Here user is expected to maintain the letter template and data model for corresponding
transaction. In current scenario, for following mentioned transaction types letter template
and data model already maintained.
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> On running of batch job, system generates letters for monetary transaction for lease.
>  Currently, this batch job covers following letters:
— Lease Extension
- Lease Security Deposit Adjustment
— Change Payment
- Change Rate
- Payoff Quote Lease

Sample Extension Letter:

To,

GA HIGHWAY 137
BLOOMINGDALE

Lease Extension Letter ORACLE

Financial Services Lending and Leasing

MACCORMICK RUSSELL
(Acc #:20170100023222)

Dear MACCORMICK RUSSELL
This is to notify that lease contract terms are rescheduled and details are as follows:

Transaction Date 01/01/2018
Existing Term 12

New Term 14

Existing Residual % 10

New Residual % 2

New Payment Amount | 482.21

C-0001

Please contact with Bank Personnel, in case of any discrepancy in numbers.
This notice is dated on 9t day of April , 2018.
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Sample Lease Change Payment Letter:

Lease Change Payment Letter ORACLE
Financial Services Lending and Leasing

To,

MACCORMICK RUSSELL
(Acc #:20170100023222)
GA HIGHWAY 137
BLOOMINGDALE

Dear MACCORMICK RUSSELL

This is to notify that lease contract terms are rescheduled and details are as follows:

Payment Change Date | 04/09/2018
Existing Payment Amt | 3391.54
New Payment Amt 3500

Please contact with Bank Personnel, in case of any discrepancy in numbers.

This notice is dated on 9th day of April,2018.

C-0001

Sample Payoff Amount Letter:

Payoff Amount Letter OoORACLE’

Financial Services Lending and Leasing

DEMO BANK USA

LINE1

LINE2

MINNEAPOLIS MN 55344 7255
Phone: s

Fax: &SR

Date: 4/9/2018

GA HIGHWAY 137
BLOOMINGDALE

Name: MACCORMICK RUSSELL
Account number: 20171100010194
Collateral: 0 TOYOTA CAMRY -

This letter is in regards to the payoff request. The payoff amount is USD 100.00. This payoff
amount is good through 03/04/2018.
If you have additional questions, please feel free to contact us at #HaERREEREE.

Sincerely,

DEMO BANK USA
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Sample Lease Change Rate Letter:

Lease Change Rate Letter\

To,

MACCORMICK RUSSELL
(Acc #: 20170100023222)
GA HIGHWAY 137
BLOOMINGDALE

Dear MACCORMICK RUSSELL

ORACLE’
Financial Services Lending and Leasing

This is to notify that lease contract terms are rescheduled and details are as follows:

Rate Change Date 01/02/2017
Existing Rate 7
New Rate 11

Existing Payment Amt 0

New Payment Amt 601.86

This notice is dated on 9t day of April,2018.

C-0001

Please contact with Bank Personnel, in case of any discrepancy in numbers.
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Sample Security Deposit Adjustment Letter:

Security Deposit Adjustment Letter ORACLE

Financial Services Lending and Leasing

To,

MACCORMICK RUSSELL
(Acc #:20170100023222)
GAHIGHWAY 137
BLOOMINGDALE

Dear MACCORMICK RUSSELL

This is to notify that lease 'Security Deposit' is adjusted against outstanding dues. Details are as
follows:

11/01/2017
1000

Transaction Date

Security Deposit Amt
Adjusted

Security Deposit Amt | 900
after adjustment

Reason

Please contact with Bank Personnel, in case of any discrepancy in numbers.

This notice is dated on the 9% day of April 2018.

C-0001

‘Asset Change Usage/ Charge Details’ transaction

e New non-monetary transaction ‘Asset Change Usage/ Charge Details’ is provided to
update ‘Usage & Charge Details’ of collateral for Lease Account.

e User can post ‘Usage Fee’ for providing facility of updating Usage and Charge Details.

Transaction Parameters:

Parameter Data Type | Mandatory | Default | Description | Validation /
Value Comments
Txn Date Date Y Input Allows current or
transaction back dated.
date
New Usage | Number Y 0 Input new Update usage fields —
Value Usage ‘Total’ under
Number Collateral header
details.
New Charge | Integer N 0 Input new If user inputs this
per Unit charge field, system updates
applicable for | new charge at
usage. collateral header tab
— Charge field.
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Parameter Data Type | Mandatory | Default | Description | Validation /

Value Comments
Excess Number N 0 Input, if fee is | Input applicable
Usage Fee applicable for | Excess Usage Fee.
providing . .
additional If this value is ZERO,

system doesn’t post

usage facility. any transaction.

If this value greater
than ZERO, system
posts the transaction.

Validations:

e If tries to post this transaction on account, where collateral type other than “Vehicle’,
system displays error “Transaction allowed for only collateral type Vehicle’

Result:
e On successful posting of transaction, following changes done in system:

e System posts ‘FUSG_ADJ_PLUS—- ADJUSTMENT TO EXCESS USAGE FEE - ADD’
transaction to post value as adjustment to excess usage fee balance.

e System updates the ‘New Charge’ and ‘Total’ at collateral header tab — ‘Charge’ field and
‘Total field.

Change Payment Transaction

Following new monetary transaction ‘LEASE CHANGE PAYMENT AMOUNT is introduced. This
transaction is applicable only for ‘Interest Rate’ method.

System allows user to use transaction in two ways:

If ‘Auto Compute Indicator’ = Yes

e System automatically calculates the ‘New payment Amount’ (Here, if user inputs ‘Balloon
Payment Amount’ or ‘New payment amount’ with combination Y, system ignores the
values input by user).

If ‘Auto Compute Indicator’ = No

e If userinputs ‘New payment amount’, system considers the new payment amount for
reschedule.

e If User inputs ‘Balloon’ for ‘Auto Compute Indicator’ is selected as No, system displays
following error message: ‘Balloon amount should be zero for override payment change’.

e Result:

e On posting of transaction, system applies ‘New payment Amount’ on account.
e System generates the new repayment schedule after posting this Transaction.
e System generates letter on successful posting of transaction.

e If user reverses this transaction, system reverts back the payment to old amount and if
any payment received will be readjusted to due buckets accordingly.

Validations:
e Change payment not allowed for final bill
e Change payment not allowed for Extended accounts
e Change payment not allowed on account with active promotion.

2-66 ORACLE

Financial Services



Amount

Parameter Name | Type Mandatory | Description Comments
Transaction Date Date Yes ‘Payment change’
applicable date
Payment Amount Date Yes Input ‘New Payment
Amount’ (Rent)
Payment Auto LOV Yes Select ‘Auto
Compute Indicator Compute’ indicator
Yes/ No
Balloon Payment Numeric Yes Input Balloon Accept only positive

Payment Amount

value or zero.

Rate Change Transaction

Existing monetary transaction, ‘INDEX / MARGIN RATE CHANGE is extended to Lease.

This transaction is applicable only for ‘Interest Rate’ method.

e System allows user to change Index & Margin Rate on account.

e On successful posting of transaction

> System updates ‘Index’ or Margin Rate or both on account.
>  System accrues interest on account till date of transaction

>  Subsequent bills would be generated with new payment amount.

> System generates the new repayment schedule after posting this Transaction by
adjusting the ‘Payment Amount’.

» On successful posting of transaction, system updates the counters in Account Details

and Summary Screen.

e If user reverses this transaction, system reverts back the index or rate posted on account
and if any payment received will be readjusted to due buckets accordingly.

Validations:

e Any rate changes (variable rate or transaction posting rate changes) are governed by the
rate caps defined in setup.

Parameter Name | Type Mandatory | Description Error message/
Validations

Transaction Date Date Yes Input transaction date.

Index LOV No Input ‘applicable Index’

Margin Rate Numeric | Yes Input new margin rate.

Reason Text Yes Input Reason

Lease Extension

New monetary transaction, ‘LEASE EXTENSION' is introduced to extend the lease after maturity.

This transaction is applicable only for ‘Interest Rate’ method.

e Extension allowed is less or equal to current available residual %.
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e While posting the transaction, system validates the limits defined under setup > contract
to allow extension.
Validations:
e System allows posting of transaction for ‘Active’ status accounts only.

> System throws an error message stating as ‘Extension is allowed only for ‘Active’
Accounts.

e System does not allow posting extension transaction, if the residual value is already
included in final bill.

> System throws an error message stating as ‘Extension is not allowed as the Residual
value is already included in final Bill.

e System does not allow posting extension transaction, if the date is less than maturity
date.

> System throws an error message stating as ‘Extension is allowed to post on or after
maturity date.’

e System does not allow posting extension transaction, if ‘Estimated Life’ of asset is less
than extension period.

> System throws an error message stating as ‘Extension requested beyond available
Life of Asset’.

e System does not allow posting extension transaction, if the residual value is ZERO.

> System throws an error message stating as ‘Extension is not allowed as the Residual
value zero'.

=  On successful posting of transaction

» System updates ‘Maturity Date’ on account.
> System generates the new repayment schedule after posting this Transaction.

e If user reverses this transaction, system automatically reverses the bills generated after
old maturity date.

Parameter Name | Type Mandatory | Description Comments
Extension Date Date Yes Date of Transaction
Posting
Term Numeric | Yes Input “Term’ to be
extended
Residual Numeric | Yes Input ‘Residual Accept only
Remaining % Remaining%’ of the positive value or
asset. zero.
Ex Account
residual Value
=20%,
Extension
residual should
be <=20%
Error Message:
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Parameter Name

Type Mandatory

Description

Comments

Residual Amount
Remaining
should be less
than
X%(Residual
Value Cur)

Comment

Varchar | No

Input Comment /
justification for
extension.

Lease Securitization:

e Ability to securitize the lease accounts has been added.

e Provided provision to select the product type while creating the pool. l.e. user can
securitize only the Loan/Lease accounts alone.

e System will support only to securitize the active lease accounts i.e. user need to maintain
the POOL_ACTIVE_ACCOUNTS_ONLY system parameter to ‘Y’.

e Provided the ‘Pool Status’ and ‘Pool Account Status’ transactions to maintain the pool life

cycle.

> User can configure the responsibilities to these transactions in Setup >
Administration > System > Securitization screen.

> ‘Securitization Pool Account Status Cycle’ and ‘Securitization Pool Status Cycle’
setups are limited to system provided cycles only. If user adds any new cycles, those
need to be handle through customization root only.

e Providing summaries based on the Product, Status, Rate, Delinquency, and Term.
e Along with, GL transactions will be posted based on the ‘Pool Status’.
e User can also track the pool details at account level.

Securitization . 3] Close
~
Pool Inquiry  Pool Creation
Pools o add | 7 Edit —| View || & Audit
view = Format+ B¢ Freeze &l Detach rap o)
4 By
Pool Status Description Class Company Product Type End Dt QOwner
UNDEFIMED UNDEFINED 12/31f4000
Pools
Save and Add Save and Stay SaveandRetun || {9Return
*pool UNDEFINED *EndDt 12/31/4000 (B *Days Repo 0
Status Owner *Days Delg 0
*Deseription UNDEFINED *+Super Pool  UNDEFINED - * Max Limit Amt 0,00
* Class Repurchase Dt * Service Rate 0.0000
* Company Select the product type * Certificate Rate 0.0000
saEw
*Product Type LEASE
Pool Queries o add | Edit =] view | & Audit
View * Format = ﬁ Freeze ﬂ' Detach rap @ﬂ
Query Name Query Desc Enabled
Mo data to display.
v
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Lease 842 Reporting

OFSLL is enhanced to be compliant with the FASB’s ASC Topic 842 leasing standards and also it
significantly impacts the US Lease Finance Companies in the form of having dual mode for lease
accounting

e Provide a daily batch job under SET-GOV3 which generates the file at the end of each
day with lease contracts that funded on that day.
e The generated file can be handover to the third party.
e User can configure the file format in required format using the data file configuration
Data Files 5 [ Close
Output ~ Input .
Data File Definitions Feadd | LEdt | [ view || o Audit
view = Formatv [EJ| [|Freez=  5fiDetach = @
O Yes
¢ ONo
MName Description File Mame Directory Path System Defined Yes/No
LEASE_842_EXTRACT OUTBOUND LEASE ACCOUNTS EXTRACT TO EXTERNAL SYS... lease 842 extract_$(COMPANY_CODE... UNDEFINED Yes @/No
< >
l Record Definitions o Add | A Edit | [S]View || o Audit
View v Format v [ Freeze i Detach 1) virap i
Record Type Description Record Format Delimiter Terminator
1 FILE HEADER RECORD FIXED | CARRIAGE RETURN AND LINE FEED
2 FILE DETAILS RECORD FIXED | CARRIAGE RETURN AND LINE FEED
Column Definitions Feadd | AEdt | [Fvew || o Audit
view v Formatv B Freeze i Detach 1) Wrap o0
Seq Column Name Data Type Format Mask Length Data Calumn Qutput Column
1 COMPANY_CODE VARCHAR2 NOT APPLICABLE 30 1 1A
2 LEASE_APPLICATION_MUMBER VARCHAR2 NOT APPLICABLE 30 2 2
3 LEASE_ACCOUNT_NUMBER VARCHAR2 NOT APPLICABLE 30 3 3
4 APPLICANT_FIRST_NAME VARCHAR2 NOT APPLICABLE 15 4 4
5 APPLICANT_LAST_NAME VARCHAR2 NOT APPLICABLE 15 5 5
£ ADDITCANT ANNDESCT WADICHAD Y AT ADDI TEARI k'S A A &
Batch Jobs [3] Close

Batch Jobs  Job Holidays

Batch Job Sets Gpadd | AEdt || [Fvew | o Audit

vieww Format~v [B9| [ Freeze HfiDetach | oJwrap @

& SET-GOV3 2
Set Code Job Set Description Frequency Frequency value Start Time Critical Enabled Last Run Dt e
SET-GOV3 GOVERNMENT REPORTING (DAILY) DAILY DAILY 10:00 AM N N 03/22/2018 o
< >

Batch Jobs Fadd | AEdt | G vew | o audi

View v Formatv B Freeze i Detach J| wrap 5]
Seq Job Type Job Code Job Description Threads Commit Count Errors Allowed Weekend
1.0000 PROCEDURE GASPRC_B]_100_01 ASC 842 REPORTING 1 100 50 N
< >
Batch Job Threads Fadd | AEdt | G vew | o audi
View v Formatv B Freeze i Detach J| wrap 5]
Thread Trace Level Enabled
1 0 Y
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Screenshot of sample file:

& lease_842_extract_C-0001_20180411_115055dat E3 |[Blease_842 extract C-D001 20180411 114644 dat _j]

1 [LEASE 842 EXTRACT|20180411|C-0001

2 C-0001]0000002232|20180100021134 | SHUBHAM |RANA |85 N KGASDGJ
BCH N #
1B|20180101|1858.19]27872.85|20180201|20190401 |0 30000030000
667127872.85115/1858.19]0|0|1858.19] | UNDEFINED | DAY | UPFRONT | DIF |
35973.104] 10010

3 C-0001]0000002234]20170100021143|842|LEASE 1|AR N AR1 BCH N #
AR2|20170101]2330.64]27967.68]20170701|20180601 025000025000
1010125000]2967.62|12].005]27967.62]12]2330.64|0]0]2330.64| |UND
EFINED| DAY | UPFRONT | DIF| 25000 [0]0]0

Batch Job Changes:

1.

Existing batch job — SET-TPE > TXNRAT_BJ 100 01 (Rate Change Processing) and
TXNRAT_BJ_100_02 (RATE CHANGE PROCESSING FOR BACKDATED INDEXES) is
modified to handle ‘Variable Rate’ changes for Lease.

SET-LTR > LCSRAT_BJ 100 01 (RATE CHANGE PRE-INTIMATION LETTER) batch job is
modified to handle ‘Variable Rate’ changes for Lease.

Extended the “TXNINS_BJ 100_01’ batch job to lease i.e. system will automatically change
the insurance status to 'Expired' once the insurance end date is greater than equal to GL
date.

Extended the TXNPRM_BJ_100_01 — PROCEDURE PROMOTION END PROCESSING
batch jobs under SET-TPE to Lease Promotion.
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2.5 Data purging from archived (OO) tables

OFSLL archival and purging utility helps the user to control the growth of online transaction
processing tables and thereby reduce the performance impacts by archiving the concluded
transaction data to history tables and deleting the same there after based on the archival and
purging rules set.

e At present, system can archive data from main transaction processing tables to O tables
and O tables to OO tables based on number of days configured in system parameter.

e With this release, there is a new facility available to delete the archived records from OO
tables based on the following system parameters

e Purge is enhanced to support

>

Application data
Accounts data

GL transactions data

Pools data

Producer transactions data
Account transaction data
Vendor assignments data

Parameter Parameter Description Parameter Value
PAP_PURGE_DAYS | OOAPPLICATION PURGE DAYS | 999
PAC_PURGE_DAYS | OOACCOUNT PURGE DAYS 999

Following new batch jobs has been introduced

e While running the below job, system uses PAP_PURGE_DAYS parameter days to purge
application data.

Job Code

Job Description

PJRPAP_BJ 100 01

PURGE APPLICATION DATA

e While running the below jobs, system uses PAC_PURGE_DAYS parameter days to

purge account related data.

Job Code

Job Description

PJRPAC_BJ_100_01

PURGE ACCOUNTS DATA

PJRPGL_BJ_100 01

PURGE GL TXNS DATA

PJRPPA_BJ_100 01

PURGE POOLS DATA

PJRPPX_BJ_100 01

PURGE PRODUCER TXNS DATA

PJRPTX_BJ_100_01

PURGE TXNS DATA

PJRPVA_BJ_100_01

PURGE VENDOR ASSIGNMENTS DATA
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2.6

Customer Credit Limit Enhancements

Overview

An Overall customer credit limit will be given for each customer and applications are going to
funded based on the customer credit limit.

This kind of feature will be mainly leveraged by the SME customers and lenders who leverage
Home-credit/e-commerce based lenders.

This Enhancement will enable FI to give a credit limit to the customer and track utilization of the
customer limit for all the Accounts [Loan, Line, Leases]

For every customer a credit Limit to be created based on the Underwriting/credit worthiness
analysis. Once an account, created credit limit of the customer is utilized.

This would be based on the configuration. For an implementation if customer limit is not intended
to use Customer Limit and continue with current way of working.

Current Process With Limit Process

Application Entry Application Entry

Underwriting ‘
Underwriting

Funding

Funding

Customer Limit Creation Account

Account Creation

Account Creation *  Limit will be defined at
Underwriting stage

* For all kind of accounts,
Limit is created
[Loan/Line/Lease]

Servicing & Collection + Customer level

Maintenance

Transaction for Limit

Servicing & Collection

Applicable for Individual and Business Customer

Proposed Process

et . Application Under_wr\tlng Account Servicing &
Bty el Entr (Welfikiia Creation Collections
Limit Y Customer Limit) - -
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Customer/Business
(Customer/Business)
ID

Limitations:
e Payment at customer level not supported
e Billing at customer level
e Transaction at customer level

Impact of Customer Credit Limit on Origination:

A new “Customer Credit Limit” flag is added in Setup >Products for LOAN, LINE and LEASE to

specify the application is funded using “Customer Credit Limit”.

o If the flag = Y’, system will enable the “Customer Credit Limit” tab next to the decision tab
and Customer Credit Limit details will be populated for the customer in servicing.

o If the flag = ‘N’, system will not display the “Customer Credit Limit” tab and Customer

Credit Limit details will not be populated in servicing.

Origination x | Products x
Loan || Line || Lease
Loan Product
View v Format v @ Fresze FHDetach ol Wrap T rewProduct % Create Capy
Product Description Start Dt End Dt Direct
LOAN-VE-TEST  LOAN VEHICLE (FR) TEST 04/21/199% 12/31/4000 ¥ ¥
CR_LOAN_UN CR_LOAN UNSECURED 14/21/1995 12/31/4000 Y Y
DARA-HOMELN  IJARA HOME LOAN (FR) 04/21/199% 12/31/4000 ¥ [
ISTISHA-HOME-LN  ISTISNA HOME LOAN (FR) 04/21/199% 12/31/4000 ¥ [
KEF_LOAN_CL KEF_LOAN_CL 10/10/2010 12/31/4000 N Y
LEASE TEST ISTISMA HOME LOAN (FR) 03/21/2018 12/31/4000 Y N
N LEASE TEST1 LOAN VEHICLE (FR) PAVAN 03/21/2018 12/31/4000 ¥ ¥
LOAN HOME (VR)  LOAN VEHICLE (FR) TEST 03/21/2018 12/31/4000 Y Y
Loan Product
Product LOAN-VE-TEST * Customer Credit Limit
* Description LOAN VEHICLE (FR) TEST * Same Billing Cyde @)
=startDt 04/21/19%6 (@ = Enabled @)
=End Dt 12/31/4000 |G * Collateral Type VEHICLE COLLATERAL v
“Direct ¥ * Collateral Sub Type PERSONAL PROPERTY VEHICLE ¥
* Flexible Repayment @) = Credit Bureau Portfolio Type LINE OF CREDIT v

Customer Credit
Flexible Repayment Limit

3] Close

gk add || # Edit || [E view | < Audit

Same Billing Cycle  Enabled Collateral T
Y ¥ VEHICLE O
Y Y UNSECURE
N Y HOME COL
[ Y HOME COL
N Y VEHICLE ©
n H HOME COL
[ N VEHICLE O
Y N VEHICLE O ™

»

[ save and stay || [ Save and Retumn | G Return

* Credit Bureau Account Type AUTO

* Billing Cycle  MONTHLY
* Category STANDARD
Index Rounding  HO ROUNDING TO INDEX RATE

Reschedule Method UNDEFINED

Reschedule value 0.0000

<« 4 4 4 a
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Ellaerlr?e Type Sglf:g;t Comments Reference
Customer Check | N If the flag = Y’, system should
Credit Limit | Box enable a “Customer Credit Limit”
tab next to the decision tab and
Customer Credit Limit should be
created.
If the flag = ‘N’ system shouldn’t
display the “Customer Credit Limit”
tab and Customer Credit Limit
shouldn’t be created.
Same Check | N To decide whether the applications | This flag and the
Billing Box are created with same billing cycle | validation (Section Il
Cycle or not for an existing customer Point 19) is only
applicable for
applications with Billing
Cycle as “Monthly” and
“Weekly”

e A new “Customer Credit Limit” tab is added next to “Decision tab in origination.

e If the user changes the product from product with Customer Credit Limit = Y to product
with Customer Credit Limit = N, system will delete the captured customer credit limit
details as part of Origination and when funded no customer credit limit will be created in
case of new customer and no customer credit limit record update in case of existing
customer.

e Applicants and business records which are added to the application will be prepopulated
in “Customer Credit Limit” tab.

Following fields are added to “Customer Credit Limit”:

Field Name Data Type | Field Default | Population Logic
Type Value

Relation Type VARCHAR | Read NA Populated from Application >Applicant tab
only

Customer # / VARCHAR | Read NA Blank in case of new customer.

Business # only

Populated from servicing >Credit Limit in
case of Existing Customer.

Customer # / Business # Render based on
Customer Type

Name VARCHAR | Read NA Populated from Application >Applicant tab
only

Max Limit NUMBER Text 0.00 User entered field in case of new customer /
field Read only in case of existing customer

Total Utilized NUMBER Read 0.00 Max Limit — Utilization Amount
Amt only
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Field Name Data Type | Field Default | Population Logic
Type Value
Available Amt NUMBER Read | 0.00 Max Limit — (Utilized Amount + Hold Amt +
only Suspended Amt)
Hold Amt Number Read | 0.00 Based on Hold transaction posted at
only customer level.
Suspended NUMBER Read | 0.00 Based on suspense transaction posted at
Amt only customer level.
Grade VARCHAR | LOV User entered field
Max Late Number Text 0.00 User entered field
Charge field
Limit Expiry Date Date System | User entered field
Date
Limit Next Date Date System | User entered field
Renewal Date
% of Utilization | Percentage | Text 0.00 User entered field
field
Utilization Amt | Number Text 0.00 User entered field
field

Origination x

Credit Limit Details

Credit Limit Details

Relation Type PRIMARY
Customer # 0000000000

Application Utilization
3% of Utilization | 10,000.02

Name HARISH CREDIT LIMIT
= Max Limit | 10,000,000.00

Total Utilized Amt 0.00
Available Amt 10,000,000.00

Hold Amt 0.00

Suspended Amt 0.00

= Utilization Amt 1,000,002.00

summary Applicant  Business  Request Decsion | Customer Credit Limit | Bureau = Collatersl Comments Tracking Document Verification Corespondence = Tools

A gt | [ view
View = | Format» Freeze i Detach Wrap (0]
Relation Type a:f:::’j/ Name Mae Limit % of Utilization Utilization Amt  Total Utilized Amt Available Amt
PRIMARY 0000000000 HARISH CREDIT L 10,000,000.00 10,000.02 1,000,002.00 0.00 10,000,000.00
BUSINESS 0000000000 HM CORP 10,000,000.00 30.00 3,000.00 0.00 10,000,000.00 0.00

Save and Stay Save and Return

Grade A GRADE
= Max Late Charge 0.0000
* Limit Expiry | 12/31/4000
* Limit Next Renewal | 12/31/4000

<7 Audit

Suspended Amt Grade
0.00 A GRADE

<A Return

[ Close
Requested  Approved | =

Advance 10,000.00 10,000.0C
Rate 4.5500 4.5900
Term 12 12
Grade AGRADE  Score 600
LTvi 100.00 LTz 100
Stated PTI0.00 Stated After DTL6.¢
Book 10,000 Mileage 0

Asset Desc 2015 HONDA ACCORD

Queue NEW APPLICATIONS QUE!

Change Status
Status NEW - REVIEW REQUIRED

Change Status

Add Comment

* Mlert
*Type v
=Sub v

Type

* Comment

User will provide the “% of Utilization” against each applicant (Customer and business) added to

the application.

e This % of Utilization is percentage portion of amount financed.
Ex: if the amount financed it 10,000 $ and
% of Utilization for Primary is 80% then Utilized amount should be 10,000*0.8 = 8000 $
% of Utilization for Spouse is 20% the Utilized amount should be 10,000*0.2 = 2000 $

e Based on the % of Utilization system will calculate the Utilization amount and auto
populate in Utilization amount field (Financed Amt * % of Utilization).
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e If the Utilization amount is provided, system will auto calculate the % utilization and
populate in % Utilization field.

e Max Limit field will be prepopulated from selected pricing (“Max Loan Amt” field in setup>
Pricing) in decision tab for new applicant/business.

e “Customer Credit Limit” details are added to following functionalities.
> 0,00 tables, Archive and Purge
> Application Entry Web service (GET,PUT and POST)

- In case of Customer credit limit flag = Y and existing customer, system will
validate if user provides Max Limit details saying “Max limit is not required for
existing customer for relation type <<>>". As these details are fetched from
Servicing >Customer Credit Limit details.

> As part of web service following validations are available.

- If the Credit Limit Renewal date for individual is less than Current date system
will through an error message 'Applicant Credit Limit Renewal Date less than
Current Date'

- If the Credit Limit Renewal date for business is less than Current date system will
through an error message 'Business Credit Limit Renewal Date less than Current
Date'

> Account on boarding web service
> API process
e When the Application having the product with Customer Credit Limit flag = Y,

>  System will make the “Update Customer Info” flag = Y and read only for all the
existing Customers.

>  System will make the “Link to Existing Customer” flag = Y and read only.

e Before the application is funded (Approved — Funded), system will validate the utilization
of existing customers added to application with customer credit limit record of respective
customer in servicing.

> If the Utilized amount is less than Available amount, system will show an error
message saying “<<Relationship>>Utilization amount is less than available amount”
and will not allow to fund the application.

Edits:

Following edits are created to validate.

e <<Relationship>> Utilization amount is more than Available Amount.
e Total Utilization amount is not equal to Financed Amount

In case

»> Loan : Amount Financed

> Line: Credit Limit

> Lease: Gross Capitalized Cost

e Credit Limit of <<Relationship>> is expired. This edit will be fired when Limit Expiry date
< System date.

e This edit is applicable to applicants who’s Utilization amount > 0 in Application Utilization
block.

> The above edits are by default Result = “ERROR” and Enabled = “N”.

e A contract edit is added to validate “Customer Limit Expiry Date is greater than or equal
to Contact Maturity Date”. If validation failed system will fire the edit.
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> Edit Description: Customer Credit Limit Expiry Date is less than Contact Maturity
Date.

> This edit is applicable to applicants who’s Utilization amount > 0 in Application
Utilization block.
e The above “Customer Credit Limit” edits are part of following functionalities
> Application Entry Web service
> Account on boarding web service
> API process

e Once the application is funded with new applicants and “Customer Credit Limit” details,
system will automatically create new records for each new customer in “Customer Credit
Limit” main menu in servicing.

e The percentage Utilization of each customer for each account are saved in “Customer
Account Relationship” table.

e If the existing customer is added to application, system will pre populate the Customer
Credit limit record from servicing and update the existing customer credit limit record
once the application is funded.

e Following fields are added to the Setup >Pricing Selection criteria.
> Existing Customer LOV with following values and default value will be “ALL”.
- ALL — Applicable for both existing and new customers
- YES - Existing Customer
- NO — New Customer
» Existing Customer Since (In Years) — Default value “0”.
- Customer Creation Date to Current Date.

> Based on the selection criteria, system will default the first pricing for applications
which are having “Existing customer flag = “Y” at primary applicant details.

Sl. No | Attribute Description Default Value | Value

XVL : TOTAL UTILIZATION
ORIGINATION AMOUNT IS NOT EQUAL TO
1 DECISION EDITS | FINANCED AMOUNT ERROR Y

XVL : SECONDARY

UTILIZATION AMOUNT IS
ORIGINATION MORE THAN AVAILABLE
2 DECISION EDITS | AMOUNT ERROR Y

XVL : BUSINESS APPLICANT
UTILIZATION AMOUNT IS
ORIGINATION MORE THAN AVAILABLE
3 DECISION EDITS | AMOUNT ERROR Y

XVL : COSIGNER UTILIZATION
ORIGINATION AMOUNT IS MORE THAN
4 DECISION EDITS | AVAILABLE AMOUNT ERROR Y

XVL : COSIGNER 2

UTILIZATION AMOUNT IS
ORIGINATION MORE THAN AVAILABLE
5 DECISION EDITS | AMOUNT ERROR Y
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SI. No | Attribute Description Default Value | Value
XVL : PRIMARY UTILIZATION
ORIGINATION AMOUNT IS MORE THAN
6 DECISION EDITS | AVAILABLE AMOUNT ERROR Y
XVL : SPOUSE UTILIZATION
ORIGINATION AMOUNT IS MORE THAN
7 DECISION EDITS | AVAILABLE AMOUNT ERROR Y
XVL : COSIGNER SPOUSE
UTILIZATION AMOUNT IS
ORIGINATION MORE THAN AVAILABLE
8 DECISION EDITS | AMOUNT ERROR Y
XVL : COSIGNER 2 SPOUSE
UTILIZATION AMOUNT IS
ORIGINATION MORE THAN AVAILABLE
9 DECISION EDITS | AMOUNT ERROR Y
CHD : CREDIT LIMIT OF
ORIGINATION SECONDARY APPLICANT IS
10 DECISION EDITS | EXPIRED ERROR Y
CHD : CREDIT LIMIT OF
ORIGINATION BUSINESS APPLICANT IS
11 DECISION EDITS | EXPIRED ERROR Y
CHD : CREDIT LIMIT OF
ORIGINATION COSIGNER APPLICANT IS
12 DECISION EDITS | EXPIRED ERROR Y
CHD : CREDIT LIMIT OF
ORIGINATION COSIGNER 2 APPLICANT IS
13 DECISION EDITS | EXPIRED ERROR Y
CHD : CREDIT LIMIT OF
ORIGINATION PRIMARY APPLICANT IS
14 DECISION EDITS | EXPIRED ERROR Y
CHD : CREDIT LIMIT OF
ORIGINATION SPOUSE APPLICANT IS
15 DECISION EDITS | EXPIRED ERROR Y
CHD : CREDIT LIMIT OF
ORIGINATION COSIGNER SPOUSE
16 DECISION EDITS | APPLICANT IS EXPIRED ERROR Y
CHD : CREDIT LIMIT OF
ORIGINATION COSIGNER 2 SPOUSE
17 DECISION EDITS | APPLICANT IS EXPIRED ERROR Y
XVL : TOTAL UTILIZATION
ORIGINATION AMOUNT IS NOT EQUAL TO
18 DECISION EDITS | FINANCED AMOUNT ERROR Y
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SI. No | Attribute Description Default Value | Value
CHD : CREDIT LIMIT EXPIRY
ORIGINATION DATE OF SECONDARY
CONTRACT APPLICANT IS LESS THAN
19 EDITS CONTRACT MATURITY DATE | ERROR Y
CHD : CREDIT LIMIT EXPIRY
ORIGINATION DATE OF BUSINESS
CONTRACT APPLICANT IS LESS THAN
20 EDITS CONTRACT MATURITY DATE | ERROR Y
CHD : CREDIT LIMIT EXPIRY
ORIGINATION DATE OF COSIGNER
CONTRACT APPLICANT IS LESS THAN
21 EDITS CONTRACT MATURITY DATE ERROR Y
CHD : CREDIT LIMIT EXPIRY
ORIGINATION DATE OF COSIGNER 2
CONTRACT APPLICANT IS LESS THAN
22 EDITS CONTRACT MATURITY DATE | ERROR Y
CHD : CREDIT LIMIT EXPIRY
ORIGINATION DATE OF PRIMARY
CONTRACT APPLICANT IS LESS THAN
23 EDITS CONTRACT MATURITY DATE | ERROR Y
CHD : CREDIT LIMIT EXPIRY
ORIGINATION DATE OF SPOUSE APPLICANT
CONTRACT IS LESS THAN CONTRACT
24 EDITS MATURITY DATE ERROR Y
CHD : CREDIT LIMIT EXPIRY
ORIGINATION DATE OF COSIGNER SPOUSE
CONTRACT APPLICANT IS LESS THAN
25 EDITS CONTRACT MATURITY DATE | ERROR Y
CHD : CREDIT LIMIT EXPIRY
DATE OF COSIGNER 2
ORIGINATION SPOUSE APPLICANT IS LESS
CONTRACT THAN CONTRACT MATURITY
26 EDITS DATE ERROR Y
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Pricings x. (3] Clof

Loan Pricing Definition

Pricing CN_CE_ALL_CUS
= Description LOAN PRICING FOR ALL CUSOMERS Selection Criteria
“Start Dt 04/21/1995 b

* Company ALL
“End Dt 12f31/3000 | (B
* Enabled /)

* Billing Cyde MONTHLY v Trade-In ALL
Result = Product ALL v Mileage 0

*Max Loan Amt 1,000,000.00 *Pro .;m: :t
=MaxTerm 124 =Pro Type ALL
* Buy Rate 0.0000 “ Producer Region ALL
“Index FLAT RATE * Producer Territory AL

*Rate From 4.9900 - LTV 0.
Channel ALL
= Rate To 24.9900 = * Existing Customer ALL
*Producer ALL Ad
* Maturity Index FLAT RATE v * Existing Customer Since (In Years) 0
*Grade ALL v

* Haturity From 4.9900 -
* Maturity To 24.3900 Amt {000 Selection Criteria : Business
o *Loan Term 0
= Profit Rate From 0.0000 . e
— = Years In Business 0
= Prafit Rate To 00000

e ALL

Setup >Product Parameter:

A flag “Same billing cycle” is added in Setup >Products to define the applications are created with
same billing cycle and Due Day for an existing customer.

e A new contract validation is added to ensure the applications of an existing customer
should have same billing cycle and Due Day based on “Same Billing Cycle” Product flag.

> CONTRACT BILLING CYCLE AND DUE DAY NOT MATCHING WITH CUSTOMER
BILLING CYCLE AND DUE DAY OF PREVIOUSLY FUNDED APPLICATIONS FOR
EXISTING PRIMARY CUSTOMER.

Consider below points to compare “Same Billing Cycle and Due Day” with an existing account

e Consider all “Open” accounts for the customer [ACC_OPEN_IND=Y]

e If there are more than one account exists for the applicant and there billing cycle/due day
are different then — First tie breaker would be to consider the account where product
enforces same billing cycle condition and if still not able to figure out the account to
match then go with latest effective date account.

If the Same billing cycle flag = Y and “Billing cycle and Due Day not matching with customer
billing cycle and Due Day of previously funded applications for an existing customer”, system will
fire the above validation.

If the Same billing cycle flag = N, system will allow to fund the applications with different billing
cycle and Due Day for existing customer.

Note the following:

e This validation will consider only the “PRIMARY” applicant previously funded
applications.

e This validation is only applicable for Applications with billing cycle as “Month” and
“Weekly”.
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Pricings x| Products x (¥ o
Loan || Line || Lease
Loan Product Fradd | A Edit | View || < Audit
View = Format v [0 Fresze ) Detach wrap B New Product Create Copy
¢ (i £
Product Description Start Dt End Dt Direct Flexible Repayment E‘;\&""‘" Credit e illing Cyde  Enabled Collateral T
LOAN-VETEST  LOAN VEHICLE (FR) TEST 12/31/4000 ¥ ¥ ¥ ¥ ¥ VEHICLE O
CR_LOAN_UN CR_LOAN UNSECURED 12/31/4000 Y Y Y Y Y UNSECURE
DARA-HOME-LN  LIARA HOME LOAN (FR) 12/31/4000 ¥ N N N ¥ HOME COL
ISTISNAHOME-LN  ISTISNA HOME LOAN (FR) 12f ¥ [ N N ¥ HOME coL
KEF_LOAN_CL 12} N Y ¥ N ¥ VEHICLE ©
LEASE TEST 1f ¥ N N N N HOME COL
4 LEASE TEST 1 12/31/4000 ¥ ¥ ¥ N N VEHICLE O
LOAN HOME (¥R) 12/31/4000 Y Y ¥ ¥ N VEHICLEQ ™
»
Loan Product
Save and Stay Save and Return || {3 Retum
Product LOAN-VE-TEST * Customer Credit Limit (¥ * Credt Bureau Account Type | AUTO v
* Description | LOAN VEHICLE (FR) TEST * 5ame Billing Cyde ¥ = Billing Cycle MONTHLY v
*Start Dt 04/21/1905 B * Enabled ¥ = Category STANDARD v
*End Dt | 12/31/4000 | By ~ Collateral Type  VERICLE COLLATERAL v Index Rounding | NO ROUNDING TO INDEX RATE ¥
= Direct @ * Collateral Sub Type PERSONAL PROPERTY VEHICLE ¥ Reschedule Method | UNDEFINED v
* Flexi ment (@ - : ol Tyoe [(DETET
lexible Repayment Credit Bureau Portfolio Type | LINE OF CREDIT v Reschedule vale 0.0000

Impact of Customer Credit Limit on Servicing:

e A main menu link “Customer Credit Limit” is created to display customer level credit limit
in servicing and collections.

> Following field are added to “Customer Credit Limit >Customer/Business” Tab.

Field Name Data Type | Field Type | Default | Comments

Displays both customer and
Customer # VARCHAR | Read Only NA business numbers based on the
searched record

Displays both customer and
Name VARCHAR | Read Only NA business numbers based on the
searched record

Max Limit Amount provided to a
Max Limit NUMBER | Read Only NA Customer/Business based on his
credit worthiness

Total amount utilized by the
Customer/Business = Sum of
Applications funded — Reinstated
amount

Total Utilized Amt | NUMBER | Read Only NA

Max Limit — (Utilized Amount +

Available Amt NUMBER | Read Only NA Hold Amt + Suspended Amt)
This field is used to hold a
certain amount from available
limit of Customer/Business

Hold Amt NUMBER | Read Only NA

Increase and decreased Based
on Hold transaction posted at
customer level.

This field is used to suspend
Suspended Amt NUMBER | Read Only NA certain amount from available
amount of Customer/Business
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Increase and decreased Based
on suspense transaction posted
at customer level.

Grade VARCHAR | Read Only NA

This field represent the max late
charge that can be collected at

Customer/Business level
Max Late Charge | NUMBER | Read Only NA o . )
No validation are provided. This
is just an information capturing

field

This limit expiry field specify the
date in which the limit is going to
expire. An edit is provided at
origination >Contract level to
Limit Expiry DATE Read Only | NA check Limit Expiry date is less
than or equal to Contract
Maturity date.

There are no validations are
provided in servicing.

This field provides the

Limit Next DATE Read Only NA information about the next
Renewal renewal date of the customer
credit limit.
Explain above table with an example.
Customer ABC,
Limit provided is $ 10,000
Loan Approved and account created for $ 1,500.
Limit Table:
Max Total Available | Hold | Susp | Grade | Max Limit Limit Next
Limit Utilized | Amt Amt | ende Late Expiry Renewal
Amt d Charge
Amt
$ 10,000 | $1,500 | $8,500 0 0 A 30 12/12/2020 | 11/11/2020
When Hold Increase Transaction for $500 is posted
Max Total Available | Hold | Susp | Grade | Max Limit Limit Next
Limit Utilized | Amt Amt | ende Late Expiry Renewal
Amt d Charge
Amt
$ 10,000 | $1,500 | $8,000 $ 0 A 30 12/12/2020 | 11/11/2020
500
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When Suspend Increase Transaction for $500 is posted

Max Total Available | Hold | Susp | Grade | Max Limit Limit Next
Limit Utilized | Amt Amt | ende Late Expiry Renewal
Amt d Charge
Amt
$ 10,000 | $1,500 | $7,500 $ $500 | A 30 12/12/2020 | 11/11/2020
500

When Hold Decrease Transaction for $500 is posted

Max Total Available | Hold | Susp | Grade | Max Limit Limit Next
Limit Utilized | Amt Amt | ende Late Expiry Renewal
Amt d Charge
Amt
$ 10,000 | $1,500 | $8,000 $0 $500 | A 30 12/12/2020 | 11/11/2020

When Suspend Decrease Transaction for $500 is posted

Max Total Available | Hold | Susp | Grade | Max Limit Limit Next
Limit Utilized | Amt Amt | ende Late Expiry Renewal
Amt d Charge
Amt
$ 10,000 | $1,500 | $8,500 $0 $0 A 30 12/12/2020 | 11/11/2020

“Customer Credit Limit” details are part of following functionalities
> 0,00 tables
> Account Details Web service

When user click on “Customer Credit Limit” main menu link by default system will open
the search screen.

By default no records are shown in Customer Credit Limit> Customer tab, user is
expected to search a customer using search screen.

“Customer Credit Limit” record will be updated whenever an application is funded for an
existing customer.

> Amount Financed will be added to Total Utilization amount and deducted from
available amount.

If the advance is given for an account, system will add that amount to total utilization and
deduct from Available amount field.

> The advance % of utilization for each customers will be same as the % of utilization
provided at application >Credit Limit Details from which the account is funded.

“Available amount” field will be re-instated whenever the following actions are happened.
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> Whenever payment received for an account, system will increase the Available
amount by Principal portion (Loan: Advance/Principal, Line: Advance/Principal
and Lease: Lease Receivable) of the payment and decrease the same amount from
Total utilized amount.

- This re-instating will be done as per the %utilization provided at the time of
application funding against each applicant.

Ex: if the amount financed = 10,000 $
Primary % Utilization = 80 % (10,000 * 0.8 = 8000 $)
Spouse % Utilization = 20% (10,000 * 0.2 = 2000 $)
Payment Received and principal =100 $
Available amount re-instated for Primary =100 * 0.8 =80 $
Available amount re-instated for Spouse =100*0.2=20$
- If an account is voided, system will increase the Available amount by remaining
Principal amount of the account.

e If the payment is reversed, system will increase the Total Utilization by Principal portion
of the payment and decrease the Available amount field by same amount.

e Suspended and Hold amount fields are increased and decrease based on the respective
transactions posted.

e “View” and “Audit” buttons are provided in Servicing >Customer Credit Limit tab.

Customer Credit Limit Details in Servicing >Customer Details >Customer/Business:

e Following Customer credit limit details (read only) are added in Servicing >Customer
Details >Customer and Business tabs.

> Max Limit, Total Utilized Amt, Available Amt, Hold Amt, Suspended Amt, Grade, Max
Late Charge, Limit Expiry and Limit Next Renewal

> The Business # field is added to Servicing >Customer Details >Business tab

Servicing >Customer Details >Customer

Customer Credit Limitx  Customer Service x ] Close

Customer Information
Save and Stay Save and Retun | (G Retum

Customer Birth Place

Passport =

Customer # 0000004016 A Birth Country v
Relation PRIMARY fesue b 9 Permanent US Resident Status
ECOA INDIVIDUAL Expiry Ot [E)

Name HARISH CREDIT LIMIT Visa & Power of Attorney

* Marksti

Bith Dt 10/10/1385 (B

Marital Status UNDEFINED

Enabled ¥
Language ENGLISH

Education UNDEFINED

Hother's Maiden Name

Class Type  NORMAL

Email

“Stop Comrespondence

* Disability
* skip
Bankmuptcy__

* Privacy Opt Out
* Insurance Opt Out

ng Opt Qut

v

v

v

v

Nationality  USA
National ID - - 0

=550 0008963
License =

License State
Military Service

Active Military Duty —
Effective Dt
Order Ref =
Release Dt
Customer Decease Date B

Reference #

Power of Attomey
Holder Name
Address

Country
Nationality

Telephone Number

Credit Limit Details

Max Limit - 10,000,000.00
Total Utilized At 7,000.00
Available Amt 9,993,
Hald Amt 0,00
Suspended Amt 0,00
Grade
Max Late Charge 0.00

T Ty 7T I
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Servicing >Customer Details >Business

Customer Credit Limit x,  Customer Service ¢ Customer Service x
Company
uso1

Business Details

View v Formatv [Ep Freeze i Detach Wrap e
Business & Organization Type  Type of Business  Business Category  Name of the Business Legal Name TaxID # Start Dt

0000001001 S CORP DISTRIBUTION CORPORATE BUSS MAINT BM 2000063564 05/11/2016 b}

Business Details

trancn Sup unit Account = Froguct Lays Past Lue Lurrency Pay OI At Amount Lue Status Ulgast Due Ut v
UsSHQ UNDEFINED 20180300010143  LEASE VEHICLE-TEST -31 USD 20,000.00 0.00 ACTIVE 04/21/2018

sof L
Employeesicu)| * 2

»

Save and Stay Save and Retum || {2 Return

Business # 0000001001 Contact Person HGHGH] Total Utlized Amt 8,211.34
Organization Type 5 CORP M Business Checking Bank HCHCH ”'“":”“: ’_*”'E su;ee.ss
. = old Amé 0.0
Type of Business  DISTRIBUTION M Bank Acc # [GB574155
Business Category CORPORATE = Avg Checking Balance 95,120.00 Grade
Name of the Business BUSS MAINT ¢ of Lovations [T ax Late Charge 0,00
Legal Hame BM  Manacament Sines [T Limit Expiry 12/31/4000
anagement since Limit Next Renewal 12/31/4000

Suspended Amt 0,00

TaxID # 0004564

startDt 05/11/2006 By Credit Limit Details

= # of Employees(Cur) 25 )
Max Limit_100,000.00

*# of Employees 30

Impact on Principal Existing Transactions:

The Utilization and Available amount will be adjusted whenever a monetary transaction is
posted which will result in adjustment in ADVANCE / PRINCIPAL in case of Loan and
Line and Lease Receivables in case Lease.

As a result of any monetary transaction if the available amount is reduced then system

will check if the utilization amount is less than or equal to available amount, if not then

shown an error message saying “<<Relationship>>Ultilization Amount greater than

available amount”.

> Above validation is done for accounts having product with Customer Credit Limit flag
=Y.

When posting the DUE DATE CHANGE and DUE DATE CHANGE OVERRIDE

transactions, system will check for the “Same Billing Cycle” parameter.

» If that parameter is “Y” and user is trying to post the DUE DATE CHANGE or DUE
DATE CHANGE OVERRIDE transaction which will resulted in different Due Date,
system will post this transaction in ALL Active accounts of primary customer of
account, where these transactions are posted.

- Txn Result will display the affected accounts.

- If this transaction is failed to post in one account, system will roll back the
transaction posting in all the accounts.

Exceptions:

In case of Pre — Compute Loan and Lease (Rent Charge) as there is no separate
balance for principle/Advance the Customer Limit reinstating is happening once the
Account is paid off.

In case of Revolving LoC accounts the customer Credit Limit reinstating will happen
when the account is Paid Off.

Customer Credit Limit Search:

A Customer Credit Limit Search is added before the Customer tab in Customer Credit Limit tab.

Search tab is having following two sections.

> Quick Search
> Customer Search

Quick Search is having Customer # and Business # as parameters.
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> “Customer” and “Business” radio buttons are provided to specify which entity to be
searched.

> Customer # or Business # field is (based on selected radio button) provided to search
customer/business record by clicking the “Submit” button which is access controlled.

> If system no records are founded with provided information, then system displays an
error message, “No Customer/Business found”.

Customer Credit Limit search is having following sections.
> Search Criteria
> Search Results

Search Criteria:

Two radio buttons are provided for “Customer” and “Business” search.
By default “Customer” radio button is selected when page is loaded.

Provide ‘Reset Criteria’ and ‘Search’ buttons to the ‘Search Criteria’ section. These two
buttons doesn’t required any access keys. Use the same search tab access key to this.
l.e. if Search tab is accessible to the logged in user, then these two buttons are available.

‘Reset Criteria’ button — on click of this, system will clear the search parameter values.
‘Search’ button —

> On click of this, system will get the exact Customer Credit Limit details based on the
parameter value provided and comparison operator.

> Show the Customer Credit Limit details results in the ‘Search Results’ section.

> If user doesn’t provide any data to the value fields then show an error message ‘No
search criteria defined. Please define minimum one search criteria”

>  If system doesn’t found any record using the provided information, then show a
warning message, “No records found for given search criteria”

“Search Criteria” selections is having three columns, ‘Criteria’, ‘Comparison Operator’
and ‘Value'.

> ‘Criteria’ — displays the User Defined Table attribute description
> ‘Comparison Operator’ — displays the Defined Table attribute operator
> ‘Value’ — displays LOV or input filed based on Defined Table attribute field type.

“Search Results” section displays the following fields along with “Open Customer Details”
button.

» Customer ID — Display In case of Individual Customer

> Name — Display In case of Individual Customer

» Business ID — Display In case of Business Customer

> Name of the Business — Display In case of Business Customer
> Max Limit

» Total Utilized Amt

> Available Amt

> Hold Amt
> Suspended Amt
> Grade

» Max Late Charge
> Limit Expiry
>  Limit Next Renewal

If user click on the Open Customer Details button or double click on the record in search
results, system will open the record in Customer Credit Limit >Customer screen.
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e If user doesn’t have access to Customer Credit Limit >Customer tab then system
displays an error ‘you don’t have access to Customer Credit Limit >Customer screen”.

e A user defined table is created for Customer Credit Limit >Customer Search with
following attributes as part of the seed data for customer search.

> CUSTOMER #

> CUSTOMER FIRST NAME

> CUSTOMER LAST NAME

> CUSTOMER SSN

> CUSTOMER NATIONAL ID

> CUSTOMER PASSPORT NUMBER
> CUSTOMER PHONE NUMBER

> CUSTOMER ZIP CODE

> CREDIT MAXIMUM LIMIT

> CREDIT LIMIT TOTAL UTILIZED AMOUNT

> CREDIT LIMIT AVAILABLE AMOUNT
> CREDIT LIMIT HOLD AMOUNT

> CREDIT LIMIT SUSPENDED AMOUNT

e A user defined table is created for Customer Credit Limit >Customer Search with
following attributes as part of the seed data for business search.

> BUSINESS #

> BUSINESS NAME

> TAXID#

> START DATE

> PHONE NUMBER

> ZIP CODE

> CREDIT MAXIMUM LIMIT

> CREDIT LIMIT TOTAL UTILIZED AMOUNT

> CREDIT LIMIT AVAILABLE AMOUNT
> CREDIT LIMIT HOLD AMOUNT

> CREDIT LIMIT SUSPENDED AMOUNT

e On selecting and double click on the Customer Credit Limit >Customer details from
search results or click of ‘Open Customer Details’ button, show the Customer/Business

details in Credit Limit >Customer tab.

Quick Search:

Customer Credit Limit x  Origination x

Search  Business

Quick Search

Business Submit

»» Search Criteria

Search Results
View v Formatw  [5p

» Business # Name
No data to display.

Freeze s Detach Wrap i)

Max Limit ~ Total Utilized Amt Available Amt

Hold Amt Suspended Amt Grade Max Late Charge Limit Expiry Limit Next Renewal
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Search Criteria:

SRACE

Financial Services Lending and Leasing

Customer Credit Limit x  Ongination x (3] Close
Search  Businzss

Search Options: Customer ® Business

> Quick Search

Search Criteria
& Resstcriteria || @ search

View v Format v [ Freeze i Detach Wrap [0

Criteria Comparison Gperator Value

BUSINESS # LIKE M

BUSINESS NAME LIKE )

TAXID 2 LIKE v

START DATE GREATER THAN OR EQUAL v )

o PHONE NUMBER EQUAL v

ZIP CODE LIKE v

CREDIT MAXIMUM LIMIT EQUAL v

CREDIT LIMIT TOTAL UTILIZED AMOUNT EQUAL v

CREDIT LIMIT AVAILABLE AMOUNT EQUAL )

CREDIT LIMIT HOLD AMOUNT EQUAL v

CREDIT LIMIT SUSPENDED AMOUNT EQUAL v

(2] Open Customer Details

Search Results

View v Format v g Freeze i Detach Wrap (0]
Business # Name Max Limit  Total Utlized Amt Available Amt Hold Amt  Suspended Amt Grade Max Late Charge Limit Expiry _ Limit Next Renewal
No data to display.
Copynight © 1986,2018, Oracle and/or its affiiztes. All ights reserved, About

Customer Transactions:

New Customer Non-Monitory Transactions are added in Setup> Transaction codes.

e Following new Customer and Business non-monetary transactions are added under
Setup> Transaction codes > Non monitory txns.

Transaction Code Transaction Description | Result
CUS_CRLMT_DECREASE CUSTOMER CREDIT LIMIT | Decrease the Customer Max
DECREASE limit field by given amount.
CUS_CRLMT_INCREASE CUSTOMER CREDIT LIMIT | Increase the Customer Max
INCREASE limit field by given amount.
CUS_CRLMT_HOLD_DECREASE DECREASE CUSTOMER Move given transaction amount
CREDIT LIMIT HOLD from Hold amount to Customer
AMOUNT Available Amount field.
CUS_CRLMT_HOLD_INCREASE INCREASE CUSTOMER Move given transaction amount
CREDIT LIMIT HOLD from customer Available
AMOUNT Amount to HOLD amount field.
CUS_CRLMT_MAINT CUSTOMER CREDIT LIMIT | Update the Customer credit
MAINTENANCE limit details
CUS_CRLMT_SUSPEND_DECREASE | DECREASE CUSTOMER Move the given transaction
CREDIT LIMIT SUSUPEND | amount from suspended field to
AMOUNT Available amount field
CUS_CRLMT_SUSPEND_INCREASE INCREASE CUSTOMER Move the given transaction
CREDIT LIMIT SUSUPEND | amount from Available Amount
AMOUNT field to suspended amount
field.
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Transaction Code

Transaction Description

Result

BUS_CRLMT_DECREASE

BUSINESS CREDIT LIMIT
DECREASE

Decrease the Business Max
limit field by given amount.

BUS_CRLMT_INCREASE

BUSINESS CREDIT LIMIT
INCREASE

Increase the Business Max
limit field by given amount.

BUS_CRLMT_HOLD_DECREASE

DECREASE BUSINESS
CREDIT LIMIT HOLD
AMOUNT

Move given transaction amount
from Hold amount to Business
Available Amount field.

BUS_CRLMT_HOLD_INCREASE

INCREASE BUSINESS
CREDIT LIMIT HOLD
AMOUNT

Move given transaction amount
from Business Available
Amount to HOLD amount field.

BUS_CRLMT_MAINT

BUSINESS CREDIT LIMIT
MAINTENANCE

Update the Business credit limit
details

BUS_CRLMT_SUSPEND_DECREASE

DECREASE BUSINESS
CREDIT LIMIT SUSUPEND
AMOUNT

Move the given transaction
amount from suspended field to
Available amount field

BUS_CRLMT_SUSPEND_INCREASE

INCREASE BUSINESS
CREDIT LIMIT SUSUPEND
AMOUNT

Move the given transaction
amount from Available Amount
field to suspended amount
field.

These transactions are allowed to post from Servicing >Customer Credit Limit > Transactions tab
and Servicing >Customer Servicing>Maintenance.

Customer

Parameters for “CUSTOMER CREDIT LIMIT INCREASE” transaction.

Parameter Name Data Type Field Type Mandatory | Comment
Date Date Date Y
Amount Number Text Box Y
Reason VARCHAR LOV N

System will post a comment once the transaction is posted “Customer Max Limit Increase from

<<0ld value>> to <<New value>>".

Parameters for “CUSTOMER CREDIT LIMIT DECREASE” transaction.

Parameter Name Data Type Field Type Mandatory | Comment
Date Date Date Y
Amount Number Text Box Y
Reason VARCHAR LOV N
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System will post a comment once the transaction is posted “Customer Max Limit decreased from

<<0ld value>> to <<New value>>".

System will validate and show error message, if decrease resulted in available amount < 0 and

will not allow to post the transaction.

Parameters for “DECREASE CUSTOMER CREDIT LIMIT HOLD” transaction.

Parameter Name Data Type Field Type Mandatory | Comment
Date Date Date Y
Amount Number Text Box Y
Reason VARCHAR LOV N

System will post a comment once the transaction is posted “Customer Hold Decrease from <<Old

value>> to <<New value>>",

Parameters for “INCREASE CUSTOMER CREDIT LIMIT HOLD” transaction.

Parameter Name Data Type Field Type Mandatory | Comment
Date Date Date Y
Amount Number Text Box Y
Reason VARCHAR LOV N

System will post a comment once the transaction is posted “Customer Hold Increase from <<Old

value>> to <<New value>>".

Parameters for “INCREASE CUSTOMER CREDIT LIMIT SUSPEND” transaction.

Parameter Name Data Type Field Type Mandatory | Comment
Date Date Date Y
Amount Number Text Box Y
Reason VARCHAR LOV N

System will post a comment once the transaction is posted “INCREASE Customer Suspended
amount Increase from <<0OlId value>> to <<New value>>".

System will validate and show error message, if Increase resulted in available amount < 0 and
will not allow to post the transaction.

Parameters for “DECREASE CUSTOMER CREDIT LIMIT SUSPEND” transaction.

Parameter Name Data Type Field Type Mandatory | Comment
Date Date Date Y
2-91 ORACLE

Financial Services



Parameter Name Data Type Field Type Mandatory | Comment
Amount Number Text Box Y
Reason VARCHAR LOV N

System will post a comment once the transaction is posted “DECREASE Customer Suspended
amount Increase from <<Old value>> to <<New value>>".

Parameters for “CUSTOMER CREDIT LIMIT MAINTENANCE” transaction.

Parameter Name Data Type Field Type Mandatory | Comment
Date Date Date Y
Grade VARCHAR LOV N
Max Late Charge NUMBER Text Box N
Limit Expiry DATE DATE N
Limit Next Renewal DATE DATE N

e System will post a comment once the transaction is posted “<<Old value>> to <<New

”y

value>>"",

e System will show an error message if the Limit Expiry and Limit Next Renewal date are
less than the system date.

> A new lookup is added for “Customer Credit Limit Reasons” and provided the sub
codes to identify the reason codes for “Max Limit Increase and Decrease, Hold
Amount Decrease and Increase” and Suspended Amount”.

> Once the Customer non-monetary transactions are posted from Customer Credit
Limit>Customer >transactions tab, system will post that transaction to all the
accounts under the customer.

Note: Backdating for the above transactions are not allowed.

Business

Parameters for “BUSINESS CREDIT LIMIT INCREASE” transaction.

Parameter Name Data Type Field Type Mandatory | Comment
Date Date Date Y
Amount Number Text Box Y
Reason VARCHAR LOV Y

System will post a comment once the transaction is posted “Business Max Limit Increase from

<<0ld value>> to <<New value>>".

Parameters for “BUSINESS CREDIT LIMIT DECREASE” transaction.
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Parameter Name Data Type Field Type Mandatory | Comment
Date Date Date Y
Amount Number Text Box Y
Reason VARCHAR LOV Y

System will post a comment once the transaction is posted “Business Max Limit decreased from

<<0ld value>> to <<New value>>".

System will validate and show error message, if decrease resulted in available amount < 0 and

will not allow to post the transaction.

Parameters for “DECREASE BUSINESS CREDIT LIMIT HOLD” transaction.

Parameter Name Data Type Field Type Mandatory | Comment
Date Date Date Y
Amount Number Text Box Y
Reason VARCHAR LOV Y

System will post a comment once the transaction is posted “Business Hold Decrease from <<Old

value>> to <<New value>>".

Parameters for “INCREASE BUSINESS CREDIT LIMIT HOLD” transaction.

Parameter Name Data Type Field Type Mandatory | Comment
Date Date Date Y
Amount Number Text Box Y
Reason VARCHAR LOV Y

System will post a comment once the transaction is posted “Business Hold Increase from <<Old

value>> to <<New value>>".

Parameters for “INCREASE BUSINESS CREDIT LIMIT SUSPEND” transaction.

Parameter Name Data Type Field Type Mandatory | Comment
Date Date Date Y
Amount Number Text Box Y
Reason VARCHAR LOV Y

System will post a comment once the transaction is posted “Business Suspended amount

Increase from <<Old value>> to <<New value>>".
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System will validate and show error message, if Increase resulted in available amount < 0 and

will not allow to post the transaction.

Parameters for “DECREASE BUSINESS CREDIT LIMIT SUSPEND” transaction.

Parameter Name Data Type Field Type Mandatory | Comment
Date Date Date Y
Amount Number Text Box Y
Reason VARCHAR LOV Y

System will post a comment once the transaction is posted “Business Suspended amount

Decreased from <<Old value>> to <<New value>>".

Parameters for “BUSINESS CREDIT LIMIT MAINTENANCE” transaction.

Parameter Name Data Type Field Type Mandatory | Comment
Date Date Date Y
Grade VARCHAR LOV N
Max Late Charge NUMBER Text Box N
Limit Expiry DATE DATE N
Limit Next Renewal DATE DATE N

>  System will post a comment once the transaction is posted “<<Old value>> to <<New

value>>"",

System will show an error message if the Limit Expiry and Limit Next Renewal date
are less than the system date.

e A new lookup code is added for “Business Credit Limit Reasons” and provide the sub
codes to identify the reason codes for “Max Limit Increase and Decrease, Hold Amount
Decrease and Increase” and Suspended Amount Decrease and Increase”.

e Once the Business non-monetary transactions are posted from Customer Credit
Limit>Customer >transactions tab, system will post that transaction to all the accounts
attached to the Business which are Active and Charged off.

e Backdating for the above transactions are not allowed.

>

Following business transactions are added to create and update business details.

A new “ADD BUSINESS ADDRESS PHONE?” transaction is added to add and
maintain the address record for a Business in following tabs.

- Servicing >Customer details >Business >Address
—  Customer Credit Limit> Business >Address
The following parameter are added to “ADD BUSINESS ADDRESS PHONE”

transaction in Setup> Transaction Codes under “Non monitory Txns” and Setup
>User defined table “INP_BMP_TNM".

Parameter Name Field Type Mandatory
Address Type LOV Y
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Parameter Name Field Type Mandatory
Current Check Box Y
Permission to Call Check Box Y
Permission to Text Check Box Y
Country LOV Y
Postal Type LOV Y
Address # Text Box N
Street Pre LOV N
Street Name Text Box N
Street Type LOV N
Street Post LOV N
Apt # Text Box N
Address 1 Text box N
Address 2 Text box N
Zip LOV Y
Zip Extn Text Box N
City Text Box Y
State LOV Y
Phone Text Box Y
Own/Lease LOV N
Comment Text Box N

When there is direct record update (Adding or Updating a record) happens from the
following tabs, system will post the above transaction implicitly.

>  Servicing >Customer details >Business >Address
> Customer Credit Limit> Business >Address

A new “ADD BUSINESS TELECOM” transaction is added to add a telecom record for
Business in following tab.

>  Servicing >Customer details >Business >Address

> Customer Credit Limit> Business >Address

The following parameter are added to “ADD CUSTOMER TELECOM?” transaction in

Setup> Transaction Codes under “Non monitory Txns” and Setup >User defined table
“INP_BMP_TNM".
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Parameter Name Field Type | Mandatory
Telecom Type LOV Y
Permission to Call Check Box Y
Permission to Text Check Box Y
Phone Text Box N
Extn Text Box N
Current Check Box Y

When there is direct record update (Adding a record) happens from the following tabs,
system will post the above transaction implicitly.

>  Servicing >Customer details >Business >Telecoms
» Customer Credit Limit> Business >Telecoms

A new “BUSINESS TELECOM MAINTENANCE” transaction is added to update a
telecom record for Business in following tab.

>  Servicing >Customer details >Business >Telecoms

» Customer Credit Limit> Business >Telecoms

The following parameter are added to “BUSINESS TELECOM MAINTENANCE”
transaction in Setup> Transaction Codes under “Non monitory Txns” super group and
Setup >User defined table “INP_BMP_TNM”.

Parameter Name Field Type Mandatory
Telecom Type LOV Y
Permission to Call Check Box Y
Permission to Text Check Box Y
Phone Text Box N
Extn Text Box N
Current Check Box Y

When there is direct record update (Updating Existing Record) happens from the
following tabs, system will post the above transaction implicitly.

>  Servicing >Customer details >Business > Telecoms

> Customer Credit Limit> Business > Telecoms

A new “BUSINESS MAINTENANCE” transaction is added to Update the business record
in Servicing >Customer details >Business.

» Following parameter are added to “BUSINESS MAINTENANCE” transaction in
Setup> Transaction Codes under “Non monitory Txns” super group and Setup >User
defined table “INP_BMP_TNM".

Parameter Name Field Type Mandatory
Organization Type LOV N
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Type of Business LOV N
Business Category Read Only N
Name of the Business Text Box N
Legal Name Text Box N
Tax ID # Text Box N
Start Dt Date field N
# of Employees(Cur) Text Box Y
# of Employees Text Box Y
Contact Person Text Box N
Business Checking Bank | Text Box N
Bank Acc # Text Box N
Avg Checking Balance Text Box Y
# of Locations Text Box Y
Management Since Text Box Y

When there is direct record update (Updating Existing Record) happens from the

following tab, system will post the above transaction implicitly.

>  Servicing >Customer details >Business

A new “ADD BUSINESS PARTNER”, “BUSINESS PARTNER MAINTENANCE” and
“ADD BUSINESS AFFILIATES”,“BUSINESS AFFILIATES” transactions are added in

Setup> Transaction Code.
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> When there is direct record update from (Adding a record) following tabs, system will
post the “ADD BUSINESS PARTNER” and “ADD BUSINESS AFFILIATES”
transactions implicitly. These transactions are having setup parameter “Manual = N”
in Setup >Transaction Codes.

1

1

1

1

Servicing >Customer details >Business >Partners
Customer Credit Limit> Business> Partners
Servicing >Customer details >Business >Affiliates
Customer Credit Limit> Business >Affiliates

> When there is direct record update from (Updating existing record) following tabs,
system will post the “BUSINESS PARTNER MAINTENANCE” and “BUSINESS
AFFILIATES MAINTENANCE” transactions implicitly. These transactions are having
setup parameter “Manual = N” in Setup >Transaction Codes.

—_

—

—

—

Servicing >Customer details >Business >Partners
Customer Credit Limit> Business> Partners
Servicing >Customer details >Business >Affiliates
Customer Credit Limit> Business >Affiliates

Transaction tab in Customer Credit Limit tab:

A new transactions tab is added under Customer credit Limit tab. (Similar to Servicing >Customer
Service >Maintenance tab)

Following tables are available in this tab.

e Transaction Batch Information

Parameter Name Mandatory
Date Y
Monetary Y
Transaction Y
Status Y
Batch Y

e Parameters

Parameter Name Mandatory
Parameter Y
Value Y
Required Y
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e Result

> ADD, EDIT, VIEW and AUDIT buttons are available in transactions tab and they are
access controlled.

> Add “POST”, “Load Parameters” and “VOID” buttons are added in transactions
tab and they are access controlled.

>  This tab will only allowed to post the Customer Non monitory transactions.

>  While posting a “INCREASE CUSTOMER CREDIT LIMIT HOLD’ transaction, system
will verify the Hold amount can’t be more than available amount. If it is greater,
system will not allow posting the transaction and show an error message “Hold
Amount is greater than Available Amount”.

> While posting a “INCREASE CUSTOMER CREDIT LIMIT SUSPEND’ transaction,
system will verify the Suspend amount can’t be more than available amount. If it is
greater, system will not allow posting the transaction and show an error message
“Suspend Amount is greater than Available Amount”.

>  If the transaction posted successfully, Result will show a message “Transaction
Posting Successful”.

Customer Credit Limit x 3] Close
Search  Customer
Credit Limit Details =] wiew || & Audit
View ~ Format~ [ Freeze 54 Detach Wrap 20}
Customer # Name Max Limit  Total Utiized Amt Available Amt Hold Amt  Suspended Amt Grade Max Late Charge Limit Expiry Limit Next Renewal
0000004023 HARISH CREDIT LIMIT 1 100,000.00 5,758.83 94,241.17 0.00 0.00 0.00 3/27/2020 12/1/2018
Addresses | Telecoms | Employments | Tracking Attributes | Accounts  Applications = Comments = Documents
Transaction Batch Information P add || A Edt || Sl view || < Audit
View w Formatw [ Freeze i Detach Wirap o)) 3% post [ Veid
Date Manetary Transaction Status Batch
03/28/2018 N ADD CUSTOMER TELECOM POSTED

03/28/2018

1 ADD CUSTOMER TELECOM POSTED 1
H ADD CUSTO POSTED H
1 ADD CUSTOMER POSTED n

03/28/2018

Parameters

View = Formatw [EF Freeze {4l Detach Wirap [5h]
Parameter Value Required
TN DATE 03/28/2018 v
Result
View ~ Format~ [E Freeze ! Detach Wrap (25

Transaction Processing Details
=+=+= Direct Record Update. Transaction Posting Successful =*=*=

Address Tab in Customer Credit Limit:

A new address tab is added under “Customer Credit Limit >Customer” tab. (Similar to Servicing
>Customer Service >Customer Details> Customer> Address tab)

e Following fields are available in Address tab.

Field Name Data Type Mandatory
Type LOV Y
Current Check Box Y
Confirmed Check Box Y
Mailing Check Box Y
Permission to Call Check Box Y
Permission to Text Check Box Y
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Field Name Data Type Mandatory
Country LOV Y
Postal Address Type LOV Y
Address # Text Box Y
Street Pre LOV N
Street Name Text Box N
Street Type LOV N
Street Post LOV N
Apt # Text Box N
Address 1 Read Only N
Address 2 Text box N
Address 3 Text Box N
Zip LOV Y
Zip Extn Text Box N
City Text Box Y
State LOV Y
Phone Text Box Y
Address Read Only N
Time Zone Read Only N
Census Tract/BNA Code | Text Box N
MSA Code Text Box N
Comment Text Box N

ADD, EDIT, VIEW and AUDIT buttons are available in address tab and they will be
access controlled.

When an address record is added or updated from Customer Credit Limit >customer,
system will automatically post the “ADD CUSTOMER ADDRESS PHONE” transaction.

Once the record is added/updated in Customer Credit Limit >customer >Address same
will be reflect in Servicing >Customer Details> Address tab.
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Customer Credit Limit x

Search  Customer

Credit Limit Details
View ~ Formatw [Ep Freeze 54 Detach wirap o]
Customer * Name

0000004022 VIKAS RANA 1,000,000,000.00

Address Information

* Permission to Call [+
* Permission to Text #
* Country UNITED STATES v
* Postal Address Type NORMAL ADDRESS v
* Address # 75
Street Pre NORTH v

Max Limit  Total Utiized Amt
24,686.72

Available Amt Hold
999,975,313.28

View v Format~ (5 Freeze B} Detach Wrap &
Type Current Permission to Call  Permission to Text  Confirmed Mailing
HOME Y Y Y N Y
Address Information
»
*Type HOME M Street Name HIKI
* Current (@) Street Type BEACH
* Confirmed Strest Post NORTH

* Mailing &

Apt= 7925

Amt  Suspended Amt Grade
0.00 0.00 C

Transamnns Telecoms  Employments | Tracking Attributes | Accounts || Applications |~ Comments ~ Documents

Country Address =

UNITED STATES 75

Address 1 75 N HIKJI BCH N # 7926

Address 2 JHWEDB
Address 3 SDFVGUAS

*Zip 00601

[ view || < audit
Max Late Charge Limit Expiry  Limit Next Renewal
0.00 12/31/2022 12/31/2022
ok add | Edit || 5] view || < Audit
city State Postal Address Type ¢

ADIUNTAS PUERTQ RICO NORMAL ADDRESS I

3

Save and Stay Saveand Retun | {3 Retumn
Zip Extn
= City | ADJUNTAS
= State | PUERTO RICO v

* Phone | (000)-000-0000
Address 75 N HIKII ECH N # 7926 JHWEDB
SDFVGUAS ADIUNTAS PR-00501
Time Zone
Census Tract/BNA Code
MSA Code

Comment

A new address tab is added under “Customer Credit Limit >Business” tab. (Similar to Servicing
>Customer Service >Customer Details> Business >Address tab)

e Following field are added to business >Address tab

Field Name

Data Type

Mandatory

Address Type

LOV

Y

Current

Check Box

Y

Permission to Call

Check Box

Permission to Text

Check Box

Country

LOV

Postal Type

LOV

Address #

Text Box

Street Pre

LOV

Street Name

Text Box

Street Type

LOV

Street Post

LOV

Apt #

Text Box

Address 1

Text box
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Field Name

Data Type

Mandatory

Address 2

Text box

N

Zip

LOV

Y

Zip Extn

Text Box

City

Text Box

State

LOV

Phone Text Box Y
Own/Lease LOV N
Comment Text Box N

e ADD, EDIT, VIEW and AUDIT buttons are available in address tab and they are access

controlled.

e Whenever a new record is added/Updated in this tab, system will post an “ADD
BUSINESS ADDRESS PHONE” transaction in Customer Credit Limit> Business

>Transactions tab.

e Once the record is added/updated in Customer Credit Limit >Business >Address same
will be reflect in Servicing >Customer Details>Business> Address tab.

Customer Credit Limit x

Search  Business

Credit Limit Details

Address Information

View » Format~ [Ep Freeze i Detach Wrap

Address Type Current Permission to Call
WORK Y Y Y
RELATIVE N Y Y

Address Information

= Current [
* Permission to Call ¥
* Permission to Text ¥
Address Type WORK
* Country UNITED STATES
= Postal Type  NORMAL ADDRESS
Address = D2
Street Pre NORTH

Permission to Text  Country

View v Formatv  [&p Freeze il Detach Wrap o]
Business = Name Max Limit  Total Utilized Amt Available Amt
0000016001 ABC FINANCE 100,000.00 45,000.00 55,000.00

@

Address
UNITED STATES D2
UNITED STATES 151

Street Name A ROAD

Street Type  ALLEY ALY

Street Post NORTH
Apt= 25

Hold Amt

Suspended Amt Grade
0.00 0.00

T'ansactmns Telecoms | Partners | Affiliates | Tracking Attributes | Accounts | Applications Comments ~Documents

Gty State
AGUADA PUERTO RICO
AGUADA PUERTO RICO

Address 1 D2 N AROAD ALY N £ 25

Address Line 2

[® Close
[El view || o Audit
Max Late Charge Limit Expiry  Limit Next Renewal
0.00 12/31/4000 12/31/4000
ok Add | Edit ] View || < Audit
Postal Type Street Pre Street Name

NORMAL ADDRESS  NORTH
NORMAL ADDRESS  NORTH

A RCAD 4
BADFAS

Save and Stay. Save and Retun || 3 Retum
*Zip 00602 -
Zip Extn
* City AGUADA
= State PUERTO RICO v
Fhone (000)-000-0000
OuinjLease BUYING HOME v
Comment

Employments tab in Customer Credit Limit tab:

A new Employments tab is added in “Customer Credit Limit >Customer” tab. (Similar to Servicing
>Customer Details >Employments tab.

e Following fields are available in Employments tab

Field Name

Data Type

Mandatory

Type

LOV

Y
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Field Name Data Type Mandatory
Current Check Box Y
Permission to Call Check Box Y
Permission to Text Check Box Y
Employer LOV Y
Occupation LOV N
Title Text Field N
Department Text Field N
Country LOV Y
Address # Text Box N
Address 1 Text box N
Address 2 Text box N
Zip LOV N
Zip Extn Text Box N
City Text Box N
State LOV N
Phone Text Box N
Extn Text Field N
Comment Text Box N
Pay Day Date N
Next Pay Day Read Only N
Frequency LOV Y

ADD, EDIT, VIEW and AUDIT buttons are available in Employments tab and they are
access controlled.

When a new Employment record is added to Customer Credit Limit >Customer>
Employments tab, system will post an “EMPLOYMENT ADDRESS MAINTENANCE”
transaction in Customer Credit Limit> Customer >Transactions tab.

When an existing record is edited in Customer Credit Limit >Customer> Employments
tab, system will post an “EMPLOYMENT ADDRESS MAINTENANCE” transaction.

Once the record added/edited in Customer Credit Limit >Customer> Employments tab
same will be reflected in Servicing >Customer Details>Customer> Employments tab.
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Customer Credit Limit ¥,
Credit Limit Details
View = Formatv  f Freeze i Detach Wirap 5]
Customer # Name Max Limit  Total Utiized Amt Available Amt Hold Amt  Suspended Amt Grade
0000004023 HARISH CREDIT LIMIT 1 100,000.00 5,758.83 94,241.17 0.00 0.00
Transactions || Addresses = Telecoms Tracking Attributes || Accounts | Applications Comments | Documents
Employment Information
View = Formatw [} Freeze 4 Detach Wrap 5]
Current Permission ta Call  Permission to Text  Type Employer Qccupation Title Next Pay Day
¥ ¥ ¥ FULL TIME UNDEFINED OTHER
Employment Information
» * Current (&€ Address # 1254
* Permission to Call @) Address Line 1 ADD2
* Permission to Text (¥ Address Line 2 ADDZ
= Type | FULL TIME v
* Employer  UNDEFINED
Occupation  OTHER v Zin 96001 =
it
e Zip Extn
Department City REDDING
* Country | UNITED STATES v

e
(Sl view || < Audit
Max Late Charge Limit Expiry _ Limit Next Renewal
0.00 3j27/2020 12/1/2018
e add || A Edit | 2 view || o Audit
Frequency Country Address # i
MONTHLY UNITED STATES 1254 i
»
Save and Stay Save and Retum | {3 Retum
State CALIFORNIA v
Phone (000)-000-0000
Extn
Comment
Pay Day £:)
Next Pay Day
* Frequency MONTHLY ¥

Telecoms tab in Customer Credit Limit tab:

A new Telecoms tab is added under “Customer Credit Limit >Customer” tab. (Similar to Servicing
>Customer Service >Customer Details> Customer> Telecoms tab).

e Following fields are available in Customer Credit Limit >Customer> Telecom tab.

Field Name

Data Type

Mandatory

Type

LOV

Y

Phone

Text Box

N

Extn

Text Box

Current

Check Box

Permission to call

Check Box

Permission to Text

Check Box

Time Zone

LOV

Start Time

Text Field

Period

LOV

Best Day to Call

LOV

End Time

Text Field

N

Period

LOV

N

e ADD, EDIT, VIEW and AUDIT buttons are available in Telecoms tab and they are access

controlled.
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e When a new Telecom record is added to Customer Credit Limit >Customer> Telecom
tab, system will post an “ADD CUSTOMER TELECOM?” transaction in Customer Credit
Limit> Customer >Transactions tab.

e When an existing record is edited in Customer Credit Limit >Customer> Telecom tab,
system will post a “CUSTOMER TELECOM MAINTENANCE?” transaction.

e Once the record added/edited in Customer Credit Limit >Customer> Telecom tab same
will be reflected in Servicing >Customer Details>Customer> Telecoms tab.

Customer Credit Limit x

Search | Customer

Credit Limit Details

&

Name
HARISH CREDIT LIMIT 1

View v Format ~ Freeze ! Detach Wrap

Customer =

0000004023 100,000.00

Max Limit  Total Utilized Amt

@

Available Amt

5,758.83 94,241.17

Hold Amt

Suspended Amt Grade

0.00 0.00

Transactions ﬁddre::as Employments  Tracking Attributes  Accounts  Applications ~Comments  Documents

Telecom Information

View v Formatv [ Freeze 4l Detach Wrap

Type
FAX

PAGER
PHONE
PHONE

Telecom Information

“Type FAX
Phone (785)-456-1237
Extn

* Current ¥

@

Phone Extn Current

(789)-456-1237 7
3(214)-587-4963 Y
(032)-145-6789 Y
(789)-456-1234 N

v * Permission to Call
* Permission to Text [+
Time Zone

Start Time

Permission to  Permission to
Call Text

Y Y
Y Y
N N
Y Y

Time Zone

Max Late Charge
0.00

Save and Stay

Period

Best Day to Call
End Time
Period

[E] view || & Audit

Limit Expiry  Limit Next Renewal
3/27/2020 12/1/2018

Start Time Period

Save and Return

{3 Return

v

v

v

A new Telecoms tab is added under “Customer Credit Limit >Business” tab. (Similar to Servicing
>Customer Service >Customer Details> Business> Telecoms tab).

e Following fields are available in Customer Credit Limit >Business> Telecom tab.

Field Name Data Type Mandatory
Type LOV Y
Phone Text Box N
Extn Text Box N
Current Check Box Y

e ADD, EDIT, VIEW and AUDIT buttons are available in Telecoms tab and they are access

controlled.

e When a new record is added to Telecoms tab, system will post an “ADD BUSINESS
TELECOM?” transaction in Customer Credit Limit> Customer >Transactions tab.

e When an existing record is edited in Telecoms tab, system will post a “BUSINES
TELECOM MAINTENANCE” transaction in Customer Credit Limit> Customer

>Transactions tab.

e Once the record added/edited in Customer Credit Limit >Business> Telecom tab same
will be reflected in Servicing >Customer Details>Business> Telecoms tab.
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Business

Customer Credit Limit x

ceach

Credit Limit Details

Transactions Addressés Partners  Affiliates = Tracking Attributes  Accounts ~ Applications ~Comments = Documents

Telecom Information

View v Formatv [} Freeze G Detach Wrap 5]
Permission to Cal Permission to Text Telecom Type
Y Y

ANSWERING SERVICE

Telecom Information

* Permission to Call ¥
* Permission to Text (¢

* Telecom Type  ANSWERING SERVICE v

View ~ Formatv [Ep Freeze & Detach Wrap o)
Business = Name Max Limit  Total Utlized Amt Available Amt Hold Amt  Suspended Amt Grade
0000016001 ABC FINANCE 100,000.00 45,000.00 55,000.00 0.00 0.00

Elview || « audit

Max Late Charge Limit Expiry _Limit Next Renewal
0.00 12/31/4000 12/31/4000

ke add | A Edit =| view || <7 Audit

Phene
(005)-456-1560

Save and Stay Save and Return || {3 Retum

Phone (005)-456-1560
Extn 555
= Current (¢

Partner tab in Customer Credit Limit tab:

A new Partner tab is added under “Customer Credit Limit >Business” tab. (Similar to Servicing

>Customer Service >Customer Details> Business> Partner tab).

[ ]
controlled.

ADD, EDIT, VIEW and AUDIT buttons are available in Partner tab and they are access

When a new record is added to Partner tab, system will post an “ADD BUSINESS

PARTNER” transaction in Customer Credit Limit> Customer >Transactions tab.

o When an existing record is edited in Partner tab, system will post a “BUSINESS
PARTNER MAINTENANCE” transaction in Customer Credit Limit> Customer

>Transactions tab.

Customer Credit Limit x

Credit Limit Details

Transactions ~ Addresses TE\EEnms Affilistes ~ Tracking Attributes ~ Accounts  Applications ~ Comments =~ Documents

Partner Information

View v Format v [E} Freeze i Detach Wrap (03]
Business # Name Max Limit  Total Utiized Amt Available Amt Hold Amt  Suspended Amt Grade
0000016001 ABC FINANCE 100,000.00 45,000.00 55,000.00 0.00 0.00

View v Formatw [Ep Freeze (i Detach Wrap o]
Permission to Call  Permission to Text Customer 2 First Name M Last Name Suffix SSN
Y ¥ FGH HIH GIH Rr 063005456
Partner Information
" = permission to Cal (4 Bith Dt By
* Permission to Text ¥ Birth Place
First Name  FGH * Director Ind ¥
ML HIH * Networth 1,00
Last Name GIH * Gross Income | 151,121.00
Suffix IR v Language v
* 55N | J06-X0C-5456 Nationality v

5] view || < audit

Max Late Charge Limit Expiry  Limit Next Renewal
0.00 12/31/4000 12/31/4000

4k add | A Edit = view || < Audit

Birth Dt Birth Place Director Ind
Y

Save and Stay Save and Retumn || {3 Return

Title
* Ownership (%) 0.00
Email
Phone (000)-000-0000
Extn 0

Affiliates tab in Customer Credit Limit tab:

A new Affiliates tab is added under “Customer Credit Limit >Business” tab. (Similar to Servicing

>Customer Service >Customer Details> Business> Affiliates tab).
[ )

controlled.
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e When a new record is added to Affiliates tab, system will post an “ADD BUSINESS
AFFILIATES” transaction in Customer Credit Limit> Customer >Transactions tab.

e When an existing record is edited in Affiliates tab, system will post a “BUSINESS
AFFILIATES MAINTENANCE” transaction in Customer Credit Limit> Customer
>Transactions tab.

Customer Credit Limit x [] c

Credit Limit Details [E] view || o audit
View v Format~ [ Freeze i Detach Virap ot}

Business Name Max Limit  Total Utllized Amt Available Amt Hold Amt Suspended Amt Grade Max Late Charge Limit Expiry ~ Limit Next Renewal
0000016001 ABC FINANCE 100,000.00 45,000.00 55,000.00 0.00 0.00 0.00 12/31/4000 12/31/4000

Transactions ~ Addresses  Telecoms Partners| Affiliates | Tracking Attributes  Accounts  Applications  Comments  Documents

Affiliate Information 4k add || &7 Edit ] view || < Audit
view v Format~ [ Freeze {4 Detach Wrap [oh)
Organization Type Legal Name Name of the Business TaxID = Qvmership (%) # of Employees NAICS Co
0.00 0
s

Affiliate Information
Save and Add Save and Stay, Save and Retun | (@ Return

Legal Name

TaxID =

Tracking Attributes in Customer Credit Limit tab:

A new tracking Attributes tab is added in Customer Credit Limit >Customer and Business tabs.
(Similar to the customer Servicing >Customer/ Business >Tracking Attributes.

e Following parameters are available in Tracing Attributes tab.

Parameter Name

Sub Parameter

Parameter

Value

e Anew “+Load Tracking” button is added in Tracking Attributes table.

e A new user defined table “TAB_BTA_1 (TABLE ATTRIBUTES: BUSINESS TRACKING)”
is created in setup >User Defined Tables to add the tracking attributes of business.

e If user clicks on “Load Tracking” button system will load the tracking attributes from user
defined table.

e EDIT, VIEW and AUDIT buttons are available in Tracking Attributes tab and they are
access controlled.

2-107 ORACLE

Financial Services



Customer

Customer Credit Limit x

Credit Limit Details

@ cllose

[l view | & audit

BUSINESS TRACKING ATTRIBUTE 007

View v Formatv [} Freeze G Detach Wrap o)
Customer # A7 Name Max Limit  Total Utiized Amt Available Amt Hold Amt  Suspended Amt Grade Max Late Charge Limit Expiry ~ Limit Next Renewal
0000004054 PAVAN NAPHADE 100,000.00 99,888.00 112.00 0.00 0.00 B 0.00 12/31/4000 12/31/4000
Tracking Attributes A Edit | Eview ||  sudit
View = Format v [ Freeze i Detach wrap o0} o Load Tracking
Sub Parameter Parameter Value
CUSTOMER TRACKING ATTRIBUTE 001 [
CUSTOMER TRACKING ATTRIBUTE 002 HA
CUSTOMER TRACKING ATTRIBUTE 003 HA
CUSTOMER TRACKING ATTRIBUTE 004 HA
CUSTOMER TRACKING ATTRIBUTE 005 HA
CUSTOMER TRACKING ATTRIBUTE 006 HA
N
Customer Credit Limit x B
Credit Limit Details Elview | & audit
View » Format~ [5 Freeze i Detach Wrap (05
Business # Name Max Limit  Total Utlized Amt Available Amt Hold Amt  Suspended Amt Grade Max Late Charge Limit Expiry  Limit Next Renewal
0000016001 ABC FINANCE 100,000.00 45,000.00 55,000.00 0.00 0.00 0.00 12/31/4000 12/31/4000
Transactions | Addresses  Telecoms | Partners | Affilates | Tracking Attributes | Accounts | Applications |~ Comments || Documents
Tracking Attributes A Edt || [E View || o Audit
View = Format~  [5p Freeze 4 Detach Wrap @) P Load Tracking
Sub-Parameter  Parameter Value
BUSINESS TRACKING ATTRIBUTE 001 NA
BUSINESS TRACKING ATTRIBUTE 002 NA
BUSINESS TRACKING ATTRIBUTE 003 NA
BUSINESS TRACKING ATTRIBUTE 004 NA
BUSINESS TRACKING ATTRIBUTE 005 NA
BUSINESS TRACKING ATTRIBUTE 006 NA
HA

Accounts tab in Customer Credit Limit tab:

A new “Accounts” tab is added in Customer Credit Limit >Customer/Business tabs.

e These accounts are fetched using “Customer ID” from “Customer to Account Relation”
table and “Business ID” from Business to Account Relation table.

e Following field are available in “Accounts” table.

Field Name

Account #

Title

Relation

Product

Pay Off Amount

Amount Due

Oldest Due Dt

Status
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Field Name

Collateral Description

Identification #

Company
Branch
e The Primary Collateral Description and Identification # field are added to Accounts tab.
e In case of Home Collateral no Collateral Description is shown.
e A hyper link is provided on “Account #” which will open the respective account in
servicing.
e If the user is not having the access to Servicing, system will show an error message
saying “No access available”
e “Total Pay off Amt” and “Total Amt Due” fields are shown bottom of the Accounts table.
Customer

Customer Credit Limit x

Credit Limit Details

Sl view || < audit

View v Format~ [Ep Freeze i Detach Wrap o)
Customer = Name Max Limit  Total Utilized Amt Available Amt Hold Amt  Suspended Amt Grade Max Late Cdige Limit Expiry _ Limit Next Renewal
0000004054 PAVAN NAPHADE 100,000.00 99,888.00 112,00 0.00 0.00 B 0.00 12/31/4000 12/31/4000
Transactions | Addresses | Telecoms | Employments | Tracking Attributes Applications | Comments | Documents
Accounts
View v Format~ g Freeze B} Detach Wrap [}
Account Title Relation Product Pay Off Amount Amount Due Oldast Due Dt Status Collateral 150
Description
2080300012917 PAVAN NAPHADE  PRIMARY LOAN VEHICLE (FR) TEST 40,020.89 0.00 04/28/2018 ACTIVE 2015 HONDA ACC..
»
Total 40,020.8%  Total Amt 0.00
Payoff Amt
Customer Credit Limit x 3] Close
Credit Limit Details [El view | « audit
View v Format~ P Freeze I Detach Wrap ®
Business # Name Max Limit Total Utiized Amt Available Amt Hold Amt  Suspended Amt Grade Max Late Charge Limit Expiry _Limit Next Renewal
0000001001 BUSS MAINT 100,000.00 921134 90,788.66 0.00 0.00 12/31/4000 12/31/4000
Transactions | Addresses | Telecoms || Partners | Affiliates | Tracking Attributes Applications || Comments | Documents
Accounts
View - Formatv [ Freeze i Detach Wrap o)
Account # Title Product Pay Off Amount Amount Due Oldest Due Dt Status Collateral Identification # Company
Description
2018030010143 AKASH RANA LEASE VEHICLE-TEST 20,000.00 0.00 04/21/2018 ACTIVE 2015 HONDA ACC.. usoL
2018040014334 SHUBH RANA LEASE VEHICLE-TEST 18,422.67 0.00 05/02/2018 ACTIVE 2017 TOYOTA CA.. usoL

Total 38422.67  Total Amt 0.00

PayOff Amt

Applications tab in Customer Credit Limit tab:

A new “Applications” tab is added in Customer Credit Limit >Customer/Business tabs.

Link to existing customer flag = Y in contract.
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e No funded applications are shown in this tab.

e A hyper link is added on “Application #” which will open the respective Application in

Origination.

o |If the user is not having the access to origination system will show an error message

saying “No access available”.
e Following fields are available in Application tab.

Field Name

Company

Branch

Application #

Date

Title

Product

Status

Sub Status

Collateral Description

Identification #

e The Primary Collateral Description and Identification # shown in Applications table.

> In case of Home Collateral no Collateral Description will be shown.

Customer

Customer Credit Limit x

Credit Limit Details

View = Format = 5P Freeze &4} Detach Wrap ot}
Customer # Name Max Limit  Total Utilized Amt Available Amt Hold Amt  Suspended Amt Grade
0000004054 PAVAN NAPHADE 100,000.00 99,888.00 112.00 0.00 0.00 B
Transactions | Addresses Telecoms | Employments | Tracking Attributes  Accounts | Applications | Comments | Documents
Applications
View v Format~ [ Freeze i Detach Wrap o)
App # Company Branch Date Title Product Status
0000001672 usol uUsHg 3/1/2018 NILESH CHAVAN [... LEASE VEHICLE-T... NEW

Mo
S view || < Audit
Max Late Charge Limit Expiry  Limit Next Renewal
0.00 12/31/4000 12/31/4000

Collateral
Description
REVIEW REQ... 2015 HONDA ACC.

Sub Status Identification #
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Business

Customer Credit Limit 3
Credit Limit Details
View v Formatv  [5p Fresze 4 Detach Wrap o)
Business £ Name Max Limit  Total Utilized Amt Available Amt Hold Amt Suspended Amt Grade
0000002011 KING WHEELS 100,000.00 5800.00 91,200.00 0.00 0.00 A
Transactions | Addresses || Telecoms | Partners | Affiates | Tracking Attributes | Accounts Comments | Documents
Applications
View = Format~ [} Freeze i Detach Wrap (0]
AppE Company Branch Date Titke Product Status
0000001050 uso1 USHQ 3/22/2018 RANA ARNAV LEASE VEHICLE-T... NEW
0000001091 usoL UsHQ 3/22/2018 RANA ARNAY LEASE VEHICLE-T... NEW
0000001334 uso1 USHQ 3/29/2018 DEEPALI SHAH LINE HE (VR)-TEST APPROVED

VERIFIED 0

3] Close}
Elview || o audit
Max Late Charge Limit Expiry  Limit Next Renewal
0.00 12/31/2022 12/31/2022

Collateral
Description
REVIEW REQ. 2018 TOYQTA CO.
REVIEW REQ... 2018 TOYOTA CO..

Sub Status Identification #

Comments tab in Customer Credit Limit tab:

A new comments tab is created in Customer Credit Limit >Customer/Business tabs.

e Following field are available in comments.

Field Name

Comment

Commented By

Commented Date

¢ CUSTOMER and BUSINESS lookup values are added to COMMENT_SUB_TYPE_CD

lookup.

> If the record is updating from customer >Comments tab, system will default the Type

to “Regular” and Sub type to “Customer”.

> If the record is updating from Business >Comments tab, system will default the Type

to “Regular” and Sub type to “Business”.

e “ADD, EDIT, VIEW and AUDIT” buttons are available in Comments tab.
e “Delete” button is provided to delete the comments which not system posted.

o If user clicks on “Delete” button system will show warning message “Do you want to

delete the comment?” with “Yes”, “No” buttons.

e System posted comments will be read only and can’t be edited or deleted.
e If user add a Comment to Comments tab, system will by default send the Alert flag= N.

Customer

Customer Credit Limit x
(© Information

Transaction Completed Successfully.

Search | Customer

Credit Limit Details

View  Format v  [5p Freeze I Detach Wrap 1]
Customer # Name Max Limit  Total Utiized Amt Available Amt Hold Amt  Suspended Amt Grade
0000004054 PAVAN NAPHADE 100,000.00 99,888.00 112.00 0.00 0.00 B
Transactions  Addresses  Telecoms | Employments | Tracking Attributes  Accounts | Applications Documents
Comments
View v Formatv [ Freeze Eff Detach Wrap G 3 Delete
Alert Type Sub Type Comment
N REGULAR CUSTOMER TEST COMMENT

[/ d
B view || < Audit
Max Late Charge Limit Expiry  Limit Next Renewal
0.00 12/31/4000 12/31/4000

S add | A Edt | B view | < audit

Comment By Comment Dt
HMACHA 04/10/2018 11:24:21 AM
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Business:

Customer Credit Limit x 3] Cose
Credit Limit Details 5l view || o audit
View v Format~ Freeze 4] Detach Wrap 5]
Business = Name Max Limit  Total Utilized Amt Available Amt Hold Amt Suspended Amt Grade Max Late Charge Limit Expiry  Limit Next Ranewal
0000001001 BUSS MAINT 100,000.00 9,211.34 90,788.66 0.00 0.00 0.00 12/31/4000 12/31/4000
Transactions | Addresses | Telecoms | Partners | Affilistes | Tracking Attributes Accounts | Applications Documents
Comments G add | ZEdit | [E view || o Audit
View - Format v [ Freeze G Detach Wrap @ € pelete
Alert Type Sub Type Comment Comment By Comment Dt
N SYSTEM GENERATED BUSINESS ADDRESS UPDATED - CURRENT INDICATOR: OLD VALUE : Y NEW VALUE : N - ADDRESS1: . SKSK 04/04/2018 01:15:13 PM

SYSTEM GENERATED
SYSTEM GENERATED
SYSTEM GEMERATED

MNEW BUSINESS ADDRESS ADDED - ADDRESS TYPE: BUSINESS, CURRENT IND: Y /03/2018 04:25:02 PM

A 018 12:29:25 PM
018 11:20:10 AM
018 11:11:46 AM
018 02:10:07 PM
018 12:26:39 PM
018 12:06:00 PM
018 12:02:30 PM
018 11:16:13 AM
018 11:05:28 AM
018 12:13:25 PM
018 12:13:25 PM
018 09:51:09 AM
018 09:51:09 AM
22/2018 11:24:46 AM

AKASH

SYSTEM GENERATED INES! M ATE! UE : 64746471464 N VA : ... AKASH
SYSTEM GENERATED
SY¥STEM GENERATED

RESS ADDED - ADDRESS TYPE: BUSINESS, CURRENT IND: Y AKASH
ED - TELECOM TYPE: OTHER HOME PHONE, CURRENT IND: ¥

1l E ADDED - TELECOM TYPE: PHONE, CURREI :
SYSTEM GENERATED W BUSINESS ADDRESS ADDED - ADDRESS TYPE: BUSINESS, CURRENT IND: Y
BUSINESS COMMENT2

REGULAR BUSINESS COMMENTL

REGULAR BUSINESS TEST THE
REGULAR BUSINESS TEST THI
SYSTEM GENERATED SYSTEM GENERATED MNEW BUSI

ENT 2
1 AKASH
DDRESS ADDED - ADDRESS TYPE: WORK, CURRENT IND: ¥ PRITAM

Comments Web Services:

e New web services are created to POST and GET the Customer >Comments in customer
credit limit.

o New web services are created to POST and GET the Business >Comments in customer
credit limit

o Alert field is always be sent as “N”.

e Comment By and Commented Date fields are populated based on the web service user
and commented time stamp.

o Comment Type and Sub type are defaulted to Regular and Customer respectively in case
of Customer.

o Comment Type and Sub type are defaulted to Regular and Business respectively in case
of Business.

o Note: Refer the swagger documentation for request and response for this web service.

Documents tab in Customer Credit Limit tab:

A new Documents tab is added to Customer Credit Limit >Customer/Business. (Similar to
Servicing >Customer Servicing >Document Tracking tab).

e Following sections and fields in respective sections are available tab.
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> Documents
- Document Type
- Comment
» Customer Document Details or Business Document Details based on tab it is opened
- Document Type
- Document Sub Type

- Version

- Page#

- Document File Type
- Status

- Tracker #

- Docket #

- Location

Provision is provided in Servicing >Account Documents to attach documents for
Customer and Business entities.

Copy/Move Document:

Two radio buttons are added for Customer and Business for searching the documents
based on following combination in Copy/Move Document radio buttons.

» Customer

> Customer # and Account #
> Business

> Business # and Account #
> Account #

When user provides a Customer # and Account # combination, system will fetch the
documents available with that combination.

The Customer # field (Read Only) is added to the Servicing >Account Documents
>Copy/Move Documents> Document Details table.

A new Copy/Move Customer # LOV is added to the Servicing >Account Documents
>Copy/Move Documents> Document Details table.

When user searches with Customer/Account or Business/Account or Customer number
combination, system will prepopulate the Customer # field.

Copy/Move Customer # LOV will show both customer and business numbers.

If user selects a Customer # from LOV, system will show the accounts attached to that
customer in Copy/Move Account # LOV field.

If user selects a Business # from LOV, system will show the accounts attached to that
business in Copy/Move Account # LOV field.

If no customer or business selected in LOV all the accounts are shown in Copy/Move
Account # LOV field.

Once user clicks on post button after selecting the combination from Copy/Move
Customer # and Copy/Move Account # fields, system will copy or move the documents
based on selected radio button from action section.
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Account Documents x  Customer Service x | Customer Credit Limit x 3] Close

Document Maintenance
Action

None ® Copy Document () Move Document () Attach Document (Server) () Attach Document (Client)

Document Maintenance

I Customer# ® Business2  DO0043002 |f4ccnunt: @8 search

Document Details & it || 5] view
View v Format v [5 Freeze 4 Detach Virap @ [ wew Document {8 post
File Name Document Type Document 5ub Type Account = Copy/Move Customer Copy/Move Account £
JIRA- 9844.0°5 APPLICATION IMAGE IMAGE PAGE Business:0000043.

Attach Document from Server/Client:

e Customer # LOV (non-mandatory) field is added to the Servicing >Account Documents
>Attach Documents (Server/Client) > Document Details table.

e Customer #s and Business #'s are shown in above LOV.

e When selects a Customer # or Business # from this LOV, system will show the accounts
attached to that respective Customer or Business.

e If no Customer # or Business # is selected then system will show all the accounts in
Account # field.

e Using the above fields, user can attach documents to below combination.
» Customer
»  Customer — Account
> Business
» Business — Account
> Business
e When user click on “Post”, system will attach the document to selected combination in
Document Details page.
Note: Rest of the functionalities are As Is

Account Documents x | Customer Service x  Customer Credit Limit x @QCEE

Document Maintenance
Action

None () Copy Document (©) Move Document [#) Attach Document (Server) () Attach Document (Client)

Document Details & Edtt || 5] view
View v Format~ [ Freeze L Detach Wrap [0} View Document 453 Post 35 List Files
File Name Document Type Document Sub Type Account = Attach Status

No data to display.

Customer and Business Document Upload Web Service:
Customer and Business document upload web services are created.

Note: Refer the swagger documentation for request and response

Validations:
e Customer:

> If the Customer # is wrongly provided - Customer # doesn't exist.
> If no records available for provided request parameters- No records available

e Business:
> If the Customer # is wrongly provided - Business # doesn't exist.
> If no records available provided request parameters - No records available

2-114 ORACLE

Financial Services



2.7 Data Masking Enhancements

© © N o

Overview

Data masking screen in Oracle Financial Services Lending and Leasing facilitates to mask
Personally Identifiable Information (PII) displayed on the application screens to safeguard the
sensitive and confidential information while protecting them from offenders.

As part of the product installation, standard set of identified fields (seed data) which is likely to
contain either organization / customer Pl information are provided for data masking in disabled
status. Based on the need, the required fields can be enabled and masked for specific user
responsibility in the Data Masking screen. Also if there are additional Pl fields identified later by
the customer for masking, the same can be pooled into the system using input file processing
method and masked using Data Masking screen.

The data masking process involves the following steps:

5. Identify and enable field(s) (seed data) to be masked
Select user responsibility for whom the data has to be masked
Execute batch job to create data redaction policy
Compile the data redaction policy
(Optional) Process user identified Pl data for masking

Setup Data Masking

¢ A new “Data Masking” tab is added under setup >Administration >System.

e “Data Masking Details” sub tab is created under “Data Masking” tab in setup.
> Following fields are available in “Data Masking Details” tab.

Field Name Field Type Required
Table Name Read Only Y
Field Name Read Only Y
Enabled Check Box Y
System Defined Y/N Read Only Y

> EDIT, VIEW and AUDIT buttons are available in the “Data Masking Details” tab and
same have been access controlled.

» EDIT button will allow only to edit “Enabled” check box and it will be an inline edit.

> System defined radio button = Y if the seed data has been provided from base
product. If custom fields (new fields for masking) are added by user then it will be N
and read only.

> Seed data will be provided with initial set of columns, which user can mask.
> By default seed data will be in disabled status.

> By default, all the fields are having format masking type as “FULL MASK”.
> Following are the default values for Data masking based on data type.

Data Type Masking Value

NUMBER 9

2-115 ORACLE

Financial Services



Data Type Masking Value
VARCHAR X

DATE 31/12/9999

Email XXXXX.XXX@<domain>.com

| pata Hasking x|

I Data Masking Details ~ User Access Detalls I

Data Masking Details
view v Format~
Table Name
ACCOUNTS
ACCOUNTS
ACCOUNTS

Freeze i Detach

5
ACOOUNTS

Field Name

ACC_ACH_BANK_NAME
ACC_ACH_BANK_NAME_CUR.
ACC_PHP_DRAWER_CITY
PRIMARY_CUS_LANGUAGE_CD
ACC_TITLE

30 Close

A Edit || B view || « audit

nabled System Defined Y/
7
Y

ACCOUNT_ACH_DETAILS
ACCOUNT_ACH_DETAILS
ACCOUNT_ACH_DETAILS
ACCOUNT_ACH_DETAILS
ACOOUNT_ACH_DETAILS

AAC_ACH_ACCOUNT_BIC_CD
AAC_BANK_CITY
AAC_BANK_NAM
AAC_BANK_STATE_CD
AAC_DRAWER_ADDRESS1

Ei
¥
Y
N
N Y
N
N
N
N
L

“User Access” sub tab is created with following fields under “Data Masking” tab in setup.

Field Name Field Type Required Comments

Responsibility LOV Y NA
(RESPONSIBILITY_CD)

Masked Check Box Y NA

Responsibilities which are defined in the setup can’t see the masked data.

A new batch job “POLICY CREATION FOR PERSONALY IDENTIFIABLE INFORMATION DATA”
is provided to create policies with enabled fields and enabled responsibilities.

The generated policy is either written into CLOB or sql file depending on the following
option:

if the value of system parameter ‘CMN_FILE_PROCESS_TO_LOB’ is set to ‘Y’, the
policy file is generated in CLOB and can be accessed by navigating to Dashboard >
Process Files screen. For more information on handling Incoming/Outgoing process
files, refer to ‘Dashboard’ section in User Guides.

If the value of system parameter ‘CMN_FILE_PROCESS _TO LOB'is ‘N’, the policy
is generated as an sql file and stored in the repository path as defined in the system
parameter - CMN_SERVER_HOME. For example, /scratch/OFSLL/<release>/sql.

Further, the policy file needs to be manually compiled into database schema to apply
the masking rules for respective fields for that particular user. Either a system
administrator or any other user having database administration privileges needs to
compile the policies in the database.

If the user disable a field from Data Masking Details tab, user is expected to re-generate
the policy to unmask that field.

An input file is created with predefined format to add the additional fields into “Data
Masking Details” tab.
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> A new batch job “PI INFROMATION FILE UPLOAD PROCESSING” is created under
job set SET-IFP to process the above file.

> On execution, the batch job picks the file from the location, processes it and loads the
seed data into Data Masking screen. By default, all the user identified PIl data from

input file is categorized separately in Data Masking screen by assigning the value of
‘System Defined’ property as ‘N’.

Note: In case of editing a masked data, user is expected to provide full data. User can’t
provide partial data.
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Lease SCRA Enhancements

Overview

To address the regulatory compliance of Lease Service members Civil Relief Act (SCRA),
transactions are create to update Customer SCRA details and post conditions on to the account.

Lease SCRA (Interest Rate and Rent Factor):

Following transactions are created similar to Loan SCRA to apply/revers the SCRA rate and
records the Customer SCRA details for “Lease (Interest Rate and Rent Factor)”.

BORROWER ON MILITARY DUTY:

Parameters:
Parameter Name Default value Required
TXN DATE Y
BORROWERS RELATION WITH ACCOUNT | PRIM Y
ACTIVE DUTY ORDER REFERENCE N

e Once the Borrower on military duty transaction is posted, system will post the following
conditions on to the account.

> DO NOT CHARGE OFF

> DO NOT TERMINATE

> DO NOT REPOSSESS

> ON ACTIVE MILITARY DUTY

e Following lookup values are added in ACC_CONDITION_CD.

Condition System Defined
DO NOT TERMINATE Y
DO NOT REPOSSESS Y

e Following seed data is added under “TERMINATE” transaction > access grid tab.

Condition Allowed System Defined

DO NOT TERMINATE NO Y

e Once the transaction is posted SCRA details are updated in “Customer details” table.
> Active Military Duty
>  Effective Dt
> Order Ref #

e REVERSE BORROWER ON MILITARY DUTY.

»  This reverse transaction will remove the SCRA details updated in customer details
screen and reverse the conditions posted on the account.

e Following transactions are created similar to Loan SCRA to apply/reverse borrower off
military duty.
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BORROWER OFF MILITARY DUTY:

Parameters:
Parameter Name Default value Required
TXN DATE Y
BORROWERS RELATION WITH ACCOUNT | PRIM Y

e Once the BORROWER OFF MILITARY DUTY is posted, system will update the Release
Dt of customer in Servicing > Customer Details table and remove the conditions posted
by BORROWER ON MILITARY DUTY transaction.

REVERSE BORROWER OFF MILITARY DUTY:

e This reverse transaction will reverse changes done by BORROWER OFF MILITARY

DUTY transaction.
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2.9

Customer Preference Web Services Enhancements

Overview

Customer preferences facility of servicing module helps the customer service agents to record the
preferred communication medium (phone, email etc.) and customer’s availability details to make
a servicing call. Using these new web services, now third party systems can create and update
customer preference details at account level:

Customer Preference services:

« POST
. PUT
e GET

Customer Preference Web Services:

New POST, PUT and GET services are created to create and update customer preference
details.

Note: Refer the Swagger documentation for request and response structure of these web
services.
Validations:

e If account number passed as part of the request is invalid, system will show an error
“Invalid Account Number”.

e If the Relation Type passed as part of the request doesn’t exist in account, system will
show and error “Relation Type doesn’t exists for account”.

e If the Communication mode is email address, following fields are not required

> Type
> Phone
> Extn

> Time Zone
> Best Day to Call

> Start Time
> Period

> End Time
> Period

e If the Communication mode is telecom following fields are not required
> Extn
> Time Zone
> Best Day to Call
> Start Time

> Period
> End Time
> Period

e If the Communication mode is ad-hoc telecom following fields are allowed to capture as
part of Post Web service.
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> Extn

> Time Zone

> Best Day to Call
> Start Time

> Period
> End Time
> Period

If an active Communication Mode already exists for this Relationship type, system
displays an error message “Communication Mode already exists for this
Relationship type”.
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2.10 Permission to Text Enhancements

Overview

A new flag “Permission to Text” has been introduced in Origination and Servicing modules. This
will allow the user to identify weather the phone number provided is having a permission to send

text message or not.

Permission to Text

A new flag “Permission to Text” is added in the following screens of origination module to capture
applicant consensus for sending a text message and same information has been propagated to

respective tabs in servicing module.

Field Name Data Type

Default

Mandatory

Permission to Text | Check Box

Y Yes

Applicant > Addresses:

Address | Employments = Telecoms =~ Summary | Credit Scores

Addresses
View ~ Format v [

Current Permission to Call Permission to Text  Own/Rent
Y ¥ 7
Addresses

* pddress Type HOME A
* Current ¥/
* Confirmed
* Mailing (@
* Permission to Call ¥

* Permi to Text ¥

Freeze i Detach Wrap o]

4k add | 2 Edit || 5 View || < Audit
Address Type Address Line 1 Gity State Zip Stated Years st
HOME 52 N CWING BCH... AGUADA PUERTO RICO 00602 0
»
Save and Stay Save and Retun || {3 Return
*7ip 00602 = Address Rent Mortgage Stated
Zip Exin *Years 0
* City  AGUADA *Months 0
* State PUERTO RICO M Currency US DOLLAR Y
Phene  (000)-000-0000 = Pmt Amount 0.00

Duplicate Applicant || Existing Accounts ~ Tracking Attributes

* Frequency MONTHLY v

Employee ID

Contact Extn

* Country UNITED STATES v Additional Info
Rent/Mortgage 0.00
Address Details * Own/Rent Y
Address Rent Mortgage Actual
Landlord
* Postal Type  NORMAL ADDRESS T
Landlord Phone *Years 0
* Address # 52
Contact * Months 0
Street Pre NORTH v
Contact Title * Pmt Amount  0.00
Street Name C WING
Contact Phone (000)-000-0000 *Frequency MONTHLY r
Street Type BEACH v -
_ R — Extn Rent/Mortgage 0.00
Applicant >Employments:
Address | Employments ~ Telecoms | Summary | Credit Scores | Duplicate Applicant || Existing Accounts | Tracking Attributes
Employment Information Gk add | A Edit | 5] view || o audit
View = Format~ [ Freeze i Detach Wrap 0]
Current Permission to Call  Permission to Text  Type Employer Title Occupation Phane Stated Years Stated Months |
Y Y Y FULL TIME UNDEFINED OTHER (000)-000-0000 3 3
»
Employment Information
Save and Stay Save and Return || {3 Return
* Current (] = Months 3
- nission to Call ¥
Permission to Call Additional Info Pay Day [
* Frequency  MONTHLY v
“Type FULL TIME v Phone | (000)-000-0000 Currency  US DOLLAR Y
* Employer UNDEFINED Extn * Income Amt  9,000.00
Occupation OTHER v Contact Salary 9,000.00
Title Contact Title
Department Contact Phone Employment Details Actual

* Years

3
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Applicant > Telecoms:

* Country  UNITED STATES

Address | Employments Telecoms Summary = Credit Scores  Duplicate Applicant ~ Existing Accounts  Tracking Attributes
Telecom Information gk add | # Edit | 5] view || < audit
View » Formatv [ Freeze Wrap L)
Permission to  Permission to
Type Phone Extn Current cal Text Time Zone Start Time Period
(000}-000-0000 Y Y Y
3
Telecom Information
E Save and Add E Save and Stay E. Save and Return (,L.l Return
*Type v Start Time
Phone (000)-000-0000 Period v
Extn Time Zone M End Time
* Current [#) Best Day to Call v period v
Contract >Reference
Contract (2) Repayment Itemizations Trade-In Subvention Insurances ESC Compensation Proceeds Disbursements Fees ACH Coupons References Tax Details
Reference Information qradd | A Edt | S view || oF Audit
View v Format v [ Freeze i Detach Wrap )
Relationship Name Status Years Months Comment Gty State Address Line 1 Address Line 2
] 0
3
Reference Information
[ saveand Add || [ Saveand stay || [ Save and Return || ¢aRetum
* Relationship v Address Line 1 Extn
* Name Address Line 2 = Permission to Call
Status | ACTIVE v Zp 5
*Years 0 Zip Extn Phone 2
* Months 0 City Extn
Comment State v * Permissicn to Call
'
A Phone 1
v

In case of business credit (SME) applications,

“Permission to call’ and “permission to text” flags

have been added to the following tabs in Origination module and same details have been
propagated to respective tabs in servicing module.

Business > Address:

Business

Business Details

&

Existing Business # Organization Type
0000000000 5 CORP

View v Format » Freeze ff Detach

Business Type

(CORPORATE

Address | Telecoms  Financials = Liabiliies = Partners

Address Information

&

Permission to Call  Permission to Text
Y Y

View v Format » Freeze g Detach

Address Type

Address Information

 Current

* Permission to Call

* Permission to Text

* Mailing
Address Type

* Country  UNITED STATES
Ovin/Lease

Comment

@

Business Category

INDIVIDUAL

Wrap

Affiliates = Other Details

Wrap
Country

@

Business Name Legal Name TaxID #

MISSION IMPOSSL... MISSION IMPOSSI... x0000B765

Tracking Attributes

Address = Gty State

* Postal Type MORMAL ADDRESS
Address #
Street Pre
Street Name
Street Type
Street Post
Apt =

Address Line 1

Start Dt
03/30/2000

OwnjfLease

E Save and Add

Z Edit || Bl view || o audit
#of . fEmployess  Contad
Employees(Cur)
123 132
13
4 add | A Edit || [ View || o Audit
Comment Postal Type Street P
3
E Save and Stay B Save and Return (pBelum
Address Line 2
=7ip -
Zip Extn
* City
* State 0
Phone | (000)-000-0000
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Business > Telecoms:

Address Telecoms = Finangals ~Liabilities Pariners  Affiliates = Other Details  Tracking Attributes
Telecom Information Fadd | Fedt | [Hven | o aud
View = Format~ 5 Freeze i Detach Wrap (o)
Type Permission to Call  Permission to Text Phone Extn Current
Y Y N
Telecom Information
Save and Add Save and Stay Save and Retun | {3 Return
Phone
Extn
= Type v * Current
Business > Partners:
Address = Telecoms Financials = Liabilities Partners = Affiliates  Other Details = Tracking Attributes
Partner Information Fadd | FEdt | S view | < aud
View v Formatv Freeze 74! Detach Wrap 5]
Permission to Call  Permission to Text  First Name MI Last Name Suffix SSN# Birth Dt Birth Place Title Ow
Y Y
3
Partner Information
Save and Add Save and Stay Save and Return || {3 Return
* Permission to Call ¢ Title Address Line 2
* Permission to Text (¥ = Qwinership (%) 0.00 *Zip =
First Name * Networth 0 Zip Extn
MI * Gross Income 0 = City
Last Name Language v = State v
5 v -
Suffix Nationality M Phone (000)-000-0000
*55N= * Country UNITED STATES Y Extn
Birth Dt B Address # Email
Birth Place Address Line 1

e When a “Business” information is copied using “Business Search”, system pre populate
the “Permission to text” field in respective tabs.

e When a “Customer” information is copied using Customer Search to Origination>
Applicant screen, system pre populate the customer “Permission to Text” field in

respective tabs.

e When a “Customer” information is copied from Customer Search to Origination>Business
>Partners screen, system pre populate the customer “Permission to Text” field in

respective tabs.

¢ New “Permission to call” and “Permission to text” flags have been added in following

tabs.
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»  Origination/Servicing >Producer

Origination/Servicing >Producer

> Origination/Servicing > Vendor

Producers %] Close
L4 -
Columns Hidden 32
Producer Details
[ save and stay || [ save and Return || (3 Retum
Producer # (CA-00002 Address # Email
Ohd Producer # (GA:00H02 Address Line 1 10993 SOUTH CENTRAL AVENUE * Loss Reserve Amount 0
¥ Name [RAKDVSIAUTOISATES Address Line 2 Max Float 99,999
* Company USOL v * Country UNITED STATES v Remaining Float 99999
=Branch USHQ v < 2p (91762 = Enabled #)
startDt 05/27/1954 By -
; % Zip Extn Subvention Participation
g End Dt 12/31/4000 » Gty [ONTARID
= * Subvention Particpant
Contact (JAMK * State CALIFORNIA v ’
= Group GROUP 1 v * Collection Type STATEMENT v
= Permission to Call
. c s b v
Grade PLATINUM v < Dermiesion to Text Collection Frequency MONTHLY
= Type DEALER v = Phone 1| {319) 5914116 * Refund Disbursement Method NONE v
(909)-591-
=Status ACTIVE v Extn 1 = Region ALL i
*Sales Agent  DEMO LEAD v * Territory | ALL hd
*Underwriter VINAY BHATIA v -
License Details
*Funder DWIDESH VEETIL v Phon 2
* Collector VICKY KUMAR v B 2 *=Valid From 01/01/1800 B
*Fed Tax = 458765979 * Fax Prefixt | 11 DIGIT v =Valid To 12/31/4000 B
*Fax 1 (909)-465-9402
Address Details i
Fax Prefiiz v
Vendors x (3] Close.
Columns Hidden 14 B
Vendor Details
[ saveand Add | [ Save and Stay || [ Save and Retum || (3 Retum
“Enzbled ¥ Fed Tax # Fax 2
Vendor # UNDEFINED * Cred * Country v
* Channel | INTERNAL v adress =
01d Vendor = * Address Line 1
teme Phone 1 Address Line 2
* status v
=7ip -
* Company v
aip Extn
* Branch v
» =City
= Start 0t 047102018 B Phone 2
* State
=End Dt 12319009 [y Extn 2
Email
* Contact Person Fax
Payment Details | Vendor Groups || Tracking Attributes || Comments
Payment Details A Edit || Bl view || <2 Audit
View » Formatw 52 Freeze fiDetach < Wrap o]
Country City State Address Line 1 zip Zip Extn Pre Process Days Currency Mode Bank Start Dt
UNDEFINED 0.00

o New “Permission to call” and “Permission to text” flags have been added in following
system components.
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O tables

OO tables

Application Entry web service — (GET,PUT and POST)
Account On-boarding web service and Ul
Account Details Search web service
Data Migration

Servicing Customer related transactions
-  CUS_ADR_PH_MAINT

- CUS_EMPL_MAINT

- CUS_NEW_TEL

-  CUS_TEL_MAINT

-  REF_STATUS_MAINT

-  REF_STATUS_NEW

Data fix script is provided to update the “Permission to Text” field same as
“Permission to Call” value for existing accounts.
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2.11 Lease Sales/Usage Tax Enhancements

Overview

OFSLL supports recording and calculation of Sales /Usage Tax. This feature is used to enhance
existing Sales and Usage tax functionality and also to support integrate with third-party vendor
like ‘Vertex O Series’ to support external tax calculation.

As part of this requirement we consider integration with Vertex® Indirect Tax for Leasing. Vertex®
Indirect Tax for Leasing (Vertex Leasing) is the tax calculation solution developed to meet the
needs of leasing software vendors and their enterprise customers within the equipment and
vehicle leasing industries. Vertex Leasing leverages the Vertex O Series platform and automates
the taxability and ongoing maintenance of rental and leasing rules.

Below are the high-level impacted areas for Internal and Vertex integration:

e Setup
> Sales tax definition origination
- Percentage of Itemization
- Lease Payment Amount
- Total of Lease Payments
- Purchase Price Amount
> Lease Sales Tax Servicing/Collections
- Upfront
- Payment Stream
> Sales Tax Range definition
> Tax Exemption
e Origination
» Calculate Sales Tax

> New Edits
> Recording Tax Exemption
> Reports

e Servicing/Collection
> Sales tax as part of the Bill
> Sales tax as part of the Late Charge
> Sales tax as part of the Payoff Quote
> Sales tax in Statement
> Sales Tax handling in case of Reversal
» Tax Exemption
> Reports

Note the following:

e All the changes detailed in this feature are displayed only for Lease
Applications/Accounts. These changes are only applicable for Lease module.

e In this document Sales and Usage Tax is used interchangeable with Tax.

Description

This feature details OFSLL Lease Module enhancements to support Sales Tax Compliance
process of calculating, billing and collecting the correct amount of taxes. This enhancement also
details integration with third-party Sales Tax Compliance interfaces like Vertex.
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OFSLL will now support three Lease Tax compliance process:

Internal: Prior to this release, OFSLL only supports tax metric based on State using
SALES TAX table. This section of enhancement details the different parameters that
would be used to calculate tax.

External: There are different Lease tax compliance applications used by enterprise to
calculate Sales and Usage Tax. Vertex is predominant market leader in tax compliance.
This section of enhancement details the configuration required in OFSLL to outsource tax
calculation to Vertex.

Manual: This is existing process and does not undergo any changes. As part of this
processes, user is expected to calculated tax eternally and update OFSLL in Origination
and Customer Service.

To determine these channels, System Parameter “XSL_TAX_INTERFACE” is used. This
parameter is relocated to Company parameter to support different Sale and Usage Tax
channels per Company/Branch. As part of this release system supports below
parameters

> MANUAL
> INTERNAL
> VERTEX

Every country will have a governing body to collect, monitor and regulate Sales and Usage Tax
collection. In some countries these rule are controlled by State and others they are generalized
for all the State [referred as VAT/GST]. In most of the regions Sales and Usage tax collection
process is categorized into below:

Upfront: This will be collected while funding the application. Customer should have a
flexibility of requesting this amount as part of Lease Receivables.

Stream: This will be collected as part of Customer Service billing process. The tax is
estimated as part of billing and fee assessment etc. and opening balances will be
updated accordingly.

Exemption: If the customer is eligible for tax exemption, tax authorities will issue a
certificate to confirm and tax will not be applied.

Prerequisites:

Address: A tax can either be origin based or destination based. Origin based tax or
production tax is levied where goods or services are produced. Destination based tax or
consumption tax are levied where goods and services are consumed.

For tax determination, Address of source and destination will play a key role. In some
states, if an out-of-state business sells products into a state then it is liable for collecting
Sales Tax on sales into the state. This scenario is referred as Nexus.

OFSLL will use below references in the application/document to refer Source and
Destination address.

> Source Address: Producer Address.
> Destination Address: Asset Address.
OFSLL supports two Sales Tax Mode and Tax Method to determine if the Sales and

Usage Tax has to be collected in Origination/Customer Service. Based on state rules
below configuration should be updated in Contract.

If Lease contract is configured as UPFRONT/ PURCHASE_PRICE then system will
collect Sales and Usage Tax during Origination process.

If Lease contract is configured as CYCLE/ PAYMENT _STREAM then system realizes
Sales and Usage Tax during Customer Service as part Bill/Due generation.

Tax Method and Mode Origination | Servicing/Collection
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Upfront/Purchase Price

YES

NO

Cycle/Payment Stream

NO

YES

Internal

Setup

e Anew screen Setup = Administration 2 System 2 Sales Tax = Lease is created to
capture Sale and Usage Tax rules. This screen is used to capture tax rules for
Origination and Customer Service using itemizations/transactions.

e During Origination with upfront tax calculation, system supports calculation based on
MSRP, Itemization and Total of Lease Payments and for stream tax calculation system
provide support to predict Estimating Tax using Individual Lease payments.

Example:
Tax Paym

Payme | Total Item Tax | Amt | ent Total

nt Amt | Amt MSRP | Amt Calc Method % Amt Amt
$558.1 | $20,093. | $20,0 | $20,00 $558. | $21,093.
7 72 00 0 Purchase Price | 5% | NA 17 72
$558.1 | $20,093. | $20,0 | $20,00 | Percent of Itm $558. | $21,093.
7 72 00 0 Amt 5% | NA 17 72
$558.1 | $20,093. | $20,0 | $20,00 $1,0 | $558. | $21,093.
7 72 00 0 Flat of Itm Amt 00 17 72
$558.1 | $20,093. | $20,0 | $20,00 | Lease $586. | $21098.
7 72 00 0 Payment Amt 5% | NA 08 83
$558.1 | $20,093. | $20,0 [ $20,00 | Total of Lease $558. | $21098.
7 72 00 0 Payment Amt 5% | NA 17 41

e During Customer Service and Collection, system provide support for stream accounts by
calculating tax when BILL/DUE DATE, LATE CHARGE transactions are posted. System
also calculate estimated tax in PAYOFF QUOTE LEASE on unpaid lease amount.

Example:
Txn Code Tax Tax Txn Total Txn
Calc Method % Amt Amt Amt
BILL/DUE Percentage of Transaction $558.1
DATE Amt 5% 7 $586.08
BILL/DUE $558.1
DATE Flat Transaction Amt $100 7 $658.17
LATE CHARGE | Percentage of Transaction
Amt 5% $20 $21
LATE CHARGE | Flat Transaction Amt $5 $20 $25

e Range in Tax setup is used for gradually increase in tax rate based on different charges
levied for Product/Service.
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For example if the cost of the Vehicle is less than or equal to $20,000 then Sales and
Usage Tax slab is 20% and if the cost is greater than $20,000 then slab is 30%. To
facilitate this below configuration should be maintained in the system.

Origination

Calculation Method

Itemization

Sign

Value

Enabled

PERCENTAGE OF
ITEMIZATION AMOUNT

ITM CASH SALES

+ 100 Y
Range
Tax Setup — Origination:
Sales Tax Definition G add | 2 Ed || [E view || o audic
View v Format v r@ Freeze ! Detach Wrap (0]
& HINTERNAL% £ )
Tax Description Start Dt End Dt Enabled Channel Company Branch Billing Cycle Product Asz
PHANI_INTERMAL . PHANI_INTERNAL. . 10/10/2010 10/10/2029 Y INTERNAL KGF-US KGF-US-BR MONTHLY ALL ALl
JC_INTERMNAL JC_INTERNAL 04/03/2017 05/04/2019 N INTERNAL ALL ALL ALL ALL ALl
3
Origination  Customer Service | Range
( Formula Details b add | AEdt | [Eview | & Audit
View = Format = [Ep Freeze i Detach Wrap [5F]
Calc Method Itemization Sign Value Tax Exemption Enabled
PERCENTAGE OF ITEMIZATION AMOUNT  ITM CASH SALES tve o -ve B850 N Y
Tax Setup — Customer Service
Sales Tax Definition G add | ZEdit | S view || o audt
View v Format » [0 Freeze i Detach Wrap e
& “LINTERNAL% [y By
Tax Description Start Dt End Dt Enabled Channel Company Branch Billing Cydle Product Ass
PHANI_INTERMAL... PHANI_INTERNAL.. 10/10/2010 10/10/2029 Y INTERNAL KGF-Us KGF-US-BR MONTHLY ALL ALl
JC_INTERNAL JC_INTERNAL 04f03/2017 05/04/2019 N INTERNAL ALL ALL ALL ALL ALl
3
Origination ~ Customer Service Range
1 Formula Details 9k add | G Edit | B view || o Audit
View v Format~ [Ep Freeze 41 Detach Wrap 5]
Calc Method Txn Code Sign Value Tax Exemption Enabled
PERCENTAGE OF TRANSACTION AMOUNT BILL/DUE DATE +ve | -ve 850 N ¥
FLAT TRANSACTION AMOUNT LATE CHARGE +ve [ -ve 8.50 N ¥
PERCENTAGE OF TRANSACTION AMOUNT PAYOFF QUOTE LEASE +ve e 8.50 N ¥
Tax Setup — Range:
Sales Tax Definition P add | A Edt || ] view || o Audit
View » Format r@ Freeze g Detach Wrap 0]
& LINTERNAL% ) £
Tax Description Start Dt End Dt Enabled Channel Company Branch Billing Cycle Product Ast
PHANI_INTERNAL. . PHANI_INTERNAL 10/10/2029 Y INTERNAL KGF-US KGF-US-BR. MONTHLY ALL AL
JC_INTERNAL JC_INTERNAL 05/04/2019 N INTERNAL ALL ALL ALL ALL ALl
3
Origination  Customer Service Range
Range Details b add | A Edit | [E] view ||  Audit
View v Format v [5p Fresze f) Detach Wrap (5]
Amt From
0.00
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Sales Tax Definition

Field Type Default | Comments Reference
Name Values
Tax A/N Null Specify the tax identification code | NA
Descripti | A/N Null Specify the tax description NA
on
Start Dt Date Null Specify the tax rule Start Date NA
End Dt Date Null Specify the tax rule End Date NA
Enabled | Checkbox | N Check this box to enable the tax NA
rule
Channel | LOV NULL Specify the tax channel TAX_CHANNEL_CD
Company | LOV ALL Select the portfolio company from
the drop-down list. Company Setup
Branch LOV ALL Select the portfolio branch
associated with the commission, Company setup
from the drop-down list.
Enabled lookup
Billing LOV ALL Select the billing cycle from the codes in
Cycle dropdown list. LEASE_BILL_CYCL
E_CD
Product LOV ALL Select_the product from the drop- | List of enabled lease
down list. products
Enabled lookup
codes in
VEHICLE_ASSET_C
Asset LOV ALL Select the asset class from the LASS_CD,
Class dropdown list. HOME ASSET CLA
SS_CD,
OTHER_ASSET_CL
ASS_CD
All enabled Asset
i Type from ‘Asset
Asset LOV ALL Select_the asset from the drop Type Setup’ where
Type down list. .
collateral type is
‘Vehicle’
Select the asset sub type from the | List of enabled ‘Asset
SubType | LOV ALL dropdown list. Sub Type’
List of enabled Make
Asset LOV ALL Select the z_isset make from the under ‘Makes and
Make dropdown list.

Models’ setup
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Field Type Default | Comments Reference
Name Values
List of enabled Model
Asset LOV ALL Select the asset model from the under Makes and
Model dropdown list.
Models setup
Age Integer 0 S_peC|fy the asset age associated NA
with the commission
Enabled lookup
Country LOV Null Specify the country. codes in
COUNTRY_CD
. . . List of enabled Zip
From Zip | LOV ALL Specify start zip code. codes from Zip Matrix
. . . List of enabled Zip
To Zip LOV ALL Specify end zip code. codes from Zip Matrix
List of unique
City LOV ALL Specify the City. enabled Cities from
Zip Matrix
. Enabled lookup
State LOV ALL Specify the State. codes in STATE_CD
Enabled lookup
County LOV ALL Specify the County. codes in
COUNTY_CD
Origination Formula Details
Field Type Default | Comments Reference
Name Values
Calc LOV Null Specify calculation method code Enabled lookup
Method codes in
SALES_TAX_INT_A
MT_CD for Internal
and
SALES TAX_EXT_A
MT_CD for Vertex
Itemizatio | LOV Null Specify the itemization Valid itemization
n Code codes
Sign Alphabetic | + Specify if the tax amount NA
determined should be add to
application or rebate give to
application
Value Number 0.00 Specify amount or percentage of | NA
tax to be calculated
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formula

Field Type Default | Comments Reference
Name Values
Tax Checkbox | N Specify if the tax formula defined | NA
Exemptio is meant for exemption.
n If Y, system will not assess this
tax formula if application is having
valid exemption details.
If N, system will assess this tax
formula irrespectively.
Enabled | Checkbox | N Check this box to enable the tax NA
formula
Customer Service Formula Details
Field Type Default | Comments Reference
Name Values
Calc LOV Null Specify calculation method code Enabled lookup
Method codes in
SALES_TAX_INT_A
MT_CD for Internal
and
SALES_TAX_EXT_A
MT_CD for Vertex
Txn LOV Null Specify the transaction details Enabled lookup
Code codes in
SALES_TAX_TXNS_
CD
Sign Alphabetic | + Specify if the tax amount NA
determined should be add to
application or rebate give to
application
Value Number 0.00 Specify amount or percentage of | NA
tax to be calculated
Tax Checkbox | N Specify if the tax formula defined | NA
Exemptio is meant for exemption.
n If Y, system will not assess this
tax formula if application is having
valid exemption details.
If N, system will assess this tax
formula irrespectively.
Enabled Checkbox | N Check this box to enable the tax NA
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Range Details

Field Type Default | Comments Reference
Name Values
Amt Number 0.00 Specify the lowest calculated NA
From value
Percent Number 0.00 Specify the percent of value to be | NA
used
Enabled | Checkbox | N Check this box to enable the tax NA
range
Origination

e For Upfront and Stream tax basis, OFSLL records Sales and Usage Tax for each Lease
application based on following:

>  With Tax mode and method as UPFRONT/ PURCHASE_PRICE, system uses
itemization ITM_CSH_SALES_TAX to record tax details. On Funding tax amount
calculated during origination will be part of Lease Receivable based on itemization
adjustments.

> With Tax mode and method as CYCLE/ PAYMENT_STREAM, system uses Contract
fields Estimated Sales Tax and Sales Tax to record estimated tax amount and
percentage. This data will not be propagated to Account.

e A new button “Calculate Tax” is added in Lease = Origination - Decision. On click of
“Calculate Tax” button, system gets the tax details based on setup and populate tax
amount in ITM_CSH_SALES_TAX itemization.

Summary = Applicant Request |Decision Bureau @ Collateral Comments = Tracking =~ Document = Verification =~ Correspondence  Tools

Decision Information Z Edit || E]view || o audit
View ~ Format~ [ Freeze ifi Detach Wrap o] Select Pricing Re-Score & Calculate Tax
Current Grade Score Decision Term Dedision Maég{g Approved Buy Rate Pmt Amt Underwriter
Y D GRADE 12 18 0.0000 2,0000 0.00 JAYANTA
N 0 18 4.0000 2.0000 0.00 JAYANTA

4

e Existing Lease = Origination - Contract is enhanced with the below:

»  Existing button “Calculate Tax” supports tax calculation based on new setup.
» Contract Tax Fields are rearranged as below.

Contract Margin 499 Lease Type DIRECT FINANCE # of Adjs / Life 5
Rate ACH Fee Ind _
C t (1]
Contract Rate 4.99 - o ™
Balloom Method N + 1 PMTS =
Balloon Amt 0.00 Post Maturity
- . ) Sales Tax Method PAYMENT STREAM
Security Deposit 0,00 Sales Tax Mode AT CYCLE TIME Default Rate ¥
sales |ax Mode T E i &
Gross Capitalized 35,000.00 ae AR erault Rate _
Cost Tax Life 0 Index FLAT RATE
Capitalized Cost 0.00 Ads Lifz 0 Post Margin Rate 4.99
Reduction (-) Tax Salvage Value 0.00
Adjusted Cap Cost  35,000.00 EOT Value 0.00 Recourse Details
=) Tax Book Type COND_SALE
Residual % 10.0000 \. i Recourse__
Residual Value (-) 3,500.00 Early Termination Recourse Type MOME
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e Any Lease application can request tax exemption based on different tax rules. A new tab
is added in Lease = Origination = Decision/Contract = Tax Details to record tax
exemption details. If the exemption details are provided for application, all the tax details
marked with Exemption Indicator ‘Y’ are exempted for this application

Decision
System Recommendation = Stipulations =~ Itemizations  Trade-In  Subvention
Tax Details ZEdit || [E view || o Audit
View = Format - % Freeze ﬂ' Detach Wrap @ﬂ
Exemption Exemption Start Dt Ewemption End Dt Reason Tax Code
N UNDEFINED
Contract
< Itemizations = Trade-In =~ Subvention | Insurances ESC  Proceeds  Disbursements Fees ACH | Coupons — References -
Tax Details ZEdit || [Eview | < sudit
View v Formatv  [Ep Freeze A Detach Wrap 03]
Exemption Exemption Start Dt Exemption End Dt Reason Tax Code
N IC_INTERNAL
Tax Details
Field Type Default | Comments Reference
Name Values
Exemptio | Checkbox | N Check this box to enable the NA
n exemption for application
Exemptio | Date Null Specify the exemption Start Date | NA
n Start Dt
Exemptio | Date Null Specify the exemption End Date NA
n End Dt
Reason LOV Null Specify the exemption reason Enabled lookup
codes in
TAX_EXEMPTION_R
EASON_CD
Tax A/N UNDEFI | Displays system selected Tax Enabled Tax Code
Code NED Code

A new document sub type “TAX EXEMPTION PROOF” is added to record exemption certificate
details.
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Checklist  Document

Application Documents & Edit || E] view || < audit
View = Format « % Freeze fﬂ' Detach Wrap E}ﬂ
Document Type Comments
CONTRACT
Application Document Details & Edit || B view || < sudit
View + Format E Freeze ﬂ Detach Wrap @ﬂ View Document

Document Sub Type Versio Page # Document File Type Tracker # Docket # Location Received Dt Efi
AX EXEMPTION PROOF i | 1 1

For Lease applications with Tax mode and method as CYCLE/ PAYMENT_STREAM, a new
contract edit is added to check if itemization ITM_CSH_SALES_TAX is greater than zero.

Attribute Description Default Value | Value

XVL_CON_SAL_TAX | XVL:CONTRACT SALES TAX ERROR NA
_AMT_FOR_CYCLE | ITEMIZATION AMT SHOULD BE
ZERO FOR CYCLE SALES TAX MODE

e A new report “SALES USAGE TAX - LEASE” is added in Origination to view tax amount
recorded in OFSLL before and after funding. This report is generated for all the
applications with Tax mode and method as UPFRONT/ PURCHASE_PRICE

e Tax recorded before funding is called as “Quotation Tax Amt” and actual tax recorded for
the application is recorded as “Invoice Tax Amt”.

e If there is any difference in these amount, the different has to be operationally handled.

Reports x [8] Close

Reports
View v Format = % Freeze i} Detach Wrap o]
& TR
Description
SALES USAGE TAX - LEASE

Module
ORIGIMATION

Report Parameters

View v Format~ & Freeze i Detach Virap B 48 Run Report
Description Value
COMPANY [ BRANCH ALLJALL A
FROM MM/DD/YYYY 04/17/2017 By
TO MM/DD/YYYY 04/17/2018 F@
REPORT FORMAT PDF A

Customer Service

OFSLL records tax for accounts by posting existing Sales / Use Tax Transaction. These
transactions update Sales / Usage Tax balance.

e Based on setup, if a transaction is eligible for tax calculation, system place a tax request
and update tax details by posting a link transaction. If the parent transaction is reversed
then corresponding child tax transaction will also be reversed.

e In case of “Payoff Quote Lease” transaction, system calculate tax on unpaid Lease
Receivables. OFSLL displays Sales / Usage Tax due bucket by summing current
outstanding and future due.
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Transaction Processing Details
OVERDUE PAYMENTS =USD 15,867.32

LEASE RECEIVABLE =USD 15,266.54

ADVANCE [ PRINCIPAL =USD 0.00

INTEREST =USD 0.00

FEE LATE CHARGE =USD 0.00

FEE NSF =USD 0.00

FEE PHONE PAY =USD 0.00

RENTAL FEE =USD 0.00

FEE PERIODIC MAINTENMANCE =USD 0.00
EXPENSE BANKRUPTCY =USD 0.00

EXPENSE REPOSESSION/FORECLOSURE =USD 0.00
EXPENSE SERVICING =USD 0.00
:SALES / USAGE TAX =USD 1,450.35
FEE DISPOSITION =USD 0.00

FEE EXCESS USAGE =USD 0.00
OTHER. FEE AND TAX =USD 0.00

FEE EARLY TERMINATION =USD 0.00
TERMIMATION =USD 0.00
INVENTORY =USD 0.00

RESIDUAL AMOUNT =USD 5,250.00
PAYOFF QUOTE = USD 32,5584.51
“““““ Transaction Posting Successful

e Any Lease account can request tax exemption based on different tax rules. A new tab is
added in Lease = Customer Service 2 Account Details 2 Tax Details to record tax
exemption details. If the exemption details are provided for account, all the transactions
marked with Exemption Indicator ‘Y’ are exempted for this tax calculation.

Account Details =~ Statements  Rate Schedule = Insurances = Condition Details = Securitization =~ Contract Information | Tax Details

Tax Details El view || < Audit
View v Format~ Freeze A Detach = Wrap (05
Exemption <57 E::E:pﬁun SEarE Exemption End Date Reason Tax Code
N NONE

o |If exemption details are provided in Origination, system will propagate to Customer
Service. To update these details in Customer Service a new Non-Monetary “SALES TAX
EXEMPTION DETAILS MAINTENANCE” is added to update exemption details.

Date Monetary Transaction Status Batch
04/15/2018 N SALES TAX EXEMPTION DETAILS MAINTEMANCE POSTED M
Parameters
View = Format v ﬁ' Freeze ;:j' Detach = Wrap E’[i

Parameter Value Required
TXN DATE 04/15/2018 Y

TAX EXEMPTION INDICATOR Y Y

TAX EXEMPTION REASON CODE TAX EXEMPTED USER M

N
N

TAX MPTION START DATE
TAX EXEMPTION END DATE

Result
View v Format « ﬁ Freeze ﬁ' Detach = Wrap E’[i

Transaction Processing Details
*=*== Transaction Posting Successful ===

e A new document sub type “TAX EXEMPTION PROOF” is added to record exemption
certificate details.
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Summary = Collections  Customer Service = Account Details  Customer Details =~ Customer Preferences  Transaction History ~ Pmt Modes  Bank » ™

€  Promises Checklists =~ Tracking Attributes  Field Investigation =~ References  Correspondence  Letters Document Tracking = Scenario fnz » ™

Documents El view || < Audit
View = Format - ﬁ Freeze |: Detach &=l Wrap E’ﬂ
Document Type Comments
CONTRACT
Account Document Details A Edt || [E] view || < audit
View « Format = % Freeze Detach Wrap Eﬁ View Document
Document Type Document Sub Type Wersion Page # Document File Type Statu
CONTRACT TAX EXEMPTION PROOF 1 1 RECE

e For Lease accounts a new field is added in Lease statements to display tax to be
collected at each bill.

Statements  Transactions = Messages

Statement Details o Audit

View = Format = % Freeze d‘ Detach & Wrap E[i
Current Due{+) PastDue(+) Late Charge{+)  Other Charges{+) Tax Charges(+) Total Due =
7.004.93 12,635.30 0.00 0.00 160.49 15,800.72

Statement Details
{Ga Return

Current Due(+) 7,004.93 Other Charges(+)
PastDue{+) 12,635.30 Tax Charge
Late Charge{+) 0.00 Total Due = 19,800.72

e A new report “SALES USAGE TAX - LEASE” is added in Customer Service to view tax
amount recorded in OFSLL during Servicing. This report is generated for all the accounts
with Tax mode and method as CYCLE/ PAYMENT_STREAM.

Reports x (3] Close
Reports
View ~ Format + .I Freeze Eﬂ' Detach ¢l Wrap E'[i
& T
Description

Module
SERVICING

SALES USAGE TAX - LEASE

Report Parameters

View + Format+ [} Freeze i Detach ol wrap R 48 Run Report
Description Value
COMPANY / BRANCH  ALL/ALL v
ACCOUNT NUMBER ALL
FROM MM/DD/YYYY  04/17/2017 &
TO MM/DD/YYYY 04/17/2018 B
REPORT FORMAT PDF v
Vertex:

The basic different between Vertex and Internal is Sale and Usage Tax calculation happens
externally and on a successfully tax computation, OFSLL will update back tax details. To enable

this integration OFSLL created below modules. For more detail refer to OFSLL technical
documentation.
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o Vertex Adapter: This is used to receive OFSLL interface data and then create Vertex
Specific SOAP Request/Response. Vertex provide “FlexibleFields” to exchange
implementation specific customization data. These fields are mapped to PL/SQL custom
fields in Vertex Adapter and will be left for implementation. This is Vertex specific adapter
and has to be replaced by implementation team to provide support for different Tax
Vendor.

e Common Tax API: Once Vertex Adapter receive response, OFSLL will use Common
Tax API to update Sale and Usage Tax details. This adapter contains exit point and can
be used to update Tax details from External System.

o MDB Interface: To support Vertex interface new message types
[QUOTATION_SERVICE, INVOICE_SERVICE, CREATE_CERTIFICATE_SERVICE,
CUSTOMER_SERVICE] are added and existing error queue [OFSLL_OUTBOUND_Q] is
enhanced to record Vertex interface error messages during the integration.

OFSLL Vertex
Integration

[ I|
' [
' |
' |
' |
' |
! User Interface i I —
' . ., Vertex I = Vertex
I [un =i Java Api Call - -— =
| L I—p Aclapter | _— Interface
: lava Api Call : SOAP
I — |
| - |
: MDB Request—® MDB L |
|
' |
| — Common |
' Tax AP I
' |
' [
' |
' |
: +—Update Tax Details :
| 1] |
| ! }
| — g |
tabase
~ s

Note: During Origination process, all the Vertex interface calls are done through user interface.
On Funding/Customer Service, these call are made from database using MDB flow.

To support this integration OFSLL consumes below Vertex Services. Below are the high-level
overview of these service. For detail documentation please refer Vertex O Series documentation.

e Quotation Request: It is used to estimate the Tax of the proposed Lease Contract. This
service is called by OFSLL to estimate tax during Decision/Contract and Lease Payoff
Quote.

e Invoice Request: Itis used to bill the Tax for the Lease Contract. This service is called
by OFSLL to record tax during Funding and Lease transaction posting.

o Delete Request: Itis used to reverse Vertex Invoice request. Every Vertex Invoice
request trigged from OFSLL use “transactionld” to stamp OFSLL internal transaction
reference. This internal transaction id is used by this service to reverse Vertex Invoice
request based on OFSLL reversal.

e Create Customer Request: It is used to register Customer.
e Create Certificate Request: To upload Tax Exception Certificate Id for Customer.

Below are details changes in OFSLL tax process to support Vertex Interface
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Setup

e Enabled OFSLL infrastructure to support Vertex Integration. Configuration details are
updated in Installation document of release notes.

e To enable Vertex integration, System Parameter “XSL_TAX_INTERFACE” should be
updated as ‘VERTEX and “VTX_OUTBOUND_URL” should be updated with valid Vertex
URL.

e Sales Tax Setup should be added to indicate the transaction/itemizations that should be
passed to Vertex for Tax Calculation.

[ ]

In case of Vertex custom tax definition, range in OFSLL tax setup can be used to provide
to configure tax slabs similar to Internal.

Tax Setup — Origination:

Sales Tax Definition

Fadd | A Edt | 5 view | o Audit
View ~ Format~  [{58 Freeze s Detach Wrap i
& RaH_VERTEX ) B v
Tax Description Start D End Dt Enabled Channel Company Branch Billing Cycle Product Ast
RAH_VERTEX RAHUL VERTEX T 01/01/1900 12/31/4000 ¥ VERTEX AL AL AL AL AL
RAH_VERTEX_STR_ RAHUL VERTEX T 01/01/1900 12/31/4000 ¥ VERTEX AL AL AL AL AUl

Origination = Customer Service = Range

Formula Details

b add || A Edit || B view || o2 audit
view = Format~ [Ep Freeze s Detach Wrap @
Calc Method Itemization Enabled
ITEMIZATION AMOUNT ITM CASH SALES Y

Tax Setup — Customer Service:

Lease

Sales Tax Definition

3 add || A Edt || B view || o Audit
View v Format v [ Freeze i Detach Wrap (5]
é YeRAH_VERTEX_ST EEIB F@ Y
Tax Description Start Dt End Dt Enabled Channel Company Branch Billing Cycle Product Ass
RAH_VERTEX_STR... RAHUL VERTEX T... 01f01/1900 12/31/4000 Y VERTEX ALL ALL ALL ALL ALl

Originatien  Customer Service Range

Formula Details

G add || A Edt || [ view || < Audit
View v Format= [ Freeze o Detach Wrap o)
Txn Code Enabled
BILL/DUE DATE Y
LATE CHARGE

PAYOFF QUOTE LEASE
Origination

and Upload button is disabled.
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Origination Tax calculation process for Internal and Vertex remains the same.

A new button is added in Lease = Origination = Document 2 Document. This button
is used to upload exemption certificate details to Vertex.

On successful upload a Tax Exemption Certificated ID will be recorded in the system
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Summary  Applicant Reguest = Decision Contract Collateral Comments Tracking Document \Verification — Correspondence  Tools
Checklist Document
Application Documents Z Edit || B view || < Audit
View = Format = ﬁ Freeze fj' Detach Wrap @é}
Document Type Comments
CONTRACT
Application Document Details # Edit || B view || « Audit
View = Format = ﬁ Freeze fﬂ' Detach Wrap E}?} View Document Er} Upload
Document Sub Type ersio Page # Document File Type Tracker # Docket # Location Received Dt Efl
TAX EXEMPTION PROOF 1 i | 1
3

Customer Service

Customer Service Tax calculation process for Internal and Vertex mostly remains the
same except the Sales/Usage Tax link transaction posting is done once we receive tax
details from Vertex. This transaction will be posted after posting the main transaction.

A new button is added in Lease = Origination = Document 2 Document. This button
is used to upload exemption certificate details to Vertex.

On successful upload a Tax Exemption Certificated ID will be recorded in the system
and Upload button is disabled.

Summary = Collections Customer Service Account Details = Customer Details =~ Customer Preferences  Transaction History =~ Pmt Modes = Bank » ¥
£  Promises Checklists = Tracking Atiributes = Field Investigation =~ References  Correspondence  Letters  Document Tracking — Scenario Anz > ™
Documents B view || < Audit
View = Format - ﬁ Freeze ;:j' Detach Wrap @ﬂ
Document Type Comments
CONTRACT
Account Document Details A Edit || & view || o Audit
View » Format~ Fresze G Detach Wrap & =] view Document [Z Upload
Document Type Document Sub Type Wersion Page # Document File Type Statu
CONTRACT TAX EXEMPTION PROOF 1 1 RECE
3
Limitations

Use of “TABLE” value for system parameter “XSL_TAX_INTERFACE” is deprecated and
replaced with “INTRENAL” for consistency.

Existing data of SALES_TAX has to be revisited before and after upgrade. This table is
enhanced to support multiple criteria.

Current solution don’t support Sales and Usage Tax calculation for multiple assets as
part of Origination and Customer Servicing.

OFSLL only supports to capture three transactions for Sales and Usage Tax calculation
[BILL/DUE, LATE FEE and PAYOFF QUOTE]. This is not a finite list of transaction.
Based on different implementation specification system can facilitate addition of multiple
transactions. Any requirement of additional transaction should be requested to product
team, based on analysis support will be provided.

Existing use of Setup = Products = Contract 2 Itemizations - Taxable Indicator is
depreciated and can rely on new Lease Origination Sales and Usage Tax Setup.
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As part of current release, OFSLL does not provide support for CASH basis of Sales and
Usage Tax calculation.

When uploading tax Exemptions Certificate to Vertex OFSLL call’s Vertex Create
Customer followed by Create Certificate. Due to any internal error if OFSLL is unable to
complete Vertex Create Certificate request, OFSLL will enter into a dead lock and will try
to call Create Customer followed by Create Certificate which will fail as customer already
exist in Vertex. This has to be operationally handled base on messages in the error
queue.

Care should be taken to disable “Calculate Tax” tax button in Decision for Stream based
Lease application.

Vertex use Imposition codes to identify multiple tax rules that can be levied on
application/account. OFSLL records all the tax details into single itemization/transaction
amount. Split of tax details should be gathered outside the system using Vertex
‘transactionld’ stored in SALES_USAGE_TAX_DETAILS [SUD_ID].

Adjustment, Void, Charge off and Wave of tax balance based on parent transaction has
to be handled manually.

For manual transactions posted from User Interface/Web Service that are requesting for
Vertex Tax update, a delay of 30 seconds is introduced to get response from Vertex. If
response is received in the due time, transaction will be posted with Vertex tax data else
transaction will be marked as Error and user is requested to repost the transaction based
on Vertex interface availability.

In current release, we are unable to support retriggering of failed transaction during
Vertex integration. Support will be added in future.

Vertex Address cleansing is currently out of scope of this release. Address cleansing
adapter has to be written to interact with Vertex and get source and destination address
updated before using based OFSLL-Vertex integration.

Sale and Usage Tax is not part of Bill/Due amount. Care should be taken to disable billed
indicator Setup =2 Products 2 Contract 2Lease.

Balances Amortized Balances ~ Itemizations = Fees

Contract Balances A Edit | [E]view | « audit

View = Format~  Ep Freeze i Detach

Balance Type Chargeoff Method
EXPENSE BANKRUP... CHGOFF BALANCE
EXPEMSE REPOSES... CHGOFF BALANCE
EXPENSE SERVICING CHGOFF BALANCE
CHGOFF BALANCE
FEE DISPOSITION CHGOFF BALANCE
FEE EXCESS USAGE  CHGOFF BALANCE
OTHER FEE AND TAX CHGOFF BALANCE
FEE EARLY TERMIN .. CHGOFF BALANCE

TEDMTMATTAN FUCAEE BALANCE

Writeoff Method

WALV

y
y
y
y
y
y
W

Reschedule Method

ROLLOVER BALANCE
ROLLOVER BALANCE
ROLLOVER BALANCE
ROLLOVER BALANCE
ROLLOVER BALANCE
ROLLOVER BALANCE
ROLLOVER BALANCE
ROLLOVER BALANCE

DAIIAVED RAT ARICE

Wrap EE} ‘:ﬂ- Load Balances

Sort

401
402
403
620
640
650
660
670
ann

Billed

N
N

N
N
N
N
N
N

n

Accrued

N
N

N
N
M
M
N
N

n

Non Performing Non Performing

Rollover
N

N
I
M
M
N
N
u

Balance Type
NONE
NONE
NONE
NONE
NONE
NONE
NONE
NONE
nANE

€ € < <M

e Currently Vertex tax data is not getting updated in Lease 2 Customer Service 2
Account Details = Statements [Tax Charges (+)]. This bug will be fixed in future

release.

e Tax calculation support for APl and Account On-boarding will be added in subsequent

patch release.
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2.12 RESTful Web Services

Overview

In this release, OFSLL RESTful Web Services have been enhanced as follows:

e Support for Swagger documentation

o New Web Services have been added

e Changes/Modifications to existing Web Services
e URL restricting to existing Web Services

Description

Swagger

Swagger is an open source tool based on OpenAPI (https://www.openapis.org) standards that is
used for documenting RESTful APIs. The goal of Swagger is to define a standard, language-
agnostic interface to REST APIs which allows both humans and computers to discover and
understand the capabilities of the service without access to source code, documentation, or
through network traffic inspection.

Existing OFSLL RESTful documentation is upgraded to Swagger 2.0 documentation. OFSLL
Swagger documentation can be accessed in two ways:
Online

o Swagger documentation for OFSLL services are shipped with the OFSLL Web Service
ear file.

e Below are the steps to access swagger documentation:
> Navigate to Swagger Ul page http://<host>:<port>/<deployment context>/

> This page displays all the OFSLL RESTful Web Services hosted as part of current
release.

OFSLL Rest API Collection “***

Terms of service

Oracle license 2017-18

Account Boarding Service ~

m JaccountBoarding/executelLoanApplication Account Creation service
Account Comment Service ™

m Jservicing/account/comments Account Comments posting service

ﬂ /servicing/account/{number}/comments Fetch Multiple Account Comments

e On click of individual service, Swagger provides details like RESTful Service description,
Sample Request/Response for json and xml, Data model, Element description and HTTP
error codes.
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https://www.openapis.org/

Business comments service

Bl

Post Business comments details

|Th\s sel

ice is used to post Customer Credit Limit >Business >Comments I

Parameters
Name Description
body * reauired Post Business Comments request
(Body) Note : Start below JSON example with node
"BusinessCommentsRequest":
and end with
}
serCode”: "USR123"
usinessComments": [
"Businesshumber”: 8808001001,
1,
"Humber Data" z
KeyName": "BusinessPhoneNumber™ ,
KeyValue™: 1234.81
1
Dateata: [
KeyName": "CreationDaten,
KeyValuem: "2017-12-18T60:08:60"
Responses
Code Description

Business comments posted successtully
Note : Start below JSON example with node
i

"BusinessCommentsResponse™s

and end with
7

Example Value | Model

Bus inessComments™: [

usinessNumber™:
omments’

"Comment": "Comment from the user",
"CommentedBy": "USR123",
"CommentedDate": "2017-12-18T68:
"Custom"z {
tringhata’
{
"KeyName
"KeyValue"
1

1,
"NumberData" :
"KeyName": "BusinessPhoneNumber",
"KeyValue": 1234.81
T

1,
"DateDatar: [

"KeyName": "CreationDate",
"KeyValue": "2017-12-18T60:09:00'

s": "Comments Successfully Posted/Quer

"Resultm: {
"Status": "SUCCESS",
"StatusDetails": "Comments Successfully Posted/Queried"

Bad Request
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Note: A root element should be added to all the JISON Request/Response sample. The root
element details are different for each service and are added as part of Note for Request and
Description as part of Response.

Request
body * "9 red Post Business Comments request
(Body) Note : Start below |]SON example with node
{
"BusinessCommentsRequest™:
and end with
}
Response
201 .
Business comments posted successTully
Note : Start below JSON example with node
{
"BusinessCommentsResponse™:
and end with
}
Offline

o Download swagger.json file from here.

o Use online editor[apiary/swagger] to generate documentation
>  https://app.apiary.io/<regestration id>/editor
>  https://editor.swagger.io/

Note: These editors usually accept yaml as an input but can convert json to yaml at
runtime.

RESTful Web Service

OFSLL 14.5.0.0.0 Release Web Service enhancements are categorized as follows. The
specification and element descriptions of these services are specified in the corresponding
Swagger documentation.
o New Web Services: These are the new web services introduced in the current release.
» Transaction Parameters Service
» Customer Account Preference Service
» Customer Document Service
» Business Document Service
» Customer Comments Service
> Business Comments Service
>  Customer Credit Limit Service
> Business Credit Limit Service

e Record Type Changes: No change in the request/response, however changes have
been made in underlying PL/SQL customization record types

> Application Comments
> Account Comments

o Update of Existing Services: Following existing request/response and underlying
PL/SQL customization record types have been updated.

2-145 ORACLE

Financial Services


https://mosemp.us.oracle.com/epmos/main/downloadattachmentprocessor?parent=DOCUMENT&sourceId=2389831.1&attachid=2389831.1:JSON_FILE&clickstream=no
https://editor.swagger.io/

> Application Entry

> Application Search

> Application Document Service
» Account Document Service

> Account Detail

> Account Search Service
> Account On-Boarding

Note: Scenario Analysis and Calculator Services yet to be certified with all the business
scenarios of Lease. There are known bugs in these services and will be addressed in the sub

sequent release patch sets.

e URL Restructuring: URL'’s of below services have been restructured to sync with

OFSLL modules.

> Application Search
> Scenario Analysis

> Calculator

> Account Search
> Account Details

> Call Activity

> Payment Posting
> Dialer Integration

> Scheduler

> Generic Post Transaction
» Account On-boarding

> Invoice
> Remarketing

Service Method | Old URL New URL

Name

Application GET application-search/get- origination/applications/?applicati

Search application- onnumber=?&applicantfirstname=
info/?applicationNumber=?& | ?&applicantlastname=?&applicant
applicantFirstName=?&appli | birthdate=?&applicationcreationd
cantLastName=?&applicant | ate=?&ssn=?&producernumber="?
BirthDate=?&applicationCre | &customernumber=?
ationDate=?&SSN=?&produ
cerNumber=?&customernum
ber=?

Scenario GET scenarioanalysis?inquiryid=? | origination/scenarioanalysis/inquir

Analysis ? yid/{inquiryid}

Scenario POST scenarioanalysis origination/scenarioanalysis/

Analysis

Scenario PUT Scenarioanalysis origination/scenarioanalysis/appli

Analysis cation/inquiryid/{inquiryid}

Calculator POST calculator/do-calculation origination/calcaulator/
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Service Method | Old URL New URL

Name

Account GET account/get-account- servicing/accounts/?accountnumb

Search info?accountNbr=?&custFna | er=?&custfirstname=?&custlastna
me=?&custLname=?&Aseld | me=?&aseidnumber=?&custphon
entificationNbr=?&custPhon | enumber=?&custbirthdate=?&ssn
eNumber=?&custBirthDate= | =?&custnumber="?
?&SSN=?&customernumber
=?

Account GET accountdetail/get-account- servicing/account/{number}

Details detail-info?accountNbr="?

Call Activity | POST call-activity/post-call-activity | servicing/callactivity/

Payment POST paymentpost/payment-post servicing/payment/

Posting

Dialer POST dialerintegration/dialerintegr | servicing/dialerintegration

Integration atorService

Scheduler POST scheduler/executeJobSet setup/scheduler/jobsubmit/

Scheduler PUT scheduler/forceresubmit setup/scheduler/jobforcesubmit/

Generic POST generic-post- servicing/transaction/

Post transaction/post-transaction

Transaction

Account On- | POST accountBoarding/executeLo | servicing/account/

boarding anApplication

Invoice GET Invoice?invoiceNbr=?invoice | servicing/invoice?invoicenumber=
XrefNbr=? ?invoicexrefnumber="?

Invoice POST Invoice servicing/invoice

Remarketing | GET Remarketing?remarketingNb | servicing/remarketing?remarketin
r=?remarketingXrefNbr=?ac | gnumber=?remarketingxrefnumbe
countNbr=?status=?lastUpd | r=?accountnumber=?status=2?last
atedDate=7statusDate=? updateddate=?statusdate="

Remarketing | POST Remarketing servicing/remarketing

2.13 Appendix — Seed Data chanqges

Sample Data

SI. No | TABLE KEY DATA TYPE
1 PRODUCTS LEASE-RF INSERT
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SI. No | TABLE KEY DATA TYPE

LEASE-IR
CR-139
2 PRODUCT_INSTRUMENTS INSERT
CR-140
PRC-13
3 PRODUCT_PRICINGS INSERT

LEASE_PRICING_INTEREST

LS-CE-001

4 PROMOTIONS LS-CE-VR-001 INSERT
LS-CE-PC

5 PRODUCT_INSURANCES LS-CE-VR-INS-001 INSERT

LS-CE-FR-INS-002

CMP-LS-01
CMP-LS-02
6 COMMISSION_PLANS INSERT
CMP-LS-VR-01
CMP-LS-VR-02
Access Grid
Sl. No | TABLE KEY DATA TYPE
SECURITY_DEP_ADJUST|ACC_CONDITION_CDJ|AL
1 L
SECURITY_DEP_ADJUST|ACC_STATUS CD|ALL
SECURITY_DEP_ADJUST_REV|ACC_CONDITION_C
D|ALL
ACCESS_G ELECURITY_DEP_ADJUST_REV|ACC_STATUS_CD|A
RID_FUNCT INSERT
IONS

LS_CHANGE_PMT_AMT|ACC_CONDITION_CDJALL

LS_CHANGE_PMT_AMT|ACC_STATUS_CD|ALL

LS_CHANGE_PMT_AMT_REV|ACC_CONDITION_CD
|ALL

LS_CHANGE_PMT_AMT_REV|ACC_STATUS_CDIAL
L
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Sl. No | TABLE KEY DATA TYPE
LS _EXTENSION|JACC_CONDITION_CDJ|ALL
LS _EXTENSION|ACC_STATUS CD|ALL
LS _EXTENSION_REV|ACC_CONDITION_CDJALL
LS _EXTENSION_REV|ACC_STATUS CDJ|ALL
Usage Charge Details
Sl. No | TABLE KEY DATA TYPE
TXN_CODE
1 S ASSET_CHANGE_USAGE INSERT
ASSET_CHANGE_USAGE|TNM_ASE_USAGE_TOTA
2 L INSERT
ASSET_CHANGE_USAGE|TNM_ASE_USAGE_CHA
RGE INSERT
ASSET_CHANGE_USAGE|TNM_ASE_EXCESS_USA
GE_FEE INSERT
TXN_CODE | FUSG_ADJ_PLUS|TXN_DT INSERT
_PARAMET
ERS FUSG_ADJ_PLUS|TXN_AMT INSERT
3 INP_BMP_TNM|TNM_ASE_USAGE_TOTAL INSERT
FLEX_TABL | INP_BMP_TNM|TNM_ASE_USAGE_CHARGE INSERT
E_ATTRIBU
TES INP_BMP_TNM|TNM_ASE_EXCESS_USAGE_FEE INSERT
TXN_CODE
_PRODUCT
4 S ASSET_CHANGE_USAGE|ALL|LS|CE INSERT
Rate Change
SINo | TABLE KEY DATA TYPE
TXN_CODE | RATE_CHANGEJALL|ALL|CE
_PRODUCT UPDATE
1 S RATE_CHANGE_REVI|ALL|ALL|CE
SYS|SYS|SYS|TXN|002006| TRANSACTIONISNOTAL
TRANSLATI | LOWEDFORRENTFACTORBASEDLEASE.|SYS|MSG
2 ON_DATA -SE INSERT
Security Deposit
SI No | TABLE KEY DATA TYPE
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SECURITY_DEP_ADJUST
TXN_CODE INSERT
1 S SECURITY_DEP_ADJUST _REV
SECURITY_DEP_ADJUST|TXN_DT
TXN_CODE | SECURITY_DEP_ADJUST|TXN_AMT INSERT
_PARAMET
2 ERS SECURITY_DEP_ADJUST|TXN_COMMENT
TXN_CODE | SECURITY_DEP_ADJUST|ALL|LS|CE
3 _PRODUCT INSERT
S SECURITY_DEP_ADJUST REV|ALL|LS|CE
TRANSLATI | SYS|SYS|SYS|TXN|002007|INSUFFICIENTSECURIT
4 ON_DATA YDEPOSITAMOUNTTOADJUST.|SYS|MSG-SE INSERT
Miscellaneous
SINo | TABLE KEY DATA TYPE
TRANSLATI | SYS|SYS|SYS|TXN|002008|MINIMUMCRITERIAFOR
1 ON_DATA EARLYTERMINATIONISNOTMET.|SYS|MSG-SE INSERT
INT|ALL|LS|ALL
INT_ADJ_MINUS|ALL|LS|ALL
INT_ADJ_MINUS_REVI|ALL|LS|ALL
INT_ADJ_PLUSIALL|LS|ALL
INT_ADJ_PLUS_REVIALL|LS|ALL
INT_BILL|ALL|LS|ALL
INT_BILL_REV|ALL|LS|JALL
XN CoDE | 'NT_CHGOFFIALLILS|ALL
2 PRODUCTS INSERT
INT_CHGOFF_REV|ALL|LS|ALL
INT_ESTIMATEDIALL|LS|ALL
INT_ESTIMATED_REV|ALL|LS|ALL
INT_REBATE|ALL|LS|ALL
INT_REBATE_REV|ALL|LS|ALL
INT_REV|ALL|LS|ALL
INT_WAIVE|ALL|LS|ALL
INT_WAIVE_REV|ALL|LS|ALL
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SINo | TABLE KEY DATA TYPE

CNLSCE_ACX_EDIT_01|]XVL_CON_TOTAL_OF_PMT
S _EST

CNLSCE_ACX_EDIT_01|]XVL_CON_TOTAL_PMTS_D
EP_RENT

CNLSCE_ACX_EDIT_01|]XVL_CON_TOTAL_PMTS_T
ERM_PMT

CNLSCE_ACX_EDIT_01|JMAX_CON_BALLOON_AMT

CNLSCE_ACX_EDIT_01|MAX_CON_FINANCE_CHA
RGE

CNLSCE_ACX_EDIT_01|MAX_CON_MRATE

CNLSCE_ACX_EDIT_01|MAX_REPAYMENT_SKIP_P
ERIOD

CNLSCE_ACX_EDIT_01|MIN_CON_BALLOON_AMT

CNLSCE_ACX_EDIT_01|MIN_CON_FINANCE_CHAR
GE

CNLSCE_ACX_EDIT_01|MIN_CON_MRATE

EDIT_DETAI
LS CNLSCE_ACX_EDIT_01|MIN_REPAYMENT_SKIP_P
ERIOD

INSERT

CNLSCE_ACX_EDIT_01|REQ_REPAYMENT_SCHED
ULE

CNLSCE_ACX_EDIT_01|REQ_REPAYMENT_TYPE_
CD

CNLSCE_ACX_EDIT_01|XVL_CON_ACD_ADVANCE
_AIT

CNLSCE_ACX_EDIT_01|XVL_CON_BALLOON_FINA
L_PMT

CNLSCE_ACX_EDIT_01|XVL_CON_BILL_MTHD_FP_
REPAYMENT

CNLSCE_ACX_EDIT_01|XVL_CON_FINANCE_CHAR
GE_TOL

CNLSCE_ACX_EDIT_01|XVL_CON_INDEX_ADC

CNLSCE_ACX_EDIT_01|XVL_CON_INDEX_PRP

CNLSCE_ACX_EDIT_01|]XVL_CON_MRATE_ADC
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SINo | TABLE KEY DATA TYPE

CNLSCE_ACX_EDIT_01|XVL_CON_RATE_ADC

CNLSCE_ACX_EDIT_01|XVL_CON_RATE_IRATE_M
RATE

CNLSCE_ACX_EDIT_01|XVL_CON_SKIP_MTH_MAT
URITY_MTH

CNLSCE_ACX_EDIT_01|JMIN_CON_RESIDUAL_VAL

CNLSCE_ACX_EDIT_01|JMAX_CON_RESIDUAL_VAL

CNLSCE_ACX_EDIT_01|]XVL_CON_TOTAL_PMTS_T
ERM_PMT

CNLSCE_ACX_EDIT_01|]XVL_CON_TOTAL_OF_PMT
S EST

CNLSCE_ACX_EDIT_01|XVL_CON_TOTAL_PMTS_D
EP_RENT

CNLSCE_ACX_EDIT_01|XVL_CON_TERM_ASE_EST
M_LIFE

CNLSCE_ACX_EDIT_01|XVL_CON_PREPAID_AMT _
ACD

CNLNCE_ACX_EDIT_01|CHD_CR_LMT_MAT_DT_P
RIM

CNLSCE_ACX_EDIT_01|CHD_CR_LMT_MAT DT _P
RIM

CNLNOE_ACX_EDIT_01|CHD_CR_LMT_MAT_DT_P
RIM

CNLNCE_ACX_EDIT_01|XVL_CR_LMT_UTL_AMT_P
RIM

CNLSCE_ACX_EDIT_01|XVL_CR_LMT_UTL_AMT_P
RIM

CNLNOE_ACX_EDIT_01|XVL_CR_LMT_UTL_AMT_P
RIM

CNLNCE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_P
RIM

CNLSCE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_PR
IM

CNLNOE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_P
RIM
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SINo | TABLE KEY DATA TYPE
CNLNCE_ACX_EDIT_01|XVL_CR_LMT_TOTAL_UTIL
_AMT
CNLSCE_ACX_EDIT_01|XVL_CR_LMT_TOTAL_UTIL
_AMT
CNLNOE_ACX_EDIT_01|XVL_CR_LMT_TOTAL_UTIL
_AMT
CNLNCE_ACX_EDIT_01|XVL_CON_SAME_DUE_DA
Y CYCLE
CNLSCE_ACX_EDIT_01|XVL_CON_SAME_DUE_DA
Y _CYCLE
CNLNOE_ACX_EDIT_01|XVL_CON_SAME_DUE_DA
Y _CYCLE
CNLNCE_ACX_EDIT_01|CHD_CR_LMT_MAT_DT_2
NDRY
CNLSCE_ACX_EDIT_01|CHD_CR_LMT_MAT_DT_2N
DRY
CNLNOE_ACX_EDIT_01|CHD_CR_LMT_MAT DT 2
NDRY
CNLNCE_ACX_EDIT_01|CHD_CR_LMT_MAT_DT_S
POUSE
CNLSCE_ACX_EDIT_01|CHD_CR_LMT_MAT _DT_S
POUSE
CNLNOE_ACX_EDIT_01|CHD_CR_LMT_MAT _DT_S
POUSE
CNLNCE_ACX_EDIT_01|CHD_CR_LMT_MAT_DT_C
0S
CNLSCE_ACX_EDIT_01|CHD_CR_LMT_MAT DT _C
0S
CNLNOE_ACX_EDIT_01|CHD_CR_LMT_MAT DT_C
0S
CNLNCE_ACX_EDIT_01|CHD_CR_LMT_MAT_DT_S
POUSE_COS1
CNLSCE_ACX_EDIT_01|CHD_CR_LMT_MAT_DT_S
POUSE_COS1
CNLNOE_ACX_EDIT_01|CHD_CR_LMT_MAT_DT_S
POUSE_COS1
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SINo | TABLE KEY DATA TYPE

CNLNCE_ACX_EDIT_01|CHD_CR_LMT_MAT_DT_C
0S2

CNLSCE_ACX_EDIT_01|CHD_CR_LMT_MAT_DT_C
0S2

CNLNOE_ACX_EDIT_01|CHD_CR_LMT_MAT_DT_C
0S2

CNLNCE_ACX_EDIT_01|CHD_CR_LMT_MAT_DT_S
POUSE_COS?2

CNLSCE_ACX_EDIT_01|CHD_CR_LMT_MAT DT_S
POUSE_COS2

CNLNOE_ACX_EDIT_01|CHD_CR_LMT_MAT DT_S
POUSE_COS2

CNLNCE_ACX_EDIT_01|CHD_CR_LMT_MAT_DT B
us

CNLSCE_ACX_EDIT_01|CHD_CR_LMT_MAT DT B
us

CNLNOE_ACX_EDIT_01|CHD_CR_LMT_MAT DT _B
us

CNLNCE_ACX_EDIT_01|XVL_CR_LMT _UTL_AMT_S
POUSE

CNLSCE_ACX_EDIT_01|]XVL_CR_LMT_UTL_AMT_S
POUSE

CNLNOE_ACX_EDIT_01|XVL_CR_LMT_UTL_AMT_S
POUSE

CNLNCE_ACX_EDIT_01|XVL_CR_LMT_UTL_AMT_2
NDRY

CNLSCE_ACX_EDIT_01]XVL_CR_LMT_UTL_AMT_2
NDRY

CNLNOE_ACX_EDIT_01|XVL_CR_LMT_UTL_AMT_2
NDRY

CNLNCE_ACX_EDIT_01|XVL_CR_LMT_UTL_AMT_C
oS

CNLSCE_ACX_EDIT_01|XVL_CR_LMT_UTL_AMT_C
oS

CNLNOE_ACX_EDIT_01|XVL_CR_LMT_UTL_AMT_C
oS
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SINo | TABLE KEY DATA TYPE

CNLNCE_ACX_EDIT_01]XVL_CR_LMT_UTL_AMT_S
POUSE_COS1

CNLSCE_ACX_EDIT_01|]XVL_CR_LMT_UTL_AMT_S
POUSE_COS1

CNLNOE_ACX_EDIT_01|XVL_CR_LMT_UTL_AMT_S
POUSE_COS1

CNLNCE_ACX_EDIT_01|XVL_CR_LMT_UTL_AMT_C
0S2

CNLSCE_ACX_EDIT_01|XVL_CR_LMT_UTL_AMT_C
0S2

CNLNOE_ACX_EDIT_01]XVL_CR_LMT_UTL_AMT_C
0S2

CNLNCE_ACX_EDIT_01|XVL_CR_LMT_UTL_AMT_S
POUSE_COS2

CNLSCE_ACX_EDIT_01]XVL_CR_LMT_UTL_AMT_S
POUSE_COS2

CNLNOE_ACX_EDIT_01|XVL_CR_LMT_UTL_AMT_S
POUSE_COS2

CNLNCE_ACX_EDIT_01|XVL_CR_LMT_UTL_AMT_B
us

CNLSCE_ACX_EDIT_01|XVL_CR_LMT_UTL_AMT_B
uUsS

CNLNOE_ACX_EDIT_01|XVL_CR_LMT_UTL_AMT_B
uUsS

CNLNCE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_SP
OUSE

CNLSCE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_SP
OUSE

CNLNOE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_S
POUSE

CNLNCE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_2N
DRY

CNLSCE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_2N
DRY

CNLNOE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_2N
DRY
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SINo | TABLE KEY DATA TYPE

CNLNCE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_C
oS

CNLSCE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_C
oS

CNLNOE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_C
oS

CNLNCE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_SP
OUSE_COS1

CNLSCE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_SP
OUSE_COS1

CNLNOE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_S
POUSE_COS1

CNLNCE_ACX_EDIT_01|CHD_CR_LMT_EXP DT _C
0S2

CNLSCE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_C
0S2

CNLNOE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT _C
0S2

CNLNCE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_SP
OUSE_COS2

CNLSCE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_SP
OUSE_COS2

CNLNOE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_S
POUSE_COS2

CNLNCE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_B
us

CNLSCE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_BU
S

CNLNOE_ACX_EDIT_01|CHD_CR_LMT_EXP_DT_B
us

CNLNCE_ACX_EDIT_01|XVL_CR_LMT_TOTAL_UTIL
_AMT

CNLSCE_ACX_EDIT_01]XVL_CR_LMT_TOTAL_UTIL
_AMT

CNLNOE_ACX_EDIT_01|XVL_CR_LMT_TOTAL_UTIL
_AMT

2-156 ORACLE

Financial Services



SI No | TABLE KEY DATA TYPE
CNLSCE_ACX_EDIT_01|XVL_CON_TOTAL_PMTS_TERM_
PMT]|0.99
CNLSCE_ACX_EDIT_01|XVL_CON_TOTAL_OF_PMTS_ES
T|0.99
CNLSCE_ACX_EDIT_01|XVL_CON_TOTAL_PMTS_DEP_R
ENT|0.99
Lease Extension
SINo | TABLE KEY DATA TYPE
LS _EXTENSION
1 EXN—CODE INSERT
LS_EXTENSION_REV
LS _EXTENSION|TXN_EXTN_DT
TXN_CODE LS _EXTENSION|TXN_EXTN_TERM
2 _PARAMET INSERT
ERS LS_EXTENSION|TXN_RESIDUAL_PER
LS_EXTENSION|TXN_COMMENT
TXN_CODE | LS_EXTENSIONI|ALL|LS|CE
3 _PRODUCT INSERT
S LS_EXTENSION_REV|ALL|LS|CE
SYS|SYS|SYS|TXN|002009|EXTENSIONNOTALLOW
ED,ASRESIDUALVALUEALREADYINCLUDEDINFINA
LBILL.|SYS|MSG-SE
SYS|SYS|SYS|TXN|002010|EXTENSIONREQUESTE
DISBEYONDAVAILABLELIFEOFASSET.|SYS|MSG-
SE
SYS|SYS|SYS|TXN|002011|EXTENSIONPERIODREQ
UESTEDISBEYONDTHEDEFINEDLIMIT.|SYS|MSG-
SE
4 -gRNAgi.LI.ﬁ‘TI SYS|SYS|SYS|TXN|002013|BILLISGENERATEDAFTE | INSERT
- REXTENSION,REVERSENOTALLOWED.|SYS|MSG-
SE
SYS|SYS|SYS|TXN|002015|EXISTINGDETAILS:MAT
URITYDATE=~OLD_MATURITY_DATE~TERM=~0OLD
_TERM~RESIDUAL%=~OLD_RESIDUAL_PER~NEW
DETAILS:MATURITYDATE:~NEW_MATURITY_DATE
~TERM=~NEW_TERM~RESIDUAL%=~NEW_RESID
UAL_PER~|SYS|MSG-SE
SYS|SYS|SYS|TXN|002012|MAXIMUMEXTENSIONS
ALLOWEDAREALREADYMET.|[SYS|MSG-SE
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SINo | TABLE KEY DATA TYPE

SYS|SYS|SYS|TXN|002024|LEASEEXTENSIONISAL
LOWEDONLYFORACTIVEACCOUNTS.|SYS|MSG-SE

SYS|SYS|SYS|TXN|002019|EXTENSIONISALLOWED
TOPOSTONORAFTERMATURITYDATE.|SYS|MSG-
SE

SYS|SYS|SYS|TXN|002027|EXTENSIONPERIODREQ
UESTEDISBEYONDTHEDEFINEDLIMITINCONTRAC
T.|SYS|MSG-SE

SYS|SYS|SYS|TXN|002025|EXTENSIONISNOTALLO
WEDASTHERESIDUALVALUEISALREADYINCLUDE
DINFINALBILL.|SYS|MSG-SE

SYS|SYS|SYS|TXN|002027|EXTENSIONISNOTALLO
WEDASTHERESIDUALVALUEISZERO.|SYS|MSG-SE

INP_BMP_TXN|TXN_RESIDUAL_PER

INP_BMP_TXN|TXN_EXTN_DT

CNB_CON_LOAN|CHD_CR_LMT_MAT_DT_PRIM

CNB_CON_LEASE|CHD_CR_LMT_MAT_DT_PRIM

CNB_CON_LOC|CHD_CR_LMT_MAT_DT_PRIM

CNB_CON_LOAN|XVL_CR_LMT_UTL_AMT_PRIM

CNB_CON_LEASE|XVL_CR_LMT_UTL_AMT_PRIM

CNB_CON_LOC|XVL_CR_LMT_UTL_AMT_PRIM

FLEX_TABL
5 E_ATTRIBU
TES

CNB_CON_LOAN|CHD_CR_LMT_EXP_DT_PRIM INSERT

CNB_CON_LEASE|CHD_CR_LMT_EXP_DT_PRIM

CNB_CON_LOC|CHD_CR_LMT_EXP_DT_PRIM

CNB_CON_LOAN|XVL_CON_SAME_DUE_DAY_CYC
LE

CNB_CON_LEASE|XVL_CON_SAME_DUE_DAY_CY
CLE

CNB_CON_LOC|XVL_CON_SAME_DUE_DAY_CYCL
E

CNB_CON_LOAN|CHD_CR_LMT_MAT_DT_2NDRY

CNB_CON_LEASE|CHD_CR_LMT_MAT_DT_2NDRY
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SINo | TABLE KEY DATA TYPE

CNB_CON_LOC|CHD_CR_LMT_MAT_DT_2NDRY

CNB_CON_LOAN|CHD_CR_LMT_MAT_DT_SPOUSE

CNB_CON_LEASE|CHD_CR_LMT_MAT_DT_SPOUS
E

CNB_CON_LOC|CHD_CR_LMT_MAT_DT_SPOUSE

CNB_CON_LOAN|CHD_CR_LMT_MAT_DT_COS

CNB_CON_LEASE|CHD_CR_LMT_MAT_DT_COS

CNB_CON_LOC|CHD_CR_LMT_MAT_DT_COS

CNB_CON_LOAN|CHD_CR_LMT_MAT_DT_SPOUSE
_COS1

CNB_CON_LEASE|CHD_CR_LMT_MAT_DT_SPOUS
E_COS1

CNB_CON_LOC|CHD_CR_LMT_MAT_DT_SPOUSE_
cos1

CNB_CON_LOAN|CHD_CR_LMT_MAT_DT_COS2

CNB_CON_LEASE|CHD_CR_LMT_MAT_DT_COS2

CNB_CON_LOC|CHD_CR_LMT_MAT_DT_COS2

CNB_CON_LOAN|CHD_CR_LMT_MAT_DT_SPOUSE
_COS2

CNB_CON_LEASE|CHD_CR_LMT_MAT_DT_SPOUS
E_COS2

CNB_CON_LOC|CHD_CR_LMT_MAT_DT_SPOUSE_
COS2

CNB_CON_LOAN|CHD_CR_LMT_MAT_DT_BUS

CNB_CON_LEASE|CHD_CR_LMT_MAT_DT_BUS

CNB_CON_LOC|CHD_CR_LMT_MAT_DT_BUS

CNB_CON_LOAN|XVL_CR_LMT_UTL_AMT_SPOUS
E

CNB_CON_LEASE|XVL_CR_LMT_UTL_AMT_SPOUS
E

CNB_CON_LOC|XVL_CR_LMT_UTL_AMT_SPOUSE
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SINo | TABLE KEY DATA TYPE

CNB_CON_LOAN|XVL_CR_LMT_UTL_AMT_2NDRY

CNB_CON_LEASE|XVL_CR_LMT_UTL_AMT_2NDRY

CNB_CON_LOC|XVL_CR_LMT_UTL_AMT_2NDRY

CNB_CON_LOAN|XVL_CR_LMT_UTL_AMT_COS

CNB_CON_LEASE|XVL_CR_LMT_UTL_AMT_COS

CNB_CON_LOC|XVL_CR_LMT_UTL_AMT_COS

CNB_CON_LOAN|XVL_CR_LMT_UTL_AMT_SPOUS
E_COS1

CNB_CON_LEASE|XVL_CR_LMT_UTL_AMT_SPOUS
E_COS1

CNB_CON_LOC|XVL_CR_LMT_UTL_AMT_SPOUSE
_COS1

CNB_CON_LOAN|XVL_CR_LMT_UTL_AMT_COS2

CNB_CON_LEASE|XVL_CR_LMT_UTL_AMT_COS2

CNB_CON_LOC|XVL_CR_LMT_UTL_AMT_COS?2

CNB_CON_LOAN|XVL_CR_LMT_UTL_AMT_SPOUS
E_COS2

CNB_CON_LEASE|XVL_CR_LMT_UTL_AMT_SPOUS
E_COS2

CNB_CON_LOC|XVL_CR_LMT_UTL_AMT_SPOUSE
_COS2

CNB_CON_LOAN|XVL_CR_LMT_UTL_AMT_BUS

CNB_CON_LEASE|XVL_CR_LMT_UTL_AMT_BUS

CNB_CON_LOC|XVL_CR_LMT_UTL_AMT_BUS

CNB_CON_LOAN|CHD_CR_LMT_EXP_DT_2NDRY

CNB_CON_LEASE|CHD_CR_LMT_EXP_DT_2NDRY

CNB_CON_LOC|CHD_CR_LMT_EXP_DT_2NDRY

CNB_CON_LOAN|CHD_CR_LMT_EXP_DT_SPOUSE

CNB_CON_LEASE|CHD_CR_LMT_EXP_DT_SPOUS
E
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S| No

TABLE

KEY DATA

TYPE

CNB_CON_LOC|CHD_CR_LMT_EXP_DT_SPOUSE

CNB_CON_LOAN|CHD_CR_LMT_EXP_DT_COS

CNB_CON_LEASE|CHD_CR_LMT_EXP_DT_COS

CNB_CON_LOC|CHD_CR_LMT_EXP_DT_COS

CNB_CON_LOAN|CHD_CR_LMT_EXP_DT_SPOUSE
_COS1

CNB_CON_LEASE|CHD_CR_LMT_EXP_DT_SPOUS
E_COS1

CNB_CON_LOC|CHD_CR_LMT_EXP_DT_SPOUSE_
cos1

CNB_CON_LOAN|CHD_CR_LMT_EXP_DT_COS2

CNB_CON_LEASE|CHD_CR_LMT_EXP_DT_COS2

CNB_CON_LOC|CHD_CR_LMT_EX+E19:F71P_DT_
COS2

CNB_DEC_LEASE|XVL_ADC_DOWN_AMT_APP_DO
WN_AMT

Change Payment

S| No

TABLE

KEY DATA

TYPE

TXN_CODE
S

LS_CHANGE_PMT_AMT

LS_CHANGE_PMT_AMT_REV

INSERT

TXN_CODE
_PARAMET
ERS

LS_CHANGE_PMT_AMT|TXN_DT

LS_CHANGE_PMT_AMT|TXN_PMT_AMT

LS_CHANGE_PMT_AMT|TXN_AUTO_COMPUTE_PM
T_IND

LS_CHANGE_PMT_AMT|TXN_BALLOON_PMT_AMT

INSERT

TXN_CODE
_PRODUCT
S

LS _CHANGE_PMT_AMT|ALL|LS|CE

LS_CHANGE_PMT_AMT_REV|ALL|LS|CE

INSERT

TRANSLAT]
ON_DATA

SYS|SYS|SYS|TXN|002014|BALLOONAMOUNTSHOU
LDBEZEROFOROVERRIDEPAYMENTCHANGE|SYS|
MSG-SE

INSERT
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SYS|SYS|SYS|TXN|002020|PAYMENTAMOUNTCANN
OTBEZEROFORAUTOCOMPUTEINDICATORNO.|SY
S|MSG-SE

SYS|SYS|SYS|TXN|002025|CHANGEPAYMENTNOTA
LLOWEDASACCOUNTREACHEDFINALBILL.|[SYS|MS
G-SE

SYS|SYS|SYS|TXN|002026|]CHANGEPAYMENTNOTA
LLOWEDASPROMOTIONISACTIVEONACCOUNT.|SY

S|MSG-SE
Index Rate Change
SINo | TABLE KEY DATA TYPE
TXN_CODE | RESCHEDULE_INDEX|ALL|ALL|CE
1 _PRODUCT UPDATE
S RESCHEDULE_INDEX_REVI|ALL|ALL|CE

Lease Variable Rate

SINo | TABLE KEY DATA TYPE

CALC_METHOD_CD

LOOKUP_T

VPES RENT_COL_METHOD_CD INSERT

RESIDUAL_VALUATION_CD

CALC_METHOD_CD|INT

CALC_METHOD_CD|RF

RENT_COL_METHOD_CD|ADV

RENT_COL_METHOD_CD|ARR

RESIDUAL_VALUATION_CD|FMV

RESIDUAL_VALUATION_CD|CMV
2 LOOKUPS INSERT
LEASE_ACCRUAL_CALC_METHOD_CD]|IBL

LEASE_BILL_CYCLE_CD|W

LEASE_BILL_CYCLE_CD|B

LEASE_BILL_CYCLE_CD|Q

LEASE_BILL_CYCLE_CD|S

LEASE_BILL_CYCLE_CD|Y
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S| No

TABLE

KEY DATA

TYPE

LEASE_BILL_METHOD_CD|OB

LEASE_BILL_METHOD_CD|PI

TXN_CODE
_PRODUCT
S

INT|ALL|LS|ALL

INT_ADJ_MINUSI|ALL|LSJALL

INT_ADJ_MINUS_REV|ALL|LS|ALL

INT_ADJ_PLUS|ALL|LS|ALL

INT_ADJ_PLUS_REV|ALL|LS|ALL

INT_BILLJALL|LS|ALL

INT_BILL_REV|ALL|LS|ALL

INT_CHGOFF|ALL|LS|ALL

INT_CHGOFF_REV|ALL|LS|ALL

INSERT

INT_ESTIMATEDIALL|LS|ALL

INT_ESTIMATED_REV|ALL|LS|ALL

INT_REBATE|ALL|LS|ALL

INT_REBATE_REV|ALL|LS|ALL

INT_REV|ALL|LS|ALL

INT_WAIVE|ALL|LS|ALL

INT_WAIVE_REVI|ALL|LS|ALL

RATE_CHANGE|ALL|ALL|CE]

RATE_CHANGE_REVI|ALL|ALL|CE

UPDATE

PRODUCT_
CORRESP
ONDENCES

CNLSCE_EXP_LTR

INSERT

JOB_THRE
ADS

SET-LTR2|LCSEXP_BJ_121 011

SET-LTR2|LCSEXP_BJ_121_01|2

SET-LTR2|LCSEXP_BJ_121_01|3

INSERT

SET-LTR2|LCSEXP_BJ_121_01|4
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SINo | TABLE KEY DATA TYPE

6 JOBS SET-LTR2|LCSEXP_BJ_121_01 INSERT

CNLSCE_CON_EDIT_01|XVL_CON_BALLOON_FINA
L_PMT

CNLSCE_CON_EDIT_01|XVL_CON_BILL_MTHD_FP
_REPAYMENT

CNLSCE_CON_EDIT_01|XVL_CON_RATE_IRATE_M
RATE

CNLSCE_CON_EDIT_01|XVL_CON_SKIP_MTH_MAT
URITY_MTH

CNLSCE_CON_EDIT_01|XVL_CON_INDEX_ADC

CNLSCE_CON_EDIT_01|XVL_CON_MRATE_ADC

CNLSCE_CON_EDIT_01|XVL_CON_RATE_ADC

CNLSCE_CON_EDIT_01|XVL_CON_INDEX_PRP

CNLSCE_CON_EDIT_01|XVL_CON_ACD_ADVANCE

_AIT
. EDIT_DETA | CNLSCE_CON_EDIT_O1|REQ_REPAYMENT_TYPE_ | |\ crpr
ILS CcD
CNLSCE_CON_EDIT_01|REQ_REPAYMENT_SCHE
DULE
CNLSCE_CON_EDIT_01|MIN_CON_BALLOON_AMT
CNLSCE_CON_EDIT_01|MAX_CON_BALLOON_AMT
CNLSCE_CON_EDIT_01|MIN_CON_FINANCE_CHAR
GE
CNLSCE_CON_EDIT_01|MAX_CON_FINANCE_CHA
RGE
CNLSCE_CON_EDIT_01|MIN_CON_MRATE
CNLSCE_CON_EDIT_01|MAX_CON_MRATE
CNLSCE_CON_EDIT_01|MIN_REPAYMENT_SKIP_P
ERIOD
CNLSCE_CON_EDIT_01|MAX_REPAYMENT_SKIP_
PERIOD
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CNLSCE_CON_EDIT_01|XVL_CON_ADV_1ST_PMT_
DT_CON_DT

CNLSCE_CON_EDIT_01|XVL_CON_ARR_1ST_PMT_
DT_CON_DT

CNLSCE_CON_EDIT_01|XVL_CON_TERM_ASE_ES
TM_LIFE

CNLSCE_ADC_EDIT_01|MIN_ADC_MRATE

CNLSCE_ADC_EDIT_03|MIN_ADC_MRATE

CNLSCE_ADC_EDIT_01|MAX_ADC_MRATE

CNLSCE_ADC_EDIT_03|MAX_ADC_MRATE

CNLSCE_ADC_EDIT_01|XVL_ADC_IRATE_MRATE_
RATE

CNLSCE_ADC_EDIT_03|XVL_ADC_IRATE_MRATE_
RATE

CNLSCE_ADC_EDIT_01|XVL_ADC_MRATE_PRP_M
RATE

CNLSCE_ADC_EDIT_03|XVL_ADC_MRATE_PRP_M
RATE

CNLSCE_ADC_EDIT_01|XVL_ADC_RATE_APP_REQ
_RATE

CNLSCE_ADC_EDIT_03|XVL_ADC_RATE_APP_REQ
_RATE

CNLSCE_ADC_EDIT_01|XVL_ADC_DOWN_AMT_AP
P_DOWN_AMT

CNLSCE_ADC_EDIT_01|XVL_ADC_CAP_COST_ADJ
_AIT

CNLSCE_ADC_EDIT_03|XVL_ADC_DOWN_AMT_AP
P_DOWN_AMT

CNLSCE_CON_EDIT_01|XVL_CON_TOTAL_OF PM
TS_EST|0.99

CNLSCE_CON_EDIT_01|XVL_CON_TOTAL_PMTS_
DEP_RENT]|0.99

CNLSCE_CON_EDIT_01|XVL_CON_TOTAL_PMTS_T
ERM_PMT|0.99

2-165 ORACLE

Financial Services



SINo | TABLE KEY DATA TYPE

CNLSCE_CON_EDIT_01|XVL_CON_FIRST_PMT_DT
_CON_DT

CNLSCE_CON_EDIT_01|XVL_CON_TOTAL_OF_PM
TS_ESTINA

CNLSCE_CON_EDIT_01|XVL_CON_TOTAL_PMTS_
DEP_RENT|NA

EDIT_DETA | CNLSCE_CON_EDIT_01|XVL_CON_TOTAL_PMTS_T
ILS ERM_PMT|NA DELETE

CNB_CON_LEASE|XVL_CON_BALLOON_FINAL_PM
7

CNB_CON_LEASE|XVL_CON_BILL_MTHD_FP_REP
AYMENT

CNB_CON_LEASE|XVL_CON_RATE_IRATE_MRATE

CNB_CON_LEASE|XVL_CON_SKIP_MTH_MATURIT
Y_MTH

CNB_CON_LEASE|XVL_CON_INDEX_ADC

CNB_CON_LEASE|XVL_CON_MRATE_ADC

CNB_CON_LEASE|XVL_CON_RATE_ADC

CNB_CON_LEASE|XVL_CON_INDEX_PRP

FLEX_TABL
9 E_ATTRIBU | CNB_CON_LEASE|XVL_CON_ACD_ADVANCE_AIT | INSERT

TES

CNB_CON_LEASE|REQ_REPAYMENT_TYPE_CD

CNB_CON_LEASE|REQ_REPAYMENT_SCHEDULE

CNB_CON_LEASE|MIN_CON_BALLOON_AMT

CNB_CON_LEASE|MAX_CON_BALLOON_AMT

CNB_CON_LEASE|MIN_CON_FINANCE_CHARGE

CNB_CON_LEASE|MAX_CON_FINANCE_CHARGE

CNB_CON_LEASE|MIN_CON_MRATE

CNB_CON_LEASE|MAX_CON_MRATE

CNB_CON_LEASE|MIN_REPAYMENT_SKIP_PERIO
D
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SINo | TABLE KEY DATA TYPE
CNB_CON_LEASE|MAX_REPAYMENT_SKIP_PERIO
D
CNB_CON_LEASE|XVL_CON_ADV_1ST_PMT DT C
ON_DT
CNB_CON_LEASE|XVL_CON_ARR_1ST_PMT_DT_C
ON_DT
CNB_CON_LEASE|XVL_CON_TERM_ASE_ESTM_LI
FE
CNB_DEC_LEASE|MIN_ADC_MRATE
CNB_DEC_LEASE|MAX_ADC_MRATE
CNB_DEC_LEASE|XVL_ADC_IRATE_MRATE_RATE
CNB_DEC_LEASE|XVL_ADC_MRATE_PRP_MRATE
CNB_DEC_LEASE|XVL_ADC_RATE_APP_REQ RAT
E
CNB_DEC_LEASE|XVL_ADC_CAP_COST_ADJ_AIT
CNB_DEC_LEASE|XVL_ADC_DOWN_AMT_APP_DO
WN_AMT
FLEX_TABL
1 E_ATTRIBU CDN TB_c:o N_LEASE|XVL_CON_FIRST_PMT_DT_CON
TES - DELETE
Servicing and Termination changes
Sl. No | TABLE KEY DATA TYPE
CNLSCE_SDA_LTR_VR
CNLSCE_POQ LTR_VR
PRODUCT_ | CNLSCE_RAT_LTR_VR_01
1 CORRESP INSERT
ONDENCES | CNLSCE_RAT _LTR_VR 02
CNLSCE_PMT_LTR_VR
CNLSCE_EXT_LTR_VR
FLEX_TABL | INP_BMP_TNM|TNM_TERMINATE_ALLOWED_IND
2 E_ATTRIBU INSERT
TES INP_BMP_TNM|TNM_TERMINATE_BILLED _TERM
2-167 ORACLE




SI. No

TABLE

KEY DATA

TYPE

INP_BMP_TNM|TNM_MIN_AMT_RECOVERD_PER

TXN_CODE
S

ACC_ETM

ACC_CHECK_ETM_ALLOWED

SECURITY_DEP_ADJUST

SECURITY_DEP_ADJUST_REV

INSERT

TXN_CODE
_PARAMET
ERS

ACC_ETM|TNM_DT

ACC_ETM|TNM_TERMINATE_ALLOWED_IND

ACC_ETM|TNM_TERMINATE_BILLED_TERM

ACC_ETM|TNM_MIN_AMT_RECOVERD_PER

ACC_CHECK_ETM_ALLOWED|TNM_DT

SECURITY_DEP_ADJUST|TXN_DT

SECURITY_DEP_ADJUST|TXN_AMT

SECURITY_DEP_ADJUST|TXN_COMMENT

INSERT

TXN_CODE
_PRODUCT
S

ACC_ETMI|ALL|LS|CE]

ACC_CHECK_ETM_ALLOWEDIALL|LS|CE

SECURITY_DEP_ADJUST|ALL|LS|CE

SECURITY_DEP_ADJUST_REV|ALL|LS|CE

INSERT

TRANSLAT]
ON_DATA

SYS|SYS|SYS|TNM|001874|EITHERTERMINATEBILL
TERMORRECOVERDPERAMOUNTSHOULDBEGRE
ATERTHANZERO|SYS|MSG-SE

SYS|SYS|SYS|TNM|001875|ACCOUNTSTATUSISTE
RMINATECANNOTPOSTTRANSACTION|SYS|MSG-
SE

SYS|SYS|SYS|TNM|001876[*****TRANSACTIONPOS
TEDSUCCESSFULLY****QLDVALUES:ALLOWEDT
OTERMINATE:~TER_ALL_IND~BILLEDTERM:~TER_
BILL_TERM~AMTRECOVERED~ACC_AMT_RECOV
ERD~NEWVALUES:~ALLOWEDTOTERMINATE:~TE
R_ALL_IND~BILLEDTERM:~TER_BILL_TERM~AMTR
ECOVERED~ACC_AMT_RECOVERD~|SYS|MSG-SE

INSERT
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SYS|SYS|SYS|TNM|001877|********TRANSACTIONPO
STEDSUCCESSFULLY********EARLYTERMINATIONA
LLOWED:YES.|SYS|MSG-SE

SYS|SYS|SYS|TNM|001878***++*TRANSACTIONPO
STEDSUCCESSFULLY***+++EARLYTERMINATIONA
LLOWED:NOREASON:EARLYTERMINATIONFLAG=
NO.|SYS|MSG-SE

SYS|SYS|SYS|TNM|001879[***++TRANSACTIONPO
STEDSUCCESSFULLY***+++*EARLYTERMINATIONA
LLOWED:NOREASON:STILL~REMAINING_TERM~T
ERMSAND~REMAINING AMT~LEASERECEIVABLE/I
NTERESTAMOUNTPENDINGFOREARLYTERMINATI
ON.|SYS|MSG-SE

SYS|SYS|SYS|UPS|001599|TERMINATEBILLEDTER
MORRECOVERDPERCENTAGESHOULDBEOIFALLO
WEDTOTERMINATEINDICATORISNO.|SYS|MSG-SE

SYS|SYS|SYS|UPS|001598|TERMINATEBILLEDTER
MANDRECOVERDPERCENTAGECANNOTBENULL.|
SYS|MSG-SE

SYS|SYS|SYS|TXN|002017|RESIDUALAMOUNTREM
AININGSHOULDBELESSTHAN~ACC_RESIDUAL_PE
R_CUR~|SYS|MSG-SM

SYS|SYS|SYS|TNM|001597|RESIDUALVALUATIONIS
NOTAPPLICABLE.|SYS|MSG-SE

SYS|SYS|SYS|UPS|001599|TERMINATEBILLEDTER
MANDRECOVERDPERCENTAGESHOULDBEOASAL
LOWEDTOTERMINATEINDICATORISNO.|SYS|MSG-
SE

SYS|SYS|SYS|TXN|002023|AMORTIZEBALANCETYP
E~AMORTIZE_TXN_TYPE_CD~ISNOTFOUNDFORT
HESELECTEDINSTRUMENT.|SYS|MSG-SM

SYS|SYS|SYS|TXN|002007|INSUFFICIENTSECURIT
YDEPOSITAMOUNTTOADJUST.|SYS|MSG-SE

7 JOBS SET-LTR2|LCSTXN_BJ_121_01 INSERT

SET-LTR2|LCSTXN_BJ_121_01|1

JOB_THRE SET-LTR2|LCSTXN_BJ_121_01|2

8 ADS INSERT
SET-LTR2|LCSTXN_BJ 121 _01|3
SET-LTR2|LCSTXN_BJ_121_01|4
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LOOKUP_T

YPES LEASE_LETTER_TYPE_CD INSERT

LEASE_LETTER_TYPE_CD|PAYOFF|PAYOFF_LEAS
E

LEASE_LETTER_TYPE_CD|SECURITY_DEPOSIT L
ETTER

LEASE_LETTER_TYPE_CD|EXTENSION_LETTER

LEASE_LETTER_TYPE_CD|CHANGE_PAYMENT_LE
TTER

LEASE_LETTER_TYPE_CD|CHANGE_RATE_LETTE
R

10 LOOKUPS | cORRESPONDENCE_TYPE_CDISECURITY DEPOS | NoERT
IT_LETTER

CORRESPONDENCE_TYPE_CD|CHANGE_RATE_L
ETTER

CORRESPONDENCE_TYPE_CD|CHANGE_PAYMEN
T_LETTER

CORRESPONDENCE_TYPE_CD|EXTENSION_LETT
ER

CORRESPONDENCE_TYPE_CD|LEASE_EXPIRY_L
ETTER

FLL.SET.UAD.SALESTAXSETUP.MENU

FLL.SET.UAD.SALESTAXLEASE.TAB

FLL.SET.UAD.SALESTAXLEASE.ADD.BUTTON

FLL.SET.UAD.SALESTAXLEASE.EDIT.BUTTON

FLS_ACCE FLL.SET.UAD.SALESTAXLEASE.VIEW.BUTTON

SS

11 INSERT

FLL.SET.UAD.SALESTAXLEASE.AUDIT.BUTTON

FLL.SET.UAD.SALESTAXORIGINATIONLEASE.TAB

FLL.SET.UAD.SALESTAXORIGINATIONLEASE.AUDI
T.BUTTON

FLL.SET.UAD.SALESTAXORIGINATIONLEASE.VIEW
.BUTTON
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FLL.SET.UAD.SALESTAXORIGINATIONLEASE.EDIT.
BUTTON

FLL.SET.UAD.SALESTAXORIGINATIONLEASE.ADD.
BUTTON

FLL.SET.UAD.SALESTAXCUSTOMERSERVICELEAS
E.TAB

FLL.SET.UAD.SALESTAXCUSTOMERSERVICELEAS
E.AUDIT.BUTTON

FLL.SET.UAD.SALESTAXCUSTOMERSERVICELEAS
E.VIEW.BUTTON

FLL.SET.UAD.SALESTAXCUSTOMERSERVICELEAS
E.EDIT.BUTTON

FLL.SET.UAD.SALESTAXCUSTOMERSERVICELEAS
E.ADD.BUTTON

FLL.SET.UAD.SALESTAXRANGELEASE.TAB

FLL.SET.UAD.SALESTAXRANGELEASE.AUDIT.BUT
TON

FLL.SET.UAD.SALESTAXRANGELEASE.VIEW.BUTT
ON

FLL.SET.UAD.SALESTAXRANGELEASE.EDIT.BUTT
ON

FLL.SET.UAD.SALESTAXRANGELEASE.ADD.BUTT
ON

FLL.SET.UPS.PRODUCTRATESCHEDULELEASE.TA
B

FLL.SET.UPS.PRODUCTRATESCHEDULELEASE.AD
D.BUTTON

FLL.SET.UPS.PRODUCTRATESCHEDULELEASE.ED
IT.BUTTON

FLL.SET.UPS.PRODUCTRATESCHEDULELEASE.VI
EW.BUTTON

FLL.SET.UPS.PRODUCTRATESCHEDULELEASE.AU
DIT.BUTTON

FLL.CMN.UVN.VENDORSEARCH.TAB
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FLL.CMN.UVN.VENDORSEARCH.OPEN.BUTTON

FLL.SET.UPS.INSURANCELEASE.TAB

FLL.SET.UPS.INSURANCELEASE.VIEW.BUTTON

FLL.SET.UPS.INSURANCELEASE.EDIT.BUTTON

FLL.SET.UPS.INSURANCELEASE.AUDIT.BUTTON

FLL.SET.UPS.INSURANCELEASE.ADD.BUTTON

FLL.SET.UPS.INSURANCEDETAILLEASE.ADD.BUTT
ON

FLL.SET.UPS.INSURANCEDETAILLEASE.EDIT.BUT
TON

FLL.SET.UPS.INSURANCEDETAILLEASE.VIEW.BUT
TON

FLL.SET.UPS.INSURANCEDETAILLEASE.AUDIT.BU
TTON

FLL.SET.UPS.COMMISSIONPLANLEASE.VIEW.BUT
TON

FLL.SET.UPS.COMMISSIONPLANLEASE.EDIT.BUTT
ON

FLL.SET.UPS.COMMISSIONPLANLEASE.AUDIT.BUT
TON

FLL.SET.UPS.COMMISSIONPLANLEASE.ADD.BUTT
ON

FLL.SET.UPS.COMMISSIONPLANLOAN.TAB

FLL.ORG.ULN.APPLICATIONSALESTAXDETAILS.ED
IT.BUTTON

FLL.ORG.ULN.APPLICATIONSALESTAXDETAILS.AU
DIT.BUTTON

FLL.ORG.ULN.APPLICATIONSALESTAXDETAILS.VI
EW.BUTTON

FLL.ORG.ULN.APPLICATIONDECISIONLEASE.CALC
ULATETAX.BUTTON

FLL.SER.UCS.ACCOUNTTAXDETAILS.AUDIT.BUTT
ON
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FLL.SER.UCS.ACCOUNTTAXDETAILS.TAB
FLL.SER.UCS.ACCOUNTTAXDETAILS.VIEW.BUTTO
N
FLL.ORG.ULN.APPLICATIONDECISIONSALESTAXD
ETAILS.TAB
FLL.SET.UPS.COMMISSIONPLANLEASE.TAB
FLL.SER.UCS.ACCOUNTDOCUMENTDETAIL.UPLO
AD.BUTTON
FLL.ORG.ULN.APPLICATIONDOCUMENTDETAIL.UP
LOAD.BUTTON

MENU_ACC

12 ESS FLL.SET.UAD.SALESTAXSETUP.MENU INSERT
ACC_CHECK_ETM_ALLOWED|ACC_CONDITION_C
D|ALL

ACCESS G
RID_FUNCT | ACC_CHECK_ETM_ALLOWED|ACC_STATUS_CD|A
13 IONS LL INSERT
Lease 842 Report
SI. No | TABLE KEY DATA TYPE
1 FLEX_TABL | SET_SYP_SYSTEM|PAC_PURGE_DAYS INSERT
E_ATTRIBU

2 TES SET_SYP_SYSTEM|PAP_PURGE_DAYS

3 SYSTEM_P | PAC_PURGE_DAYS|SET_SYP_SYSTEM|ALL|ALL|AL | INSERT
ARAMETER | LJALL|ALLJALLJALL
S

4 PAP_PURGE_DAYS|SET_SYP_SYSTEM|ALL|ALL|AL
L|ALL|ALL|ALLJALL

5 JOBS SET-PUR|PJRPAC_BJ 100 01 INSERT

6 SET-PUR|PJRPAP_BJ 100 01

7 SET-PUR|PJRPGL_BJ_100 01

8 SET-PUR|PJRPPA_BJ 100 01

9 SET-PUR|PJRPPX_BJ_100_01

10 SET-PUR|PJRPTX_BJ 100 01

11 SET-PUR|PJRPVA_BJ_100_01
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12 JOB SET-PUR|PJRPAC_BJ_100_01|1
THREADS
13 SET-PUR|PJRPAP_BJ 100 011 INSERT
14 SET-PUR|PJRPGL_BJ 100 011
15 SET-PUR|PJRPPA_BJ 100 011
16 SET-PUR|PJRPPX_BJ 100 011
17 SET-PUR|PJRPTX_BJ_100_01|1
18 SET-PUR|PJRPVA_BJ 100 011

Lease Insurance

Sl.No | TABLE KEY DATA TYPE

CNB_CON_LEASE|MAX_INS_TERM

CNB_CON_LEASE|MAX_INS_VAL

CNB_CON_LEASE|MIN_INS_TERM

CNB_CON_LEASE|MIN_INS_VAL

CNB_CON_LEASE|REQ_INS_EFFECTIVE_DT

CNB_CON_LEASE|REQ_INS_PHONE_NO

CNB_CON_LEASE|REQ_INS_PIN_CODE

CNB_CON_LEASE|REQ_INS_POLICY_NBR

FLEX_TABL
1 E_ATTRIBU | CNB_CON_LEASE|REQ_INS PRIMARY_BENEFICIA | INSERT
TES RY

CNB_CON_LEASE|XVL_INS_EFFECTIVE_DT_CON_
DT

CNB_CON_LEASE|XVL_INS_TERM_CON_TERM

CNB_CON_LEASE|XVL_CON_PROM_RATE_RATE_
CAP_MAX

CNB_CON_LEASE|XVL_CON_PROM_TERM_TERM

CNB_CON_LEASE|XVL_CON_PRM_CODE_ADC

CNB_CON_LEASE|XVL_CON_BILL_MTHD_FP_PRO
MOTION
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CNB_CON_LEASE|XVL_CON_CSH_FIRST_BILL_DT

CNB_CON_LEASE|XVL_CON_MULTI_DISB_BILL_P
ROM

CNB_CON_LEASE|XVL_CON_PROM_RATE_RATE_
CAP_MIN

INS_ADD

INS_MODIFY

INS_CANCEL

TXN_CODE
2 _PRODUCT | INS_ACTIVATE INSERT
S

INS_DETAILS_MODIFY

INS_REBATE

INS_EXPIRE

CNLSCE_ACX_EDIT_01|MAX_INS_TERM]|72

CNLSCE_ACX_EDIT_01|MAX_INS_VAL|25000

CNLSCE_ACX_EDIT_01|MIN_INS_TERM]|0

CNLSCE_ACX_EDIT_01|MIN_INS_VAL|50

CNLSCE_ACX_EDIT_01|REQ_INS_EFFECTIVE_DT|
NA

CNLSCE_ACX_EDIT_01|REQ_INS_PHONE_NO|NA

EDIT_pETAl | CNLSCE_ACX_EDIT_O1|REQ_INS_POLICY_NBRINA

LS INSERT

CNLSCE_ACX_EDIT_01|REQ_INS_PRIMARY_BENE
FICIARY|NA

CNLSCE_ACX_EDIT_01|XVL_INS_EFFECTIVE_DT_
CON_DT|NA

CNLSCE_ACX_EDIT_01|XVL_INS_TERM_CON_TER
M|NA

CNLSCE_API_EDIT_01|MAX_INS_TERM|72

CNLSCE_API_EDIT_01|MAX_INS_VAL|25000

CNLSCE_API_EDIT_O01|MIN_INS_TERM|0
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CNLSCE_API_EDIT_01|MIN_INS_VAL|50

CNLSCE_API_EDIT_01|REQ_INS_EFFECTIVE_DT|N
A

CNLSCE_API_EDIT_01|REQ_INS_PHONE_NO|NA

CNLSCE_API_EDIT_01|REQ_INS_POLICY_NBR|NA

CNLSCE_API_EDIT_01|REQ_INS_PRIMARY_BENEF
ICIARY|NA

CNLSCE_API_EDIT_01|XVL_INS_EFFECTIVE_DT_C
ON_DT|NA

CNLSCE_API_EDIT_01|XVL_INS_TERM_CON_TER
M|NA

CNLSCE_CON_EDIT_01|MAX_INS_TERM|72

CNLSCE_CON_EDIT_01|MAX_INS_VAL|100000

CNLSCE_CON_EDIT_01|MIN_INS_TERM|0

CNLSCE_CON_EDIT_01|MIN_INS_VAL|50

CNLSCE_CON_EDIT_01|REQ_CON_PIS_INSTRUM
ENTINA

CNLSCE_CON_EDIT_01|REQ_INS_EFFECTIVE_DT|
NA

CNLSCE_CON_EDIT_01|REQ_INS_PHONE_NO|NA

CNLSCE_CON_EDIT_01|JREQ_INS_PIN_CODE|NA

CNLSCE_CON_EDIT_01|REQ_INS_POLICY_NBR|N
A

CNLSCE_CON_EDIT_01|REQ_INS_PRIMARY_BENE
FICIARY|NA

CNLSCE_CON_EDIT_01|XVL_CON_INSTALL_METH
OD_FIN_PMT|NA

CNLSCE_CON_EDIT_01|XVL_INS_EFFECTIVE_DT_
CON_DT|NA

CNLSCE_CON_EDIT_01|XVL_INS_TERM_CON_TER
M|NA

4 CNB_CON_LEASE|MAX_INS_TERM INSERT
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CNB_CON_LEASE|MAX_INS_VAL

CNB_CON_LEASE|MIN_INS_TERM

CNB_CON_LEASE|MIN_INS_VAL

CNB_CON_LEASE|REQ_INS_EFFECTIVE_DT

CNB_CON_LEASE|REQ_INS_PHONE_NO

FLEX_TABL
E_ATTRIBU | CNB_CON_LEASE|REQ_INS_PIN_CODE
TES

CNB_CON_LEASE|REQ_INS_POLICY_NBR

CNB_CON_LEASE|REQ_INS_PRIMARY_BENEFICIA
RY

CNB_CON_LEASE|XVL_INS_EFFECTIVE_DT_CON_
DT

CNB_CON_LEASE|XVL_INS_TERM_CON_TERM

Lease Promotions

Sl.No | TABLE KEY DATA TYPE

CNLSCE_CON_EDIT_01|XVL_CON_BILL_MTHD_FP
_PROMOTION|NA

CNLSCE_CON_EDIT_01|XVL_CON_MULTI_DISB_BI
LL_PROM|0

CNLSCE_CON_EDIT_01|XVL_CON_PROM_RATE_R
ATE_CAP_MAX|NA

EDIT_DETA | CNLSCE_CON_EDIT_01|XVL_CON_PROM_RATE_R

! ILS ATE_CAP_MIN|NA INSERT
CNLSCE_CON_EDIT_01|XVL_CON_PROM_TERM_T
ERM|NA
CNLSCE_CON_EDIT_01|XVL_CON_PRM_CODE_AD
CINA
CNLSCE_CON_EDIT_01|XVL_CON_CSH_FIRST_BIL
L_DT|NA
FLEX_TABL '\CANOI?_TSISN_LEASE|XVL_CON_BILL_MTHD_FP_PRO
2 E_ATTRIBU INSERT
TES CNB_CON_LEASE|XVL_CON_CSH_FIRST_BILL_DT
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CNB_CON_LEASE|XVL_CON_MULTI_DISB_BILL_P
ROM

CNB_CON_LEASE|XVL_CON_PRM_CODE_ADC

CNB_CON_LEASE|XVL_CON_PROM_RATE_RATE_
CAP_MAX

CNB_CON_LEASE|XVL_CON_PROM_RATE_RATE_
CAP_MIN

CNB_CON_LEASE|XVL_CON_PROM_TERM_TERM

Vertex changes

SI. No | Table Key Data Type
1 FLL.SET.UAD.SALESTAXSETUP.MENU INSERT
2 FLL.SET.UAD.SALESTAXLEASE.TAB INSERT
3 FLL.SET.UAD.SALESTAXLEASE.ADD.BUTTON INSERT
4 FLL.SET.UAD.SALESTAXLEASE.EDIT.BUTTON INSERT
5 FLL.SET.UAD.SALESTAXLEASE.VIEW.BUTTON INSERT
6 FLL.SET.UAD.SALESTAXLEASE.AUDIT.BUTTON INSERT
7 FLL.SET.UAD.SALESTAXORIGINATIONLEASE.TAB INSERT
FLL.SET.UAD.SALESTAXORIGINATIONLEASE.ADD.
8 BUTTON INSERT
9 FLS_ACCE FLL.SET.UAD.SALESTAXORIGINATIONLEASE.EDIT INSERT
SS .BUTTON
FLL.SET.UAD.SALESTAXORIGINATIONLEASE.VIE
10 W.BUTTON INSERT
FLL.SET.UAD.SALESTAXORIGINATIONLEASE.AUDI
1 T.BUTTON INSERT
12 FLL.SET.UAD.SALESTAXRANGELEASE.TAB INSERT
13 EIF\IL.SET.UAD.SALESTAXRANGELEASE.ADD.BUTT INSERT
14 EIF\IL.SET.UAD.SALESTAXRANGELEASE.EDIT.BUTT INSERT
15 EINL.SET.UAD.SALESTAXRANGELEASE.VIEW.BUTT INSERT
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FLL.SET.UAD.SALESTAXRANGELEASE.AUDIT.BUT

16 e INSERT
17 gII_EL_.riII:ST.UAD.SALESTAXCUSTOMERSERVICELEA INSERT

FLL.SET.UAD.SALESTAXCUSTOMERSERVICELEA
18 SE.ADD.BUTTON INSERT

FLL.SET.UAD.SALESTAXCUSTOMERSERVICELEA
19 SE.EDIT.BUTTON INSERT

FLL.SET.UAD.SALESTAXCUSTOMERSERVICELEA
20 SE.VIEW.BUTTON INSERT

FLL.SET.UAD.SALESTAXCUSTOMERSERVICELEA
21 SE.AUDIT.BUTTON INSERT

FLL.ORG.ULN.APPLICATIONDECISIONLEASE.CAL
22 CULATETAX.BUTTON INSERT

FLL.ORG.ULN.APPLICATIONDECISIONSALESTAXD
23 ETAILS.TAB INSERT

FLL.ORG.ULN.APPLICATIONSALESTAXDETAILS.E
24 DIT.BUTTON INSERT

FLL.ORG.ULN.APPLICATIONSALESTAXDETAILS.VI

25 EW.BUTTON INSERT
FLL.ORG.ULN.APPLICATIONSALESTAXDETAILS.A
26 UDIT.BUTTON INSERT
FLL.ORG.ULN.APPLICATIONCONTRACTSALESTAX
21 DETAILS.TAB INSERT
28 FLL.SER.UCS.ACCOUNTTAXDETAILS.TAB INSERT
09 ELL.SER.UCS.ACCOUNTTAXDETAILS.VIEW.BUTTO INSERT
30 (F)LI\IL.SER.UCS.ACCOUNTTAXDETAILS.AUDIT.BUTT INSERT
31 TAX_SOURCE_CD INSERT
32 TAX_CHANNEL_CD INSERT
33 \L(g(E)gUP—T TAX_EXEMPTION_REASON_CD INSERT
34 SALES_TAX_TXNS_CD INSERT
35 SALES_TAX_EXT_AMT_CD INSERT
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36 SALES_TAX_INT_AMT_CD INSERT
37 TAX_SOURCE_CD|INTERNAL INSERT
38 TAX_SOURCE_CD|MANUAL INSERT
39 TAX_SOURCE_CDI|VERTEX INSERT
40 TAX_CHANNEL_CDJ|INTERNAL INSERT
41 TAX_CHANNEL_CDI|VERTEX INSERT
42 TAX_EXEMPTION_REASON_CD|TAX_EXEMPTED_ | |\ cERT

USER
43 SALES TAX_TXNS_CD|DDT INSERT
44 SALES TAX_TXNS_CD|FLC INSERT
45 SALES TAX_TXNS_CD|PAYOFF_LEASE INSERT
46 SALES TAX_TXNS_CD|TRM INSERT
47 SALES TAX_EXT_AMT_CD|ITM_AMOUNT INSERT
48 LooKUPS | SALES_TAX_EXT_AMT_CD|LEASE_PMT_AMT INSERT
49 SALES TAX_EXT_AMT_CD|PURCHASE_PRC INSERT
50 SALES_TAX_EXT_AMT_CD|TOT_LEASE_AMT INSERT
51 SALES_TAX_INT_AMT_CD|FLAT_ITM_AMOUNT INSERT
52 SALES_TAX_INT_AMT_CD|FLAT_TXN_AMOUNT INSERT
53 SALES_TAX_INT_AMT_CD|LEASE_PMT_AMT INSERT
54 SALES_TAX_INT_AMT_CD|PERC_ITM_AMOUNT INSERT
55 SALES_TAX_INT_AMT_CD|PERC_TXN_AMOUNT INSERT
56 SALES TAX_INT_AMT_CD|PURCHASE_PRC INSERT
57 SALES_TAX_INT_AMT_CD|TOT_LEASE_AMT INSERT
£g EE;AI\\;I?\I_CC:ZSDMP_FORMULA_METHOD_CD|PER_AMT INSERT
59 IIEIIEl\IIAASI\IIEC_ICEZSMP_SPREAD_FORMULA_CD|PER_AMT_ INSERT
60 ESDIT_DETAI Sl:\lcl)_gi:CE?gE)IIE\l_EDIT_Ol|XVL_CON_SAL_TAX_AMT INSERT
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61 ULN|001754|SALESTAXITEMIZATIONNOTFOUNDFO INSERT
RAPPLICATION|SYS|MSG-SE
62 ULN|001753]ASSETADDRESSISMANDATORYTOCA INSERT
LCULATESALETAX|SYS|MSG-SE
63 XLS|000001|SALESTAXSHOULDBECALCULATEDM INSERT
ANUALLY.|SYS|MSG-SE
XLS|000002|NOSALESTAXINTERFACEDEFINED|SY
64 S|MSG-SE INSERT
65 XLS|000003|SALESTAXINTERFACEINTHESETUPIS INSERT
TRANSLAT| | NOTSUPPORTED.|SYS|MSG-SE
66 ON_DATA XLS|000005|NOAPPLICATIONFOUNDFORTHEAAD | INSERT
D.|SYS|MSG-SE
67 UST|000001|SALESTAXCODEALREADYEXIST|SYS| | |\ cenT
MSG-SE
UST|000002|SALESTAXFORMULACODEALREADYE
68 XIST|SYS|MSG-SE INSERT
69 UST|000003|STARTDATESHOULDBELESSTHANEN INSERT
DDATE|SYS|MSG-SE
70 TNM|001880|TAXEXEMPTIONSTARTDATESHOULD INSERT
BELESSTHANENDDATE|SYS|MSG-SE
71 SET_SYP_COMPANY|XSL_TAX_INTERFACE INSERT
72 SET_SYP_SYSTEM|VTX_OUTBOUND_URL INSERT
73 CNB_CON_LEASE|XVL_CON_SAL_TAX_AMT_FOR INSERT
_CYCLE
FLEX_TABL
74 E_ATTRIBU | INP_BMP_TNM|TNM_TAX_EXEMPTION_IND INSERT
TES
75 Iglg_BMP_TNM|TNM_TAX_EXEMPTION_REASON_ INSERT
76 INP_BMP_TNM|TNM_TAX_EXEMPTION_START_DT | INSERT
77 INP_BMP_TNM|TNM_TAX_EXEMPTION_END_DT INSERT
Web Services
SNO TABLE KEY DATA TYPE
1 FLS_ACCE | FLL.TRANSACTIONPARAMETERSRESOURCE.GET. INSERT
SS GETTRANSACTIONPARAMETERS
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FLL.CUSTOMERPREFERENCERESOURCE.GET.FE

2 TCHPREFERENCE NSERT
3 FLL.CUSTOMERPREFERENCERESOURCE.POST.P INSERT
OSTPREFERENCE

4 FLL.UPDATECUSTOMERPREFERENCERESOURCE. INSERT
PUT.UPDATEPREFERENCE

FLL.CREDITLIMITRESOURCEIMPL.GET.FETCHCUS

5 TOMER INSERT
6 FLL.CUSTOMERCOMMENTSRESOURCEIMPL.GET. INSERT
FETCHCOMMENTS

7 FLL.CUSTOMERCOMMENTSRESOURCEIMPL.POST INSERT
.POSTCOMMENTS

8 FLL.CUSTOMERDOCUMENTRESOURCEIMPL.GET. INSERT
DOWNLOADCUSTOMERDOCUMENT

9 FLL.CUSTOMERDOCUMENTRESOURCEIMPL.GET. INSERT
LISTCUSTOMERDOCUMENTS

10 FLL.CUSTOMERDOCUMENTRESOURCEIMPL.POST INSERT
.UPLOADCUSTOMERDOCUMENT

FLL.BUSINESSCOMMENTSRESOURCEIMPL.GET.F

11 ETCHCOMMENTS INSERT
FLL.BUSINESSCOMMENTSRESOURCEIMPL.POST.
12 POSTCOMMENTS INSERT

13 FLL.BUSINESSDOCUMENTRESOURCEIMPL.GET.D INSERT
OWNLOADBUSINESSDOCUMENT

14 FLL.BUSINESSDOCUMENTRESOURCEIMPL.GET.LI INSERT
STBUSINESSDOCUMENTS

15 FLL.BUSINESSDOCUMENTRESOURCEIMPL.POST. INSERT
UPLOADBUSINESSDOCUMENT

FLL.CREDITLIMITRESOURCEIMPL.GET.FETCHBUSI

16 NESS INSERT
Lease SCRA
SI. No | Table Key Data Type
TXN_COD
E_PRODU
1 CTS CUST_ON_MLTRY_DUTY|ALL|LNJALL INSERT
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Table

Key Data

Type

TXN_COD
E_PRODU
CTS

CUST_ON_MLTRY_DUTY_REV|ALL|LN|ALL

INSERT

TXN_COD
E_PRODU
CTS

CUST_OFF_MLTRY_DUTY_LSIALL|LS|CE

INSERT

TXN_COD
E_PRODU
CTS

CUST_OFF_MLTRY_DUTY_LS_REV|ALL|LS|CE

INSERT

TXN_COD
E_PRODU
CTS

CUST_ON_MLTRY_DUTY_LS|ALL|LS|CE

INSERT

TXN_COD
E_PRODU
CTS

CUST_ON_MLTRY_DUTY_LS_REVI|ALL|LS|CE

INSERT

TXN_COD
E_PRODU
CTS

CUST_OFF_MLTRY_DUTY|ALL|LN|ALL

INSERT

TXN_COD
E_PRODU
CTS

CUST_OFF_MLTRY_DUTY_REV|ALL|LN|ALL

INSERT

TXN_COD
E_PARAM
ETERS

CUST_OFF_MLTRY_DUTY_LS|TXN_DT

INSERT

10

TXN_COD
E_PARAM
ETERS

CUST_OFF_MLTRY_DUTY_LS|TXN_RELATION
_TYPE_CD

INSERT

11

TXN_COD
E_PARAM
ETERS

CUST_ON_MLTRY_DUTY_LS|TXN_DT

INSERT

12

TXN_COD
E_PARAM
ETERS

CUST_ON_MLTRY_DUTY_LS|TXN_RELATION_
TYPE_CD

INSERT

13

TXN_COD
E_PARAM
ETERS

CUST_ON_MLTRY_DUTY_LS|TXN_SCRA_ORD
ER_REF_NBR

INSERT
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ACCESS _
GRID_FUN | CUST_OFF _MLTRY_DUTY_LS|ACC_CONDITIO

14 CTIONS N_CDJALL INSERT
ACCESS _
GRID_FUN | CUST_OFF _MLTRY_DUTY_LS|ACC_STATUS

15 CTIONS CD|ALL INSERT
ACCESS _
GRID_FUN | CUST_OFF _MLTRY_DUTY_LS REVI|ACC_CON

16 CTIONS DITION_CDIJALL INSERT
ACCESS _
GRID_FUN | CUST_OFF_MLTRY_DUTY_LS REV|ACC_STA

17 CTIONS TUS_CD|ALL INSERT
ACCESS _
GRID_FUN | CUST_ON_MLTRY_DUTY_LSJACC_CONDITION

18 CTIONS _CDJALL INSERT
ACCESS _
GRID_FUN | CUST_ON_MLTRY_DUTY_LSJACC_STATUS_C

19 CTIONS D|ALL INSERT
ACCESS _
GRID_FUN | CUST_ON_MLTRY_DUTY_LS_REV|ACC_COND

20 CTIONS ITION_CDJALL INSERT
ACCESS _
GRID_FUN | CUST_ON_MLTRY_DUTY_LS_REV|ACC_STAT

21 CTIONS US_CD|ALL INSERT
ACCESS _
GRID_FUN

22 CTIONS TERMINATE|ACC_CONDITION_CDI|DNT INSERT
TXN_COD

23 ES CUST_OFF_MLTRY_DUTY_LS INSERT
TXN_COD

24 ES CUST_OFF_MLTRY_DUTY_LS REV INSERT
TXN_COD

25 ES CUST_ON_MLTRY_DUTY_LS INSERT
TXN_COD

26 ES CUST_ON_MLTRY_DUTY_LS REV INSERT

27 LOOKUPS | ACC_CONDITION_CD|DNT INSERT
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28 LOOKUPS | ACC_CONDITION_CDIDNR INSERT
Customer Credit Limit

SI. No | Table Key Data Type
FLS_ACC

1 ESS FLL.ORG.ULN.CUSTOMERCREDITLIMIT.TAB INSERT
FLS ACC FLL.ORG.ULN.CUSTOMERCREDITLIMIT.EDIT.B

2 ESS UTTON INSERT
FLS _ACC FLL.ORG.ULN.CUSTOMERCREDITLIMIT.VIEW.

3 ESS BUTTON INSERT
FLS ACC FLL.ORG.ULN.CUSTOMERCREDITLIMIT.AUDIT

4 ESS .BUTTON INSERT
FLS _ACC

5 ESS FLL.SER.CRL.CUSTOMERCREDITLIMIT.MENU | INSERT
FLS ACC FLL.SER.CRL.CUSTOMERCREDITLIMITSEARC

6 ESS HRESULT.TAB INSERT
FLS ACC FLL.SER.CRL.CREDITLIMITTRANSACTIONBAT

7 ESS CH.ADD.BUTTON INSERT
FLS ACC FLL.SER.CRL.CREDITLIMITTRANSACTIONBAT

8 ESS CH.EDIT.BUTTON INSERT
FLS ACC FLL.SER.CRL.CREDITLIMITTRANSACTIONBAT

9 ESS CH.VIEW.BUTTON INSERT
FLS ACC FLL.SER.CRL.CREDITLIMITTRANSACTIONBAT

10 ESS CH.AUDIT.BUTTON INSERT
FLS ACC FLL.SER.CRL.CREDITLIMITTRANSACTIONBAT

11 ESS CH.TAB INSERT
FLS_ACC FLL.SER.CRL.CREDITLIMITCUSTOMERADDRE

12 ESS SS.TAB INSERT
FLS ACC FLL.SER.CRL.CREDITLIMITCUSTOMERTELEC

13 ESS OM.TAB INSERT
FLS_ACC FLL.SER.CRL.CREDITLIMITCUSTOMEREMPLO

14 ESS YMENT.TAB INSERT
FLS ACC FLL.SER.CRL.CREDITLIMITCUSTOMERTRACKI

15 ESS NGATTRIBUTE.TAB INSERT
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FLS_ACC FLL.SER.CRL.CREDITLIMITBUSINESSADDRES

16 ESS S.TAB INSERT
FLS ACC FLL.SER.CRL.CREDITLIMITBUSINESSTELECO

17 ESS M.TAB INSERT
FLS_ACC FLL.SER.CRL.CREDITLIMITBUSINESSPARTNE

18 ESS R.TAB INSERT
FLS ACC FLL.SER.CRL.CREDITLIMITBUSINESSAFFLIAT

19 ESS E.TAB INSERT
FLS _ACC FLL.SER.CRL.CREDITLIMITBUSINESSTRACKI

20 ESS NGATTRIBUTE.TAB INSERT
FLS ACC FLL.SER.CRL.CUSTOMERCREDITLIMITACCOU

21 ESS NTS.TAB INSERT
FLS _ACC FLL.SER.CRL.BUSINESSCREDITLIMITACCOUN

22 ESS TS.TAB INSERT
FLS ACC FLL.CREDITLIMITRESOURCEIMPL.GET.FETCH

23 ESS CUSTOMER INSERT
FLS ACC FLL.CREDITLIMITRESOURCEIMPL.GET.FETCH

24 ESS BUSINESS INSERT
FLS ACC FLL.SER.CRL.CREDITLIMITCOMMENTS.ADD.B

25 ESS UTTON INSERT
FLS ACC FLL.SER.CRL.CREDITLIMITCOMMENTS.EDIT.B

26 ESS UTTON INSERT
FLS ACC FLL.SER.CRL.CREDITLIMITCOMMENTS.VIEW.

27 ESS BUTTON INSERT
FLS ACC FLL.SER.CRL.CREDITLIMITCOMMENTS.AUDIT.

28 ESS BUTTON INSERT
FLS_ACC FLL.SER.CRL.CREDITLIMITCOMMENTS.DELET

29 ESS E.BUTTON INSERT
FLS ACC

30 ESS FLL.SER.CRL.CREDITLIMITCOMMENTS.TAB INSERT
FLS_ACC FLL.SER.CRL.CUSTOMERCREDITLIMITAPPLIC

31 ESS ATIONS.TAB INSERT
FLS ACC FLL.SER.CRL.BUSINESSCREDITLIMITAPPLICA

32 ESS TIONS.TAB INSERT
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FLS_ACC FLL.BUSINESSCOMMENTSRESOURCEIMPL.P

33 ESS OST.POSTCOMMENTS INSERT
FLS ACC FLL.BUSINESSCOMMENTSRESOURCEIMPL.G

34 ESS ET.FETCHCOMMENTS INSERT
FLS_ACC FLL.CUSTOMERCOMMENTSRESOURCEIMPL.

35 ESS GET.FETCHCOMMENTS INSERT
FLS ACC FLL.CUSTOMERCOMMENTSRESOURCEIMPL.

36 ESS POST.POSTCOMMENTS INSERT
FLS _ACC FLL.SER.CRL.BUSINESSCREDITLIMITDETAIL.

37 ESS AUDIT.BUTTON INSERT
FLS ACC FLL.SER.CRL.CREDITLIMITDOCUMENT.AUDIT.

38 ESS BUTTON INSERT
FLS _ACC FLL.SER.CRL.CREDITLIMITDOCUMENT.VIEW.

39 ESS BUTTON INSERT
FLS ACC FLL.SER.CRL.CREDITLIMITDOCUMENTDETAIL

40 ESS AUDIT.BUTTON INSERT
FLS ACC FLL.SER.CRL.CREDITLIMITDOCUMENTDETAIL

41 ESS .EDIT.BUTTON INSERT
FLS ACC FLL.SER.CRL.CREDITLIMITDOCUMENTDETAIL

42 ESS VIEW.BUTTON INSERT
FLS ACC

43 ESS FLL.SER.CRL.CREDITLIMITDOCUMENTS.TAB INSERT
EDIT_DET | CNLNCE_ADC_EDIT_01|XVL_CR_LMT_UTL_A

44 AILS MT_PRIM|NA INSERT
EDIT_DET | CNLSCE_ADC_EDIT_01|]XVL_CR_LMT_UTL_A

45 AILS MT_PRIM|NA INSERT
EDIT_DET | CNLNOE_ADC_EDIT_01|]XVL_CR_LMT_UTL_A

46 AILS MT_PRIM|NA INSERT
EDIT_DET | CNLNCE_ADC_EDIT_01|XVL_CR_LMT_UTL_A

47 AILS MT_2NDRY|NA INSERT
EDIT_DET | CNLSCE_ADC _EDIT_01|]XVL_CR_LMT_UTL_A

48 AILS MT_2NDRY|NA INSERT
EDIT_DET | CNLNOE_ADC_EDIT_01|XVL_CR_LMT_UTL_A

49 AILS MT_2NDRY|NA INSERT
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EDIT_DET | CNLNCE_ADC_EDIT_01|XVL_CR_LMT_UTL_A

50 AILS MT_SPOUSE|NA INSERT
EDIT_DET | CNLSCE_ADC_EDIT_O01|]XVL_CR_LMT_UTL_A

51 AILS MT_SPOUSE|NA INSERT
EDIT_DET | CNLNOE_ADC _EDIT 01|]XVL_CR_LMT _UTL_A

52 AILS MT_SPOUSE|NA INSERT
EDIT_DET | CNLNCE_ADC_EDIT_01|XVL_CR_LMT_UTL_A

53 AILS MT_COS|NA INSERT
EDIT_DET | CNLSCE_ADC_EDIT_01|XVL_CR_LMT_UTL_A

54 AILS MT_COSI|NA INSERT
EDIT_DET | CNLNOE_ADC_EDIT_01|]XVL_CR_LMT_UTL_A

55 AILS MT_COS|NA INSERT
EDIT_DET | CNLNCE_ADC_EDIT_01|XVL_CR_LMT_UTL_A

56 AILS MT_SPOUSE_COS1|NA INSERT
EDIT_DET | CNLSCE_ADC_EDIT_01|]XVL_CR_LMT_UTL_A

57 AILS MT_SPOUSE_COS1|NA INSERT
EDIT_DET | CNLNOE_ADC_EDIT_01|XVL_CR_LMT_UTL_A

58 AILS MT_SPOUSE_COS1|NA INSERT
EDIT_DET | CNLNCE_ADC_EDIT_01|XVL_CR_LMT_UTL_A

59 AILS MT_COS2|NA INSERT
EDIT_DET | CNLSCE_ADC_EDIT_01|]XVL_CR_LMT_UTL_A

60 AILS MT_COS2|NA INSERT
EDIT_DET | CNLNOE_ADC_EDIT_01|]XVL_CR_LMT_UTL_A

61 AILS MT_COS2|NA INSERT
EDIT_DET | CNLNCE_ADC_EDIT_01|XVL_CR_LMT_UTL_A

62 AILS MT_SPOUSE_COS2|NA INSERT
EDIT_DET | CNLSCE_ADC _EDIT_01|]XVL_CR_LMT_UTL_A

63 AILS MT_SPOUSE_COS2|NA INSERT
EDIT_DET | CNLNOE_ADC_EDIT_01|]XVL_CR_LMT_UTL_A

64 AILS MT_SPOUSE_COS2|NA INSERT
EDIT_DET | CNLNCE_ADC_EDIT_01|XVL_CR_LMT_UTL_A

65 AILS MT_BUS|NA INSERT
EDIT_DET | CNLSCE_ADC_EDIT_01|]XVL_CR_LMT_UTL_A

66 AILS MT_BUS|NA INSERT

2-188 ORACLE

Financial Services



Sl. No | Table Key Data Type
EDIT_DET | CNLNOE_ADC _EDIT 01|]XVL_CR_LMT _UTL_A

67 AILS MT_BUS|NA INSERT
EDIT_DET | CNLNCE_ADC_EDIT_01|CHD_CR_LMT_EXP_D

68 AILS T_PRIM|NA INSERT
EDIT_DET | CNLSCE_ADC _EDIT _01|CHD_CR _LMT_EXP_D

69 AILS T_PRIM|NA INSERT
EDIT_DET | CNLNOE_ADC_EDIT_01|CHD_CR_LMT_EXP_D

70 AILS T_PRIM|NA INSERT
EDIT_DET | CNLNCE_ADC_EDIT_01|CHD_CR_LMT_EXP_D

71 AILS T_2NDRY|NA INSERT
EDIT_DET | CNLSCE_ADC_EDIT_01|CHD_CR_LMT_EXP_D

72 AILS T_2NDRY|NA INSERT
EDIT_DET | CNLNOE_ADC_EDIT_01|CHD_CR_LMT_EXP_D

73 AILS T_2NDRY|NA INSERT
EDIT_DET | CNLNCE_ADC_EDIT_01|CHD_CR_LMT_EXP_D

74 AILS T_SPOUSE|NA INSERT
EDIT_DET | CNLSCE_ADC_EDIT_01|CHD_CR_LMT_EXP_D

75 AILS T_SPOUSE|NA INSERT
EDIT_DET | CNLNOE_ADC_EDIT_01|CHD_CR_LMT_EXP_D

76 AILS T_SPOUSE|NA INSERT
EDIT_DET | CNLNCE_ADC_EDIT_01|CHD_CR_LMT_EXP_D

77 AILS T_COS|NA INSERT
EDIT_DET | CNLSCE_ADC_EDIT_01|CHD_CR_LMT_EXP_D

78 AILS T_COS|NA INSERT
EDIT_DET | CNLNOE_ADC_EDIT_01|CHD_CR_LMT_EXP_D

79 AILS T_COS|NA INSERT
EDIT_DET | CNLNCE_ADC_EDIT_01|CHD_CR_LMT_EXP_D

80 AILS T_SPOUSE_COS1|NA INSERT
EDIT_DET | CNLSCE_ADC_EDIT_01|CHD_CR_LMT_EXP_D

81 AILS T_SPOUSE_COS1|NA INSERT
EDIT_DET | CNLNOE_ADC_EDIT _01|CHD_CR_LMT_EXP_D

82 AILS T_SPOUSE_COS1|NA INSERT
EDIT_DET | CNLNCE_ADC_EDIT_01|CHD_CR_LMT_EXP_D

83 AILS T _COS2|NA INSERT
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EDIT_DET | CNLSCE_ADC EDIT _01|CHD_CR _LMT_EXP_D

84 AILS T _COS2|NA INSERT
EDIT_DET | CNLNOE_ADC_EDIT_01|CHD_CR_LMT_EXP_D

85 AILS T_COS2|NA INSERT
EDIT_DET | CNLNCE_ADC_EDIT_01|CHD_CR_LMT_EXP_D

86 AILS T _SPOUSE_COS2|NA INSERT
EDIT_DET | CNLSCE_ADC_EDIT_01|CHD_CR_LMT_EXP_D

87 AILS T_SPOUSE_COS2|NA INSERT
EDIT_DET | CNLNOE_ADC_EDIT_01|CHD_CR_LMT_EXP_D

88 AILS T_SPOUSE_COS2|NA INSERT
EDIT_DET | CNLNCE_ADC_EDIT_01|CHD_CR_LMT_EXP_D

89 AILS T_BUS|NA INSERT
EDIT_DET | CNLSCE_ADC_EDIT_01|CHD_CR_LMT_EXP_D

90 AILS T_BUS|NA INSERT
EDIT_DET | CNLNOE_ADC_EDIT_01|CHD_CR_LMT_EXP_D

91 AILS T_BUS|NA INSERT
EDIT_DET | CNLNCE_CON_EDIT_01|CHD_CR_LMT_MAT_D

92 AILS T_PRIM|NA INSERT
EDIT_DET | CNLSCE_CON_EDIT_01|CHD_CR_LMT_MAT_D

93 AILS T_PRIM|NA INSERT
EDIT_DET | CNLNOE_CON_EDIT_01|CHD_CR_LMT_MAT_

94 AILS DT_PRIM|NA INSERT
EDIT_DET | CNLNCE_CON_EDIT_01|CHD_CR_LMT_MAT_D

95 AILS T_2NDRY|NA INSERT
EDIT_DET | CNLSCE_CON_EDIT_01|CHD_CR_LMT_MAT_D

96 AILS T_2NDRY|NA INSERT
EDIT_DET | CNLNOE_CON_EDIT_01|CHD_CR_LMT_MAT _

97 AILS DT_2NDRY|NA INSERT
EDIT_DET | CNLNCE_CON_EDIT_01|CHD_CR_LMT_MAT_D

98 AILS T_SPOUSE|NA INSERT
EDIT_DET | CNLSCE_CON_EDIT_01|CHD_CR_LMT_MAT_D

99 AILS T_SPOUSE|NA INSERT
EDIT_DET | CNLNOE_CON_EDIT_01|CHD_CR_LMT_MAT _

100 AILS DT_SPOUSE|NA INSERT
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EDIT_DET | CNLNCE_CON_EDIT _01|CHD_CR_LMT_MAT D

101 AILS T_COS|NA INSERT
EDIT_DET | CNLSCE_CON_EDIT_01|CHD_CR_LMT_MAT_D

102 AILS T_COS|NA INSERT
EDIT_DET | CNLNOE_CON_EDIT_01|CHD_CR_LMT_MAT _

103 AILS DT_COS|NA INSERT
EDIT_DET | CNLNCE_CON_EDIT_01|CHD_CR_LMT_MAT_D

104 AILS T_SPOUSE_COS1|NA INSERT
EDIT_DET | CNLSCE_CON_EDIT_01|CHD_CR_LMT_MAT_D

105 AILS T_SPOUSE_COS1|NA INSERT
EDIT_DET | CNLNOE_CON_EDIT_01|CHD_CR_LMT_MAT _

106 AILS DT_SPOUSE_COSI1|NA INSERT
EDIT_DET | CNLNCE_CON_EDIT_01|CHD_CR_LMT_MAT_D

107 AILS T_COS2|NA INSERT
EDIT_DET | CNLSCE_CON_EDIT_O01|CHD_CR_LMT_MAT_D

108 AILS T_COS2|NA INSERT
EDIT_DET | CNLNOE_CON_EDIT_01|CHD_CR_LMT_MAT_

109 AILS DT_COS2|NA INSERT
EDIT_DET | CNLNCE_CON_EDIT_01|CHD_CR_LMT_MAT_D

110 AILS T_SPOUSE_COS2|NA INSERT
EDIT_DET | CNLSCE_CON_EDIT_01|CHD_CR_LMT_MAT_D

111 AILS T_SPOUSE_COS2|NA INSERT
EDIT_DET | CNLNOE_CON_EDIT_01|CHD_CR_LMT_MAT _

112 AILS DT_SPOUSE_COS2|NA INSERT
EDIT_DET | CNLNCE_CON_EDIT_01|CHD_CR_LMT_MAT_D

113 AILS T_BUS|NA INSERT
EDIT_DET | CNLSCE_CON_EDIT_01|CHD_CR_LMT_MAT_D

114 AILS T_BUS|NA INSERT
EDIT_DET | CNLNOE_CON_EDIT_01|CHD_CR_LMT_MAT _

115 AILS DT_BUS|NA INSERT
EDIT_DET | CNLNCE_ADC_EDIT_01|XVL_CR_LMT_TOTAL__

116 AILS UTIL_AMT|NA INSERT
EDIT_DET | CNLSCE_ADC_EDIT_01|XVL_CR_LMT_TOTAL_

117 AILS UTIL_AMT|NA INSERT
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EDIT_DET | CNLNOE_ADC EDIT _01|]XVL_CR_LMT_TOTAL

118 AILS _UTIL_AMT|NA INSERT
EDIT_DET | CNLNCE_API_EDIT_01|CHD_CR_LMT_EXP_DT

119 AILS _PRIM|NA INSERT
EDIT_DET | CNLNCE_API_EDIT 01|CHD_CR_LMT_EXP_DT

120 AILS _SPOUSE|NA INSERT
EDIT_DET | CNLNCE_API_EDIT_01|CHD_CR_LMT_EXP_DT

121 AILS _BUSINA INSERT
EDIT_DET | CNLNCE_API_EDIT_01|CHD_CR_LMT_EXP_DT

122 AILS _2NDRY|NA INSERT
EDIT_DET | CNLNCE_API_EDIT_01|CHD_CR_LMT_EXP_DT

123 AILS _COS|INA INSERT
EDIT_DET | CNLNCE_API_EDIT_01|CHD_CR_LMT_EXP_DT

124 AILS _COS2|NA INSERT
EDIT_DET | CNLNCE_API_EDIT_01|CHD_CR_LMT_EXP_DT

125 AILS _SPOUSE_COS1|NA INSERT
EDIT_DET | CNLNCE_API_EDIT_01|CHD_CR_LMT_EXP_DT

126 AILS _SPOUSE_COS2|NA INSERT
EDIT_DET | CNLNCE_API_EDIT_01|]XVL_CR_LMT_TOTAL _

127 AILS UTIL_AMT|NA INSERT
EDIT_DET | CNLNCE_API_EDIT_01|XVL_CR_LMT_UTL_AM

128 AILS T_2NDRY|NA INSERT
EDIT_DET | CNLNCE_API_EDIT_01|]XVL_CR_LMT_UTL_AM

129 AILS T_BUS|NA INSERT
EDIT_DET | CNLNCE_API_EDIT_O01|XVL_CR_LMT_UTL_AM

130 AILS T_COS|NA INSERT
EDIT_DET | CNLNCE_API_EDIT_01|]XVL_CR_LMT_UTL_AM

131 AILS T_COS2|NA INSERT
EDIT_DET | CNLNCE_API_EDIT_O01|XVL_CR_LMT_UTL_AM

132 AILS T_PRIM|NA INSERT
EDIT_DET | CNLNCE_API_EDIT_01|XVL_CR_LMT_UTL_AM

133 AILS T_SPOUSE|NA INSERT
EDIT_DET | CNLNCE_API_EDIT_01|XVL_CR_LMT_UTL_AM

134 AILS T _SPOUSE_COS1|NA INSERT
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EDIT_DET | CNLNCE_API_EDIT _01|XVL_CR_LMT _UTL_AM

135 AILS T _SPOUSE_COS2|NA INSERT
EDIT_DET | CNLNCE_API_EDIT_O01|CHD_CR_LMT_MAT_DT

136 AILS _2NDRY|NA INSERT
EDIT_DET | CNLNCE_API_EDIT _01|CHD_CR_LMT_MAT_DT

137 AILS _BUS|NA INSERT
EDIT_DET | CNLNCE_API_EDIT_01|CHD_CR_LMT_MAT_DT

138 AILS _COSINA INSERT
EDIT_DET | CNLNCE_API_EDIT_01|CHD_CR_LMT_MAT_DT

139 AILS _COS2|NA INSERT
EDIT_DET | CNLNCE_API_EDIT_O01|CHD_CR_LMT_MAT_DT

140 AILS _PRIM|NA INSERT
EDIT_DET | CNLNCE_API_EDIT_01|CHD_CR_LMT_MAT_DT

141 AILS _SPOUSE|NA INSERT
EDIT_DET | CNLNCE_API_EDIT_O01|CHD_CR_LMT_MAT_DT

142 AILS _SPOUSE_COS1|NA INSERT
EDIT_DET | CNLNCE_API_EDIT_01|CHD_CR_LMT_MAT_DT

143 AILS _SPOUSE_COS2|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_01|CHD_CR_LMT_EXP_DT

144 AILS _PRIM|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_01|CHD_CR_LMT_EXP_DT

145 AILS _SPOUSE|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_01|CHD_CR_LMT_EXP_DT

146 AILS _BUS|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_01|CHD_CR_LMT_EXP_DT

147 AILS _2NDRY|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_01|CHD_CR_LMT_EXP_DT

148 AILS _COS|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_01|CHD_CR_LMT_EXP_DT

149 AILS _COS2|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_01|CHD_CR_LMT_EXP_DT

150 AILS _SPOUSE_COS1|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_01|CHD_CR_LMT_EXP_DT

151 AILS _SPOUSE_COS2|NA INSERT
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EDIT_DET | CNLNOE_API_EDIT_01|XVL_CR_LMT_TOTAL_

152 AILS UTIL_AMT|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_O01|]XVL_CR_LMT_UTL_AM

153 AILS T_2NDRY|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_01|]XVL_CR_LMT_UTL_AM

154 AILS T_BUS|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_O01|]XVL_CR_LMT_UTL_AM

155 AILS T_COS|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_01|XVL_CR_LMT_UTL_AM

156 AILS T_COS2|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_O1|]XVL_CR_LMT_UTL_AM

157 AILS T_PRIM|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_01|XVL_CR_LMT_UTL_AM

158 AILS T_SPOUSE|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_O1|]XVL_CR_LMT_UTL_AM

159 AILS T_SPOUSE_COS1|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_01|XVL_CR_LMT_UTL_AM

160 AILS T_SPOUSE_COS2|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_01|CHD_CR_LMT_MAT_D

161 AILS T_2NDRY|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_O01|CHD_CR_LMT_MAT_D

162 AILS T_BUS|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_01|CHD_CR_LMT_MAT_D

163 AILS T_COS|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_01|CHD_CR_LMT_MAT_D

164 AILS T_COS2|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_01|CHD_CR_LMT_MAT_D

165 AILS T_PRIM|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_01|CHD_CR_LMT_MAT_D

166 AILS T_SPOUSE|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_01|CHD_CR_LMT_MAT_D

167 AILS T_SPOUSE_COS1|NA INSERT
EDIT_DET | CNLNOE_API_EDIT_01|CHD_CR_LMT_MAT_D

168 AILS T_SPOUSE_COS2|NA INSERT
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EDIT_DET | CNLSCE_API_EDIT_01|CHD_CR_LMT_EXP_DT

169 AILS _PRIM|NA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|CHD_CR_LMT_EXP_DT

170 AILS _SPOUSE|NA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|CHD_CR_LMT_EXP_DT

171 AILS _BUS|NA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|CHD_CR_LMT_EXP_DT

172 AILS _2NDRY|NA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|CHD_CR_LMT_EXP_DT

173 AILS _COSINA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|CHD_CR_LMT_EXP_DT

174 AILS _COS2|NA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|CHD_CR_LMT_EXP_DT

175 AILS _SPOUSE_COS1|NA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|CHD_CR_LMT_EXP_DT

176 AILS _SPOUSE_COS2|NA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|XVL_CR_LMT_TOTAL_

177 AILS UTIL_AMTI|NA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|XVL_CR_LMT_UTL_AM

178 AILS T_2NDRY|NA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|XVL_CR_LMT_UTL_AM

179 AILS T_BUS|NA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|XVL_CR_LMT_UTL_AM

180 AILS T_COS|NA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|XVL_CR_LMT_UTL_AM

181 AILS T_COS2|NA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|XVL_CR_LMT_UTL_AM

182 AILS T_PRIM|NA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|XVL_CR_LMT_UTL_AM

183 AILS T_SPOUSE|NA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|XVL_CR_LMT_UTL_AM

184 AILS T_SPOUSE_COS1|NA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|XVL_CR_LMT_UTL_AM

185 AILS T_SPOUSE_COS2|NA INSERT
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EDIT_DET | CNLSCE_API_EDIT_01|CHD_CR_LMT_MAT_DT

186 AILS _2NDRY|NA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|CHD_CR_LMT_MAT_DT

187 AILS _BUSINA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|CHD_CR_LMT_MAT_DT

188 AILS _COSI|NA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|CHD_CR_LMT_MAT_DT

189 AILS _COS2|NA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|CHD_CR_LMT_MAT_DT

190 AILS _PRIM|NA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|CHD_CR_LMT_MAT_DT

191 AILS _SPOUSE|NA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|CHD_CR_LMT_MAT_DT

192 AILS _SPOUSE_COS1|NA INSERT
EDIT_DET | CNLSCE_API_EDIT_01|CHD_CR_LMT_MAT_DT

193 AILS _SPOUSE_COS2|NA INSERT
FLEX_TAB
LE _ATTRI

194 BUTES CNB_DEC|XVL_CR_LMT_UTL_AMT_PRIM INSERT
FLEX_TAB
LE ATTRI

195 BUTES CNB_DEC|XVL_CR_LMT_UTL_AMT_2NDRY INSERT
FLEX TAB
LE ATTRI

196 BUTES CNB_DEC|XVL_CR_LMT_UTL_AMT_SPOUSE INSERT
FLEX_TAB
LE_ATTRI

197 BUTES CNB_DEC|XVL_CR_LMT_UTL_AMT_COS INSERT
FLEX_TAB
LE_ATTRI | CNB_DEC|XVL_CR_LMT_UTL_AMT_SPOUSE_

198 BUTES Cos1 INSERT
FLEX_TAB
LE_ATTRI

199 BUTES CNB_DEC|XVL_CR_LMT_UTL_AMT_COS2 INSERT
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FLEX_TAB
LE_ATTRI | CNB_DEC|XVL_CR_LMT_UTL_AMT_SPOUSE_

200 BUTES C0S2 INSERT
FLEX_TAB
LE_ATTRI

201 BUTES CNB_DEC|XVL_CR_LMT_UTL_AMT_BUS INSERT
FLEX_TAB
LE_ATTRI | CNB_DEC_ LOAN|XVL_CR _LMT _TOTAL_UTIL

202 BUTES AMT INSERT
FLEX _TAB
LE_ATTRI | CNB_DEC_LEASE|XVL_CR_LMT_TOTAL_UTIL_

203 BUTES AMT INSERT
FLEX_TAB
LE_ATTRI | CNB_DEC_LOC|XVL_CR_LMT_TOTAL_UTIL_A

204 BUTES MT INSERT
FLEX_TAB
LE ATTRI

205 BUTES INP_BMP_TNM|TNM_CRLMT_REASON_CD INSERT
FLEX_TAB
LE ATTRI

206 BUTES INP_BMP_TNM|TNM_CRLMT_AMT INSERT
FLEX TAB
LE ATTRI

207 BUTES INP_BMP_TNM|TNM_CRLMT_GRADE_CD INSERT
FLEX TAB
LE _ATTRI

208 BUTES INP_BMP_TNM|TNM_CRLMT_MAX_LC_RATE INSERT
FLEX_TAB
LE_ATTRI

209 BUTES INP_BMP_TNM|TNM_CRLMT_EXPIRY_DT INSERT
FLEX_TAB
LE_ATTRI

210 BUTES INP_BMP_TNM|TNM_CRLMT_RENEW_DT INSERT
FLEX_TAB
LE_ATTRI | SEARCH_CUS_CUSTOMERS|CUS_CRED_LIMI

211 BUTES T_MAX_AMT INSERT
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FLEX_TAB
LE_ATTRI | SEARCH_CUS CUSTOMERS|CUS_CRED_LIMI

212 BUTES T _UTILIZE_AMT INSERT
FLEX_TAB
LE_ATTRI | SEARCH_CUS CUSTOMERS|CUS_CRED_LIMI

213 BUTES T _AVAILABLE_AMT INSERT
FLEX_TAB
LE_ATTRI | SEARCH_CUS CUSTOMERS|CUS_CRED_LIMI

214 BUTES T HOLD_AMT INSERT
FLEX _TAB
LE_ATTRI | SEARCH_CUS_CUSTOMERS|CUS_CRED_LIMI

215 BUTES T _SUSPENDED_AMT INSERT
FLEX_TAB
LE_ATTRI | SEARCH_BUS_BUSINESS DETAILS|BUS_CRE

216 BUTES D _LIMIT_MAX_ AMT INSERT
FLEX_TAB
LE_ATTRI | SEARCH_BUS_ BUSINESS_DETAILS|BUS_CRE

217 BUTES D _LIMIT_UTILIZE_AMT INSERT
FLEX_TAB
LE_ATTRI | SEARCH_BUS BUSINESS_ DETAILS|BUS_CRE

218 BUTES D _LIMIT_AVAILABLE_AMT INSERT
FLEX TAB
LE_ATTRI | SEARCH_BUS BUSINESS_DETAILS|BUS_CRE

219 BUTES D _LIMIT_HOLD_AMT INSERT
FLEX TAB
LE_ATTRI | SEARCH_BUS BUSINESS DETAILS|BUS_CRE

220 BUTES D _LIMIT_SUSPENDED_AMT INSERT
FLEX_TAB
LE_ATTRI

221 BUTES CNB_DEC|CHD_CR_LMT_EXP_DT_PRIM INSERT
FLEX_TAB
LE_ATTRI

222 BUTES CNB_DEC|CHD_CR_LMT_EXP_DT_2NDRY INSERT
FLEX_TAB
LE ATTRI

223 BUTES CNB_DEC|CHD_CR_LMT_EXP_DT_SPOUSE INSERT
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FLEX_TAB
LE_ATTRI

224 BUTES CNB_DEC|CHD_CR_LMT_EXP_DT_COS INSERT
FLEX_TAB
LE_ATTRI | CNB_DEC|CHD_CR_LMT_EXP_ DT _SPOUSE_C

225 BUTES 0os1 INSERT
FLEX_TAB
LE_ATTRI

226 BUTES CNB_DEC|CHD_CR_LMT_EXP_DT_COS2 INSERT
FLEX _TAB
LE_ATTRI | CNB_DEC|CHD_CR_LMT_EXP_DT_SPOUSE_C

227 BUTES 0S2 INSERT
FLEX_TAB
LE ATTRI

228 BUTES CNB_DEC|CHD_CR_LMT_EXP_DT_BUS INSERT
FLEX_TAB
LE ATTRI

229 BUTES CNB_CON|CHD_CR_LMT_MAT_DT_PRIM INSERT
FLEX_TAB
LE ATTRI

230 BUTES CNB_CON|CHD_CR_LMT_MAT_DT_2NDRY INSERT
FLEX TAB
LE ATTRI

231 BUTES CNB_CON|CHD_CR_LMT_MAT_DT_SPOUSE INSERT
FLEX TAB
LE _ATTRI

232 BUTES CNB_CON|CHD_CR_LMT_MAT_DT_COS INSERT
FLEX_TAB
LE_ATTRI | CNB_CON|CHD_CR_LMT_MAT_DT_SPOUSE_

233 BUTES Cos1 INSERT
FLEX_TAB
LE_ATTRI

234 BUTES CNB_CON|CHD_CR_LMT_MAT_DT_CO0OS2 INSERT
FLEX_TAB
LE_ATTRI | CNB_CON|CHD_CR_LMT_MAT_DT_SPOUSE_

235 BUTES C0Ss2 INSERT
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FLEX_TAB
LE_ATTRI

236 BUTES CNB_CON|CHD_CR_LMT_MAT_DT_BUS INSERT
FLEX_TAB
LE_ATTRI | SET_SYP_SYSTEM|CUS DOT_STORAGE_DIR

237 BUTES ECTORY INSERT
FLEX_TAB
LE_ATTRI

238 BUTES API_DEC_LOAN|CHD_CR_LMT_EXP_DT PRIM | INSERT
FLEX _TAB
LE_ATTRI | API_DEC_LOAN|CHD_CR_LMT_EXP_DT_SPO

239 BUTES USE INSERT
FLEX_TAB
LE ATTRI

240 BUTES API_DEC_LOAN|CHD_CR_LMT_EXP_DT_BUS INSERT
FLEX_TAB
LE_ATTRI | API_DEC_LOAN|CHD_CR_LMT_EXP_DT_2NDR

241 BUTES Y INSERT
FLEX_TAB
LE ATTRI

242 BUTES API_DEC_LOAN|CHD_CR_LMT_EXP_DT_COS INSERT
FLEX TAB
LE ATTRI

243 BUTES API_DEC_LOAN|CHD_CR_LMT_EXP_DT_COS2 | INSERT
FLEX TAB
LE_ATTRI | API_DEC_LOAN|CHD_CR_LMT_EXP_DT_SPO

244 BUTES USE_COS1 INSERT
FLEX_TAB
LE_ATTRI | API_DEC_LOAN|CHD_CR_LMT_EXP_DT_SPO

245 BUTES USE_COS2 INSERT
FLEX_TAB
LE_ATTRI | API_DEC_LOAN|XVL_CR_LMT_TOTAL_UTIL_A

246 BUTES MT INSERT
FLEX_TAB
LE_ATTRI | API_DEC_LOAN|XVL_CR_LMT_UTL_AMT_2ND

247 BUTES RY INSERT
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FLEX_TAB
LE_ATTRI

248 BUTES API_DEC_LOAN|XVL_CR_LMT_UTL_AMT_BUS | INSERT
FLEX_TAB
LE_ATTRI

249 BUTES API_DEC_LOAN|XVL_CR_LMT_UTL_AMT_COS | INSERT
FLEX_TAB
LE_ATTRI | API_DEC _LOAN|XVL_CR_LMT _UTL _AMT_COS

250 BUTES 2 INSERT
FLEX _TAB
LE_ATTRI | API_DEC_LOAN|XVL_CR_LMT_UTL_AMT_PRI

251 BUTES M INSERT
FLEX_TAB
LE_ATTRI | API_DEC_LOAN|XVL_CR_LMT_UTL_AMT_SPO

252 BUTES USE INSERT
FLEX_TAB
LE_ATTRI | API_DEC_LOAN|XVL_CR_LMT_UTL_AMT_SPO

253 BUTES USE_COS1 INSERT
FLEX_TAB
LE_ATTRI | API_DEC_LOAN|XVL_CR_LMT_UTL_AMT_SPO

254 BUTES USE_COS2 INSERT
FLEX TAB
LE ATTRI

255 BUTES API_DEC_LOC|CHD_CR_LMT_EXP_DT_PRIM INSERT
FLEX TAB
LE_ATTRI | API_DEC_LOC|CHD_CR_LMT_EXP_DT_SPOU

256 BUTES SE INSERT
FLEX_TAB
LE_ATTRI

257 BUTES API_DEC_LOC|CHD_CR_LMT_EXP_DT_BUS INSERT
FLEX_TAB
LE_ATTRI

258 BUTES API_DEC_LOC|CHD_CR_LMT_EXP_DT_2NDRY | INSERT
FLEX_TAB
LE ATTRI

259 BUTES API_DEC_LOC|CHD_CR_LMT_EXP_DT_COS INSERT
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FLEX_TAB
LE_ATTRI

260 BUTES API_DEC_LOC|CHD_CR_LMT_EXP_DT_COS2 INSERT
FLEX_TAB
LE_ATTRI | API_DEC LOC|CHD _CR_LMT_EXP_DT_SPOU

261 BUTES SE_COs1 INSERT
FLEX_TAB
LE_ATTRI | API_DEC LOC|CHD _CR_LMT_EXP_DT_SPOU

262 BUTES SE_COS2 INSERT
FLEX _TAB
LE_ATTRI | API_DEC_LOC|XVL_CR_LMT_TOTAL_UTIL_AM

263 BUTES T INSERT
FLEX_TAB
LE_ATTRI | API_DEC_LOC|XVL_CR_LMT_UTL_AMT_2NDR

264 BUTES Y INSERT
FLEX_TAB
LE ATTRI

265 BUTES API_DEC_LOC|XVL_CR_LMT_UTL_AMT_BUS INSERT
FLEX_TAB
LE ATTRI

266 BUTES API_DEC_LOC|XVL_CR_LMT_UTL_AMT_COS INSERT
FLEX TAB
LE ATTRI

267 BUTES API_DEC_LOC|XVL_CR_LMT_UTL_AMT_COS2 | INSERT
FLEX TAB
LE _ATTRI

268 BUTES API_DEC_LOC|XVL_CR_LMT_UTL_AMT_PRIM | INSERT
FLEX_TAB
LE_ATTRI | API_DEC_LOC|XVL_CR_LMT_UTL_AMT_SPOU

269 BUTES SE INSERT
FLEX_TAB
LE_ATTRI | API_DEC_LOC|XVL_CR_LMT_UTL_AMT_SPOU

270 BUTES SE_COS1 INSERT
FLEX_TAB
LE_ATTRI | API_DEC_LOC|XVL_CR_LMT_UTL_AMT_SPOU

271 BUTES SE_COS2 INSERT
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FLEX_TAB
LE_ATTRI | API_DEC LEASE|CHD CR _LMT_EXP_DT PRI

272 BUTES M INSERT
FLEX_TAB
LE_ATTRI | API_DEC LEASE|CHD CR _LMT_EXP_DT_SPO

273 BUTES USE INSERT
FLEX_TAB
LE_ATTRI

274 BUTES API_DEC_LEASE|CHD_CR_LMT_EXP_DT_BUS | INSERT
FLEX _TAB
LE_ATTRI | API_DEC_LEASE|CHD_CR_LMT_EXP_DT_2ND

275 BUTES RY INSERT
FLEX_TAB
LE ATTRI

276 BUTES API_DEC_LEASE|CHD_CR_LMT_EXP_DT_COS | INSERT
FLEX_TAB
LE_ATTRI | API_DEC_LEASE|CHD_CR_LMT_EXP_DT_COS

277 BUTES 2 INSERT
FLEX_TAB
LE_ATTRI | API_DEC_LEASE|CHD_CR_LMT_EXP_DT_SPO

278 BUTES USE_COS1 INSERT
FLEX TAB
LE_ATTRI | API_DEC_LEASE|CHD_CR_LMT_EXP_DT_SPO

279 BUTES USE_COS2 INSERT
FLEX TAB
LE_ATTRI | API_DEC_LEASE|XVL_CR_LMT_TOTAL_UTIL_

280 BUTES AMT INSERT
FLEX_TAB
LE_ATTRI | API_DEC_LEASE|XVL_CR_LMT_UTL_AMT_2N

281 BUTES DRY INSERT
FLEX_TAB
LE_ATTRI | API_DEC _LEASE|XVL_CR_LMT_UTL_AMT_BU

282 BUTES S INSERT
FLEX_TAB
LE_ATTRI | API_DEC_LEASE|XVL_CR_LMT_UTL_AMT_CO

283 BUTES S INSERT
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FLEX_TAB
LE_ATTRI | API_DEC_LEASE[XVL_CR_LMT_UTL_AMT_CO

284 | BUTES s2 INSERT
FLEX_TAB
LE_ATTRI | API_DEC_LEASE[XVL_CR_LMT_UTL_AMT_PRI

285 | BUTES M INSERT
FLEX_TAB
LE_ATTRI | API_DEC_LEASE|XVL_CR_LMT_UTL_AMT_SP

286 | BUTES OUSE INSERT
FLEX_TAB
LE_ATTRI | API_DEC_LEASE|XVL_CR_LMT_UTL_AMT_SP

287 | BUTES OUSE_COS1 INSERT
FLEX_TAB
LE_ATTRI | API_DEC_LEASE|XVL_CR_LMT_UTL_AMT_SP

288 | BUTES OUSE_COS2 INSERT
FLEX_TAB
LE_ATTRI | API_CON_LOAN|CHD_CR_LMT_MAT_DT_2ND

289 | BUTES RY INSERT
FLEX_TAB
LE_ATTRI

290 | BUTES API_CON_LOAN|CHD_CR_LMT_MAT DT BUS | INSERT
FLEX_TAB
LE_ATTRI

291 | BUTES API_CON_LOAN|CHD_CR_LMT_MAT_DT_COS | INSERT
FLEX_TAB
LE_ATTRI | API_CON_LOAN|CHD_CR_LMT_MAT _DT_COS

292 | BUTES 2 INSERT
FLEX_TAB
LE_ATTRI

293 | BUTES API_CON_LOAN|CHD_CR_LMT_MAT_DT_PRIM | INSERT
FLEX_TAB
LE_ATTRI | API_CON_LOAN|CHD_CR_LMT_MAT DT _SPO

294 | BUTES USE INSERT
FLEX_TAB
LE_ATTRI | API_CON_LOAN|CHD_CR_LMT_MAT_DT_SPO

295 | BUTES USE_COS1 INSERT
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FLEX_TAB
LE_ATTRI | API_CON_LOAN|CHD_CR_LMT_MAT_DT_SPO

296 BUTES USE_COS2 INSERT
FLEX_TAB
LE_ATTRI | API_CON_LOC|CHD_CR_LMT_MAT _DT_2NDR

297 BUTES Y INSERT
FLEX_TAB
LE_ATTRI

298 BUTES API_CON_LOC|CHD_CR_LMT_MAT_DT_BUS INSERT
FLEX _TAB
LE ATTRI

299 BUTES API_CON_LOC|CHD_CR_LMT_MAT_DT_COS INSERT
FLEX_TAB
LE ATTRI

300 BUTES API_CON_LOC|CHD_CR_LMT_MAT_DT_COS2 | INSERT
FLEX_TAB
LE ATTRI

301 BUTES API_CON_LOC|CHD_CR_LMT_MAT_DT_PRIM INSERT
FLEX_TAB
LE_ATTRI | API_CON_LOC|CHD_CR_LMT_MAT_DT_SPOU

302 BUTES SE INSERT
FLEX TAB
LE_ATTRI | API_CON_LOC|CHD_CR_LMT_MAT_DT_SPOU

303 BUTES SE_COS1 INSERT
FLEX TAB
LE_ATTRI | API_CON_LOC|CHD_CR_LMT_MAT_DT_SPOU

304 BUTES SE_COS2 INSERT
FLEX_TAB
LE_ATTRI | API_CON_LEASE|CHD_CR_LMT_MAT_DT_2ND

305 BUTES RY INSERT
FLEX_TAB
LE_ATTRI

306 BUTES API_CON_LEASE|CHD_CR_LMT_MAT _DT_BUS | INSERT
FLEX_TAB
LE_ATTRI | API_CON_LEASE|CHD_CR_LMT_MAT_DT_CO

307 BUTES S INSERT
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FLEX_TAB
LE_ATTRI | API_CON_LEASE|CHD _CR_LMT_MAT DT _CO

308 BUTES S2 INSERT
FLEX_TAB
LE_ATTRI | API_CON_LEASE|CHD CR_LMT_MAT_DT_ PRI

309 BUTES M INSERT
FLEX_TAB
LE_ATTRI | API_CON_LEASE|CHD CR_LMT_MAT _DT_SP

310 BUTES OUSE INSERT
FLEX _TAB
LE_ATTRI | API_CON_LEASE|CHD_CR_LMT_MAT_DT_SP

311 BUTES OUSE_COs1 INSERT
FLEX_TAB
LE_ATTRI | API_CON_LEASE|CHD_CR_LMT_MAT_DT_SP

312 BUTES OUSE_CO0S2 INSERT
SYSTEM _
PARAMET | CUS_DOT_STORAGE_DIRECTORY|SET_SYP_

313 ERS SYSTEM|ALL|ALL|JALL|ALLJALL|ALLJALL INSERT
MENU_AC | FLL.SER.CRL.CUSTOMERCREDITLIMIT.MENU|

314 CESS SERVICING_MENU INSERT
ACCESS _
GRID_FUN | CUS_CRLMT_INCREASE|ACC_STATUS_CDJAL

315 CTIONS L INSERT
ACCESS _
GRID_FUN | CUS_CRLMT_INCREASE|ACC_CONDITION_CD

316 CTIONS [ALL INSERT
ACCESS _
GRID_FUN | CUS_CRLMT_DECREASE|ACC_STATUS_CDI|A

317 CTIONS LL INSERT
ACCESS _
GRID_FUN | CUS_CRLMT_DECREASE|ACC_CONDITION_C

318 CTIONS D|ALL INSERT
ACCESS _
GRID_FUN | CUS_CRLMT_HOLD_INCREASE|ACC_STATUS

319 CTIONS _CDJ|ALL INSERT
ACCESS _
GRID_FUN | CUS_CRLMT_HOLD_INCREASE|ACC_CONDITI

320 CTIONS ON_CDI|ALL INSERT
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ACCESS _
GRID_FUN | CUS_CRLMT_HOLD_DECREASE|ACC_STATU

321 CTIONS S_CDJALL INSERT
ACCESS _
GRID_FUN | CUS_CRLMT_HOLD_DECREASE|ACC_CONDIT

322 CTIONS ION_CDJ|ALL INSERT
ACCESS _
GRID_FUN | CUS_CRLMT_SUSPEND_INCREASE|ACC_STA

323 CTIONS TUS_CD|ALL INSERT
ACCESS _
GRID_FUN | CUS_CRLMT_SUSPEND_INCREASE|ACC_CON

324 CTIONS DITION_CD|ALL INSERT
ACCESS _
GRID_FUN | CUS_CRLMT_SUSPEND_DECREASE|ACC_ST

325 CTIONS ATUS_CDIJALL INSERT
ACCESS _
GRID_FUN | CUS_CRLMT_SUSPEND_DECREASE|ACC_CO

326 CTIONS NDITION_CDJALL INSERT
ACCESS _
GRID_FUN

327 CTIONS CUS_CRLMT_MAINT|ACC_STATUS_CDJALL INSERT
ACCESS _
GRID_FUN | CUS_CRLMT_MAINT|ACC_CONDITION_CDJAL

328 CTIONS L INSERT
ACCESS _
GRID_FUN | BUS_CRLMT_INCREASE|ACC_STATUS_CD|AL

329 CTIONS L INSERT
ACCESS _
GRID_FUN | BUS_CRLMT_INCREASE|JACC_CONDITION_CD

330 CTIONS |ALL INSERT
ACCESS _
GRID_FUN | BUS _CRLMT_DECREASE|JACC_STATUS_CD|A

331 CTIONS LL INSERT
ACCESS _
GRID_FUN | BUS_CRLMT_DECREASE|JACC_CONDITION_C

332 CTIONS D|ALL INSERT
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ACCESS _
GRID_FUN | BUS CRLMT_HOLD_INCREASE|ACC_STATUS

333 CTIONS _CDJALL INSERT
ACCESS _
GRID_FUN | BUS _CRLMT_HOLD_INCREASE|JACC_CONDITI

334 CTIONS ON_CDI|ALL INSERT
ACCESS _
GRID_FUN | BUS CRLMT_HOLD_DECREASE|ACC_STATUS

335 CTIONS _CDJALL INSERT
ACCESS _
GRID_FUN | BUS_CRLMT_HOLD_DECREASE|ACC_CONDIT

336 CTIONS ION_CD|ALL INSERT
ACCESS _
GRID_FUN | BUS_CRLMT_SUSPEND_INCREASE|ACC_STA

337 CTIONS TUS_CDJ|ALL INSERT
ACCESS _
GRID_FUN | BUS_CRLMT_SUSPEND_INCREASE|ACC_CON

338 CTIONS DITION_CDIJALL INSERT
ACCESS _
GRID_FUN | BUS_CRLMT_SUSPEND_DECREASE|ACC_ST

339 CTIONS ATUS_CDIJALL INSERT
ACCESS _
GRID_FUN | BUS_CRLMT_SUSPEND_DECREASE|ACC_CO

340 CTIONS NDITION_CD|ALL INSERT
ACCESS _
GRID_FUN

341 CTIONS BUS_CRLMT_MAINT|ACC_STATUS_CDI|ALL INSERT
ACCESS _
GRID_FUN

342 CTIONS BUS_CRLMT_MAINT|ACC_CONDITION_CDI|ALL | INSERT

343 LOOKUPS | CREDIT_LIMIT_REASON_CD|UNDEFINED INSERT

344 LOOKUPS | COMMENT_SUB_TYPE_CD|CUS INSERT

345 LOOKUPS | COMMENT_SUB_TYPE_CD|BUS INSERT
TRANSLA | SYS|SYS|SYS|TNM|001850|TRANSACTIONNOT
TION_DAT | APPLICABLEFORTHISACCOUNTASCREDITLIM

346 A ITISNOTENABLED|SYS|MSG-SE INSERT
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TRANSLA | SYS|SYS|SYS|TNM|001855|TRANSACTIONWILL
TION_DAT | RESULTINCREDITLIMITAVAILABLEAMOUNTLE

347 A SSTHANZERO|SYS|MSG-SE INSERT
TRANSLA | SYS|SYS|SYS|TNM|001860|TRANSACTIONWILL
TION_DAT | RESULTINCREDITLIMITHOLDAMOUNTLESSTH

348 A ANZERO|SYS|MSG-SE INSERT
TRANSLA | SYS|SYS|SYS|TNM|001865|TRANSACTIONWILL
TION_DAT | RESULTINCREDITLIMITSUSUPENDAMOUNTLE

349 A SSTHANZERO|SYS|MSG-SE INSERT
TRANSLA | SYS|SYS|SYS|ULN|001750|APPLICANTCREDIT
TION_DAT | LIMITRENEWALDATELESSTHANCURRENTDAT

350 A E|SYS|MSG-SE INSERT
TRANSLA | SYS|SYS|SYS|ULN|001752|BUSINESSCREDITLI
TION_DAT | MITRENEWALDATELESSTHANCURRENTDATE

351 A |SYS|MSG-SE INSERT
TRANSLA | SYS|SYS|SYS|TNM|001870|CREDITLIMITEXPIR
TION_DAT | YDATEANDNEXTRENEWALDATECANNOTBEL

352 A ESSTHANSYSTEMDATE|SYS|MSG-SE INSERT
TRANSLA
TION_DAT | SYS|SYS|SYS|UIX|001757[NOCUSTOMER/BUSI

353 A NESSFOUND.|SYS|MSG-SE INSERT
SYS|SYS|SYS|TXN|002005|CREDITLIMITUTILIZ

TRANSLA | ATIONAMOUNTGREATERTHANAVAILABLEAM
TION_DAT | OUNTFOR~RELATION~CUSTOMER|SYS|MSG-

354 A SE INSERT

SYS|SYS|SYS|AAI|001355|CREDITLIMITUTILIZA
TRANSLA | TIONAMOUNTGREATERTHANAVAILABLEAMO
TION_DAT | UNTFOR~RELATION~CUSTOMER|SYS|MSG-

355 A SE INSERT
SYS|SYS|SYS|ULN|001723|CONTRACTDUEDA
YORBILLCYCLENOTMATCHINGWITHCUSTOM
ERDUEDAY:BILLCYCLE:~CYCLE~ANDDUEDAY

TRANSLA | :~-DUEDAY~OFPREVIOUSLYFUNDEDAPPLICA
TION_DAT | TIONSFOREXISTINGPRIMARYCUSTOMER|SY

356 A S|MSG-SE INSERT
TRANSLA
TION_DAT | SYS|SYS|SYS|UDT|000038|INVALIDACCOUNTN

357 A UMBER|SYS|MSG-CE DELETE
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TRANSLA
TION_DAT | SYS|SYS|SYS|UDT|000711|ACCOUNTNUMBER

358 A CANNOTBEBLANK|SYS|MSG-SE DELETE
TRANSLA
TION_DAT | SYS|SYS|SYS|UDT|000719|DESTINATIONACCO

359 A UNTNUMBERCANNOTBEBLANK|SYS|MSG-SE DELETE
TRANSLA | SYS|SYS|SYS|UDT|001164|CUSTOMERIDSPEC
TION_DAT | IFIEDBYFILE~FILE_ NAME~NOTFOUND.|SYS|M

360 A SG-SE INSERT
TRANSLA | SYS|SYS|SYS|UDT|001165|BUSINESSIDSPECI
TION_DAT | FIEDBYFILE~FILE_NAME~NOTFOUND.|SYS|M

361 A SG-SE INSERT
TRANSLA | SYS|SYS|SYS|UDT|001166|COULDNOTDETER
TION_DAT | MINECUS DOT_STORAGE_DIRECTORYPARA

362 A METERVALUE|SYS|MSG-SE INSERT
TRANSLA | SYS|SYS|SYS|UDT|001167|ACCOUNT/CUSTOM
TION_DAT | ER/BUSINESSNUMBERCANNOTBEBLANK|SYS

363 A IMSG-SE INSERT
TRANSLA | SYS|SYS|SYS|UDT|001168|DESTINATIONACCO
TION_DAT | UNT/CUSTOMER/BUSINESSNUMBERCANNOT

364 A BEBLANK|SYS|MSG-SE INSERT
TRANSLA | SYS|SYS|SYS|UDT|001169|DESTINATIONCUST
TION_DAT | OMER/BUSINESSNUMBERNOTFOUNDI|SYS|M

365 A SG-SE INSERT
TRANSLA
TION_DAT | SYS|SYS|SYS|UDT|001170|CUSTOMER/BUSIN

366 A ESSNUMBERCANNOTBESAME|SYS|MSG-SE INSERT
TRANSLA | SYS|SYS|SYS|UDT|001171|CUSTOMER/BUSIN
TION_DAT | ESSSPECIFIEDNUMBERNOTFOUNDI|SYS|MSG

367 A -SE INSERT
TRANSLA
TION_DAT | SYS|SYS|SYS|UDT|001172|INVALIDACCOUNTN

368 A UMBER|SYS|MSG-SE INSERT
TRANSLA
TION_DAT | SYS|SYS|SYS|UDT|001173|INVALIDCUSTOMER

369 A NUMBER|SYS|MSG-SE INSERT
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TRANSLA
TION_DAT | SYS|SYS|SYS|UDT|001174|INVALIDBUSINESS

370 A NUMBER|SYS|MSG-SE INSERT
TRANSLA | SYS|SYS|SYS|UDT|001175|INVALIDCUSTOMER
TION_DAT | NUMBERANDACCOUNTNUMBERCOMBINATIO

371 A N|SYS|MSG-SE INSERT
TRANSLA | SYS|SYS|SYS|UDT|001176|INVALIDBUSINESS
TION_DAT | NUMBERANDACCOUNTNUMBERCOMBINATIO

372 A N|SYS|MSG-SE INSERT
TRANSLA
TION_DAT | SYS|SYS|SYS|UDT|001172|INVALIDACCOUNTN

373 A UMBER|SYS|MSG-SE INSERT
TRANSLA | SYS|SYS|SYS|UDT|000712|ACCOUNTNUMBER
TION_DAT | CANNOTBEBLANKFORFILE:~FILE_NAME~|SYS

374 A IMSG-SE DELETE
TRANSLA | SYS|SYS|SYS|UDT|000712|ACCOUNTNUMBER
TION_DAT | ANDCUSTOMER/BUSINESSNUMBERCANNOT

375 A BEBLANKFORFILE:~FILE_NAME~|SYS|MSG-SE | INSERT
FLEX_TAB

376 LES CNB_DEC INSERT
FLEX TAB

377 LES CNB_CON INSERT
LOOKUP_

378 TYPES CREDIT_LIMIT_REASON_CD INSERT
TXN_COD
E_PARAM

379 ETERS CUS_CRLMT_INCREASE|TNM_DT INSERT
TXN_COD
E_PARAM | CUS_CRLMT_INCREASE|TNM_CAR_RELATIO

380 ETERS N_TYPE_CD INSERT
TXN_COD
E_PARAM

381 ETERS CUS_CRLMT_INCREASE|TNM_CRLMT_AMT INSERT
TXN_COD
E_PARAM | CUS_CRLMT_INCREASE|TNM_CRLMT_REASO

382 ETERS N_CD INSERT
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TXN_COD
E_PARAM

383 ETERS CUS_CRLMT_DECREASE|TNM_DT INSERT
TXN_COD
E_PARAM | CUS _CRLMT_DECREASE|TNM_CAR_RELATIO

384 ETERS N _TYPE_CD INSERT
TXN_COD
E_PARAM

385 ETERS CUS_CRLMT_DECREASE|TNM_CRLMT_AMT INSERT
TXN_COD
E_PARAM | CUS_CRLMT_DECREASE|TNM_CRLMT_REAS

386 ETERS ON_CD INSERT
TXN_COD
E_PARAM

387 ETERS CUS_CRLMT_HOLD_INCREASE|TNM_DT INSERT
TXN_COD
E_PARAM | CUS_CRLMT_HOLD_INCREASE|TNM_CAR_RE

388 ETERS LATION_TYPE_CD INSERT
TXN_COD
E_PARAM | CUS_CRLMT_HOLD_INCREASE|TNM_CRLMT _

389 ETERS AMT INSERT
TXN_COD
E_PARAM | CUS_CRLMT_HOLD_INCREASE|TNM_CRLMT _

390 ETERS REASON_CD INSERT
TXN_COD
E_PARAM

391 ETERS CUS_CRLMT_HOLD_DECREASE|TNM_DT INSERT
TXN_COD
E_PARAM | CUS_CRLMT_HOLD_DECREASE|TNM_CAR_R

392 ETERS ELATION_TYPE_CD INSERT
TXN_COD
E_PARAM | CUS_CRLMT_HOLD_DECREASE|TNM_CRLMT

393 ETERS _AMT INSERT
TXN_COD
E_PARAM | CUS_CRLMT_HOLD_DECREASE|TNM_CRLMT

394 ETERS _REASON_CD INSERT
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TXN_COD
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395 ETERS CUS_CRLMT_SUSPEND_INCREASE|TNM_DT INSERT
TXN_COD
E_PARAM | CUS_CRLMT_SUSPEND_ INCREASE|TNM_CAR

396 ETERS _RELATION_TYPE_CD INSERT
TXN_COD
E_PARAM | CUS_CRLMT_SUSPEND_ INCREASE|TNM_CRL

397 ETERS MT_AMT INSERT
TXN_COD
E_PARAM | CUS_CRLMT_SUSPEND_INCREASE|TNM_CRL

398 ETERS MT_REASON_CD INSERT
TXN_COD
E_PARAM

399 ETERS CUS_CRLMT_SUSPEND_DECREASE|TNM_DT | INSERT
TXN_COD
E_PARAM | CUS_CRLMT_SUSPEND_DECREASE|TNM_CA

400 ETERS R_RELATION_TYPE_CD INSERT
TXN_COD
E_PARAM | CUS_CRLMT_SUSPEND_DECREASE|TNM_CR

401 ETERS LMT_AMT INSERT
TXN_COD
E_PARAM | CUS_CRLMT_SUSPEND_DECREASE|TNM_CR

402 ETERS LMT_REASON_CD INSERT
TXN_COD
E_PARAM

403 ETERS CUS_CRLMT_MAINT|TNM_DT INSERT
TXN_COD
E_PARAM | CUS_CRLMT_MAINT|TNM_CAR_RELATION_TY

404 ETERS PE_CD INSERT
TXN_COD
E_PARAM

405 ETERS CUS_CRLMT_MAINT|TNM_CRLMT_GRADE_CD | INSERT
TXN_COD
E_PARAM | CUS_CRLMT_MAINT|TNM_CRLMT_MAX_LC_R

406 ETERS ATE INSERT
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407 ETERS CUS_CRLMT_MAINT|TNM_CRLMT_EXPIRY_DT | INSERT
TXN_COD
E_PARAM | CUS_CRLMT_MAINT|TNM_CRLMT_RENEW_D

408 ETERS T INSERT
TXN_COD
E_PARAM

409 ETERS BUS_CRLMT_INCREASE|TNM_DT INSERT
TXN_COD
E_PARAM

410 ETERS BUS_CRLMT_INCREASE|TNM_CRLMT_AMT INSERT
TXN_COD
E_PARAM | BUS_CRLMT_INCREASE|TNM_CRLMT_REASO

411 ETERS N _CD INSERT
TXN_COD
E_PARAM

412 ETERS BUS_CRLMT_DECREASE|TNM_DT INSERT
TXN_COD
E_PARAM

413 ETERS BUS_CRLMT_DECREASE|TNM_CRLMT_AMT INSERT
TXN_COD
E_PARAM | BUS_CRLMT_DECREASE|TNM_CRLMT_REAS

414 ETERS ON_CD INSERT
TXN_COD
E_PARAM

415 ETERS BUS_CRLMT_HOLD_INCREASE|TNM_DT INSERT
TXN_COD
E_PARAM | BUS _CRLMT_HOLD_INCREASE|TNM_CRLMT_

416 ETERS AMT INSERT
TXN_COD
E_PARAM | BUS _CRLMT_HOLD_ INCREASE|TNM_CRLMT_

417 ETERS REASON_CD INSERT
TXN_COD
E_PARAM

418 ETERS BUS_CRLMT_HOLD DECREASE|TNM_DT INSERT
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TXN_COD
E_PARAM | BUS CRLMT_HOLD DECREASE|TNM_CRLMT

419 ETERS _AMT INSERT
TXN_COD
E_PARAM | BUS CRLMT_HOLD DECREASE|TNM_CRLMT

420 ETERS _REASON_CD INSERT
TXN_COD
E_PARAM

421 ETERS BUS CRLMT_SUSPEND_ INCREASE|TNM_DT INSERT
TXN_COD
E_PARAM | BUS_CRLMT_SUSPEND_INCREASE|TNM_CRL

422 ETERS MT_AMT INSERT
TXN_COD
E_PARAM | BUS_CRLMT_SUSPEND_INCREASE|TNM_CRL

423 ETERS MT_REASON_CD INSERT
TXN_COD
E_PARAM

424 ETERS BUS_CRLMT_SUSPEND_DECREASE|TNM_DT | INSERT
TXN_COD
E_PARAM | BUS_CRLMT_SUSPEND_DECREASE|TNM_CR

425 ETERS LMT_AMT INSERT
TXN_COD
E_PARAM | BUS_CRLMT_SUSPEND_DECREASE|TNM_CR

426 ETERS LMT_REASON_CD INSERT
TXN_COD
E_PARAM

427 ETERS BUS_CRLMT_MAINT|TNM_DT INSERT
TXN_COD
E_PARAM

428 ETERS BUS_CRLMT_MAINT|TNM_CRLMT_GRADE_CD | INSERT
TXN_COD
E_PARAM | BUS _CRLMT_MAINT|TNM_CRLMT_MAX LC R

429 ETERS ATE INSERT
TXN_COD
E_PARAM

430 ETERS BUS_ CRLMT_MAINT|TNM_CRLMT_EXPIRY_DT | INSERT
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431 ETERS BUS_CRLMT_MAINT|TNM_CRLMT_RENEW_DT | INSERT
TXN_COD UPDAT

432 ES CUS_EMPL_MAINT E
TXN_COD

433 ES CUS_CRLMT_INCREASE INSERT
TXN_COD

434 ES CUS_CRLMT_DECREASE INSERT
TXN_COD

435 ES CUS_CRLMT_HOLD_ INCREASE INSERT
TXN_COD

436 ES CUS_CRLMT_HOLD_ DECREASE INSERT
TXN_COD

437 ES CUS_CRLMT_SUSPEND_ INCREASE INSERT
TXN_COD

438 ES CUS_CRLMT_SUSPEND_ DECREASE INSERT
TXN_COD

439 ES CUS_CRLMT_MAINT INSERT
TXN_COD

440 ES BUS_CRLMT_INCREASE INSERT
TXN_COD

441 ES BUS CRLMT_DECREASE INSERT
TXN_COD

442 ES BUS_ CRLMT_HOLD INCREASE INSERT
TXN_COD

443 ES BUS _CRLMT_HOLD DECREASE INSERT
TXN_COD

444 ES BUS CRLMT_SUSPEND_ INCREASE INSERT
TXN_COD

445 ES BUS CRLMT_SUSPEND_DECREASE INSERT
TXN_COD

446 ES BUS_ CRLMT_MAINT INSERT
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447

TXN_COD
E_PRODU
CTS

CUS_CRLMT_INCREASE|ALL|ALL|ALL

INSERT

448

TXN_COD
E_PRODU
CTS

CUS_CRLMT_DECREASE|ALL|ALL|ALL

INSERT

449

TXN_COD
E_PRODU
CTS

CUS_CRLMT_HOLD_INCREASE|ALL|ALL|ALL

INSERT

450

TXN_COD
E_PRODU
CTS

CUS_CRLMT_HOLD_DECREASE|ALL|ALL|ALL

INSERT

451

TXN_COD
E_PRODU
CTS

CUS_CRLMT_SUSPEND_INCREASE|ALL|ALL|A
LL

INSERT

452

TXN_COD
E_PRODU
CTS

CUS_CRLMT_SUSPEND_DECREASE|ALL|ALL|
ALL

INSERT

453

TXN_COD
E_PRODU
CTS

CUS_CRLMT_MAINT|ALL|ALL|ALL

INSERT

454

TXN_COD
E_PRODU
CTS

BUS_CRLMT_INCREASE|ALL|ALL|ALL

INSERT

455

TXN_COD
E_PRODU
CTS

BUS_CRLMT_DECREASE|ALL|ALL|ALL

INSERT

456

TXN_COD
E_PRODU
CTS

BUS_CRLMT_HOLD_INCREASE|ALL|ALLJALL

INSERT

457

TXN_COD
E_PRODU
CTS

BUS_CRLMT_HOLD_DECREASEJALLJALLJALL

INSERT

458

TXN_COD
E_PRODU
CTS

BUS_CRLMT_SUSPEND_INCREASE|ALL|ALL|A
LL

INSERT
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TXN_COD
E_PRODU | BUS CRLMT_SUSPEND_ DECREASE|ALL|ALL|

459 CTS ALL INSERT
TXN_COD
E_PRODU

460 CTS BUS_CRLMT_MAINT|ALLJALLJALL INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOAN|CHD _CR_LMT_MAT DT _ PRI

461 BUTES M INSERT
FLEX _TAB
LE_ATTRI | CNB_CON_LEASE|CHD_CR_LMT_MAT_DT_PR

462 BUTES IM INSERT
FLEX_TAB
LE ATTRI

463 BUTES CNB_CON_LOC|CHD_CR_LMT_MAT_DT_PRIM | INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOAN|XVL_CR_LMT_UTL_AMT_PRI

464 BUTES M INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LEASE|XVL_CR_LMT_UTL_AMT_P

465 BUTES RIM INSERT
FLEX TAB
LE_ATTRI | CNB_CON_LOC|XVL_CR_LMT_UTL_AMT_PRI

466 BUTES M INSERT
FLEX TAB
LE_ATTRI | CNB_CON_LOAN|CHD_CR_LMT_EXP_DT_PRI

467 BUTES M INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LEASE|CHD_CR_LMT_EXP_DT_PRI

468 BUTES M INSERT
FLEX_TAB
LE_ATTRI

469 BUTES CNB_CON_LOC|CHD_CR_LMT_EXP_DT_PRIM | INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOAN|XVL_CON_SAME_DUE_DAY_

470 BUTES CYCLE INSERT
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FLEX_TAB
LE_ATTRI | CNB_CON_LEASE|XVL_CON_SAME_DUE_DAY

471 BUTES _CYCLE INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOC|XVL_CON_SAME_DUE_DAY _

472 BUTES CYCLE INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOAN|CHD _CR_LMT_MAT DT 2ND

473 BUTES RY INSERT
FLEX _TAB
LE_ATTRI | CNB_CON_LEASE|CHD_CR_LMT_MAT_DT_2N

474 BUTES DRY INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOC|CHD_CR_LMT_MAT_DT_2NDR

475 BUTES Y INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOAN|CHD_CR_LMT_MAT_DT_SP

476 BUTES OUSE INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LEASE|CHD_CR_LMT_MAT_DT_SP

477 BUTES OUSE INSERT
FLEX TAB
LE_ATTRI | CNB_CON_LOC|CHD_CR_LMT_MAT_DT_SPO

478 BUTES USE INSERT
FLEX TAB
LE_ATTRI | CNB_CON_LOAN|CHD_CR_LMT_MAT_DT_CO

479 BUTES S INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LEASE|CHD_CR_LMT_MAT _DT_CO

480 BUTES S INSERT
FLEX_TAB
LE_ATTRI

481 BUTES CNB_CON_LOC|CHD_CR_LMT_MAT_DT_COS | INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOAN|CHD_CR_LMT_MAT_DT_SP

482 BUTES OUSE_COS1 INSERT
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FLEX_TAB
LE_ATTRI | CNB_CON_LEASE|CHD_CR_LMT_MAT DT_SP

483 BUTES OUSE_COs1 INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOC|CHD_CR _LMT_MAT DT _SPO

484 BUTES USE_COS1 INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOAN|CHD _CR_LMT_MAT DT _CO

485 BUTES S2 INSERT
FLEX _TAB
LE_ATTRI | CNB_CON_LEASE|CHD_CR_LMT_MAT_DT_CO

486 BUTES S2 INSERT
FLEX_TAB
LE ATTRI

487 BUTES CNB_CON_LOC|CHD_CR_LMT_MAT_DT_COS2 | INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOAN|CHD_CR_LMT_MAT_DT_SP

488 BUTES OUSE_CO0S2 INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LEASE|CHD_CR_LMT_MAT_DT_SP

489 BUTES OUSE_CO0S2 INSERT
FLEX TAB
LE_ATTRI | CNB_CON_LOC|CHD_CR_LMT_MAT_DT_SPO

490 BUTES USE_COS2 INSERT
FLEX TAB
LE _ATTRI

491 BUTES CNB_CON_LOAN|CHD_CR_LMT_MAT_DT_BUS | INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LEASE|CHD_CR_LMT_MAT_DT_BU

492 BUTES S INSERT
FLEX_TAB
LE_ATTRI

493 BUTES CNB_CON_LOC|CHD_CR_LMT_MAT_DT_BUS INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOAN|XVL_CR_LMT_UTL_AMT_SP

494 BUTES OUSE INSERT
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FLEX_TAB
LE_ATTRI | CNB_CON_LEASE|XVL_CR_LMT _UTL _AMT_S

495 BUTES POUSE INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOC|XVL_CR_LMT _UTL_AMT_SPO

496 BUTES USE INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOAN|XVL _CR_LMT_UTL_AMT_2N

497 BUTES DRY INSERT
FLEX _TAB
LE_ATTRI | CNB_CON_LEASE|XVL_CR_LMT_UTL_AMT_2N

498 BUTES DRY INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOC|XVL_CR_LMT_UTL_AMT_2ND

499 BUTES RY INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOAN|XVL_CR_LMT_UTL_AMT_CO

500 BUTES S INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LEASE|XVL_CR_LMT_UTL_AMT_C

501 BUTES (ON INSERT
FLEX TAB
LE ATTRI

502 BUTES CNB_CON_LOC|XVL_CR_LMT_UTL_AMT_COS | INSERT
FLEX TAB
LE_ATTRI | CNB_CON_LOAN|XVL_CR_LMT_UTL_AMT_SP

503 BUTES OUSE_COs1 INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LEASE|XVL_CR_LMT_UTL_AMT_S

504 BUTES POUSE_COS1 INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOC|XVL_CR_LMT_UTL_AMT_SPO

505 BUTES USE_COS1 INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOAN|XVL_CR_LMT_UTL_AMT_CO

506 BUTES S2 INSERT
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FLEX_TAB
LE_ATTRI | CNB_CON_LEASE|XVL_CR_LMT UTL AMT_C

507 BUTES 0Ss2 INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOC|XVL_CR _LMT _UTL_AMT_COS

508 BUTES 2 INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOAN|XVL _CR_LMT _UTL_AMT_SP

509 BUTES OUSE_CO0S2 INSERT
FLEX _TAB
LE_ATTRI | CNB_CON_LEASE|XVL_CR_LMT_UTL_AMT_S

510 BUTES POUSE_COS2 INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOC|XVL_CR_LMT_UTL_AMT_SPO

511 BUTES USE_COS2 INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOAN|XVL_CR_LMT_UTL_AMT_BU

512 BUTES S INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LEASE|XVL_CR_LMT_UTL_AMT_B

513 BUTES us INSERT
FLEX TAB
LE ATTRI

514 BUTES CNB_CON_LOC|XVL_CR_LMT_UTL_AMT_BUS | INSERT
FLEX TAB
LE_ATTRI | CNB_CON_LOAN|CHD_CR_LMT_EXP_DT_2ND

515 BUTES RY INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LEASE|CHD_CR_LMT_EXP_DT_ 2N

516 BUTES DRY INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOC|CHD_CR_LMT_EXP_DT_2NDR

517 BUTES Y INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOAN|CHD_CR_LMT_EXP_DT_SPO

518 BUTES USE INSERT
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FLEX_TAB
LE_ATTRI | CNB_CON_LEASE|CHD_CR_LMT_EXP_DT_SP

519 BUTES OUSE INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOC|CHD_CR_LMT_EXP_DT_SPOU

520 BUTES SE INSERT
FLEX_TAB
LE_ATTRI

521 BUTES CNB_CON_LOAN|CHD_CR_LMT_EXP_DT_COS | INSERT
FLEX _TAB
LE_ATTRI | CNB_CON_LEASE|CHD_CR_LMT_EXP_DT_CO

522 BUTES S INSERT
FLEX_TAB
LE ATTRI

523 BUTES CNB_CON_LOC|CHD_CR_LMT_EXP_DT_COS INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOAN|CHD_CR_LMT_EXP_DT_SPO

524 BUTES USE_COS1 INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LEASE|CHD_CR_LMT_EXP_DT_SP

525 BUTES OUSE_CoOs1 INSERT
FLEX TAB
LE_ATTRI | CNB_CON_LOC|CHD_CR_LMT_EXP_DT_SPOU

526 BUTES SE_COS1 INSERT
FLEX TAB
LE_ATTRI | CNB_CON_LOAN|CHD_CR_LMT_EXP_DT_COS

527 BUTES 2 INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LEASE|CHD_CR_LMT_EXP_DT_CO

528 BUTES S2 INSERT
FLEX_TAB
LE_ATTRI

529 BUTES CNB_CON_LOC|CHD_CR_LMT_EXP_DT_COS2 | INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOAN|CHD_CR_LMT_EXP_DT_SPO

530 BUTES USE_COS2 INSERT
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FLEX_TAB
LE_ATTRI | CNB_CON_LEASE|CHD_CR_LMT_EXP_DT_SP

531 BUTES OUSE_CO0S2 INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOC|CHD_CR _LMT_EXP_DT_SPOU

532 BUTES SE_COS2 INSERT
FLEX_TAB
LE_ATTRI

533 BUTES CNB_CON_LOAN|CHD_CR_LMT_EXP_DT_BUS | INSERT
FLEX _TAB
LE_ATTRI | CNB_CON_LEASE|CHD_CR_LMT_EXP_DT_BU

534 BUTES S INSERT
FLEX_TAB
LE ATTRI

535 BUTES CNB_CON_LOC|CHD_CR_LMT_EXP_DT_BUS INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LOANI|XVL_CR_LMT_TOTAL_UTIL_

536 BUTES AMT INSERT
FLEX_TAB
LE_ATTRI | CNB_CON_LEASE|XVL_CR_LMT_TOTAL_UTIL

537 BUTES _AMT INSERT
FLEX TAB
LE_ATTRI | CNB_CON_LOC|XVL_CR_LMT_TOTAL_UTIL_A

538 BUTES MT INSERT
EDIT_DET | CNLNCE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

539 AILS T_PRIM|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

540 AILS T_PRIM|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

541 AILS T_PRIM|NA INSERT
EDIT_DET | CNLNCE_ACX_EDIT_01|]XVL_CR_LMT_UTL_A

542 AILS MT_PRIM|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|XVL_CR_LMT_UTL_A

543 AILS MT_PRIM|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|XVL_CR_LMT_UTL_A

544 AILS MT_PRIM|NA INSERT

2-224 ORACLE

Financial Services




Sl. No | Table Key Data Type
EDIT_DET | CNLNCE_ACX EDIT _01|CHD_CR _LMT_EXP_D

545 AILS T_PRIM|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|CHD_CR_LMT_EXP_D

546 AILS T_PRIM|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|CHD_CR_LMT_EXP_D

547 AILS T_PRIM|NA INSERT
EDIT_DET | CNLNCE_ACX_EDIT_01|]XVL_CR_LMT_TOTAL_

548 AILS UTIL_AMT|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|XVL_CR_LMT_TOTAL_

549 AILS UTIL_AMTI|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|XVL_CR_LMT_TOTAL_

550 AILS UTIL_AMT|NA INSERT
EDIT_DET | CNLNCE_ACX_EDIT_01|XVL_CON_SAME_DUE

551 AILS _DAY_CYCLE|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|XVL_CON_SAME_DUE

552 AILS _DAY_CYCLE|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|XVL_CON_SAME_DUE

553 AILS _DAY_CYCLE|NA INSERT
EDIT_DET | CNLNCE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

554 AILS T_2NDRY|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

555 AILS T_2NDRY|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

556 AILS T_2NDRY|NA INSERT
EDIT_DET | CNLNCE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

557 AILS T_SPOUSE|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

558 AILS T_SPOUSE|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

559 AILS T_SPOUSE|NA INSERT
EDIT_DET | CNLNCE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

560 AILS T_COS|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

561 AILS T_COS|NA INSERT
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EDIT_DET | CNLNOE_ACX_EDIT_01|CHD_CR_LMT_MAT D

562 AILS T_COS|NA INSERT
EDIT_DET | CNLNCE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

563 AILS T_SPOUSE_COS1|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT _01|CHD_CR_LMT_MAT D

564 AILS T _SPOUSE_COS1|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

565 AILS T_SPOUSE_COS1|NA INSERT
EDIT_DET | CNLNCE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

566 AILS T_COS2|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

567 AILS T_COS2|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

568 AILS T_COS2|NA INSERT
EDIT_DET | CNLNCE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

569 AILS T_SPOUSE_COS2|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

570 AILS T_SPOUSE_COS2|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

571 AILS T_SPOUSE_COS2|NA INSERT
EDIT_DET | CNLNCE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

572 AILS T_BUS|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

573 AILS T_BUS|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|CHD_CR_LMT_MAT_D

574 AILS T_BUS|NA INSERT
EDIT_DET | CNLNCE_ACX EDIT_01|]XVL_CR_LMT_UTL_A

575 AILS MT_SPOUSE|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|XVL_CR_LMT_UTL_A

576 AILS MT_SPOUSE|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|XVL_CR_LMT_UTL_A

577 AILS MT_SPOUSE|NA INSERT
EDIT_DET | CNLNCE_ACX_EDIT_01|]XVL_CR_LMT_UTL_A

578 AILS MT_2NDRY|NA INSERT
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EDIT_DET | CNLSCE_ACX_EDIT_01|XVL_CR_LMT_UTL_A

579 AILS MT_2NDRY|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|XVL_CR_LMT_UTL_A

580 AILS MT_2NDRY|NA INSERT
EDIT_DET | CNLNCE_ACX EDIT_01j]XVL_CR_LMT_UTL_A

581 AILS MT_COSI|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|XVL_CR_LMT_UTL_A

582 AILS MT_COS|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|XVL_CR_LMT_UTL_A

583 AILS MT_COSI|NA INSERT
EDIT_DET | CNLNCE_ACX_EDIT_O01|]XVL_CR_LMT_UTL_A

584 AILS MT_SPOUSE_COS1|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|XVL_CR_LMT_UTL_A

585 AILS MT_SPOUSE_COS1|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|XVL_CR_LMT_UTL_A

586 AILS MT_SPOUSE_COS1|NA INSERT
EDIT_DET | CNLNCE_ACX_EDIT_01|]XVL_CR_LMT_UTL_A

587 AILS MT_COS2|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|XVL_CR_LMT_UTL_A

588 AILS MT_COS2|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|XVL_CR_LMT_UTL_A

589 AILS MT_COS2|NA INSERT
EDIT_DET | CNLNCE_ACX_EDIT_01|]XVL_CR_LMT_UTL_A

590 AILS MT_SPOUSE_COS2|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|XVL_CR_LMT_UTL_A

591 AILS MT_SPOUSE_COS2|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|XVL_CR_LMT_UTL_A

592 AILS MT_SPOUSE_COS2|NA INSERT
EDIT_DET | CNLNCE_ACX_EDIT_01|]XVL_CR_LMT_UTL_A

593 AILS MT_BUS| NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|XVL_CR_LMT_UTL_A

594 AILS MT_BUS| NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|XVL_CR_LMT_UTL_A

595 AILS MT_BUS|NA INSERT
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EDIT_DET | CNLNCE_ACX EDIT _01|CHD_CR _LMT_EXP_D

596 AILS T_SPOUSE|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|CHD_CR_LMT_EXP_D

597 AILS T_SPOUSE|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|CHD_CR_LMT_EXP_D

598 AILS T_SPOUSE|NA INSERT
EDIT_DET | CNLNCE_ACX_EDIT_01|CHD_CR_LMT_EXP_D

599 AILS T_2NDRY|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|CHD_CR_LMT_EXP_D

600 AILS T_2NDRY|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|CHD_CR_LMT_EXP_D

601 AILS T_2NDRY|NA INSERT
EDIT_DET | CNLNCE_ACX_EDIT_01|CHD_CR_LMT_EXP_D

602 AILS T_COS|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|CHD_CR_LMT_EXP_D

603 AILS T_COS|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|CHD_CR_LMT_EXP_D

604 AILS T_COS|NA INSERT
EDIT_DET | CNLNCE_ACX_EDIT_01|CHD_CR_LMT_EXP_D

605 AILS T_SPOUSE_COS1|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|CHD_CR_LMT_EXP_D

606 AILS T_SPOUSE_COS1|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|CHD_CR_LMT_EXP_D

607 AILS T_SPOUSE_COS1|NA INSERT
EDIT_DET | CNLNCE_ACX_EDIT_01|CHD_CR_LMT_EXP_D

608 AILS T_COS2|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|CHD_CR_LMT_EXP_D

609 AILS T_COS2|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|CHD_CR_LMT_EXP_D

610 AILS T_COS2|NA INSERT
EDIT_DET | CNLNCE_ACX_EDIT_01|CHD_CR_LMT_EXP_D

611 AILS T_SPOUSE_COS2|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT_01|CHD_CR_LMT_EXP_D

612 AILS T_SPOUSE_COS2|NA INSERT
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EDIT_DET | CNLNOE_ACX_EDIT_01|CHD_CR_LMT_EXP_D

613 AILS T _SPOUSE_COS2|NA INSERT
EDIT_DET | CNLNCE_ACX_EDIT_01|CHD_CR_LMT_EXP_D

614 AILS T_BUS|NA INSERT
EDIT_DET | CNLSCE_ACX_EDIT _01|CHD_CR_LMT_EXP_D

615 AILS T_BUS|NA INSERT
EDIT_DET | CNLNOE_ACX_EDIT_01|CHD_CR_LMT_EXP_D

616 AILS T_BUS|NA INSERT

Customer Preference Web Service

SI. No | Table Key Data Type
FLS ACC FLL.CUSTOMERPREFERENCERESOURCE.GE

1 ESS T.FETCHPREFERENCE INSERT
FLS _ACC FLL.CUSTOMERPREFERENCERESOURCE.PO

2 ESS ST.POSTPREFERENCE INSERT
FLS ACC FLL.UPDATECUSTOMERPREFERENCERESOU

3 ESS RCE.PUT.UPDATEPREFERENCE INSERT

Permission to Text

SI. No | Table Key Data Type
FLEX_TAB
LE _ATTRI INP_BMP_TNM|TNM_PERMISSION_TO_TEXT _|I

1 BUTES ND INSERT
FLEX TAB
LE _ATTRI INP_BMP_TNM|TNM_AAR_PERMISION_TO_TE

2 BUTES XT1_IND INSERT
FLEX_TAB
LE_ATTRI INP_BMP_TNM|TNM_AAR_PERMISION_TO_TE

3 BUTES XT2_IND INSERT
TRANSLA | SYS|SYS|SYS|TNM|001746|PERMISSIONTOCA
TION_DAT | LL/ITEXTINDICATORCHECKEDIN,PLEASEENTE

4 A RPHONE#|SYS|MSG-SE INSERT
TRANSLA | SYS|SYS|SYS|UCS|001746|PERMISSIONTOCA
TION_DAT | LL/ITEXTINDICATORCHECKEDIN,PLEASEENTE

5 A RPHONE#|SYS|MSG-SE INSERT
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TRANSLA | SYS|SYS|SYS|ULN|001746|PERMISSIONTOCAL
TION_DAT | LITEXTINDICATORCHECKEDIN,PLEASEENTE

6 A RPHONE#|SYS|MSG-SE INSERT
TRANSLA | SYS|SYS|SYS|UVN|001746|PERMISSIONTOCA
TION_DAT | LL/ITEXTINDICATORCHECKEDIN,PLEASEENTE

7 A RPHONE#|SYS|MSG-SE INSERT
TRANSLA | SYS|SYS|SYS|UPR|001746|PERMISSIONTOCA
TION_DAT | LL/ITEXTINDICATORCHECKEDIN,PLEASEENTE

8 A RPHONE#|SYS|MSG-SE INSERT
TXN_COD
E_PARAM | CUS_ADR_PH_MAINT|TNM_PERMISSION_TO_

9 ETERS TEXT_IND INSERT
TXN_COD
E_PARAM | CUS_EMPL_MAINT|TNM_PERMISSION_TO_TE

10 ETERS XT_IND INSERT
TXN_COD
E_PARAM | CUS_NEW_TEL|TNM_PERMISSION_TO_TEXT_

11 ETERS IND INSERT
TXN_COD
E_PARAM | CUS_TEL_MAINT|TNM_PERMISSION_TO_TEX

12 ETERS T _IND INSERT
TXN_COD
E_PARAM | REF_STATUS_MAINT|TNM_AAR_PERMISION_

13 ETERS TO_TEXT1 IND INSERT
TXN_COD
E_PARAM | REF_STATUS_MAINT|TNM_AAR_PERMISION_

14 ETERS TO_TEXTZ2_IND INSERT
TXN_COD
E_PARAM | REF_STATUS NEW|TNM_AAR_PERMISION_T

15 ETERS O_TEXT1_IND INSERT
TXN_COD
E_PARAM | REF_STATUS NEW|TNM_AAR_PERMISION_T

16 ETERS O_TEXTZ2_IND INSERT
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SI. No | Table Key Data Type
SEARCH _
PRO_PRO

1 DUCERS CNB_DEC INSERT
FLEX_TAB
LE_ATTRI

2 BUTES SEARCH_PRO_PRODUCERS|PRO_NBR INSERT
FLEX_TAB
LE_ATTRI

3 BUTES SEARCH_PRO_PRODUCERS|PRO_NAME INSERT
FLEX _TAB
LE_ATTRI | SEARCH_PRO_PRODUCERS|PRO_STATUS_C

4 BUTES D INSERT
FLEX_TAB
LE_ATTRI | SEARCH_PRO_PRODUCERS|PRO_GROUP_C

5 BUTES D INSERT
FLEX_TAB
LE ATTRI

6 BUTES SEARCH_PRO_PRODUCERS|PRO_TYPE_CD INSERT
FLEX_TAB
LE_ATTRI | SEARCH_PRO_PRODUCERS|PRO_GRADE_C

7 BUTES D INSERT
FLEX TAB
LE _ATTRI

8 BUTES SEARCH_PRO_PRODUCERS|PRO_ZIP INSERT

FLEX_TABLE_TYPE_CD|PRO_SEARCH_PARA

9 LOOKUPS | METER_CD INSERT
FLS ACC | FLL.CMN.UPR.PRODUCERDETAILSEARCHRE

10 ESS SULT.TAB INSERT

Personally Identifiable Information Masking

SI. No | Table Key Data Type

1 JOBS SET-IFP|IPIPRC_BJ_100_01 INSERT

2 JOBS SET-RED|REDPRC_BJ 100 01 INSERT

3 JoB SET-IFP|IPIPRC_BJ_100_01|1 INSERT
THREADS - ==
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Sl. No | Table Key Data Type
4 JoB SET-RED|REDPRC_BJ_100_01]1 INSERT
THREADS — ==
5 JOB_SETS | SET-RED INSERT
6 LOOKUPS | INCOMING_FILE_TYPE_CD|IPI INSERT
7 MENU_AC | FLL.SET.UAD.DATAMASKINGSETUP.MENU|SE INSERT
CESS TUP_SYSTEM_MENU
8 EESS—ACC FLL.SET.UAD.DATAMASKINGDETAILS.TAB INSERT
9 FLS ACC | FLL.SET.UAD.DATAMASKINGDETAILS.EDIT.BU INSERT
ESS TTON
FLS ACC | FLL.SET.UAD.DATAMASKINGDETAILS.VIEW.B
10 JEss UTTON INSERT
FLS ACC | FLL.SET.UAD.DATAMASKINGDETAILS.AUDIT.B
1 ESS UTTON INSERT
12 FLS ACC | FLL.SET.UAD.DATAMASKINGUSERACCESS.T INSERT
ESS AB
FLS ACC | FLL.SET.UAD.DATAMASKINGUSERACCESS.A
13 ESS DD.BUTTON INSERT
FLS ACC FLL.SET.UAD.DATAMASKINGUSERACCESS.E
14 ESS DIT.BUTTON INSERT
15 FLS ACC | FLL.SET.UAD.DATAMASKINGUSERACCESS.VI INSERT
ESS EW.BUTTON
FLS ACC FLL.SET.UAD.DATAMASKINGUSERACCESS.A
16 ESS UDIT.BUTTON INSERT
17 E;SS—ACC FLL.SET.UAD.DATAMASKINGSETUP.MENU INSERT
FLEX_TAB
18 LE_ATTRI | SET_SYP_SYSTEM]|IPI_DIRECTORY INSERT
BUTES
FLEX_TAB
19 LE_ATTRI (S)ER'I\'(_SYP_SYSTEM|IPI_PROCESSED_DIRECT INSERT
BUTES
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Sl. No | Table Key Data Type
SYSTEM
— | IPI_DIRECTORY|SET_SYP_SYSTEMIALL|ALL|A
21 PARAMET LLJALLIALL|ALLIALL INSERT
ERS
22 ?XFSQEI%/IAI/—ZITI' IPI_PROCESSED_DIRECTORY|SET_SYP_SYS INSERT
ERS TEMJ|ALL|ALLJALLJALLJALLJALLJALL
Lease Compensation
Sl. No | Table Key Data Type
LOOKUPS LEASE_COMP_CALC_METHOD_CD|COMP_AS_EA INSERT
RNED
LOOKUPS LEASE_COMP_CALC_METHOD_CD|COMP_PAY_A INSERT
S U GO
LOOKUPS LEASE_COMP_CALC_METHOD_CD|COMP_UPFRO INSERT
NT_ME
LEASE_COMP_FORMULA_METHOD_CD|PER_AMT
LOOKUPS _FINANCED INSERT
LEASE_COMP_SPREAD_FORMULA_CD|PER_AMT_
LOOKUPS FINANCED INSERT
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3. Patches and Bugs
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4. Security Fixes
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5.Limitations and Open issues

Bug # Bug Description
27913968 TERMINATION REVERSAL MAKING THE DUE AMOUNT AS 0
27849148 RATE CHANGE BATCH NOT PICKING THE ACCOUNTS
27831003 VERTEX: NOT GETTING PROPER ERROR MESSAGE WHEN CHANNEL IS VERTEX
27788989 AM POOL OFF - SHOW DETAILS BUTTON DOES NOT WORK IN SCENARIO ANALYSIS
27764580 ERROR IS NOT COMING ON UPLOADING TAX/CERTIFICATE WHEN START AND END DATE.
27755763 DIFFERENT TAX SET UP IS NOT GETTING SELECTED FOR MULTIPLE ASSETS
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6. Components of the Software

Documents accompanying the software

The various documents accompanying the software are as follows:

e Release Notes
e Installation Guides
e [nstaller Kit

e User Manuals, Administration/setup Guide, Installation and reference documents - These
can be accessed from the link https://docs.oracle.com/cd/E95814 01l/index.htm

Software Components

Software Components of this release are as follows:

e Core
> Ul Components Ear file (JSF, XML, XLF, JSFF)
> Stored Procedures (Packages, Views, Java Stored procedures)
> Reporting Components(Data models(xdm), Reports(xdo, rtf))
> BIP / canned reports
e Interface
> Stored Procedures (Packages, Views, Types)
> The WSDL files for the service supported
>  XSD Structure (dictionary) for the web service
>  Configuration files for the web service
» Java classes for the web service
» The service documents — describing the services
>  Extensibility Document — Describes customization for the services.
e Installation utilities
>  Script based installation for Database components
> Installation documents for Database, Ul, Web services
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7. Annexure — A: Environment Details

Component Deployment Machine Ol Software Version
option System
Oracle WebLogic
Enterprise
Edition(Fusion
Middleware 12.2.1.3.0
Infrastructure installer
—includes ADF and
Application Oracle RCU)
server Enterprise
Linux 6.7+
&7.0 (64 Oracle JDK 1.8.0_144
Bit) and
Sun o
Application
SPARC
with Oracle D':evelopmel?t 12.2.1.3.0
Solaris 11 ramewor
(64 Bit)
Oracle Database Oracle Database
\ ; . o 12.1.0.2.0
Financial Server Enterprise Edition
Services Centralized
Lending and _ _
Leasing Reporting Oracle Business
Server Intelligence Publisher 12.2.1.3.0
Windows 7 *Microsoft Edge 20
(version (64 Bit)
6.1),
Windows Internet Explorer 11.0
10* (64 Bit) '
(version
Client 1703) Mozilla Firefox 52
Machines (32 Bit)
Google Chrome 65
(64 Bit)
Apple Safari 11
(64 Bit)
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8. Annexure — B: Third Party Software Details

Licensor Name Licensed Technology Version
Apache SOAP 2.3.1
Jason Hunter & Brett McLaughlin JDOM 2.0.6
Apache Ant 1.10.1
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